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LEGATO Software
A Division of EMC Corporation

End-User License Agreement
THIS PRODUCT CONTAINS CERTAIN COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL, THE USE OF WHICH IS SUBJECT TO 
THIS END-USER LICENSE AGREEMENT (THE "EULA").  DO NOT PROCEED WITH THE INSTALLATION OF THIS PRODUCT UNTIL YOU (LATER 
DEFINED AS LICENSEE) HAVE READ THIS EULA AND AGREE TO BE BOUND BY AND BECOME A PARTY TO THIS EULA.  BY PROCEEDING 
WITH THE INSTALLATION OF THIS PRODUCT (OR AUTHORIZING ANY OTHER PERSON TO DO SO), YOU AND YOUR COMPANY ACCEPT 
THIS EULA AND YOU REPRESENT THAT YOU ARE AUTHORIZED TO DO SO. IF YOU ARE ACCESSING THE PRODUCT ELECTRONICALLY 
INDICATE YOUR ACCEPTANCE OF THESE TERMS BY SELECTING THE "ACCEPT" BUTTON AT THE END OF THE EULA.  IF YOU DO NOT AGREE 
TO THE TERMS OF THIS EULA, YOU MAY RETURN THIS PRODUCT, ALL MEDIA AND DOCUMENTATION, AND PROOF OF PAYMENT, TO THE 
PLACE YOU OBTAINED THEM FOR A FULL REFUND WITHIN THIRTY (30) DAYS OF FIRST ACQUIRING THIS PRODUCT OR, IF THE PRODUCT 
IS ACCESSED ELECTRONICALLY, SELECT THE "DECLINE" BUTTON AT THE END OF THIS EULA AND RETURN PROOF OF PAYMENT IN 
ACCORDANCE WITH THE ABOVE REFERENCED RETURN/REFUND PROCESS. WRITTEN APPROVAL IS NOT A PREREQUISITE TO THE 
VALIDITY OR ENFORCEABILITY OF THIS EULA AND NO SOLICITATION OF ANY SUCH WRITTEN APPROVAL BY OR ON BEHALF OF LEGATO 
SHALL BE CONSTRUED AS AN INFERENCE TO THE CONTRARY.  IF YOU HAVE ORDERED THIS PRODUCT, LEGATO'S ACCEPTANCE IS 
EXPRESSLY CONDITIONAL ON YOUR ASSENT TO THESE TERMS TO THE EXCLUSION OF ALL OTHER TERMS; IF THESE TERMS ARE 
CONSIDERED AN OFFER BY LEGATO, ACCEPTANCE IS EXPRESSLY LIMITED TO THESE TERMS.

1. DEFINITIONS

1.1 Authorization Code: means the unique code provided to Licensee by 
LEGATO for permanent activation of the Software.  The Authorization 
Code is provided to Licensee once the Enabler Code is registered with 
LEGATO.  The Authorization Code may be tied to a unique machine ID 
code supplied by Licensee.

1.2 Documentation: Documentation:  means the user reference materials 
on any media, provided by LEGATO for use with the Software.

1.3 Enabler Code: means the code provided by LEGATO for activation of 
the Software.

1.4 Licensee: means the person or entity acquiring this License or for 
whom this License was acquired.

1.5 Software: means the object code copy of the software program 
provided to You in association with this EULA, together with the 
associated original media and all accompanying Documentation, and 
together with all Updates that may be provided by LEGATO to You from 
time to time.

2. OWNERSHIP AND ADMINISTRATION OF SOFTWARE 

2.1 Ownership and Title.  As between the parties, LEGATO, and its 
licensors, own and shall retain all right, title, and interest in and to:  (i) the 
Software including all intellectual property rights embodied therein; (ii) all 
of the service marks, trademarks, trade names, or any other designations 
associated with the Software; and (iii) all copyrights, patent rights, trade 
secret rights, and other proprietary rights relating to the Software.  

2.2     Software Activation.  LEGATO employs Enabler Codes and 
Authorization Codes that enable the use of the Software.  The Software is 
shipped in a ”Media Kit” which consists of object code software on 
CD-ROM and an Enabler Code for initial activation of the Software or the 
Software and Enabler Code may be delivered electronically.  Once 
LEGATO receives confirmation from Licensee that the Software is 
installed with the correct Enabler Code, and is provided with the host ID 
information, LEGATO will provide the Authorization Code to Licensee. 
LEGATO administers the generation and distribution of Enabler and 
Authorization Codes, which administration may be modified by LEGATO 
from time to time.

2.3 Administration of Software.  LEGATO may include on the media with 
the Software additional computer programs which are not currently 
licensed for use by Licensee and to which the Enabler Code or 
Authorization code will not permit access.  Inclusion of such additional 
computer programs in no way implies a license from LEGATO and access 
or use of such programs is strictly prohibited unless Licensee procures the 
right to use any such program and the applicable Enabler Code is 
provided thereto.

3. LICENSE GRANT

3.1 Grant.  LEGATO grants to Licensee a non-exclusive, nontransferable, 
non-sublicensable, perpetual (unless terminated in accordance with the 
provisions of this EULA), license (the “License”) to (i) use the Software 
installed in accordance with the Documentation and only on the licensed 
computer(s) solely for its own internal operations; and (ii) move the 
Software temporarily in case of computer system malfunction.  The 
Software may be licensed: (a) on a per copy or per seat basis, on a physical 
or virtual machine, (b) based upon the number of mailboxes or the number 
of non-concurrent users for which it may be used, or (c) based upon data 

volumes it supports.  The License granted under this EULA does not 
constitute a sale of the Software or any portion or copy of it.  Licensee may 
not use the Software on more than one computer system unless otherwise 
specifically authorized by an explicit Software product, or additional 
licenses for additional computers are purchased.  Rights not expressly 
granted are reserved by LEGATO.

3.2 Copies. Licensee may make copies of the Software provided that any 
such copy is:  (i) created as an essential step in utilization of the Software 
as licensed and is used in no other manner; or (ii) used for archival 
purposes.  All trademark and copyright notices must be reproduced and 
included on such copies.  Licensee may not make any other copies of the 
Software.

3.3 Restrictions on use. Licensee shall not, and shall not aid, abet, or 
permit any third party to:  (i) decompile, disassemble, or otherwise reverse 
engineer or attempt to reconstruct or discover any source code or 
underlying ideas or algorithms of the Software by any means whatsoever; 
(ii) remove any identification, copyright, or other notices from the 
Software; (iii) provide, lease, lend, use for timesharing or service bureau 
purposes; (iv) create a derivative work of any part of the Software; or (v) 
develop methods to enable unauthorized parties to use the Software.  If EC 
law is applicable, the restrictions in Section 3.3 (i) are limited so that they 
prohibit such activity only to the maximum extent such activity may be 
prohibited without violating the EC Directive on the legal protection of 
computer programs.  Notwithstanding the foregoing, prior to 
decompiling, disassembling, or otherwise reverse engineering any of the 
Software, Licensee shall request LEGATO in writing, to provide Licensee 
with such information or assistance and Licensee shall refrain from 
decompiling, disassembling, or otherwise reverse engineering any of the 
Software unless LEGATO cannot or has not complied with such request in 
a commercially reasonable amount of time.

3.4 Purchase Orders.  Nothing contained in any purchase order, 
acknowledgment, or invoice shall in any way modify the terms or add any 
additional terms or conditions to this EULA.

3.5 Updates.  This section applies if the Software acquired is an update to 
the original Software (the “Update”).  An Update does not constitute a 
legally licensed copy of the Software unless purchased as an Update to a 
previously licensed version of the same Software.  The Update may only 
be used in accordance with the provisions of this EULA.  The Update, 
together with the original Software, constitutes one (1) legally licensed 
copy of the Software.

3.6 Evaluation License.  This Section applies if the Software is being used 
for an initial thirty (30) day evaluation period.  The license is valid only for 
a period of thirty (30) days from the delivery of the Software, and is 
designed to allow Licensee the right to evaluate the Software during such 
period.  In the event that Licensee desires to continue to license the 
Software, Licensee must purchase a license to the Software. Upon such 
purchase, Licensee will be provided with an Enabler Code in accordance 
with Section 2.2 above.  In the event Licensee determines not to purchase 
a license for the Software at the end of such thirty (30) day evaluation 
period, then Licensee’s rights under this EULA shall terminate 
automatically and Licensee shall promptly return to LEGATO or destroy 
all copies of the Software and so certify to LEGATO. 

3.7 General Public License ("GPL").  The Software may include one or 
more components which are derived from software subject to a General 
Public License.  Any such components are licensed exclusively under the 
applicable GPL and not under this EULA.



4. MAINTENANCE AND SUPPORT

4.1 LEGATO has no obligation to provide support, maintenance, 
upgrades, modifications, or new releases under this EULA.  LEGATO may 
provide such services under separate EULA.

5. LIMITED WARRANTY

5.1 Media and Documentation.  LEGATO warrants that if the media or 
documentation are damaged or physically defective at the time of delivery 
of the first copy of the Software to Licensee and if defective or damaged 
product is returned to LEGATO (postage prepaid) within thirty (30) days 
thereafter, then LEGATO will provide Licensee with replacements at no 
cost.

5.2 Limited Software Warranty.  Subject to the conditions and limitations 
of liability stated herein, LEGATO warrants for a period of thirty (30) days 
from the delivery of the first copy of the Software to Licensee that the 
Software, as delivered, will materially conform to LEGATO’s then current 
published Documentation for the Software.  This warranty covers only 
problems reported to LEGATO during the warranty period.  For 
customers outside of the United States, this Limited Software Warranty 
shall be construed to limit the warranty to the minimum warranty 
required by law.

5.3 Remedies.  The remedies available to Licensee hereunder for any such 
Software which does not perform as set out herein shall be either repair or 
replacement, or, if such remedy is not practicable in LEGATO’s opinion, 
refund of the license fees paid by Licensee upon a return of all copies of the 
Software to LEGATO.   In the event of a refund this EULA shall terminate 
immediately without notice with respect to such Software. 

6. WARRANTY DISCLAIMER

6.1 Warranty Disclaimer.  EXCEPT FOR THE LIMITED WARRANTY 
PROVIDED IN SECTION 5 ABOVE, ALL SOFTWARE IS PROVIDED "AS 
IS". LEGATO AND ITS LICENSORS MAKE NO WARRANTIES WITH 
RESPECT TO ANY SOFTWARE AND DISCLAIMS ALL STATUTORY OR 
IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, OR ARISING FROM A COURSE OF DEALING OR USAGE 
OF TRADE AND ANY WARRANTIES OF NONINFRINGEMENT.  
LEGATO DOES NOT WARRANT THAT THE SOFTWARE WILL MEET 
ANY REQUIREMENTS OR THAT THE OPERATION OF SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR FREE.  ANY LIABILITY OF 
LEGATO WITH RESPECT TO THE SOFTWARE OR THE 
PERFORMANCE THEREOF UNDER ANY WARRANTY, NEGLIGENCE, 
STRICT LIABILITY OR OTHER THEORY WILL BE LIMITED 
EXCLUSIVELY TO THE REMEDIES SPECIFIED IN SECTION 5.3 ABOVE.  
Some jurisdictions do not allow the exclusion of implied warranties or 
limitations on how long an implied warranty may last, so the above 
limitations may not be applicable.

7. LIMITATION OF LIABILITY

7.1 Limitation of Liability.  EXCEPT FOR BODILY INJURY, LEGATO 
(AND ITS LICENSORS) WILL NOT BE LIABLE OR RESPONSIBLE WITH 
RESPECT TO THE SUBJECT MATTER OF THIS EULA UNDER ANY 
CONTRACT, NEGLIGENCE, STRICT LIABILITY, OR OTHER LEGAL OR 
EQUITABLE THEORY FOR:  (I) ANY INDIRECT,  SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED 
AND WHETHER OR NOT ADVISED IN ADVANCE OF THE 
POSSIBILITY OF SUCH DAMAGES; OR (II) DAMAGES FOR LOST 
PROFITS OR LOST DATA; OR (III) COST OF PROCUREMENT OF 
SUBSTITUTE GOODS, TECHNOLOGY, SERVICES, OR RIGHTS; OR (IV) 
FOR AMOUNTS IN EXCESS OF THOSE RECEIVED BY LEGATO FOR 
THE PARTICULAR LEGATO SOFTWARE THAT CAUSED THE 
LIABILITY.  Because some jurisdictions do not allow the exclusion or 
limitation of incidental or consequential damages, LEGATO's liability in 
such jurisdictions shall be limited to the extent permitted by law.

8. TERM AND TERMINATION

8.1 Term.  The term of this EULA is perpetual unless terminated in 
accordance with its provisions.

8.2 Termination.  LEGATO may terminate this EULA, without notice, 
upon Licensee's breach of any of the provisions hereof.

8.3 Effect of Termination.  Upon termination of this EULA, Licensee 
agrees to cease all use of the Software and to return to LEGATO or destroy 
the Software and all Documentation and related materials in Licensee's 
possession, and so certify to LEGATO.  Except for the License granted 
herein and as expressly provided herein, the terms of this EULA shall 
survive termination.

9. MISCELLANEOUS

9.1 Governing Law.  This EULA shall be governed by the laws of the 
Commonwealth of Massachusetts, without regard to the principles of 
conflict of laws or the United Nations Convention on Contracts for the 
International Sale of Goods.

9.2 Government Restricted Rights.    Any Software which is acquired 
directly or indirectly for or on behalf of the United States of America, its 
agencies and/or instrumentalities ("U.S. Government"), is provided with 
Restricted Rights. Use, duplication, or disclosure by the U.S. Government 
is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 
or subparagraphs (c)(1) and (2) of the Commercial Computer Software - 
Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is 
LEGATO Software, a division of EMC Corporation, 2350 W. El Camino 
Real, Mountain View, CA 94040.  The Software is a commercial software 
product, licensed on the open market at market prices, and was developed 
entirely at private expense and without the use of any government funds.

9.3 Export and Import Controls.  Regardless of any disclosure made by 
Licensee to LEGATO of an ultimate destination of the Products, Licensee 
may not directly or indirectly export or transfer any portion of the 
Software, or any system containing a portion of the Software, to anyone 
outside the United States (including further export if Licensee took 
delivery outside the U.S.) without first complying with any export or 
import controls that may be imposed on the Software by the U.S. 
Government or any country or organization of nations within whose 
jurisdiction Licensee operates or does business.  Licensee shall at all times 
strictly comply with all such laws, regulations, and orders, and agrees to 
commit no act which, directly or indirectly, would violate any such law, 
regulation or order.

9.4 Assignment.  This EULA may not be assigned or transferred by 
Licensee without the prior written consent of LEGATO, which shall not be 
unreasonably withheld.  LEGATO may assign or otherwise transfer any or 
all of its rights and obligations under this EULA upon notice to Licensee.

9.5 Sole Remedy and Allocation of Risk.  Licensee's sole and exclusive 
remedies are set forth in this EULA.  This EULA defines a mutually 
agreed-upon allocation of risk, and the License price reflects such 
allocation of risk.

9.6 Equitable Relief.  The parties agree that a breach of this EULA 
adversely affecting LEGATO's intellectual property rights in the Software 
may cause irreparable injury to LEGATO for which monetary damages 
may not be an adequate remedy and LEGATO shall be entitled to equitable 
relief in addition to any remedies it may have hereunder or at law.

9.7 No Waiver.  Failure by either party to enforce any provision of this 
EULA will not be deemed a waiver of future enforcement of that or any 
other provision, nor will any single or partial exercise of any right or 
power hereunder preclude further exercise of any other right hereunder.

9.8 Severability.  If for any reason a court of competent jurisdiction finds 
any provision of this EULA, or portion thereof, to be unenforceable, that 
provision of the EULA will be enforced to the maximum extent 
permissible so as to effect the intent of the parties, and the remainder of 
this EULA will continue in full force and effect.

10. ENTIRE EULA

10.1 This EULA sets forth the entire understanding and EULA between the 
parties and may be amended only in a writing signed by authorized 
representatives of both parties.  No vendor, distributor, reseller, dealer, 
retailer, sales person, or other person is authorized by LEGATO to modify 
this EULA or to make any warranty, representation, or promise which is 
different than, or in addition to, the warranties, representations, or 
promises made in this EULA.  No pre-printed purchase order terms shall 
in any way modify, replace or supersede the terms of this EULA.
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Preface

This guide provides information on how to configure and manage the 
EmailXtender® software.

Install the EmailXtender (EX) software on the appropriate server and clients 
before using the information presented in this guide. Refer to the EmailXtender 
Installation Guide for installation instructions.

Post-release information is contained in the Release Supplement for this 
product.

Audience
The information in this guide is intended for system administrators who are 
responsible for installing software and maintaining the servers and clients on 
a network.

Product Documentation
For a complete list of documentation related to this product, see the 
EmailXtender product installation CD-ROM. Most of the documents are 
Adobe Acrobat PDFs, and can be viewed by downloading and installing the 
Adobe Acrobat Reader. The Reader is available on the product installation 
CD-ROM, or directly from Adobe. To install and use the Reader on the 
preferred platform, refer to the instructions in the CD-ROM or at the Adobe 
web site.
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Conventions
This document uses the following typographic conventions and symbols to 
make information easier to access and understand.

Convention Indicates Example

boldface Names of line commands, 
daemons, options, 
programs, or scripts

The nsradmin command starts the 
command line version of the NetWorker 
Administrator program.

italic in text Pathnames, filenames, 
computer names, new terms 
defined in the Glossary or 
within the chapter, or 
emphasized words

Displayed messages are also written to 
/nsr/logs/daemon.log.

The specifications are created, one for each 
swap file, in c:\pagefile.sys.

italic in 
command line

A variable that must be 
provided in the command 
line

nwadmin -s server_name

fixed-width Examples and information 
displayed on the screen

media waiting: recover waiting for 
8mm 5GB tape volume name

fixed-width, 
boldface

Commands and options that 
must be entered exactly as 
shown

nsr_shutdown -a

Menu_Name>
Command

A path or an order to follow 
for making selections in the 
user interface

Volume>Change Mode>Appendable

Important: Information that must be 
read and followed to ensure 
successful backup and 
recovery of data

Important: Use the no_verify option with 
extreme caution.
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Information and Services
LEGATO offers a variety of methods (including e-mail, telephone, and fax 
support) to obtain company, product, and technical information.

General Information

The LEGATO web site provides most of the information that customers might 
need, including technical bulletins and binary patches from its FTP site. For 
specific sales or training needs, e-mail or call LEGATO.

Technical Support

The LEGATO web site provides contact information, software patches, 
technical documentation, and information about available support programs.

• Customers with an active support agreement have access to the LEGATO 
integrated product knowledge base. Help with software issues is also 
available through Technical Support.

• Customers without an active support agreement can contact Support Sales 
and Renewal to purchase annual software update subscriptions, or 
technical support services for per-update/per-incident assistance.

Note: LEGATO Software technical support and update subscription services 
apply only to (i) LEGATO price-listed software that LEGATO supplies to its 
customers; and (ii) customers that have entered into an authorized LEGATO 
technical support agreement.

Service or Resource
Technical 
Bulletins

Binary 
Patches

Company 
and Product 
Information Training 

www.legato.com Yes Yes Yes Yes

ftp.legato.com
(log in as anonymous)

Yes Yes

LEGATO Sales
(650) 210-7000 (option 1)
sales@legato.com

Yes

LEGATO Education 
Services
(650) 842-9357
training@legato.com

Yes

http://www.legato.com
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Licensing and Registration

To license and register products, go to the licensing web site at www.legato.com. 
To change contact information, transfer licenses, or ask questions about 
licensing, contact LEGATO by using one of the following methods.

Customer Feedback
LEGATO welcomes comments and suggestions about software features, the 
installation procedure, and its documentation.

• To comment on a particular guide, complete the Comments form at 
www.legato.com. Navigate to the documentation page and click the 
Comments link beside the name of the guide. All comments are reviewed 
and acted upon, usually within one business day.

• To help improve our documentation in general, complete a brief survey at 
www.legato.com. Navigate to the documentation page and click the link to 
the survey.

• To provide other suggestions and comments, send e-mail to 
feedback@legato.com. Although LEGATO cannot respond personally to 
every request, all comments and suggestions are considered during 
product design.

Licensing and Registration Contact

Telephone number (650) 812 6000 (option 3, option 2)a

+31 23 554 8881b

a. Contact information for the Americas, Asia, and the Pacific.
b. Contact information for Europe, the Middle East, and Africa.

Fax number (650) 745-1477a

+31 23 554 8808b

E-mail licensing@legato.coma

licensingemea@legato.comb

http://www.legato.com
http://www.legato.com
http://www.legato.com
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Chapter 1: Introduction

LEGATO EmailXtender® (EX) is a comprehensive, policy-based system that 
automatically collects, organizes, retains, and retrieves email messages and 
attachments. EmailXtender automatically copies email and attachments into 
an enterprise Message Center and generates a full-text index of the messages 
and attachments. EmailXtender provides fast access to archived emails, 
enables quick email restoration after virus attacks, and helps reduce server 
backup time.

EmailXtender then archives the data to low-cost and high-capacity storage 
devices, reducing email server stress and bottlenecks by minimizing the size 
of message stores. Administrators can also reduce the size of Microsoft 
Exchange or Lotus Domino message stores by periodically deleting messages 
using the EmailXtract® component.

EmailXtender also helps you save on email storage space by allowing you to 
to capture only a single copy of each message sent or received. For example, if 
a message is sent to a distribution list, EmailXtender archives only a single 
copy of the message instead of a copy for each recipient on the list.

Using EmailXtender for email recordkeeping also helps you to maintain 
compliance with United States federal regulations. For example, as part of U.S. 
Securities and Exchange Commission (SEC) compliance, regulated financial 
organizations should keep records of all email communications between their 
members/employees and customers, as required by the U.S. Code of Federal 
Regulations. EmailXtender rules and retention periods allow you to collect, 
track, and retain specific messages or types of messages.

Administrators, supervisors, and users can conduct intelligent search and 
retrieval of messages. Users have access to their own historical email from a 
central archive, and authenticated administrators or supervisors can quickly 
and easily retrieve messages from an hour ago or years ago to ensure 
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compliance with an existing email policy or to help reduce the cost of 
discovering email during litigation, audit, investigation, or any other 
discovery event.

Note: EmailXaminer™, an add-on component to EmailXtender, offers 
additional advanced surveillance capabilities designed specifically for 
compliance with email regulations and policies, including message sampling, 
customizable automated procedures, intelligent cross-mailbox searching, 
purging, and more. For more information, refer to the EmailXaminer 
documentation.

Before you configure the EmailXtender system, you should be comfortable 
with EmailXtender terminology and concepts. Take the time to read all 
sections, as this will help you attain the best performance, functionality, and 
organization for your email management and archival system.

This chapter identifies key terminology and concepts. For more information, 
see the following sections:

• "EmailXtender System Architecture" on page 22
• "Message Center Architecture" on page 25
• "Collecting Messages" on page 30
• "Archiving Messages" on page 35
• "Searching Messages" on page 37
• "Managing the EmailXtender System" on page 41
• "Managing the Message Store with EmailXtract" on page 43
• "Archiving Messages with EmailXtender Archive Edition" on page 43
• "Configuration Overview" on page 45

Note: This Administrator’s Guide assumes that you have already installed 
EmailXtender. For instructions on planning for and installing the product, 
refer to the EmailXtender Installation Guide.

EmailXtender System Architecture
The EmailXtender system minimally consists of a mail server, an 
EmailXtender server, and a client workstation. (If you are using EmailXtender 
Archive Edition, see "Archiving Messages with EmailXtender Archive 
Edition" on page 43 instead.)
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If you are using Microsoft Exchange 5.5 or Lotus Domino, the EmailXtender 
journaling utility is installed on the mail server. The journaling utility copies 
each message received by the mail server to the mailbox connector monitored by 
EmailXtender.

If you are using Microsoft Exchange 2000 or 2003, you configure Exchange to 
copy messages to the mailbox connector.

EmailXtender then pulls the messages in the mailbox connector into the 
EmailXtender Message Center on the EmailXtender server and begins 
archiving them based on the Message Center hierarchy and rules. 

Note: If you are using sendmail, the MilVault milter and archiver filter the 
mail and move it to the EmailXtender Message Center using transport threads.

EmailXtender also creates full-text indexes of messages and attachments. 
Messages are organized by month and stored in flat, portable files of a 
configurable size (volumes, which are also called container files). If you are 
archiving messages in multiple languages, EmailXtender creates a separate 
volume for each language it archives. (For more information on language 
support in EmailXtender, refer to the Planning the Installation chapter of the 
EmailXtender Installation Guide.)

Volumes close after they reach the allotted capacity or are idle for five days. 
EmailXtender then copies them to the storage drive on the EmailXtender 
server as .emx files. Once they are copied to the storage drive, they can be 
written out to other media, such as media supported through LEGATO 
DiskXtender®. DiskXtender supports a variety of media types, including EMC 
Centera devices, DVD-R, tape, or magneto-optical.

When you install EmailXtender on the EmailXtender server, the software 
publishes a website (located at http://localhost/EmailXtender, where localhost is 
the IP address or server name of the EmailXtender server). Administrators, 
supervisors, and users can access this website to search the EmailXtender 
archive at any time. 

In addition, you can install the EmailXtender Search Plug-in on any computer 
with a Microsoft Outlook or Lotus Notes client installed. The Search Plug-in 
offers EmailXtender search functionality from within these programs.
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Figure 1. EmailXtender System Basic Network Diagram

Depending on your system needs, there are several optional add-in 
components and products that can enhance the EmailXtender system.

• Audit Utility - The EmailXtender Audit Utility is installed on the 
EmailXtender server. It records EmailXtender activity, including 
administrator searches, supervisor searches, directed searches, and 
deletion of any messages or volumes from the EmailXtender mail archive. 
You can then generate audit reports to view statistics or specific 
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information about the searches, retrieved messages, and deleted 
messages or volumes. For more information, see "EmailXtender Audit" 
on page 205.

• EmailXtract - You can install EmailXtract on either the mail server or the 
EmailXtender server. When you install EmailXtract on the mail server, 
you can search for and analyze messages in the message store. When you 
install EmailXtract on the EmailXtender server, you can archive legacy 
messages or other item types (such as meetings, appointments, contacts, 
and reports) in the mail server’s message store to an EmailXtender server, 
remove messages from the mail server and replace them with pointers 
(shortcuts) to copies of the archived messages, and delete messages from 
the mail server message store, in addition to searching for and analyzing 
messages in the message store. For more information, see "EmailXtract" 
on page 257.

• Bloomberg Mail Parser - The Bloomberg Mail Parser, which is installed 
on the EmailXtender server, processes aggregated text files containing 
Bloomberg mail and separates them into individual emails that conform 
to the RFC 822 email standard. The parser then writes the mail files to a 
specified directory, and you can direct EmailXtender to full-text index 
and archive the email. For more information, see "Archiving Bloomberg 
Mail" on page 231.

• LEGATO DiskXtender - If you want to "extend" the capacity of the 
EmailXtender storage drive by writing the .emx files to other storage 
media, you can install DiskXtender on the EmailXtender server. When 
you install DiskXtender, you should configure the EmailXtender storage 
drive as the DiskXtender extended drive. DiskXtender allows you to 
configure automatic file migration to other storage media, such as an 
EMC Centera device, DVD-R, tape, or magneto-optical. For more 
information, see "Using DiskXtender" on page 130.

Message Center Architecture
The EmailXtender Message Center contains all email information collected by 
the EmailXtender server. 

Within the Message Center, data is organized in the following hierarchy: 
server, vault, cabinet, folder, and volume. Each server can contain only one 
vault. By default, EmailXtender also creates a single cabinet and folder when 
you install the product. EmailXtender automatically creates volumes as it 
collects messages received by the Message Center. Volumes are organized by 
the month in which they are created.
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Figure 2. EmailXtender Administrator – Message Center

If you have a relatively simple mail collection and archival strategy - for 
example, you want to collect all mail that passes through the mail server - you 
may only need the default cabinet and folder. 

If you have a more complex collection and archival strategy - for example, you 
want to collect and archive certain users’ email separately from all other users’ 
email - you may need to create additional cabinets and/or folders, and then 
configure rules and retention periods to organize the email archive.

The hierarchy you create in the Message Center, and the rules and retention 
periods you assign to the hierarchy, allow you to classify, organize, and 
archive data in the manner most appropriate for your system. For more 
information on planning the Message Center hierarchy, see "Planning Message 
Center Configuration" on page 60.

Note: If you are using EmailXtender Archive Edition, you are allowed only the 
default cabinet and folder, and use of rules and retention periods is prohibited. 
You must upgrade to a full EmailXtender license to create additional cabinets 
and folders, and gain access to rules and retention period capabilities.

For more information about each element in the EmailXtender Message Center 
hierarchy, see the following sections:

• "Server" on page 27
• "Vault" on page 27
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• "Cabinet" on page 28
• "Folder" on page 29
• "Volume" on page 29

Server

The server is the top-level component of the EmailXtender Message Center, 
and it represents the EmailXtender server. 

Figure 3. Server Level

In the EmailXtender Administrator interface, it is labeled with the Microsoft 
Windows name of the EmailXtender server. The server appears automatically 
when you install EmailXtender and open the Administrator. 

Although the EmailXtender system may include more than one EmailXtender 
server, the Administrator allows you to connect to and configure only one 
server at a time. 

The only configuration you need to perform at the server level is related to the 
storage of EmailXtender volumes; you can specify the path, maximum size, 
and type of media to which they should be written. For more information, see 
"Configuring Volume Storage" on page 128.

Vault

The vault is the second-level component of the EmailXtender Message Center, 
located beneath the server object. Automatically named "EmailVault", the 
vault collects all email data to be processed by EmailXtender.

Figure 4. Vaults
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You can configure the frequency with which EmailXtender polls the mailbox 
connector and transfers messages into the Message Center at the vault level. 
You can also configure additional mailbox connectors, as well as encryption 
and compression for volumes.

If necessary, you can apply collection, exclusion, and action rules at the vault 
level to collect, exclude, or forward mail that matches specified message 
attributes, although you should configure rules at the cabinet or folder level 
for more efficient organization.

For more information on configuring the vault, see "Vault Management" on 
page 66.

Cabinet

Located within the vault, the cabinet is the third-level component of the 
EmailXtender Message Center. By default, EmailXtender creates a single 
cabinet named "Index".

Figure 5. Cabinets

Depending on your mail collection and archival needs, you may want to create 
additional cabinets. For more information on planning the Message Center 
hierarchy, see "Planning Message Center Configuration" on page 60.

You can apply collection, exclusion, and action rules at the cabinet level to 
collect, exclude, or forward mail that matches specified message attributes. If 
you apply rules to a cabinet, you may also want to configure directed searches 
for the cabinet, which allow certain users to search for and view all messages 
collected by the cabinet (in addition to searching their own mail). 

Note: If you are using EmailXtender Archive Edition, you are allowed only the 
default cabinet, and use of rules is prohibited. You must upgrade to a full 
EmailXtender license to create additional cabinets and gain access to rules and 
retention period capabilities.

For more information on creating and configuring a cabinet, see "Cabinets" on 
page 78.
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Folder

Located within a cabinet, the folder object is the fourth-level component of the 
EmailXtender Message Center. By default, EmailXtender creates a single 
folder named "Archive".

Figure 6. Folders

Depending on your mail collection and archival needs, you may want to create 
additional folders. For more information on planning the Message Center 
hierarchy, see "Planning Message Center Configuration" on page 60.

You can apply collection, exclusion, and action rules at the folder level to 
collect, exclude, or forward mail that matches specified message attributes. If 
you apply rules to a folder, you may also want to configure directed searches 
for the folder, which allow certain users to search for and view all messages 
collected by the folder (in addition to searching their own mail). 

You can also set retention periods at the folder level so that volumes created 
within the folder are retained for a certain period of time. After the retention 
period has passed, you can manually remove the volumes.

If necessary, you can disable mail collection for a folder.

Note: If you are using EmailXtender Archive Edition, you are allowed only the 
default folder, and use of rules and retention periods is prohibited. You must 
upgrade to a full EmailXtender license to create additional folders and gain 
access to rules and retention period capabilities.

For more information on creating and configuring a folder, see "Folders" on 
page 84.

Volume

EmailXtender collects messages received by the Message Center into volumes 
(also called container files), which it then organizes by the month of creation. 
(This is the original creation date for the message, and not the date when 
EmailXtender processes them and places them into a message volume.) 
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If you are archiving messages in multiple languages, EmailXtender creates a 
separate volume for each language it archives. (For more information on 
language support in EmailXtender, refer to the Planning the Installation chapter 
of the EmailXtender Installation Guide.)

This organization allows for quick indexing and speeds search times when 
locating archived messages through the Search Plug-in or Web Search Client.

Volumes contain email data and classification information, such as 
classification rules, properties used to create the file, and vault, cabinet, folder, 
and month names. 

Volumes close after they reach the allotted capacity, which you configure at 
the server level, or are idle for five days. EmailXtender then copies them to the 
storage drive as .emx files. Once they are copied to the storage drive, they can 
be written out to other media, such as media supported through DiskXtender.

Because volumes are stored as .emx files, you can add volumes to any 
EmailXtender Message Center with no loss of data or need to convert files, and 
they can be used to restore an entire Message Center. 

In addition, if volumes were created with earlier versions of EmailXtender, 
you can upgrade the volumes to take full advantage of new features available 
in the latest release.

For more information on managing volumes, see "Managing Volumes" on 
page 118.

Collecting Messages
If you are using Microsoft Exchange or Lotus Domino, EmailXtender pulls 
email messages from the mailbox connector on the mail server into the 
EmailXtender Message Center and begins archiving them based on rules and 
configuration. If you are using sendmail, the MilVault milter and archiver 
filter the mail and move it to the EmailXtender Message Center using transport 
threads.

EmailXtender only archives items that would naturally travel through the 
mailbox connector, such as messages and read receipts, but there are a number 
of other ways to archive information through EmailXtender:

• If you use EmailXtract, you can also archive item types such as calendar 
items, contacts, tasks, and reports. For more information on using 
EmailXtract, see "EmailXtract" on page 257.

• If you use EmailXtract in a Microsoft Exchange environment, you can 
also archive items from public folders and .pst files. 
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• If you use EmailXtract in a Lotus Domino environment, you can archive 
items in private .nsf mail databases.

• If you receive Bloomberg Mail from the Bloomberg Professional Service, 
you can use the EmailXtender Bloomberg Mail Parser to process 
Bloomberg aggregated text files and separate them into individual 
emails. The parser then writes the mail files to a specified directory, and 
you can direct EmailXtender to full-text index and archive the email. For 
more information on archiving Bloomberg Mail, see "Archiving 
Bloomberg Mail" on page 231.

• If you use third-party instant message proxy server software to capture 
instant messages, you can archive the captured instant messages to 
EmailXtender. The proxy server software captures instant message 
conversations and converts them into SMTP messages that are then sent 
to EmailXtender to be archived and full-text indexed as any other SMTP 
message. You can use proxy servers from Akonix Systems, FaceTime™ 
Communications (using XML and not Text Version formats), or IMlogic 
with EmailXtender. For information on configuring these proxy servers 
with EmailXtender, refer to the proxy server documentation.

Once the EmailXtender server receives email, it uses message classification 
rules to identify which messages to archive. 

EmailXtender also full-text indexes messages and attachments so that you can 
maximize searches of the email archive. 

You can configure encryption to add security to archived items as they are 
bundled into volumes, or compression to save on the disk space required to 
store message information.

You can also apply retention periods to a folder to define how long 
EmailXtender retains message volumes in that folder before you can delete 
them.

Note: If you are using EmailXtender Archive Edition, you can only collect mail 
and other items using the Archive task in EmailXtract and the MilVault milter 
and archiver. In addition, use of rules and retention periods is prohibited. You 
must upgrade to a full EmailXtender license to have access to additional mail 
archival, rules, and retention period capabilities.

For more information, see the following sections:

• "Rules" on page 32
• "Full-text Indexing" on page 32
• "Encryption and Compression" on page 35
• "Retention Periods" on page 35
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Rules

Mail rules allow you to efficiently organize email archives and media by 
controlling which messages EmailXtender archives. If you do not configure 
any rules, EmailXtender archives all messages. 

You can configure rules at the vault, cabinet, and folder level. Although you 
can configure rules at the vault level, you should set rules at the cabinet or 
folder level for more efficient organization.

You can configure three different types of EmailXtender rules: collection, 
exclusion, and action rules. Collection rules allow you to specify which 
messages EmailXtender collects, exclusion rules allow you to specify which 
messages EmailXtender should not collect, and action rules allow you to 
perform an action on all messages collected by the vault, cabinet, or folder to 
which the rule applies. At this time, the only type of action you can perform 
on a message is to auto-forward it to the email address you specify.

If you are using a pure SMTP mail environment, EmailXtender can also accept 
the external classification rules you configure through the SMTP mail 
program. When configured with external classification, EmailXtender 
automatically creates folders and cabinets to match the rules set up through 
SMTP mail.

You can also create rules using data from a directory services provider such as 
Domino LDAP or Microsoft ADS.

Note: If you are using EmailXtender Archive Edition, use of rules is 
prohibited. You must upgrade to a full EmailXtender license to have access to 
this feature.

For more information on configuring rules, see "Chapter 4: Rules" on page 91.

Full-text Indexing

When EmailXtender collects a message for archiving, it full-text indexes the 
message subject and body, as well as any attachments, so that you can 
maximize searches of the email archive. 
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EmailXtender automatically performs full-text indexing on the following file 
types, as well as text embedded in an email:

EmailXtender can also index .zip files as long as the file types included within 
the .zip file are supported and as long as the .zip file is not password-protected.

• Adobe Acrobat PDF 
versions 2.x - 5.x, and 
6.01 (including 
protected PDF)

• MASS-11PC • Q & A Write

• ANSI Text • Microsoft EML • SGML Text Only

• ASCII Source Code • Microsoft Excel 2, 5, 95, 
97, 2000, XP, and 2003

• Uniplex

• ASCII Text • Microsoft PowerPoint 
4, 95, 97, 2000, XP, and 
2003

• Wang IWP

• ASCII Transcript • Microsoft Word for 
DOS

• Wang WP PLUS

• Compuserve E-mail • Microsoft Word for 
Windows 1, 2, 6, 95, 97, 
2000, XP and 2003

• Windows Write 1.0, 
2.0, 3.0

• DisplayWrite 4, 5 • Microsoft Works 1, 2, 3, 
and 4 (word processor 
only)

• WordPerfect 4.2, 5.0, 
6.0, 7.0, 8.0, 10, and 
2000

• Frame Work 3 • Microsoft RTF (Rich 
Text Format)

• Wordstar 3, 4, 5, 6, 
2000

• HTML data 
(not HTML tags)

• Multimate 3.0, 4.0, 5.0, 
Advantage

• XML

• IBM DCA/RFT • Open Access II • XYWrite

• IBM FFT • Oracle 8 • Uniplex

• Lotus AmiPro • Other spreadsheets

• Lotus Manuscript • Professional Write
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Full-text Indexing of Other Languages

If you are archiving messages that use multi-byte character sets (such as 
Japanese and Simplified Chinese), EmailXtender automatically performs 
full-text indexing on the body and subject of each message, as well as any 
attachments of the following file types:

EmailXtender can also index .zip files as long as the file types included within 
the .zip file are supported and as long as the .zip file is not password-protected.

EmailXtender currently does not support full-text indexing of attachment files 
that have been compressed by LZH applications. Applications used in Asia 
typically use LZH to compress files.

EmailXtender can index only one type of multi-byte language per message. 
EmailXtender cannot index a message that contains multiple non-western 
European languages. For example, if a Simplified Chinese GB2312 encoded 
message contains a Japanese language text attachment file, EmailXtender can 
only index the Chinese characters; the Japanese text file is not indexed. The 
language used to index the message is determined by the language code page 
property of the individual message and not by the language property of the 
attachment file. However, EmailXtender can index both English and 
multi-byte character words correctly if the message is sent by a Japanese or 
Simplified Chinese language version of Microsoft Outlook or if the message is 
encoded by a multi-byte character encoding system. 

EmailXtender indexes Hankaku-Katakana (single-byte Katakana) Japanese 
characters as one word instead of as separate characters. You can search 
Hankaku-Katakana characters by entering a whole sentence (divided by 
space); however, you cannot search by a single character or characters. You 
should use wildcard (*) searches when searching for a Hankaku-Katakana 
word.

• Text • Microsoft PowerPoint 
4, 95, 97, 2000, XP, and 
2003

• Microsoft RTF (Rich 
Text Format)

• Adobe Acrobat PDF 
versions 3.x - 5.x and 
6.01

• Microsoft Word for 
WIndows 97, 2000, XP, 
and 2003

• HTML data

• Microsoft Excel 5, 95, 
97, 2000, XP, and 2003

• Microsoft Works 1, 2, 
3, and 4 (word 
processor only)

• XML
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Encryption and Compression

You can configure encryption and compression for message volumes to add 
security and save on storage space.

Encryption, which is disabled by default in EmailXtender because it can cause 
a decrease in system performance, adds security to archived items as they are 
bundled into volumes. This ensures that volumes are unreadable outside the 
EmailXtender system, thereby increasing the security of the archived data. 

When you enable compression, EmailXtender compresses all messages as they 
are processed by the Message Center. This can mean a considerable savings in 
terms of how much disk space is required for message information. 
Compression does not, however, affect index or database size. 

For more information, see "Encryption and Compression" on page 65.

Retention Periods

Retention periods, configured at the folder level, allow you to track how long 
volumes exist in the EmailXtender system. They are designed to help you to 
meet legal retention requirements by preventing you from deleting volumes 
before the specified amount of time has passed. 

The EmailXtender Administrator interface lists the number of months left in 
the retention period, providing a visible reminder of when you can remove 
outdated volumes. 

Note: If you are using EmailXtender Archive Edition, use of retention periods 
is prohibited. You must upgrade to a full EmailXtender license to have access 
to this feature.

For more information, see "The General Tab" on page 86.

Archiving Messages
EmailXtender captures messages and organizes them by month in volumes. 
Volumes close after they reach the allotted capacity (that you configure) or are 
idle for five days. EmailXtender then copies them to the storage drive on the 
EmailXtender server as .emx files.

You can manually close volumes so that they are copied to the storage drive, 
and move them from one EmailXtender server to another. 

You must regularly monitor the disk space that volumes and their indexes are 
using, and take action appropriately so that you do not run out of space. 
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You can save space by deleting volumes you no longer need, or removing 
indexes and disposing of data for all volumes in a given month. This allows 
users to search for certain messages, but they cannot view them until you 
restore the volumes in which the messages appear. 

Alternatively, you can change the location in which you are saving .emx files 
to a drive with more space, or expand archive space by writing the .emx files 
out to other media, such as media supported through DiskXtender. 
DiskXtender supports a variety of media types, including EMC Centera 
devices, DVD-R, tape, and magneto-optical.

For more information, see the following sections:

• "Managing Volumes" on page 36
• "Archiving Messages to Hard Disk" on page 36
• "Archiving Messages Through DiskXtender" on page 37

Managing Volumes

EmailXtender allows you to manage individual volumes or manage all 
volumes for a given month.

You can manually close, delete, or monitor the status of individual volumes, 
as well as restore "Lost and Found" volumes to the system. In the event that 
you have upgraded from an earlier release of EmailXtender, you can also 
upgrade the volumes created while you were using the earlier release so that 
you can take advantage of the features available in the latest release. 

The EmailXtender Administrator interface allows you to view all volumes for 
a month as a single entity so that you can perform functions on them at the 
same time, such as removing monthly indexes and disposing of all monthly 
data to save disk space. You can also re-index all volumes for a month in order 
to restore an index that you deleted to save space or to replace a corrupted 
index.

For more information on managing volumes, see "Managing Volumes" on 
page 118.

Archiving Messages to Hard Disk

If you are not archiving a large quantity of email and you have a significant 
amount of disk space, you can leave the .emx files on the EmailXtender storage 
drive, which is a local drive or partition on the EmailXtender server. If you 
start to run out of disk space, you can delete volumes you no longer need, or 
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remove indexes and dispose of data for all volumes in a given month. 
Alternatively, you can change the location in which you are saving .emx files 
to a drive with more space.

This archival approach requires careful daily monitoring and is not 
recommended.

For more information on deleting volumes, removing indexes, and disposing 
of monthly data, see "Managing Volumes" on page 118. For more information 
on configuring the volume location, see "Configuring Volume Storage" on 
page 128.

Archiving Messages Through DiskXtender

DiskXtender allows you to extend the storage capabilities of NTFS volumes by 
using DiskXtender file migration services to move files from the NTFS volume 
to other, less-expensive storage media. You can use DiskXtender to "extend" 
the capacity of the EmailXtender storage drive by automatically writing the 
.emx files to other storage media. 

DiskXtender supports a number of storage media types, including EMC 
Centera devices, tape, DVD-R, DVD-RAM, magneto-optical, Ultra-Density 
Optical (UDO), WORM, WORM-tape, and Network Attached Storage (NAS). 
(DiskXtender considers NAS media to be any media available through a 
connection to a share on a network. This could be a network share, like a RAID 
or a NAS device, or simply a shared folder on a server on the network. It could 
even be a shared media folder on another DiskXtender extended drive.)

When you install DiskXtender, you should configure the EmailXtender 
storage drive as the DiskXtender extended drive. You can then configure the 
media service, media folders, move groups, move rules, and purge rules to 
best meet your data migration needs. 

For more information on using DiskXtender with EmailXtender, see "Using 
DiskXtender" on page 130.

Searching Messages
When you install EmailXtender on the EmailXtender server, the software 
publishes a website (located at http://localhost/EmailXtender, where localhost is 
the IP address or server name of the EmailXtender server). Administrators, 
supervisors, and users can access this website to search the EmailXtender 
archive at any time. 
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In addition, you can install the EmailXtender Search Plug-in on any computer 
with a Microsoft Outlook or Lotus Notes client installed. The Search Plug-in 
offers EmailXtender search functionality from within these programs.

Users have access to their own historical email from a central archive, and 
authenticated administrators or supervisors can quickly and easily retrieve 
messages from an hour ago or years ago to ensure compliance with an existing 
email policy or to help reduce the cost of discovering email during litigation, 
audit, investigation, or any other discovery event.

Note: EmailXaminer, an add-on component to EmailXtender, offers additional 
advanced surveillance capabilities designed specifically for compliance with 
email regulations and policies, including message sampling, customizable 
automated procedures, intelligent cross-mailbox searching, purging, and 
more. For more information, refer to the EmailXaminer documentation.

The EmailXtender Audit component discourages unauthorized viewing of 
messages by tracking when supervisors and administrators view and access 
messages sent to other users.

Note: If you are using EmailXtender Archive Edition, you can only install the 
Search Plug-in on the EmailXtender server or use the Web Search Client for an 
administrator search. User searches, supervisor searches, and directed 
searches are prohibited. In addition, EmailXaminer and EmailXtender Audit 
functionality is not available. You must upgrade to a full EmailXtender license 
to have access to these features.

For more information, see the following sections:

• "User Searches" on page 38
• "Supervisor Searches" on page 39
• "Administrator Searches" on page 39
• "Directed Searches" on page 40
• "Auditing Searches" on page 40

User Searches

Once you begin archiving email through EmailXtender, all email users can 
search for their own messages with either the Search Plug-in or the Web Search 
Client.
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Users can search for messages from a particular sender or to a particular 
recipient, as well as for messages that contain certain keywords in the Subject 
field, message body, or attachments. Users can also search for messages on a 
particular date, only those messages with attachments, or messages with a 
certain Importance or Sensitivity level.

Once a user performs a search, there are a number of ways to manipulate the 
search results for easier viewing. You can sort the results by any of the column 
headings, display the results in a grid, wrap column text, remove duplicate 
results, limit the number of results that are returned, and configure whether 
all names are displayed for each result. You can also export search results to a 
tab-delimited file, which you can then open in other programs like Microsoft 
Excel. 

For more information on performing a search and working with search results, 
refer to the EmailXtender Search User’s Guide.

Supervisor Searches

If you want to authorize certain users to search and view messages of other 
selected users, you can define supervisor groups in the EmailXtender 
Administrator interface. Typically, this is used to allow managers to review 
the messages of their subordinates. 

When you create a supervisor group, you specify one or more supervisors, and 
also the users whose mail the supervisors can search for and view.

When users want to perform a supervisor search, they simply select the name 
of their supervisor group from the Search Type drop-down list in the Search 
window of either the Web Search Client or the Search Plug-in.

Supervisors can monitor messages that EmailXtender receives from and for 
the users after you create the supervisor group; messages that EmailXtender 
received before you created the group are not available for supervisor review 
unless you re-index the volumes containing the messages.

For more information on creating and managing supervisor groups, see 
"Supervisor Groups" on page 194.

Administrator Searches

If you want to allow certain users to search for and view all messages in the 
EmailXtender mail archive, you can add them to the EmailXtender 
administrators group so that they can perform administrator searches. 
Administrators can also delete messages they retrieve through a search. 
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Administrator searches can be useful in reducing the cost of discovering email 
during litigation, audit, investigation, or any other discovery event.

Permissions for administrator searches are based on Windows authentication. 
To allow users to perform administrator searches, you must add them to the 
exAdmin group on the EmailXtender server.

When users want to perform an administrator search, they simply select 
Admin from the Search Type drop-down list in the Search window of either 
the Web Search Client or the Search Plug-in.

For more information on allowing administrator searches, see "Administrator 
Searches" on page 201.

Directed Searches

If you have configured the EmailXtender Message Center so that certain types 
of messages are filtered into specific cabinets or folders, you may want to allow 
a few select users to use the Web Search Client or Search Plug-in to search for 
and view all messages in a particular cabinet or folder. This type of search is 
called a directed search, and used in combination with supervisor and 
administrator searches, it allows you to be very exact about who has 
permission to view certain messages.

When you set up directed searches, you select the cabinet or folder that you 
want the users to be able to search, and then you select the users to whom you 
want to give directed search permissions.

When users want to perform a directed search, they simply select the name of 
the cabinet or folder from the Search Type drop-down list in the Search 
window of either the Web Search Client or the Search Plug-in.

For more information on configuring directed searches, see "Directed 
Searches" on page 202.

Auditing Searches

EmailXtender Audit allows you to discourage unauthorized viewing and 
deletion of messages by tracking when supervisors and administrators view 
and access messages sent to or from other users.

When you install EmailXtender Audit, information about each supervisor 
search, administrator search, or directed search is logged to the private 
message queue. Message information is then transferred into the Microsoft 
SQL Server database created by EmailXtender Audit.
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Once the system begins populating the database with search information, you 
can generate a report to view the information.

Note: EmailXtender Audit can only produce reports for searches that were 
performed after its installation. As a result, Audit cannot work retroactively to 
produce a complete report if searches took place before you installed Audit.

For more information on installing EmailXtender Audit, refer to the 
EmailXtender Installation Guide. For more information on running audit 
reports, see "EmailXtender Audit" on page 205.

Managing the EmailXtender System
To keep the EmailXtender system running at maximum performance levels, 
you should regularly monitor the system and resolve any issues that arise as 
quickly as possible.

You can administer an EmailXtender server both from the computer on which 
the EmailXtender server components are installed and from remote 
computers.

To discourage unauthorized viewing and deletion of messages and volumes, 
you can use EmailXtender Audit to monitor administrator activity.

For more information, see the following sections:

• "Remote Administration" on page 41
• "Maintenance and Troubleshooting" on page 42
• "Auditing Administrator Activity" on page 42

Remote Administration

You can administer an EmailXtender server both from the computer on which 
the EmailXtender server components are installed and from remote 
computers. To remotely administer an EmailXtender server, you must install 
the EmailXtender Administrator interface only (you do not need to install the 
EmailXtender server components).

When you open the Administrator - either on the EmailXtender server or on a 
computer with only the Administrator interface - EmailXtender prompts you 
to choose the EmailXtender server you want to administer. You can select 
either the local computer (if the EmailXtender server components are 
installed) or another EmailXtender server on the network.
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Note: You can only configure one EmailXtender server at a time using the 
Administrator interface.

You can also remotely administer the EmailXtender Audit Utility, which is 
installed on the EmailXtender server, when you also install the Audit Utility 
on remote computers.

For more information on installing EmailXtender, including the Administrator 
interface and the Audit Utility, refer to the EmailXtender Installation Guide. For 
more information on connecting to another EmailXtender server, see 
"Connecting to Another EmailXtender Server" on page 51.

Maintenance and Troubleshooting

There are several other steps you should take regularly, such as monitoring the 
message queues and clearing the EmailXtender server of unnecessary files, to 
maintain the EmailXtender system and avoid future problems. For more 
information, see "Maintenance" on page 137.

When problems do occur, however, the information in "Troubleshooting" on 
page 183 may assist you in resolving them. 

Auditing Administrator Activity

You can use EmailXtender Audit to track when administrators view and 
access messages, or delete messages or volumes from the EmailXtender 
message store.

When you install EmailXtender Audit, information about each administrator 
search or deletion is logged and then transferred into the Microsoft SQL Server 
database created by EmailXtender Audit. Once the system begins populating 
the database, you can generate a report to view the information.

Note: EmailXtender Audit can only produce reports for searches and deletions 
that were performed after its installation. As a result, Audit cannot work 
retroactively to produce a complete report if searches and deletions took place 
before you installed Audit.

Note: If you are using EmailXtender Archive Edition, EmailXtender Audit 
functionality is not available. You must upgrade to a full EmailXtender license 
to have access to this feature.

For more information on installing EmailXtender Audit, refer to the 
EmailXtender Installation Guide. For more information on running audit 
reports, see "EmailXtender Audit" on page 205.
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Managing the Message Store with EmailXtract
EmailXtract, which is available with EmailXtender, allows you to manage 
messages in the message store on the mail server. 

When you install EmailXtract on the mail server, you can search for, analyze, 
and delete messages in the message store. 

When you install EmailXtract on the EmailXtender server, you can accomplish 
the following tasks in addition to searching for and analyzing messages in the 
mail server message store:

• Archive legacy messages in the mail server’s message store to an 
EmailXtender server

• Archive other item types, such as calendar items, contacts, tasks, and 
meetings

• Archive items from public folders and .pst files in a Microsoft Exchange 
environment, and from .nsf files in a Lotus Domino environment

• Remove messages from the mail server and replace them with pointers 
(shortcuts) to copies of the archived messages

• Restore shortcuts after you create them
• Delete messages from the mail server message store (after archiving 

them, if you want to archive the messages)

You can manage the mail server message store through EmailXtract by setting 
up tasks. All tasks in EmailXtract are based on a set of default settings. There 
are some settings that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, some that are unique to a Lotus Domino 
environment, and some that are unique to each type of task. You can change 
the default settings if necessary when you create a specific task. 

EmailXtract allows you to run tasks immediately, schedule them to run later, 
or schedule them to run on a recurring basis.

For more information, see "EmailXtract" on page 257.

Archiving Messages with EmailXtender Archive Edition
EmailXtender Archive Edition (EXAE) contains a subset of the full 
EmailXtender product functionality. Intended for the general messaging 
market instead of regulated industries, EXAE allows you to archive messages 
from Microsoft Exchange and Lotus Domino on a scheduled basis (rather than 
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in real time) in order to achieve storage savings. You can also archive messages 
from UNIX sendmail using the MilVault milter and archiver. EXAE is not 
designed for record retention or archiving.

All mail data is captured and archived to the same EXAE cabinet and folder. 
Rules and retention periods are not supported in EXAE.

If you are installing or plan to install and license EXAE, be advised that the 
license provided only allows for a subset of the full EmailXtender 
functionality. Under the License Agreement for EXAE, use of only the following 
functions is permitted: 

• Archival of Microsoft Exchange and Lotus Domino mail using the 
Archive task in EmailXtract

• Archival of UNIX sendmail using the MilVault milter and archiver
• Archival of .pst and .nsf files, as well as items from Public Folders and 

other item types such as calendar items, meetings, and appointments, 
using the Archive task in EmailXtract

• Shortcut creation and management, search, analysis, and deletion using 
EmailXtract tasks

• Full-text indexing of both messages and attachments
• Administrator search using either the Search Plug-in or the Web Search 

Client

Use of the other functions of the EmailXtender product is not permitted under 
the license agreement for EXAE, and use of the functions violates that license 
agreement. Functions that are not available when using an EXAE license 
include:

• Real-time email capture (Journaling/Listener/mailbox connectors)
• Additional cabinets and folders
• Collection, exclusion, and action rules
• Retention periods
• User searches, supervisor searches, and directed searches using either the 

Search Plug-in or the Web Search Client
• EmailXtender Audit
• EmailXaminer
• Archival of Bloomberg Mail using the Bloomberg Mail Parser
• Instant message capture
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If you have any questions regarding permitted and non-permitted 
functionality for EmailXtender Archive Edition, or if you wish to upgrade to a 
full EmailXtender license to have access to the additional functionality it 
allows, contact a LEGATO sales representative.

Configuration Overview
The following procedure lists the steps you need to take to configure 
EmailXtender to meet your system needs. You should perform these steps 
after you install EmailXtender and before you enable journaling on the mail 
server.

Note: If you are using EmailXtender Archive Edition, not all of these features 
are available. For a list of available features, see "Archiving Messages with 
EmailXtender Archive Edition" on page 43. To have access to all product 
features, you must upgrade to a full EmailXtender license.

1. Determine the appropriate mail collection and archival strategy.

For example, you may want to collect all mail that passes through the mail 
server and use DiskXtender to move the volumes to only one type of 
media on a regular basis.
Or, you may want to collect and archive certain users’ email separately 
from all other users’ email, or use DiskXtender to move the resulting 
volumes to storage media.
For assistance, see "Planning Message Center Configuration" on page 60.

2. Create additional cabinets and folders, as necessary. For instructions, see 
"Cabinets" on page 78 and "Folders" on page 84.

3. Create collection, exclusion, and auto forward action rules for the new 
cabinets and folders, as necessary. You can also create rules for collection 
and exclusion using an SMTP mail program, or rules that filter messages 
against an LDAP or ADS schema in addition to or in place of the mail 
system’s address book. For instructions, see "Rules" on page 91.

4. Decide how frequently you want EmailXtender to poll for messages to 
archive and index, and then configure polling frequency on the General 
tab of the Vault Properties dialog box. For instructions, see "The General 
Tab" on page 67.

5. Decide whether you want to enable encryption to increase security or 
compression to save disk space. You can configure these options on the 
Encryption/Compression tab of the Vault Properties dialog box. (You may 
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have already configured compression when you installed EmailXtender 
server components.) For instructions, see "The Encryption/Compression 
Tab" on page 75.

6. Decide whether you want to set retention for message volumes. To set 
retention, enter the number of months you want to retain volumes on the 
General tab of each folder’s Properties dialog box. For instructions, see 
"Vault Management" on page 66.

7. Decide where you want to archive volumes (.emx files) and the maximum 
size they should reach, and then configure those options in the Computer 
Properties dialog box. (You may have already configured these options 
when you installed EmailXtender server components.) For instructions, 
see "Configuring Volume Storage" on page 128.

8. Decide whether you want to use DiskXtender to write volumes to another 
storage media type. To use DiskXtender, install and configure the product. 
For instructions, see "Using DiskXtender" on page 130.

9. Decide whether you want to allow certain supervisors to search for and 
view certain users’ email. To allow supervisor searches, configure 
supervisor groups. For instructions, see "Supervisor Groups" on page 194.

10. Decide whether you want to allow certain users to search for and view all 
messages in the archive by performing administrator searches. For 
instructions, see "Administrator Searches" on page 201.

11. Decide whether you want to allow certain users to search for and view all 
messages in a specific cabinet or folder. To allow directed searches, 
configure them on the Directed Search Access Rights tab of the Properties 
dialog box for the cabinet or folder. For instructions, see "Directed 
Searches" on page 202.

12. If you receive Bloomberg Mail, decide whether you want to archive it 
using EmailXtender. To configure archival of Bloomberg Mail, see 
"Archiving Bloomberg Mail" on page 231.

13. If you use third-party instant message proxy server software to capture 
instant messages, decide whether you want to archive instant messages 
using EmailXtender. To configure archival of instant messages, refer to the 
proxy server documentation.

14. Decide whether to archive legacy email in the mail server message store. 
To archive legacy email, set up an Archive task in EmailXtract. For 
instructions, see "Archive Task" on page 270.
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15. Decide whether to remove messages from the mail server and replace 
them with pointers (shortcuts) to copies of the archived messages. To 
create shortcuts, set up a Shortcut task in EmailXtract. For instructions, see 
"Shortcut Task" on page 277.
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Chapter 2: Using the EmailXtender
Administrator

Because EmailXtender is a Microsoft Windows-based package, the same 
navigational standards apply to all of its components. The EmailXtender 
Administrator provides a user-friendly interface that allows you to easily view 
and manage the EmailXtender Message Center. 

The Administrator has an intuitive tree view that displays the underlying 
structure of the EmailXtender system. Each object contains child objects in a 
hierarchy that provides easy organization of archived messages.

The Administrator can be run on the same computer where EmailXtender is 
installed or from a remote workstation using an Administrator-only 
installation. For more information on installing only the Administrator 
interface, refer to the EmailXtender Installation Guide. For more information on 
connecting to another EmailXtender server so you can administer it, see 
"Connecting to Another EmailXtender Server" on page 51.

This chapter explains the basic layout of the Administrator, as well as its 
general functionality. For more information, see the following sections:

• "Starting the Administrator" on page 50
• "Connecting to Another EmailXtender Server" on page 51
• "Exploring the Administrator Interface" on page 52
• "Automatically Sizing Columns" on page 57
• "Refreshing the Administrator Window" on page 57
• "Activating Changes" on page 58
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Starting the Administrator
The EmailXtender Administrator provides access to local or remote 
EmailXtender servers and their associated Message Centers. The 
Administrator can be used to organize archived mail, set rules and directed 
search access, and configure retention schedules, among other things.

Upon successful connection to an EmailXtender server, the Administrator 
displays the Message Center view with all EmailXtender objects appearing in 
a tree-like structure. The tree structure contains a server node with one 
secondary node, the email data vault. This vault can contain one or more 
cabinets that, in turn, contain folders that hold message volumes. This filing 
structure allows for a greater amount of control and granularity when 
organizing email archives.

Each time you start the EmailXtender Administrator, you are prompted to 
choose an EmailXtender server to connect to.

Note: The Administrator can only maintain one EmailXtender system 
administrator connection at a time. If one EmailXtender system administrator 
has the EmailXtender Administrator open and another attempts to access the 
same EmailXtender server, the second user receives a message stating that an 
error has occurred connecting to the admin service on the EmailXtender 
server. 

To open the EmailXtender Administrator:

1. From the Windows Start menu, select Programs>LEGATO 
EmailXtender>EmailXtender Administrator. The Select EmailXtender 
Server dialog box appears.

Figure 7. Select EmailXtender Server Dialog Box

2. From the drop-down list, select the EmailXtender server you want to 
administer and click OK. 

Note: To refresh the list of EmailXtender servers, click Discover Servers.

One of the following occurs:
• The Administrator opens.
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• If this is the first time you are logging into the EmailXtender 
Administrator after installing the program for use in an Exchange 
environment, the Choose Profile dialog box appears.

Figure 8. Choose Profile Dialog Box

Note: You are only prompted to select a profile the first time you log 
into the EmailXtender Administrator. Any other time you wish to 
change the MAPI profile used with EmailXtender, select 
Options>Select MAPI Profile.

a. From the drop-down list, select the Profile Name that you want 
to use. If the name does not appear in the list, click New and go 
through the Profile Wizard to add a new profile. The profile you 
use should be a member of the exAdmin group on the 
EmailXtender computer. 

b. Click OK. The Administrator opens.

Connecting to Another EmailXtender Server
You can administer an EmailXtender server both from the computer on which 
the EmailXtender server components are installed and from remote 
computers. 

To remotely administer an EmailXtender server, you must install the 
EmailXtender Administrator interface only (you do not need to install the 
EmailXtender server components). For more information on installing the 
Administrator interface, refer to the EmailXtender Installation Guide.

When you open the Administrator - either on the EmailXtender server or on a 
computer with only the Administrator interface - EmailXtender prompts you 
to choose the EmailXtender server you want to administer. You can select 
either the local computer (if the EmailXtender server components are 
installed) or another EmailXtender server on the network.
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Note: You can only configure one EmailXtender server at a time using the 
Administrator interface. If one EmailXtender system administrator has the 
EmailXtender Administrator open and another attempts to access the same 
EmailXtender server, the second person receives a message stating that an 
error has occurred connecting to the admin service on the EmailXtender 
server. 

To connect to another EmailXtender server:

1. Disconnect from the current EmailXtender server. (From the Server menu, 
select Disconnect from Server, or click the Disconnect from Server toolbar 
icon.)

Figure 9. Disconnect from Server Icon

2. From the Server menu, select Connect to Server, or click the Connect to 
Server toolbar icon. 

Figure 10. Connect to Server Icon

The Select EmailXtender Server dialog box appears.

Figure 11. Select EmailXtender Server Dialog Box

3. From the drop-down list, select the EmailXtender server you want to 
administer and click OK. 

Note: To refresh the list of EmailXtender servers, click Discover Servers.

Exploring the Administrator Interface
The main portion of the Administrator window is for navigation and 
information display, and is split into three panes:
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• The left pane of the window, or the Tree view, contains the tree-like 
structure from which most commands are performed. For more 
information, see "The Tree View" on page 54. 

• The top right pane, or the Message Center List view, displays the message 
volume or month data for the item currently selected in the tree. For more 
information, see "The Message Center List View" on page 54.

• The bottom right pane, or the Description view, displays a description or 
detailed properties of the item selected. For more information, see "The 
Description View" on page 55.

Split bars separate the panes of the Administrator window. These split bars 
can be moved to change the size of each pane.

To move the split bar:

• Drag the bar to its new location.

The Administrator window also contains several additional components that 
allow you to navigate through and configure EmailXtender:

• The menu bar contains the menu commands and can be found at the top 
of the window. For more information, see "Menu Bar" on page 56.

• The toolbar, containing toolbar icons that allow you to perform 
frequently used functions, can be found just below the menu bar. For 
more information, see "Toolbar" on page 56.

• The status bar, which displays information about the selected command 
or toolbar icon, can be found at the bottom of the window. For more 
information, see "Status Bar" on page 57.
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Figure 12. EmailXtender Administrator

Note: In a Lotus Domino environment, certain actions performed through the 
Administrator require that the password be verified for the administrative 
user designated during installation. Be prepared to provide the correct 
password for this user. 

The Tree View

The left pane of the Administrator window contains a tree showing all objects 
configured for the EmailXtender server’s Message Center. Commands for 
managing EmailXtender functionality can be accessed from the tree. When 
you right-click a tree node, a shortcut menu containing commands for 
performing EmailXtender functions appears. The shortcut menu items vary, 
depending on what item you select in the tree view.

Each node in the tree indicates whether it is expandable; that is, whether it 
contains items beneath it. You can expand and collapse each expandable node 
by either double-clicking the node or clicking the plus (+) or minus (-) sign to 
the left of the node. 

The Message Center List View

The top right pane of the Administrator window displays the contents of the 
node currently selected in the tree on the left. 
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There are two Message Center List view modes you can choose from:

• Month

When you set the Message Center List view to Month mode, EmailXtender 
groups all of the volumes for a given month so that you can perform 
functions on them at the same time, such as reindexing message data, 
removing monthly indexes, and disposing of all monthly data to save disk 
space. For more information, see "Managing Volumes by Month" on 
page 124.
To change the Message Center List view to Month mode, open the View 
menu and then select Message Center>View by Month, or click the arrow 
on the Message Center View toolbar icon and select View by Month. 

Figure 13. Message Center List View Icon

• Volume

When you set the Message Center List view to Volume mode, you can 
view all volumes for the node currently selected in the Tree view. You can 
manually close, upgrade, or delete individual volumes, as well as restore 
"Lost and Found" volumes to the system. For more information, see 
"Managing Individual Volumes" on page 118.

To change the Message Center List view to Volume mode, open the View 
menu and then select Message Center>View by Volume, or click the arrow 
on the Message Center View toolbar icon and select View by Volume.

The Description View

The bottom right pane of the Administrator window contains details about the 
object currently selected in the tree on the left. For example, if the server item 
is selected, information about the vault is displayed in the Description view. 

The Description view displays the following information: names of objects 
that are contained within the selected tree item, total number of months and 
volumes, total number of messages contained in the volumes, and total file 
size. 
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Menu Bar

The menu bar contains a list of options with commands for carrying out 
functions in the Administrator. You can connect or disconnect to an 
EmailXtender server, view information about the EmailXtender server, change 
EmailXtender server options, and access online help.

Note: The EmailXtender Administrator relies strongly on the use of shortcut 
menus invoked by a right-button mouse click. Many functions are only 
available using these shortcut menus.

Toolbar

The toolbar contains icons that provide quick access to many of the 
Administrator commands and features.

Table 1. The EmailXtender Administrator Toolbar

Icon Function For more information, see:

Allows you to choose an EmailXtender server 
to connect to.

"Connecting to Another 
EmailXtender Server" on 
page 51

Allows you to disconnect from the currently 
connected EmailXtender server.

"Connecting to Another 
EmailXtender Server" on 
page 51

Changes the Message Center List view. The 
drop-down menu allows you to choose either 
the Month or Volume view.

"The Message Center List 
View" on page 54

Displays the Event Information dialog box so 
that you can view a list of EmailXtender 
specific events.

"Viewing EmailXtender 
Events" on page 157

Displays the LDAP Servers dialog box, which 
allows you to specify an LDAP server against 
which to run filters.

"LDAP/ADS Filters" on 
page 108

Displays the License Information dialog box, 
which is used to change or update licensing.

EmailXtender Installation Guide
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Status Bar

The status bar is located at the bottom of the Administrator window and 
displays information about the selected command or toolbar icon. 

To show or hide the status bar:

• From the View menu, select Status Bar. A check mark beside the 
command indicates that the status bar is displayed.

Automatically Sizing Columns
The AutoSize Columns option allows you to automatically size the columns in 
any of the visible panes of the Administrator so that they are only as wide as 
their longest entry.

To automatically adjust the size of columns in the Administrator:

• From the View menu, select AutoSize Columns.

Refreshing the Administrator Window
The Reload Configuration option refreshes and repaints the contents of the 
Administrator window to reflect recent changes. 

Displays the Account Information dialog box 
so that you can specify administrator account 
information and define supervisor groups.

"Editing Account Information" 
on page 159 and "Supervisor 
Groups" on page 194

Displays the Services Information dialog box, 
which allows you to view, stop, and start 
EmailXtender services.

"Check that EmailXtender 
Processes Receive Adequate 
Processing Time" on page 148

Launches the Health Check utility, which 
allows you to check the "health", or status, of 
the EmailXtender system.

"HealthCheck" on page 161

Table 1. The EmailXtender Administrator Toolbar

Icon Function For more information, see:
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Note: Reloading the configuration does not activate changes. If you make 
changes but do not activate them, EmailXtender does not reflect the changes 
when you refresh the Administrator window. For more information on 
activating changes, see "Activating Changes" on page 58.

To refresh the Administrator:

• In the Tree view of the Administrator, right-click the server node and 
select Reload Configuration from the shortcut menu. It may take a couple 
of seconds for the Administrator to accurately reflect changes. 

Activating Changes
To save changes to the EmailXtender system, most actions require that you 
activate the changes. When making any changes in the EmailXtender 
Administrator, you should activate the changes to have them take effect 
immediately. 

When you perform a task for the first time in a session with the Administrator, 
or for the first time since you last activated changes, a prompt appears to 
remind you to activate the change again. If you perform the same task again 
without activating the change, however, a prompt does not appear; you 
should manually activate the change.

If you do not need to immediately display the configuration changes you are 
making, EmailXtender automatically activates changes when you close the 
Administrator.

Note: If you make changes but do not activate them, choosing the Reload 
Configuration option does not reflect the changes.

To activate changes in a current EmailXtender Administrator session:

• From the Options menu, choose Activate Changes. Changes are 
activated.
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If you are using Microsoft Exchange or Lotus Domino, EmailXtender pulls 
email messages from the mailbox connector on the mail server into the 
EmailXtender Message Center and begins archiving them based on rules and 
configuration. If you are using sendmail, the MilVault milter and archiver 
filter the mail and move it to the EmailXtender Message Center using transport 
threads.

The EmailXtender Message Center contains all email information collected by 
the EmailXtender server. Within the Message Center, data is organized in the 
following hierarchy: server, vault, cabinet, folder, and volume. Each server can 
contain only one vault. By default, EmailXtender also creates a single cabinet 
and folder when you install the product. EmailXtender automatically creates 
volumes as it collects messages received by the Message Center. Volumes are 
organized by the month in which they are created. The hierarchy you create in 
the Message Center, and the rules and retention periods you assign to the 
hierarchy, allow you to classify, organize, and archive data in the manner most 
appropriate for your system.

EmailXtender also full-text indexes messages and attachments so that you can 
maximize searches of the email archive. 

You can configure encryption to add security to archived items as they are 
bundled into volumes, or compression to save on the disk space required to 
store message information.

You can also apply retention periods to a folder to define how long 
EmailXtender retains message volumes in that folder before you can delete 
them.

For more information, see the following sections:

• "Planning Message Center Configuration" on page 60
• "Vault Management" on page 66
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• "Cabinets" on page 78
• "Folders" on page 84
• "Disabling Message Collection" on page 90

Note: The different types of rules and how to configure them are discussed in 
"Chapter 4: Rules" on page 91.

Planning Message Center Configuration
The EmailXtender Message Center contains all email information collected by 
the EmailXtender server. 

Within the Message Center, data is organized in the following hierarchy: 
server, vault, cabinet, folder, and volume. Each server can contain only one 
vault. By default, EmailXtender also creates a single cabinet and folder when 
you install the product. EmailXtender automatically creates volumes as it 
collects messages received by the Message Center. Volumes are organized by 
the month in which they are created.

The hierarchy you create in the Message Center, and the rules and retention 
periods you assign to the hierarchy, allow you to classify, organize, and 
archive data in the manner most appropriate for your system. 

Once you decide how many cabinets and folders to create, as well as how to 
create message collection and exclusion rules, there are a number of additional 
settings you must consider when configuring the EmailXtender Message 
Center.

Note: If you are using EmailXtender Archive Edition, you are allowed only the 
default cabinet and folder, and use of rules and retention periods is prohibited. 
You must upgrade to a full EmailXtender license to create additional cabinets 
and folders, and gain access to rules and retention period capabilities.

For more information, see the following sections:

• "Choosing Which Mail to Collect" on page 61
• "Retention Periods" on page 63
• "Polling Frequency" on page 64
• "Encryption and Compression" on page 65
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Choosing Which Mail to Collect

By default, EmailXtender, creates a single cabinet and folder when you install 
the product. There are no rules assigned to the vault, cabinet, or folder, so 
EmailXtender collects all mail it receives and archives it together in volumes 
that are organized by the month in which they are created.

If you are using EmailXtender purely to archive mail, this simple mail 
collection and archival strategy may be appropriate for you.

You may have more specific mail collection and archival requirements, 
however. The flexibility of EmailXtender cabinets, folders, and rules allows 
you to satisfy virtually any mail collection and archival requirements you may 
have. Consider the following scenarios: 

• "Example: Collecting Only Mail To and From a Certain Domain" on 
page 61

• "Example: Excluding Mail From a Certain Domain From Collection" on 
page 61

• "Example: Archiving and Retaining Mail Differently Due To Regulatory 
Requirements" on page 62

Example: Collecting Only Mail To and From a Certain Domain

You may want to collect a certain type of mail; for example, mail to and from 
a particular domain.

To collect only mail to and from a particular domain, you should configure 
EmailXtender as follows:

1. Leave the default cabinet and folder. (Do not configure additional cabinets 
and folders.)

2. At the cabinet level, create a collection rule that identifies the domain to or 
from which you want to collect mail. For detailed instructions, see 
"Domain Rules" on page 93.

Example: Excluding Mail From a Certain Domain From Collection

You may receive some mail that you do not want to include in the archive (in 
other words, you want to exclude the mail from collection).
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For example, to exclude mail to and from spam.com from collection, you should 
configure EmailXtender as follows:

1. Leave the default cabinet and folder. (Do not configure additional cabinets 
and folders.)

2. At the cabinet level, create an exclusion rule that identifies the spam.com 
domain. For detailed instructions, see "Domain Rules" on page 93.

3. At the cabinet level, create an unmatched messages collection rule so that 
EmailXtender collects all mail that is not excluded by the exclusion rule. 
For detailed instructions, see "Unmatched Messages Collection Rules" on 
page 102.

Example: Archiving and Retaining Mail Differently Due To Regulatory 
Requirements

The mail to and from certain users may be subject to different regulatory 
requirements than other users’ mail, and it may require you to archive and 
retain the mail in a different place and for a longer time.

To archive and retain mail to and from certain users in a different place and for 
a longer time than mail from other users, you should configure EmailXtender 
as follows:

1. Leave the default cabinet. (Do not configure an additional cabinet.)

2. Create a new folder for collection of mail for the users who are subject to 
stricter regulatory requirements. 

3. In the new folder, create a collection rule that names the users who are 
subject to stricter regulatory requirements. For detailed instructions, see 
"Specific Address Rules" on page 95.

4. In the new folder, set the retention period to the appropriate number of 
months you need to retain the mail. For more information about retention 
periods, see "Retention Periods" on page 63.

5. Use the default folder to collect mail for the remaining users.
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6. In the default folder, create an unmatched messages collection rule so that 
EmailXtender collects all mail not collected by the other folder. For 
detailed instructions, see "Unmatched Messages Collection Rules" on 
page 102.

Retention Periods

Retention periods, which you configure on the General tab of each folder’s 
Properties dialog box, allow you to track how long volumes exist in the 
EmailXtender system so that you can meet legal retention requirements and 
delete the volumes after that time has passed. 

The EmailXtender Administrator lists the number of months left that 
EmailXtender retains the volume, providing a visible reminder to remove 
outdated volumes. The number of months left in the retention period is 
displayed in the Months to Retain column of the Message Center List view 
when the view is set to Month mode.

The number that appears is the number you entered on the General tab in the 
Folder Properties dialog box plus one. This is because EmailXtender 
automatically adds an additional month to include the one during which 
retention was set.

If a cabinet contains multiple folders that have different retention periods, the 
Months to Retain column at the cabinet level reflects the largest value present. 
For example, if Folder1 in the Index cabinet is set to retain volumes for 12 
months and Folder2 is set to 24 months, the cabinet shows 24 in the Months to 
Retain column. For easier monitoring of retention, it may be best to have 
consistent retention periods within a cabinet.

Once a retention period has passed, the Months to Retain column displays a 
zero, signalling that you can remove the volumes in that folder. You must 
remove both the monthly data and the individual message volumes. For more 
information, see "Disposing of Monthly Data" on page 127 and "Deleting a 
Volume" on page 123.

Note: You cannot configure retention periods for legacy volumes, which are 
volumes that are created with an earlier release of EmailXtender and that you 
have not yet upgraded. Legacy volumes are displayed in the Administrator 
with a Year/Month date of Legacy. You can set retention on legacy volumes 
after you upgrade them. For more information on upgrading legacy volumes, 
see "Upgrading a Volume" on page 122.
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If you plan to use retention periods, you should configure them before you 
configure journaling on the mail server. 

Note: If you are using EmailXtender Archive Edition, use of retention periods 
is prohibited. You must upgrade to a full EmailXtender license to have access 
to this feature.

Retention Considerations for DiskXtender and EMC Centera

If you configure DiskXtender and an EMC Centera device to store 
EmailXtender volumes and a new volume is written to the EmailXtender 
storage drive, EmailXtender automatically creates the appropriate structure in 
DiskXtender and assigns the retention period that you configured in 
EmailXtender.

You can configure different retention periods for different folders in 
EmailXtender, and those differing retention periods are maintained when the 
files are moved to DiskXtender and the EMC Centera device. (Releases of 
DiskXtender prior to 5.5 supported only a single retention period for all files 
written to a single Centera device, meaning that all volumes written to that 
device had to be retained for the same amount of time.)

For more information about using EmailXtender with DiskXtender, see "Using 
DiskXtender" on page 130.

Polling Frequency

Polling frequency settings, which you configure on the General tab of the 
Vault Properties dialog box, allow you to change the frequency with which 
EmailXtender polls the mailbox connector and transfers messages into the 
Message Center. 

You can set the following polling frequencies:

• Data Source Poll Time - This is the frequency (in seconds) with which 
EmailXtender checks the data source (EmailXtender mailbox) for new 
messages.

• Archive Process Poll Time - This is the frequency (in seconds) with 
which EmailXtender archives new messages.

• Indexer Process Poll Time - This is the frequency (in seconds) with which 
EmailXtender indexes new messages.

• File Maturity Time - This is the minimum number of seconds that must 
pass between the time that EmailXtender detects a message in the data 
source and the time it pulls the email into the Message Center for 
archival.
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The default interval for all of the polling frequencies is 60 seconds. If you want 
to limit the number of messages that collect in the mailbox connector so that 
you can better manage space usage on the mail server, set the polling time to 
a low number.

Encryption and Compression

Encryption and compression, which you configure on the 
Encryption/Compression tab of the Vault Properties dialog box, are disabled 
by default in EmailXtender because they can cause a decrease in system 
performance. You may want to enable these options, however, if you want to 
add security or save archive space. 

Encryption works to add security to archived items as they are bundled into 
volumes. This ensures that volumes are unreadable outside the EmailXtender 
system, thereby increasing the security of the archived data. 

You can encrypt email data using one of three encryption types:

• FAST

Provides security based on 64-bit blocks of information.
• ICE-Key (64-bit)

Provides security based on 64-bit blocks of information, but security relies 
on the key being kept secure, unlike other encryption programs that rely 
on mathematical properties within the key. Once this key has been set, 
information is converted to cipher text and can only be converted back to 
its original state (plain text) when the key has been provided for 
decryption.

• ICE-Key (128-bit)

Alternatively called ICE-2, 128-bit ICE encryption is a variant of 64-bit ICE 
encryption. Longer keys ensure a higher level of security, as they are much 
harder to decrypt.

You must also provide an encryption key, which can later be used in the event 
that you need to perform data recovery. You should keep the encryption key 
confidential and in a safe place.

When you enable compression, EmailXtender compresses all messages as they 
are processed by the Message Center. This can mean a considerable savings in 
terms of how much disk space is required for message information. 
Compression does not, however, affect index or database size. 

When you enable encryption or compression and there are open message 
volumes in the EmailXtender system, the volumes are automatically closed 
and a new encrypted or compressed volume is opened for subsequent 
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messages that EmailXtender receives. Similarly, if you later disable encryption 
or compression and there are open message volumes in the system, the 
volumes are automatically closed and a new unencrypted or uncompressed 
volume is opened.

Vault Management
The vault is the second-level component of the EmailXtender Message Center, 
located beneath the server object. Automatically named "EmailVault", the 
vault collects all email data to be processed by EmailXtender.

Figure 14. Vault

You can configure the frequency with which EmailXtender polls the mailbox 
connector and transfers messages into the Message Center at the vault level. 
You can also configure additional mailbox connectors, as well as encryption 
and compression for volumes.

If necessary, you can apply collection, exclusion, and action rules at the vault 
level to collect, exclude, or forward mail that matches specified message 
attributes, although you should configure rules at the cabinet or folder level 
for more efficient organization.

To configure the vault:

1. In the Tree view of the Administrator, right-click the EmailVault node and 
then select Properties from the shortcut menu. The Vault Properties dialog 
box appears, starting with the General tab.
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Figure 15. Vault Properties Dialog Box – General Tab

2. Select each of the tabs and configure vault options as necessary. For more 
information, see the following sections:

• "The General Tab" on page 67
• "The Rules Tab" on page 69
• "The Email Connection Mailboxes Tab" on page 69
• "The Encryption/Compression Tab" on page 75

3. When you finish configuring the vault, click OK.

4. Activate the changes (Options>Activate Changes).

The General Tab

The General tab of the Vault Properties dialog box allows you to change the 
frequency with which EmailXtender polls the mailbox connector and transfers 
messages into the Message Center. If you want to limit the number of 
messages that collect in the mailbox connector so that you can better manage 
space usage on the mail server, set the polling time to a low number. 
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To configure the General tab of the Vault Properties dialog box:

1. In the Tree view of the Administrator, right-click the EmailVault node and 
then select Properties from the shortcut menu. The Vault Properties dialog 
box appears, starting with the General tab.

Figure 16. Vault Properties Dialog Box – General Tab

2. In the Description text box, enter a description for the vault. 

3. In the Data Source Poll Time text box, enter the frequency (in seconds) 
with which EmailXtender checks the data source (mailbox connector) for 
new messages. The default interval is 60 seconds.

4. In the Archive Process Poll Time text box, enter the frequency (in seconds) 
with which EmailXtender archives new messages. The default interval is 
60 seconds.

5. In the Indexer Process Poll Time text box, enter the frequency (in seconds) 
with which EmailXtender indexes new messages. The default interval is 60 
seconds.

6. In the File Maturity Time text box, enter the minimum number of seconds 
that must pass between the time that EmailXtender detects a message in 
the data source and the time it pulls the message into the Message Center. 
The default interval is 60 seconds.
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The Rules Tab

The Rules tab of the Vault Properties dialog box allows you to configure 
collection, exclusion, and action rules for the vault. 

The process for adding rules is the same regardless of whether you are adding 
them at the vault, cabinet, or folder level. For more information, see "Rules" on 
page 91.

Note: Although EmailXtender allows you to configure rules at the vault level, 
you should consider setting rules at the cabinet or folder level for more 
efficient organization. Remember that rules you configure at the vault level are 
applied to all messages that EmailXtender processes. By adding rules at the 
vault level, you run the risk of unintentionally excluding some messages from 
collection.

Note: In an SMTP mail environment, you can create rules for collection and 
exclusion using the SMTP mail program instead of using the EmailXtender 
Administrator. EmailXtender then inherits these rules and automatically 
creates folders to correctly organize and archive the messages. If you collect 
mail using external rules, you should not configure EmailXtender rules. For 
more information, see "External Message Rules" on page 107.

The Email Connection Mailboxes Tab

The Email Connection Mailboxes tab of the Vault Properties dialog box allows 
you to configure additional mailbox connectors for use with EmailXtender. 
You should have already configured a mailbox connector when you installed 
EmailXtender.
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Figure 17. Vault Properties Dialog Box - Email Connection Mailboxes Tab

A mailbox connector is a mailbox (in Exchange) or database (in Domino) that 
resides on a configured mail server and is designated to interact with 
EmailXtender journaling. Messages that are received and sent by mail servers 
are copied to the mailbox connectors, which are monitored by EmailXtender 
according to polling settings. At the configured time, messages are pulled from 
the mailbox connectors into the Message Center, and then bundled into 
message volumes.

In an Exchange environment, EmailXtender retrieves messages from the 
mailbox connectors using the Messaging Application Program Interface 
(MAPI). In a Domino environment, the EmailXtender Email Data Source 
service (ExEmail.exe) pulls messages from the mailbox connector.

At least one mailbox connector is necessary to expedite communication 
between the mail environment and the EmailXtender server. Mailbox 
connectors should only be used to temporarily store messages for transfer to 
the Message Center, and should not double as user accounts.

You can forward all received mail from configured mail servers to one mailbox 
connector. If you are using Exchange 2000 or 2003, you can set up a mailbox 
connector on each mail server or mailbox store instead.
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If you are using EmailXtender with Exchange, you must add at least one 
mailbox connector to avoid receiving temporary profile error messages from 
the EmailXtender Exchange Manager service. 

You can use the EmailXtender Administrator to configure mailbox connectors 
under the following circumstances: 

• In an Exchange 5.5 environment, to add additional mailbox connectors on 
servers that have already been configured using the Journaling Utility, or 
to re-add previously configured connectors after an EmailXtender 
update. 

• In an Exchange 2000 or 2003 environment, to add mailbox connectors that 
have already had message archiving configured through the Exchange 
Administrator, or to re-add previously configured connectors after an 
EmailXtender update. 

• In a Domino environment, to add additional mailbox connectors on 
servers that have already been configured using the Journaling Utility, or 
to re-add previously configured connectors after an EmailXtender 
update. 

Note: If you have been archiving messages that use multi-byte character sets 
(such as Japanese and Simplified Chinese) and you want to change the 
mailbox connector, you must first delete the language journaling profiles that 
EmailXtender creates automatically. Otherwise, EmailXtender will not archive 
multi-byte character set messages correctly in the future. To delete the profile, 
right-click the Microsoft Outlook icon on the desktop of the EmailXtender 
server, and then select Properties from the shortcut menu. On the Service tab, 
click Show Profiles. On the General tab of the Mail dialog box, select all of the 
exJournal-language-codepage profiles (where language is the name of the language 
and codepage is the codepage number), and then click Remove. You can then 
change the mailbox connector.

For more information about configuring mailbox connectors, see the following 
sections:

• "Adding an Exchange Mailbox Connector" on page 71
• "Adding a Notes Mailbox Connector" on page 73
• "Deleting a Mailbox Connector" on page 74

Adding an Exchange Mailbox Connector

If you are using Microsoft Exchange, you can add mailbox connectors on 
servers that have already been configured using either the Journaling Utility 
(Exchange 5.5) or the Exchange Administrator (Exchange 2000 or 2003).
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You may also want to add previously configured mailbox connectors after you 
update to a newer release of EmailXtender, regardless of whether you are 
using Microsoft Exchange or Lotus Domino.

To add an Exchange mailbox connector:

1. Create the mailbox in Microsoft Exchange.

2. In the Tree view of the EmailXtender Administrator, right-click the 
EmailVault node and select Properties from the shortcut menu. The Vault 
Properties dialog box appears.

3. Select the Email Connection Mailboxes tab.

4. Click Add Exchange Mailbox. The New Exchange Connector Mailbox 
dialog box appears. 

Figure 18. New Exchange Connector Mailbox Dialog Box

5. Enter the name of the mailbox connector you want to add. You have the 
following choices:

• Enter the name in the available text box.
• Click Mailbox. The Select Journaling Mailbox dialog box appears.
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Figure 19. Select Journaling Mailbox Dialog Box

a. Select the mailbox name from the list. If the mailbox name does 
not appear on the list, click Find to search for it. 

b. To view the properties of the selected mailbox connector, click 
Properties. When you finish viewing properties, click OK.

c. When you finish selecting a mailbox, click OK to return to the 
New Exchange Connector Mailbox dialog box.

6. Click OK again to add the selected mailbox connector and return to the 
Email Connection Mailboxes tab of the Vault Properties dialog box.

7. Click OK.

8. Activate the changes (Options>Activate Changes).

Adding a Notes Mailbox Connector

 When you run the Domino Journaling Utility on a Lotus Domino server, it 
automatically sets up a mailbox (mail.box file) and a Notes database named 
ExJournal.nsf as the mailbox connector. If necessary, you can add another 
mailbox connector.

Note: If you configure additional mailbox connectors after you install the 
Journaling Utility, EmailXtender creates additional Notes databases and 
names them incrementally (such as ExJournal1.nsf, ExJournal2.nsf, etc.). There 
must be a one-to-one relationship between the mail.box files for the mailbox 
connectors and the Notes databases for each mailbox connector. 

To add a Notes mailbox connector:

1. Create a new Notes database.
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2. In the Tree view of the EmailXtender Administrator, right-click the 
EmailVault node and select Properties from the shortcut menu. The Vault 
Properties dialog box appears.

3. Select the Email Connection Mailboxes tab.

4. Click Add Notes Mail-In DB. The New Notes Connector DB dialog box 
appears. 

Figure 20. New Notes Connector DB Dialog Box

5. In the Notes Server text box, enter the name of the Notes server as 
servername/notesdomainname, where servername is the name of the Notes 
server and notesdomainname is the name of the Notes domain. You can enter 
multiple names by separating each name with a semicolon.

6. In the Mail-In Database text box, enter the name of the Notes database you 
created to use as a mailbox connector.

7. Click OK.

Deleting a Mailbox Connector

If you no longer need a mailbox connector, you can delete it. 

Note: At least one mailbox connector is necessary to expedite communication 
between the mail environment and the EmailXtender server. 

Note: If you are using EmailXtender with Exchange, you must add at least one 
mailbox connector to avoid receiving temporary profile error messages from 
the EmailXtender Exchange Manager service. 

To delete a mailbox connector:

1. In the Tree view of the EmailXtender Administrator, right-click the 
EmailVault node and select Properties from the shortcut menu. The Vault 
Properties dialog box appears.

2. Select the Email Connection Mailboxes tab.

3. Select the mailbox connector you want to delete and then click Delete. 
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The Encryption/Compression Tab

The Encryption/Compression tab of the Vault Properties dialog box allows 
you to configure encryption and compression for the EmailXtender system. 

Encryption, which is disabled by default in EmailXtender because it can cause 
a decrease in system performance, works to add security to archived items as 
they are bundled into volumes. This ensures that volumes are unreadable 
outside the EmailXtender system, thereby increasing the security of the 
archived data. 

You can encrypt email data using one of three encryption types:

• FAST

Provides security based on 64-bit blocks of information.
• ICE-Key (64-bit)

Provides security based on 64-bit blocks of information, but security relies 
on the key being kept secure, unlike other encryption programs that rely 
on mathematical properties within the key. Once this key has been set, 
information is converted to cipher text and can only be converted back to 
its original state (plain text) when the key has been provided for 
decryption.

• ICE-Key (128-bit)

Alternatively called ICE-2, 128-bit ICE encryption is a variant of 64-bit ICE 
encryption. Longer keys ensure a higher level of security, as they are much 
harder to decrypt.

You must also provide an encryption key, which can later be used in the event 
that you need to perform data recovery. You should keep the encryption key 
confidential and in a safe place.

When you enable compression, EmailXtender compresses all messages as they 
are processed by the Message Center. This can mean a considerable savings in 
terms of how much disk space is required for message information. 
Compression does not, however, affect index or database size. 

When you enable encryption or compression and there are open message 
volumes in the EmailXtender system, the volumes are automatically closed 
and a new encrypted or compressed volume is opened for subsequent 
messages that EmailXtender receives. Similarly, if you later disable encryption 
or compression and there are open message volumes in the system, the 
volumes are automatically closed and a new unencrypted or uncompressed 
volume is opened.
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To configure encryption and compression:

1. In the Tree view of the Administrator, right-click the EmailVault node and 
select Properties from the shortcut menu. The Vault Properties dialog box 
appears.

2. Select the Encryption / Compression tab.

Figure 21. Vault Properties Dialog Box - Encryption / Compression Tab

3. From the Encryption Algorithm drop-down list, choose whether to 
encrypt email data.

• To leave encryption disabled, select Data Encryption Disabled.
• To use FAST encryption, select FAST (64-bit). 
• To use 64-bit ICE encryption, select ICE-Key (64-bit).
• To use 128-bit ICE encryption, select ICE-Key (128-bit).
If you enabled encryption by selecting one of the FAST or ICE encryption 
types, the Encryption Key Definition Dialog box appears.
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Figure 22. Encryption Key Definition Dialog Box

a. In the Encryption Key text box, enter an encryption key. Keep the 
following guidelines in mind:
– If you selected FAST encryption, the encryption key must be 

exactly eight characters.
– If you selected 64-bit ICE encryption, the encryption key must be 

exactly eight characters. Once this key has been set, information 
is converted to cipher text and can only be converted back to its 
original state (plain text) when the key has been provided for 
decryption.

– If you selected 128-bit ICE encryption, the encryption key must 
be exactly 16 characters. Like 64-bit ICE encryption, once this key 
has been set, information is converted to cipher text and can only 
be converted back to its original state (plain text) when the key 
has been provided for decryption. 

Note: It is your responsibility to maintain the confidentiality of the 
encryption key. You may need to provide the key later to perform data 
recovery, so it is important to keep the encryption key in a safe place.

b. In the Verify Encryption Key text box, re-enter the encryption key 
that you entered in the Encryption Key text box and then click OK to 
close the Encryption Key Definition dialog box.

4. Choose whether to enable compression.

• To enable compression, select the Data Compression Enabled check 
box.

• To leave compression disabled, clear the Data Compression Enabled 
check box.

5. Click OK.

6. Activate the changes (Options>Activate Changes).
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If you enabled encryption or compression, all volumes that are currently open 
are closed and new ones are opened for subsequent messages received by the 
Message Center.

Cabinets
Located within the vault, the cabinet is the third-level component of the 
EmailXtender Message Center. By default, EmailXtender creates a single 
cabinet named "Index".

Figure 23. Cabinets

Depending on your mail collection and archival needs, you may want to create 
additional cabinets. For more information on planning the Message Center 
hierarchy, see "Planning Message Center Configuration" on page 60.

Note: If you are using EmailXtender Archive Edition instead of a fully licensed 
version of EmailXtender, you are allowed only one cabinet and one folder.

You can apply collection, exclusion, and action rules at the cabinet level to 
collect, exclude, or forward mail that matches specified message attributes. If 
you apply rules to a cabinet, you may also want to configure directed searches 
for the cabinet, which allow certain users to search for and view all messages 
collected by the cabinet (in addition to searching their own mail). 

For more information, see the following sections:

• "Adding a Cabinet" on page 78
• "Configuring a Cabinet" on page 79
• "Copying a Cabinet" on page 83
• "Deleting a Cabinet" on page 83

Adding a Cabinet

You can add cabinets to the EmailVault to customize the organization of 
incoming email. 
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When you create a cabinet, EmailXtender creates a directory in the 
EmailXtender installation directory for the new cabinet. The directory is 
named EmailVault_Cabinet, where Cabinet is the name of the cabinet. This 
directory contains volume information for the cabinet.

Before you add a cabinet, make sure that the drive where EmailXtender is 
installed has enough room to accommodate these new directories and the 
information that they will hold. 

Note: If you are using EmailXtender Archive Edition instead of a fully licensed 
version of EmailXtender, you are allowed only one cabinet and one folder.

Note: If you are using external message rules to classify mail for collection or 
exclusion by EmailXtender, you can configure the rules so that EmailXtender 
automatically creates cabinets to correctly organize and archive the messages.

To add a cabinet:

1. In the Tree view of the Administrator, right-click the EmailVault node and 
select Add New Cabinet from the shortcut menu. The Cabinet Name 
dialog box appears.

Figure 24. Cabinet Name Dialog Box

2. In the Cabinet Name text box, enter a name for the new cabinet. Cabinet 
names can only use the following character set: A-Z, a-z, 0-9, space, and 
dash. Underscore characters are not supported.

3. Click OK. 

4. Activate the changes (Options>Activate Changes).

After you create a cabinet, you should configure its settings and then, if 
necessary, add folders to it. For more information, see "Configuring a Cabinet" 
on page 79 and "Adding a Folder" on page 84.

Configuring a Cabinet

There are a number of settings you can configure at the cabinet level using the 
tabs on the Cabinet Properties dialog box.
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You can apply rules to collect, exclude, or forward mail that matches specified 
message attributes. If you apply rules to a cabinet, you may also want to 
configure directed searches for the cabinet, which allow certain users to search 
for and view all messages collected by the cabinet (in addition to searching 
their own mail). You can also enter a description for the cabinet. 

If you use an SMTP mail program, you can configure EmailXtender to inherit 
external collection and exclusion rules from the SMTP mail program instead 
of using EmailXtender rules.

To configure a cabinet:

1. In the Tree view of the Administrator, right-click the cabinet you want to 
configure and then select Properties from the shortcut menu. The Cabinet 
Properties dialog box appears, starting with the General tab.

Figure 25. Cabinet Properties Dialog Box – General Tab

2. Select each of the tabs and configure cabinet options as necessary. For 
more information, see the following sections:

• "The General Tab" on page 81
• "The Rules Tab" on page 82
• "The Directed Search Access Rights Tab" on page 82

3. When you finish configuring the cabinet, click OK.

4. Activate the changes (Options>Activate Changes).
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The General Tab

The General tab of the Cabinet Properties dialog box allows you to enter a 
description for the cabinet and to configure EmailXtender to inherit external 
collection and exclusion rules from an SMTP mail program instead of using 
EmailXtender rules. For more information on configuring external message 
rules, see "External Message Rules" on page 107.

To configure the General tab of the Cabinet Properties dialog box:

1. In the Tree view of the Administrator, right-click the cabinet you want to 
configure and then select Properties from the shortcut menu. The Cabinet 
Properties dialog box appears, starting with the General tab.

Figure 26. Cabinet Properties Dialog Box – General Tab

2. In the Description text box, enter a description for the cabinet. 

3. To configure EmailXtender to inherit external collection and exclusion 
rules from an SMTP mail program instead of using EmailXtender rules, 
select the Externally Classify Messages check box.

If you select the Externally Classify Messages check box, the Rules tab for 
the cabinet is dimmed, signaling that all message rules for the cabinet are 
now dependent on outside settings. If you previously configured rules for 
the Cabinet using the Rules tab, the rules are disabled.
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The Rules Tab

The Rules tab of the Cabinet Properties dialog box allows you to configure 
collection, exclusion, and action rules for the cabinet. 

The process for adding rules is the same regardless of whether you are adding 
them at the vault, cabinet, or folder level. For more information, see "Rules" on 
page 91.

Note: In an SMTP mail environment, you can create rules for collection and 
exclusion using the SMTP mail program instead of using the EmailXtender 
Administrator. EmailXtender then inherits these rules and automatically 
creates folders to correctly organize and archive the messages. If you configure 
EmailXtender to use external message rules on the General tab of the Cabinet 
Properties dialog box, the Rules tab is dimmed. For more information, see 
"External Message Rules" on page 107.

Note: If you are using EmailXtender Archive Edition, use of rules is 
prohibited. You must upgrade to a full EmailXtender license to access this 
feature.

The Directed Search Access Rights Tab

The Directed Search Access Rights tab of the Cabinet Properties dialog box 
allows you to configure directed searches for the cabinet.

When you configure a directed search, you specify a few select users who can 
use the Web Search or Search Plug-in to search for any messages in the selected 
cabinet. 

Directed searches are most useful if you have configured the EmailXtender 
Message Center so that certain types of messages are filtered into specific 
cabinets or folders. Used in combination with supervisor and administrator 
searches, directed searches allow you to be very exact about who has 
permission to view certain messages.

Because you can configure directed searches at either the cabinet or folder 
level, the process for configuring them is the same. For more information, see 
"Directed Searches" on page 202.

Note: If you are using EmailXtender Archive Edition, directed searches are 
prohibited. You must upgrade to a full EmailXtender license to access this 
feature.
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Copying a Cabinet

You can copy a cabinet structure and its configured collection rules in order to 
create a new cabinet. This saves time in configuring rules and folder 
organization when you have a cabinet that is configured similarly to the way 
you want to configure another cabinet.

Note: Email volumes are not copied when you copy a cabinet. Only the cabinet 
itself, including folders and properties, is copied to the new cabinet.

Note: If you are using EmailXtender Archive Edition instead of a fully licensed 
version of EmailXtender, you are allowed only one cabinet and one folder.

To copy a cabinet:

1. In the Administrator, right-click the cabinet you want to copy and select 
Copy Cabinet from the shortcut menu. A copy of the cabinet appears, and 
the new cabinet has the same name as the copied cabinet, with an 
incremental number appended to it. For example, a cabinet named 
"Accounting" would be copied to "Accounting(1)".

2. Activate the changes (Options>Activate Changes).

For information about how to change rules set on the copied cabinet, see 
"Rules" on page 91.

Deleting a Cabinet

If necessary, you can delete a cabinet. Volumes contained within a deleted 
cabinet are moved to Lost and Found storage and are not accessible until you 
restore them to the EmailXtender Message Center. For more information on 
restoring volumes, see "Restoring a Volume" on page 120. 

Important: If you delete all cabinets, EmailXtender is unable to collect mail.

To delete a cabinet:

1. Close any open volumes in the cabinet. For instructions, see "Closing a 
Volume" on page 120.

2. In the Administrator, right-click the cabinet you want to delete and select 
Delete Cabinet from the shortcut menu. A confirmation message appears.

3. Click OK. 

4. Activate the changes (Options>Activate Changes).
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Folders
The folder object is the fourth-level component of the EmailXtender Message 
Center. Located within a cabinet, it contains volumes once you begin collecting 
mail. You can apply collection, exclusion, and action rules at the folder level to 
collect, exclude, or forward mail that matches specified message attributes. 
You can add, copy, or delete folders, as well as set a retention period for a 
folder so that volumes in the folder are retained for a specific amount of time. 
For more information, see the following sections:

• "Adding a Folder" on page 84
• "Configuring a Folder" on page 85
• "Copying a Folder" on page 89
• "Deleting a Folder" on page 89

Adding a Folder

You can add new folders within a cabinet to customize the organization of 
archived email. 

Note: If you are using EmailXtender Archive Edition instead of a fully licensed 
version of EmailXtender, you are allowed only one cabinet and one folder.

Note: If you are using external message rules to classify mail for collection or 
exclusion by EmailXtender, you can configure the rules so that EmailXtender 
automatically creates folders to correctly organize and archive the messages.

When you create a folder in the Administrator, EmailXtender creates a 
directory for the folder in the EmailXtender installation directory. The 
directory is named EmailVault_Cabinet_Folder, where Cabinet and Folder 
represent the names of the cabinet and folder, respectively. EmailXtender 
stores the collected messages associated with the folder in this directory until 
it creates a message volume. 

Before you add a folder, make sure that the drive where EmailXtender is 
installed has enough room to accommodate these new directories and the 
information that they will hold.

To add a folder:

1. In the Administrator, right-click the cabinet to which you want to add a 
folder and select Add New Folder from the shortcut menu. The Folder 
Name dialog box appears.
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Figure 27. Folder Name Dialog Box

2. In the Folder Name text box, enter a name for the new folder. Folder names 
can only use the following character set: A-Z, a-z, 0-9, space, and dash. 
Underscore characters are not supported. In addition, if you are using 
DiskXtender 2000 with EmailXtender, the folder name should be unique 
and contain 16 or fewer characters.

3. Click OK.

4. Activate the changes (Options>Activate Changes).

After you add a folder, you may want to set up collection rules and retention 
periods to better manage archived messages collected in that folder. For more 
information, see "Configuring a Folder" on page 85.

Configuring a Folder

There are a number of settings you can configure at the folder level using the 
tabs on the Folder Properties dialog box.

You can apply rules at the folder level to collect, exclude, or forward mail that 
matches specified message attributes. If you apply rules to a folder, you may 
also want to configure directed searches for the folder, which allow certain 
users to search for and view all messages collected by the folder (in addition 
to searching their own mail). 

You can also set retention periods at the folder level so that volumes created 
within the folder are retained for a certain period of time. After the retention 
period has passed, you can manually remove the volumes.

If necessary, you can enter a description for the folder, and disable mail 
collection for a folder.

To configure a folder:

1. In the Tree view of the Administrator, right-click the folder you want to 
configure and then select Properties from the shortcut menu. The Folder 
Properties dialog box appears, starting with the General tab.



EmailXtender, Release 4.7
Administrator’s Guide

Chapter 3: Configuring Message Collection

86

3

Figure 28. Folder Properties Dialog Box – General Tab

2. Select each of the tabs and configure folder options as necessary. For more 
information, see the following sections:

• "The General Tab" on page 86
• "The Rules Tab" on page 88
• "The Directed Search Access Rights Tab" on page 88

3. When you finish configuring the folder, click OK.

4. Activate the changes (Options>Activate Changes).

The General Tab

The General tab of the Folder Properties dialog box allows you to view general 
information about the folder you have selected. It also allows you to create or 
edit the folder’s description, or disable archiving.

You can also set retention periods for the folder’s volumes. For more 
information on setting retention periods, see "Vault Management" on page 66.
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To configure the General tab of the Folder Properties dialog box:

1. In the Tree view of the Administrator, right-click the folder for which you 
want to view or edit general properties and then select Properties from the 
shortcut menu. The Folder Properties dialog box appears, starting with the 
General tab.

Figure 29. Folder Properties Dialog Box – General Tab

The name of the vault containing the folder is listed in the Vault Name text 
box, and the type of data the folder contains is listed in the Data Type text 
box. These text boxes are dimmed; you cannot edit these values.

2. If desired, enter a description of the folder in the Description text box. 

3. If you want to temporarily disable archival of messages to the selected 
folder, select the Disable Archive check box. (To re-enable message 
collection for the folder later, clear the check box.)

Important: If you have configured only one folder, then disabling archive for 
that one folder effectively means that no email is archived to the EmailXtender 
Message Center.
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4. Set the Months to Retain value to match the number of months that 
volumes should be marked for retention. If you enter zero, EmailXtender 
keeps message volumes indefinitely. For more information on choosing 
retention periods, see "Retention Periods" on page 63. 

Note: If you are using EmailXtender Archive Edition, the retention period 
feature is not available. You must upgrade to a full EmailXtender license to 
access this feature.

The Rules Tab

The Rules tab of the Folder Properties dialog box allows you to configure 
collection, exclusion, and action rules for the folder. 

The process for adding rules is the same regardless of whether you are adding 
them at the vault, cabinet, or folder level. For more information, see "Rules" on 
page 91.

Note: If you are using EmailXtender Archive Edition, use of rules is 
prohibited. You must upgrade to a full EmailXtender license to access this 
feature.

The Directed Search Access Rights Tab

The Directed Search Access Rights tab of the Folder Properties dialog box 
allows you to configure directed searches for the folder.

When you configure a directed search, you specify a few select users who can 
use the Web Search or Search Plug-in to search for messages in the selected 
folder. 

Directed searches are most useful if you have configured the EmailXtender 
Message Center so that certain types of messages are filtered into specific 
cabinets or folders. Used in combination with supervisor and administrator 
searches, directed searches allow you to be very exact about who has 
permission to view certain messages.

Because you can configure directed searches at either the cabinet or folder 
level, the process for configuring them is the same. For more information, see 
"Directed Searches" on page 202.

Note: If you are using EmailXtender Archive Edition, directed searches are 
prohibited. You must upgrade to a full EmailXtender license to access this 
feature.
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Copying a Folder

You can copy a folder to create a new folder. This saves time in configuring 
rules when you have a folder that is configured similarly to the way you want 
to configure another folder.

Note: Email volumes are not copied when you copy a folder. Only the folder 
itself, including properties and rules, is copied to the new folder.

Note: If you are using EmailXtender Archive Edition instead of a fully licensed 
version of EmailXtender, you are allowed only one cabinet and one folder.

To copy a folder:

1. In the Administrator, right-click the folder you want to copy and select 
Copy Folder from the shortcut menu. A copy of the folder appears, and the 
new folder has the same name as the copied folder, with an incremental 
number appended to it. For example, a folder named "Development" 
would be copied to "Development(1)".

2. Activate the changes (Options>Activate Changes).

For information about how to change rules set on the copied folder, see 
"Editing a Rule" on page 106.

Deleting a Folder

If necessary, you can delete a folder. Volumes contained within a deleted 
folder are moved to Lost and Found storage and are not accessible until you 
restore them to the EmailXtender Message Center. For more information on 
restoring volumes, see "Restoring a Volume" on page 120. 

Important: If you delete all folders, EmailXtender is unable to collect mail.

To delete a folder:

1. Close any open volumes in the folder. For instructions, see "Closing a 
Volume" on page 120.

2. In the Administrator, right-click the folder you want to delete and select 
Delete Folder from the shortcut menu. A confirmation message appears.

3. Click OK. 

4. Activate the changes (Options>Activate Changes).
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Disabling Message Collection
If you want to temporarily prevent EmailXtender from collecting messages, 
you can disable message collection on the General tab of the Folder Properties 
dialog box. 

If there are multiple folders in the EmailXtender system, you can either disable 
message collection for a single folder or for the entire system. To disable 
message collection for the entire system, you must disable message collection 
on the General tab of the Folder Properties dialog box for every folder.

If you have a single folder, remember that disabling message collection for the 
folder prevents EmailXtender from collecting any mail.

For more information on using the General tab to disable message collection, 
see "The General Tab" on page 86.
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Mail rules allow you to efficiently organize email archives by controlling 
which messages EmailXtender archives. If you do not configure any rules, 
EmailXtender archives all messages.

You can configure rules at the vault, cabinet, and folder level. Although you 
can configure rules at the vault level, however, you should set rules at the 
cabinet or folder level for more efficient organization.

You can configure three different types of EmailXtender rules: collection, 
exclusion, and action rules. Collection rules allow you to specify which 
messages EmailXtender collects, exclusion rules allow you to specify which 
messages EmailXtender should not collect, and action rules allow you to 
perform an action on all messages collected by the vault, cabinet, or folder to 
which the rule applies. At this time, the only type of action you can perform 
on a message is to auto-forward it to the email address you specify.

If you are using a pure SMTP mail environment, EmailXtender can also accept 
the external classification rules you configure through the SMTP mail 
program. When configured with external classification, EmailXtender 
automatically creates folders and cabinets to match the rules set up through 
SMTP mail.

If you have an LDAP (Lightweight Directory Access Protocol) or Microsoft 
Active Directory Services (ADS) server, you can configure rules that filter 
messages against the directory services schema in addition to or in place of the 
mail system’s address book. This approach may be faster or more effective 
than using a Microsoft Exchange or Lotus Domino address book.

If you plan to use rules, you should configure them before you configure 
journaling on the mail server. 
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Note: EmailXtender only archives items that would naturally travel through 
the mailbox connector, such as messages and read receipts, so these are the 
only types of items to which rules are applied. If you use EmailXtract in a 
Microsoft Exchange environment, you can also archive items such as public 
folders, calendar items, contacts, and tasks.

Note: If you are using EmailXtender Archive Edition, use of rules is 
prohibited. You must upgrade to a full EmailXtender license to access this 
feature.

For more information about rules, see the following sections:

• "Creating a Rule" on page 92
• "Editing a Rule" on page 106
• "Deleting a Rule" on page 107
• "External Message Rules" on page 107
• "LDAP/ADS Filters" on page 108

Creating a Rule
Rules allow you to control which messages EmailXtender archives. You can 
configure three different types of EmailXtender rules:

• Collection

Collection rules allow you to specify which messages EmailXtender 
collects. When a message matches the conditions of a collection rule, the 
vault, cabinet, or folder to which the rule applies collects the message and 
places it in a message volume. If the message does not match the rule 
criteria, EmailXtender does not collect the message. 
Collection rules can collect mail based on domain names, specific email 
addresses, and keywords. You can also use the Unmatched Messages 
collection rule to collect messages that are not collected by any other 
collection rule in the associated EmailXtender container object.

• Exclusion

Exclusion rules allow you to specify which messages EmailXtender 
should not collect. Similar to collection rules, exclusion rules can exclude 
mail based on domain names, specific email addresses, and keywords.

• Action
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Action rules allow you to perform an action on all messages collected by 
the vault, cabinet, or folder to which the rule applies. At this time, the only 
type of action you can perform on a message is auto-forward. An 
auto-forward action rule automatically forwards all messages in the vault, 
cabinet, or folder to the email address you specify.

Note: If you do not configure any rules, EmailXtender archives all messages.

You can configure rules at the vault, cabinet, and folder level. Although you 
can configure rules at the vault level, however, you should set rules at the 
cabinet or folder level for more efficient organization.

For more information, see the following sections:

• "Collection and Exclusion Rules" on page 93
• "Auto-Forward Action Rules" on page 105

Collection and Exclusion Rules

You can create collection and exclusion rules that collect or exclude mail based 
on whether the mail was sent to or from specific domain names or email 
addresses, as well as whether the message contains specific keywords. 

You can also create a collection rule that collects messages that are not 
collected by any other rule in the associated cabinet or folder. This type of rule 
is called an unmatched messages rule. 

If you archive messages both in real-time using an EmailXtender journaling 
utility and on a scheduled basis using EmailXtract, EmailXtender handles 
collection and exclusion differently when the message is sent to or from a 
distribution list.

For more information, see the following sections:

• "Domain Rules" on page 93
• "Specific Address Rules" on page 95
• "Keyword Rules" on page 97
• "Unmatched Messages Collection Rules" on page 102
• "Considering Distribution Lists" on page 104

Domain Rules

You can collect or exclude mail based on whether the mail was sent to or from 
a specific domain name.
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To create a collection or exclusion rule based on a domain name:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder for which you want to create the rule and select Properties from the 
shortcut menu. The Properties dialog box for the selected object appears.

2. Click the Rules tab.

3. Right-click in the Collection Rules or Exclusion Rules list box and select 
Create Rule>Domain Rule from the shortcut menu. 

The Domain Rules dialog box appears.

Figure 30. Domain Rules Dialog Box

4. In the Domain Address text box, enter the name of the domain to or from 
which you want to collect or exclude messages. Use the following 
guidelines when entering the domain name:

• Do not precede or end the rule with a forward slash. Forward slashes 
are used as terminators. Forward slashes within a domain rule, 
however, are supported. 

• The value you enter is case-insensitive. For example, mail to or from 
domain.com is still classified according to the set rules even if it is 
entered as DOMAIN.COM. 

• For more specific mail collection or exclusion, be sure to enter the 
domain suffix (such as .com, .gov, or .net). For example, if you enter 
only domain in the Domain Address text box, EmailXtender collects 
or excludes messages to or from domain@company.com in addition to 
domain.com, domain.net, and user@server.domain.com. 

• If you are planning to collect or exclude messages that use multi-byte 
characters (such as Japanese or Simplified Chinese), do not use 
multi-byte characters in the Domain Address text box. EmailXtender 
ignores rules containing multi-byte characters.

5. From the Address Qualifier drop-down list, choose whether to collect or 
exclude mail to, from, or either to or from the selected domain. 

• To collect or exclude mail that includes the specified domain in the 
recipient’s SMTP address (all mail sent to that domain), select To.
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• To collect or exclude mail that includes the specified domain in the 
sender’s SMTP address (all mail sent from that domain), select From.

• To collect or exclude mail that includes the specified domain in either 
sender’s or receiver’s SMTP address (all mail sent to or from that 
domain), select To or From.

6. Click OK to return to the Rules tab.

7. You have the following choices:

• If you want to configure additional rules for the selected vault, 
cabinet, or folder, click Apply to save the changes without leaving the 
Rules tab.

• If you are finished configuring rules, click OK to save the new rule 
and close the Properties dialog box. Then activate the changes 
(Options>Activate Changes).

Specific Address Rules

You can collect or exclude mail based on whether the mail was sent to or from 
a specific email address.

Note: If you are using both Microsoft Exchange and Lotus Domino, you must 
configure separate address rules for each environment, even if the same 
address appears in both environments.

Note: The address rule is also sometimes used for LDAP/ADS-related queries. 
For more information, see "LDAP/ADS Filters" on page 108.

To create a collection or exclusion rule based on a specific address:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder for which you want to create the rule and select Properties from the 
shortcut menu. The Properties dialog box for the selected object appears.

2. Click the Rules tab.

3. Right-click in the Collection Rules or Exclusion Rules list box and select 
Create Rule>Specific Address from the shortcut menu. 

The Address Rules dialog box appears.
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Figure 31. Address Rules Dialog Box

4. In the User Address text box, enter the SMTP address to or from which you 
want to collect or exclude messages. Use the following guidelines when 
entering the address:

• To choose an address from the Microsoft Exchange or Lotus Domino 
Address List, click User Address.

• If the address resides on the local mail server, you can enter the 
Friendly Name for the address.

• The value you enter is case-insensitive. For example, mail to or from 
user@domain.com is still classified according to the set rules even if 
it is entered as User@DOMAIN.COM. 

• For more specific mail collection or exclusion, be sure to enter the 
domain name and suffix (such as domain.com, domain.gov, or 
domain.net). For examples, see the following table:

5. From the Address Qualifier drop-down list, choose whether to collect or 
exclude mail to, from, or either to or from the selected address. 

• To collect or exclude mail sent to the specified address, select To.

Table 2. Examples of Addresses EmailXtender Collects/Excludes

If you enter this in the
User Address text box:

EmailXtender collects or excludes 
mail to or from these addresses:

User user@domain.com
user@emailxtender.org
someone@user.org

user@domain user@domain.com
user@domain.net
user@domain.org

user@domain.com user@domain.com
USER@DOMAIN.COM
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• To collect or exclude mail sent from the specified address, select From.
• To collect or exclude mail sent to or from the specified address, select 

To or From.

6. Click OK to return to the Rules tab.

7. You have the following choices:

• If you want to configure additional rules for the selected vault, 
cabinet, or folder, click Apply to save the changes without leaving the 
Rules tab.

• If you are finished configuring rules, click OK to save the new rule 
and close the Properties dialog box. Then activate the changes 
(Options>Activate Changes).

Keyword Rules

You can collect or exclude mail based on whether certain keywords appear in 
the mail.

Note: System performance may suffer when you use keyword rules to collect 
or exclude messages because they require the full-text indexer to process every 
incoming message and its attachments. You can increase system performance 
by using a bang rule, which is a keyword rule with a value starting with an 
exclamation point (!). Bang rules do not use the full-text indexer and do not 
search within message attachments unless a special command is issued. For 
bang rule guidelines and examples, see "Keyword Bang Rule Guidelines" on 
page 98 and "Keyword Bang Rule Examples" on page 101.

To create a collection or exclusion rule based on keywords:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder for which you want to create the rule and select Properties from the 
shortcut menu. The Properties dialog box for the selected object appears.

2. Click the Rules tab.

3. Right-click in the Collection Rules or Exclusion Rules list box and select 
Create Rule>Keyword(s) from the shortcut menu. 

The Keyword(s) dialog box appears.
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Figure 32. Keyword(s) Dialog Box

4. In the Keyword(s) text box, enter the keywords that should appear in the 
messages that EmailXtender collects or excludes. Use the following 
guidelines when entering the keywords:

• The value you enter is case-insensitive. For example, if you enter 
keyword, EmailXtender collects or excludes messages containing 
keyword, Keyword, and KEYWORD, among others.

• You may want to use keyword bang rules to save on system 
performance. For guidelines and examples, see "Keyword Bang Rule 
Guidelines" on page 98 and "Keyword Bang Rule Examples" on 
page 101.

• If you are planning to collect or exclude messages that use multi-byte 
characters (such as Japanese or Simplified Chinese), do not use 
multi-byte characters in the Keyword(s) text box. EmailXtender 
ignores rules containing multi-byte characters.

5. Click OK to return to the Rules tab.

6. You have the following choices:

• If you want to configure additional rules for the selected vault, 
cabinet, or folder, click Apply to save the changes without leaving the 
Rules tab.

• If you are finished configuring rules, click OK to save the new rule 
and close the Properties dialog box. Then activate the changes 
(Options>Activate Changes).

Keyword Bang Rule Guidelines

System performance may suffer when you use keyword rules to collect or 
exclude messages because they require the full-text indexer to process every 
incoming message and its attachments. You can increase system performance 
by using a bang rule, which is a keyword rule with a value starting with an 
exclamation point (!). Bang rules do not use the full-text indexer and do not 
search within message attachments unless a special command is issued.
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The following table contains guidelines for creating bang rules:

Table 3. Keyword Bang Rule Guidelines

Available Commands Details

Expression operators AND, OR, NOT, IN, ( )

For more information on using expression 
operators, see "Expression Operators" on page 363.

Wildcard characters * matches any number of characters

? matches any single character

Quotation marks and 
special characters

Single and double quote characters are treated 
identically, and are required to search for strings 
containing spaces or any of the following special 
characters:

\        :        ;        ,         .         !         ?

Message field names The following message fields can be used with the 
IN operator to apply a rule to a specific message 
field. The most useful fields are xvSubject and 
xvBody.
• xvEntryID
• xvDate
• xvSubject
• xvX-Priority
• xvAttach
• xvSize
• xvSensitivity
• xvBody
• xvLanguage (applicable only in Microsoft 

Exchange environments)
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If you are using a Microsoft Exchange environment and you want to collect or 
exclude messages that contain a certain language, you must use the xvLanguage 
variable in the keyword bang rule. The following values are used as language 
identifiers for keyword bang rules using the xvLanguage variable.   

Table 4. Language Identifiers

Identifier Language Identified

0 English, Spanish, Swedish, Danish, Finnish, Norwegian, French, 
German, Italian, Dutch, Portuguese, Greek, Hungarian, Russian

1 Japanese

2 Chinese

3 Korean

4 Arabic

5 Bulgarian

6 Catalan

7 Hebrew

8 Icelandic

9 Romanian

10 Croatian

11 Indonesian

12 Ukrainian

13 Vietnamese

14 Thai

15 Urdu
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Keyword Bang Rule Examples

The following table contains examples of the types of strings you can enter for 
keyword bang rules

Table 5. Examples of Keyword Bang Rules

If you enter this in the 
Keyword(s) text box:

EmailXtender collects or excludes 
messages containing these words:

!problem problem

!problem* problem, problems, problematic, and so 
on

!problem OR issue either problem or issue

!(problem OR issue) AND 
resolved

both resolved and either problem or issue

!invoice??? invoice followed by three characters, such 
as invoiceJan

!inv* any word that begins with inv, such as 
invoice

!invoice AND purchase both invoice and purchase

!’invoice AND purchase’ the exact string invoice and purchase

!’invoice’ AND ‘purchase order’ invoice and the exact string purchase 
order

!NOT (problem OR issue) neither problem nor issue

!personal IN xvSubject personal in the message subject field

!(personal OR private) IN 
xvSubject

personal or private in the message subject 
field

!(‘Read:’ OR ‘Not Read:’) IN 
xvSubject

Read: or Not Read: in the message subject 
field (read receipts)

![*.jpg] IN xvAttach attached .jpg files
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Unmatched Messages Collection Rules

Unmatched messages collection rules allow you to collect and archive 
messages that are not collected by other rules. You can use unmatched 
messages rules to ensure that all messages are archived (including those 
rejected by some rules), or to verify that the other rules you have defined are 
collecting all the messages you intended.

Note: Using the unmatched messages rule may cause EmailXtender to process 
more messages and so may negatively impact system performance.

You can define unmatched messages rules at either the cabinet or folder level. 

• If you have configured multiple cabinets or if you have configured other 
rules at the cabinet level, you may want to configure the unmatched 
messages rule at the cabinet level so that EmailXtender can collect all 
messages that do not match any of the rules associated with the other 
cabinet(s) or the folders within the cabinet(s).

• If you are using a single cabinet and have configured other rules at the 
folder level, you may want to configure the unmatched messages rule at 
the folder level so that EmailXtender can collect all messages that do not 
match any of the rules associated with the other folders.

Note: For a message to be placed in a folder using the unmatched messages 
rule, that message must be accepted by any rules defined on the cabinet that 
contains the folder.

You should create a new cabinet or folder for use with the unmatched 
messages rule; this should be a separate cabinet or folder from the other 
cabinets or folders with rules. Additionally, you can define the unmatched 
messages rule for only one cabinet. Similarly, you can define the unmatched 
messages rule for only one folder in a cabinet. You can only create multiple 
folders with the unmatched messages rule if those folders are located in 
different cabinets.

![secret*] IN xvAttach attached files whose names begin with 
secret, such as secretinfo.doc

!2 IN xvLanguage text written in Chinese

Table 5. Examples of Keyword Bang Rules

If you enter this in the 
Keyword(s) text box:

EmailXtender collects or excludes 
messages containing these words:
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When you apply an unmatched messages rule to a folder or cabinet, the icon 
for that folder or cabinet changes in the EmailXtender Administrator so that it 
contains an asterisk character ( * ). For example, in the following figure from 
the Tree view of the Administrator, an unmatched messages rule has been 
applied to the Unmatched folder and IndexAll cabinet.

Figure 33. Unmatched Messages Cabinet and Folder Icons

To create an unmatched messages rule:

1. Configure the other collection and exclusion rules.

2. Create the cabinet or folder to which you want to apply the unmatched 
messages. For instructions, see "Adding a Cabinet" on page 78 and 
"Adding a Folder" on page 84.

3. In the Tree view of the Administrator, right-click the cabinet or folder for 
which you want to create the rule and select Properties from the shortcut 
menu. The Properties dialog box for the selected object appears.

4. Click the Rules tab.

5. Right-click in the Collection Rules list box and select Create 
Rule>Unmatched from the shortcut menu. 

The unmatched messages rule is applied to that cabinet or folder and 
appears as a collection rule with a type and value of Unmatched Messages 
as shown in the following figure.
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Figure 34. Unmatched Messages Rule for a Folder

6. Click OK.

7. Activate the changes (Options>Activate Changes).

Considering Distribution Lists

If you archive messages both in real-time using an EmailXtender journaling 
utility and on a scheduled basis using EmailXtract, you must consider 
distribution lists when configuring collection and exclusion rules. (For more 
information on archiving messages using EmailXtract, see "EmailXtract" on 
page 257.)

When you archive messages in real-time, EmailXtender expands distribution 
lists so that everyone in the distribution list is associated with the message. If 
a collection or exclusion rule specifies a user or domain that is part of the 
distribution list for the message, EmailXtender collects or excludes the 
message. 

For example, assume that you are archiving messages in real-time using 
EmailXtender journaling and you have configured a collection rule that 
collects messages sent to user@domain.com. The user@domain.com address is part 
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of the Everyone distribution list. A message is sent to the Everyone distribution 
list. EmailXtender collects the message because user@domain.com is part of the 
Everyone distribution list.

Distribution lists are not expanded when you archive messages using 
EmailXtract. If a message to or from a distribution list is archived using 
EmailXtract and a collection or exclusion rule specifies a user or domain that 
is part of the distribution list for the message, EmailXtender does not collect or 
exclude the message.

For example, assume that you are archiving a message using the Archive task 
in EmailXtract and you still have the collection rule that collects messages sent 
to user@domain.com. The user@domain.com address is still part of the Everyone 
distribution list. The message you are archiving has been sent to the Everyone 
distribution list. EmailXtender does not collect the message because it only 
recognizes the Everyone distribution list.

If you are planning to collect or exclude messages that use multi-byte 
characters (such as Japanese or Simplified Chinese), do not use multi-byte 
characters when specifying a distribution list. EmailXtender ignores rules 
containing multi-byte characters.

Auto-Forward Action Rules

You can configure an action rule so that mail collected by the vault, cabinet, or 
folder is automatically forwarded to the specified email address.

To create an auto-forward action rule:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder for which you want to create the rule and select Properties from the 
shortcut menu. The Properties dialog box for the selected object appears.

2. Click the Rules tab.

3. Right-click in the Action Rules list box and select Create 
Rule>Auto-Forward from the shortcut menu. 

The Auto Forward dialog box appears.

Figure 35. Auto Forward Dialog Box
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4. In the Email Address text box, enter the email address to which you want 
to forward all messages that the selected vault, cabinet, or folder collects. 
Both the friendly format and the SMTP format of the email address are 
supported.

Note: To use an address from the mail server’s Address Book, click Email 
Address. If you have both Microsoft Outlook and Lotus Notes installed on 
the server, the Select Address Book dialog box appears. Select the address 
book you wish to use and then select a name from the address book.

5. Click OK to return to the Rules tab.

6. You have the following choices:

• If you want to configure additional rules for the selected vault, 
cabinet, or folder, click Apply to save the changes without leaving the 
Rules tab.

• If you are finished configuring rules, click OK to save the new rule 
and close the Properties dialog box. Then activate the changes 
(Options>Activate Changes).

Editing a Rule
After you create a collection, exclusion, keyword, or auto-forward action rule, 
you can edit it.

Note: You cannot edit an unmatched messages collection rule.

To edit a rule:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder containing the rule you want to edit and select Properties from the 
shortcut menu. The Properties dialog box for the selected object appears.

2. Click the Rules tab.

3. Right-click the rule you want to edit and select Edit from the shortcut 
menu. The dialog box that appears is the same one that appeared when 
you created the rule. For more information, see the following sections:

• "Domain Rules" on page 93
• "Specific Address Rules" on page 95
• "Keyword Rules" on page 97
• "Auto-Forward Action Rules" on page 105

4. When you finish editing the rule, click OK to return to the Rules tab.
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5. Click OK again to close the Properties dialog box.

6. Activate the changes (Options>Activate Changes).

Deleting a Rule
When you no longer need a rule, you can delete it.

To delete a rule:

1. In the Tree view of the Administrator, right-click the vault, cabinet, or 
folder containing the rule you want to delete and select Properties from 
the shortcut menu. The Properties dialog box for the selected object 
appears.

2. Click the Rules tab.

3. Right-click the rule you want to delete and select Delete from the shortcut 
menu.

4. Click OK.

5. Activate the changes (Options>Activate Changes).

External Message Rules
In an SMTP mail environment, you can create rules for collection and 
exclusion using the SMTP mail program instead of using the EmailXtender 
Administrator. EmailXtender then inherits these rules and automatically 
creates folders to correctly organize and archive the messages. If you collect 
mail using external rules, you should not configure EmailXtender rules.

To create external rules:

1. In the SMTP mail program, create rules to determine how messages are 
organized and archived. The rules must reference existing cabinets in the 
EmailXtender system. You can also configure the rules to reference 
existing folders, or you can specify new folders and EmailXtender will 
create the folders when it receives messages matching the rules.

2. In the EmailXtender Administrator, right-click each cabinet that uses 
external rules and select Properties from the shortcut menu. The Cabinet 
Properties dialog box appears.
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Figure 36. Cabinet Properties Dialog Box

3. On the General tab, select the Externally Classify Messages check box.

The Rules tab for the cabinet is dimmed, signaling that all message rules 
for the cabinet are now dependent on outside settings. If you previously 
configured rules for the cabinet using the Rules tab, the rules are disabled.

4. Click OK.

5. Activate the changes (Options>Activate Changes).

LDAP/ADS Filters
If you have an LDAP (Lightweight Directory Access Protocol) or Microsoft 
Active Directory Services (ADS) server, you can configure rules that filter 
messages against the directory services schema in addition to or in place of the 
mail system’s address book. This approach may be faster or more effective 
than using an Exchange or Domino address book.

Note: EmailXtender does not support groups or distribution lists when 
performing LDAP or ADS-based filtering, unless the group or distribution list 
has a mail account or the RFC 822 mail account attribute assigned to it. For 
more information, see "Adding an LDAP Filter" on page 112.
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Two steps are required to set up LDAP or ADS filters:

1. Add the LDAP or ADS server record to EmailXtender. See "Adding an 
LDAP or ADS Server" on page 109.

2. Add rules to cabinets or folders to capture or exclude messages based on 
LDAP or ADS properties. See "Adding an LDAP Filter" on page 112.

Note: This feature should not be used without a thorough understanding of 
LDAP and/or ADS and how they work within your organization.

Adding an LDAP or ADS Server

Before you create filters for LDAP/ADS servers, you must first add the server 
to EmailXtender.

Note: You cannot create LDAP rules for mailboxes in an Active Directory 
subdomain when you configure the domain controller of the root Active 
Directory domain as the LDAP server in EmailXtender. You must add another 
LDAP server record to EmailXtender specifying the domain controller of the 
subdomain as the LDAP server.

To add an LDAP or ADS server:

1. From the View menu in the Administrator, choose LDAP Servers, or click 
the LDAP toolbar icon. 

Figure 37. LDAP Toolbar Icon

The LDAP Servers dialog box appears.

Figure 38. LDAP Servers Dialog Box

2. Click Add. The Add LDAP Server dialog box appears, starting with the 
General tab.
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Figure 39. Add LDAP Server Dialog Box - General Tab

3. In the LDAP Account text box, enter the name by which you’d like to refer 
to the LDAP server. You use this name in your LDAP search syntax later 
on, so it should be short and easy to remember. It should not contain any 
spaces or special characters.

4. In the Server name box, enter the full server and domain name (such as 
mailserver.legato.com). 

• If you are using Windows 2000 Active Directory Services with 
Exchange 2000, this should be the primary domain controller (PDC) 
and not the Exchange 2000 server.

• If you are using LDAP with Exchange 5.5 or Lotus Domino, enter the 
Exchange or Domino server name.

5. Choose whether to log on to the server.

• If you are using Windows 2000 Active Directory Services, you must 
select the This server requires me to log on check box. Then enter the 
account name and password you use to log on in the Account name 
and Password text boxes, respectively. The account you enter must 
be a domain user account with access to the ADS schema. The format 
for the user name must be the Kerberos account, in the format 
user@subdomain.domain.com.

• If you are using LDAP with Exchange 5.5 or Domino, you probably 
have anonymous LDAP access set up. You should clear the This 
server requires me to log on check box and leave the Account name 
and Password text boxes empty unless you specifically restricted 
access on your Domino or Exchange 5.5 LDAP servers.

6. Click the Advanced tab.
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Figure 40. Add LDAP Server Dialog Box - Advanced Tab

7. In the Directory service (LDAP) box, leave the default port of 389 unless 
you specifically configured an alternate port for LDAP services on the 
ADS or LDAP server.

8. If the LDAP/ADS server requires a secure sockets connection (SSL), select 
the This server requires a secure connection (SSL) check box. 

When you select the check box, the port changes to 636.

9. In the Search timeout text box, enter the number of seconds after which 
EmailXtender stops querying the LDAP/ADS server if it hasn’t received a 
response.

10. In the Maximum number of matches to return text box, enter the 
maximum number of query matches that EmailXtender accepts before it 
stops the query.

11. If you are using Windows 2000 Active Directory Services, enter the 
domain information based on the ADS Primary Domain Controller (PDC) 
computer name in the Search base text box using the following format:

dc=subdomain,dc=domain,dc=com

For example, if the name of the PDC is LegatoPDC.Legato.com, you should 
enter the following:
dc=LegatoPDC,dc=legato,dc=com 

12. Click OK to save the changes and return to the LDAP Servers dialog box. 

13. Click Test Connection to test the connection between EmailXtender and 
the server you added.

14. Click Close to close the LDAP Servers dialog box.
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15. Activate the changes (Options>Activate Changes).

After you add the LDAP or ADS server to EmailXtender, you should create 
address filters. For more information, see "Adding an LDAP Filter" on 
page 112.

Adding an LDAP Filter

Once you add an LDAP server to EmailXtender, you can create search syntax 
and add it as a rule in EmailXtender. For more information, see the following 
sections:

• "EmailXtender LDAP Search Syntax" on page 112
• "Testing an LDAP Filter Before Creating a Rule" on page 114
• "Adding LDAP Rules to Cabinets and Folders" on page 115

EmailXtender LDAP Search Syntax

The syntax that you use to create LDAP filters is very specific and uses 
common LDAP query syntax combined with an EmailXtender-specific URL 
format. The EmailXtender-specific format is as follows:

EXLDAP://LDAPServerFriendlyName/MailSystem?LDAPFilter

where:

• LDAPServerFriendlyName is the name you defined when you added the 
server to EmailXtender. For more information, see "Adding an LDAP or 
ADS Server" on page 109.

•  MailSystem is the type of mail system you are using (either Domino or 
Exchange, depending on the LDAP server you’re querying).

• LDAPFilter is the filter you want to use. The filter should use common 
LDAP query syntax. For examples, see "LDAP Search Syntax for Finding 
Users Based on Common Names" on page 113 and "LDAP Search Syntax 
for Finding Users Based on Organization" on page 113.

Note: EmailXtender does not support groups or distribution lists when 
performing LDAP or ADS-based filtering, unless the group or distribution list 
has a mail account or the RFC 822 mail account attribute assigned to it. In 
addition, while the objectclass person may be the one you use most often, you 
can also use other objectclasses as long as they are associated with a mail 
account.

You can find more information about LDAP search syntax on the Internet. A 
few good resources include:
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• RFC 1650 and RFC 2252 specifications. This information appears in 
numerous places on the Internet, but a good comprehensive source of 
LDAP specifications is http://ldapman.org/ldap_rfcs.html.

• Novell’s overview of LDAP search filter syntax at 
http://developer.novell.com/ndk/doc/ldapover/index.html?page=/ndk/doc/ldapove
r/ldap_enu/data/a3saoeg.html.

After you create the search syntax, you can test it and then add it as a filter 
within EmailXtender. For more information, see "Testing an LDAP Filter 
Before Creating a Rule" on page 114 and "Adding LDAP Rules to Cabinets and 
Folders" on page 115.

Example: LDAP Search Syntax for Finding Users Based on 
Common Names

The following example allows you to find users on MyLDAPServer, which 
uses Lotus Notes, with common names that begin with "A":

EXLDAP://MyLDAPServer/Notes?(&(objectclass=person)(cn=a*))

On the same server, you could find users with common names beginning with 
any letter from "A" through "M" using the following syntax:

EXLDAP://MyLDAPServer/Notes?(&(objectclass=person)(cn=<m))

Example: LDAP Search Syntax for Finding Users Based on 
Organization

The following example allows you to find users on MyLDAPServer, which 
uses Microsoft Exchange, who are members of the Engineering organization:

EXLDAP://MyLDAPServer/Exchange?(&(objectclass=person)(o=Engi
neering))

On the same server, you could find users who are not members of either the 
Engineering or Accounting organizations using the following syntax:

EXLDAP://MyLDAPServer/Notes?(&(objectclass=person)(!(|(o=Eng
ineering)(o=Accounting))))

http://ldapman.org/ldap_rfcs.html
http://developer.novell.com/ndk/doc/ldapover/index.html?page=/ndk/doc/ldapover/ldap_enu/data/a3saoeg.html
http://developer.novell.com/ndk/doc/ldapover/index.html?page=/ndk/doc/ldapover/ldap_enu/data/a3saoeg.html
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Testing an LDAP Filter Before Creating a Rule

The LDAP Search Utility provided with EmailXtender allows you to quickly 
test an LDAP filter before you use it in an EmailXtender rule.

To test an LDAP filter:

1. From the Windows Start menu on the EmailXtender server, select 
Programs>Accessories>Command Prompt.

2. Use the cd command to change directories to the \bin\utils directory 
within the EmailXtender installation directory (typically C:\Program 
Files\OTG\EmailXtender\bin\utils).

3. At the command prompt, enter one of the following commands: 

• LdapSearch LDAPServerFriendlyName LDAPFilter

where LDAPServerFriendlyName is the name you defined when you 
added the server to EmailXtender (for more information, see "Adding 
an LDAP or ADS Server" on page 109) and LDAPFilter is the filter you 
want to use.

• LdapSearch ServerAddress Base Person

where ServerAddress is the name of the LDAP server machine; Base is 
an LDAP distinguished name that is the base object entry relative to 
which the search is to be performed; and Person is the name of the 
person to find. You can use a wildcard, such as an asterisk (*), with 
the Person variable.
For example, LdapSearch ns-mail "" tim* searches from the top 
of the LDAP tree for all people whose names begin with "tim".

• LdapSearch LDAP://hostport/dn[?attributes[?scope[?filter]]]

where hostport is the name of the LDAP server machine (with optional 
port number); dn is an LDAP distinguished name (the name of an 
entry in the directory) that specifies the base point for the search; 
attributes lists the fields to return about the object; scope is an optional 
string that indicates the scope of the search (it must be one of these 
three strings: base, one, or sub to represent a base-object search, a 
one-level search, or a subtree search); and filter is an optional LDAP 
search filter. For example, the following command tests searches from 
the top of the LDAP tree for all people whose names begin with "tim" 
and returns only the MAPI-Recipient fields:
LdapSearch LDAP://ns-mail/?MAPI-Recipient?sub?cn=tim*
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Adding LDAP Rules to Cabinets and Folders

After you have determined the syntax you are going to use for the LDAP filter 
(as described in "EmailXtender LDAP Search Syntax" on page 112), you can 
add the filter to a specific cabinet or folder within EmailXtender as a collection 
or exclusion rule so that the rule can be used to filter messages into the cabinet 
or folder. Collection rules allow you to specify which messages EmailXtender 
collects, and exclusion rules allow you to specify which messages 
EmailXtender should not collect.

Note: You cannot create LDAP rules for mailboxes in an Active Directory 
subdomain when you configure the domain controller of the root Active 
Directory domain as the LDAP server in EmailXtender. You must add another 
LDAP server record to EmailXtender specifying the domain controller of the 
subdomain as the LDAP server, and then you can add the rules. For more 
information on adding another LDAP server record to EmailXtender, see 
"Adding an LDAP or ADS Server" on page 109.

To add LDAP rules to a cabinet or folder:

1. In the Tree view of the Administrator, right-click the cabinet or folder to 
which you want to add the filter and select Properties from the shortcut 
menu. The Cabinet or Folder Properties dialog box appears.

2. Select the Rules tab.

3. Right-click in the Collection Rules or Exclusion Rules list box and select 
Create Rule>Specific Address from the shortcut menu. The Address Rules 
dialog box appears.

Figure 41. Address Rules Dialog Box

4. In the User Address box, enter the search syntax. For more information on 
search syntax, see "EmailXtender LDAP Search Syntax" on page 112.

5. From the Address Qualifier drop-down list, choose whether to collect or 
exclude mail to, from, or either to or from the addresses specified by the 
filter. 

• To collect or exclude mail sent to the addresses, select To.
• To collect or exclude mail sent from the addresses, select From.
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• To collect or exclude mail sent to or from the addresses, select To or 
From.

6. Click OK to return to the Rules tab.

7. You have the following choices:

8. Click OK to save the new rule and close the Properties dialog box.

9. Activate the changes (Options>Activate Changes).
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EmailXtender captures messages and organizes them by month in volumes. 
Volumes close after they reach the allotted capacity (that you configure) or are 
idle for five days. EmailXtender then copies them to the storage drive on the 
EmailXtender server as .emx files. 

You can manually close volumes so that they are copied to the storage drive, 
and move them from one EmailXtender server to another. 

You must regularly monitor the disk space that volumes and their indexes are 
using, and take action appropriately so that you do not run out of space. 

You can save space by deleting volumes you no longer need, or removing 
indexes and disposing of data for all volumes in a given month. This allows 
users to search for certain messages, but they cannot view them until you 
restore the volumes in which the messages appear. 

If you want to "extend" the capacity of the EmailXtender storage drive by 
writing the .emx files to other storage media, you can install DiskXtender on 
the EmailXtender server. When you install DiskXtender, you should configure 
the EmailXtender storage drive as the DiskXtender extended drive. DiskXtender 
allows you to configure automatic file migration to other storage media, such 
as an EMC Centera device, DVD-R, tape, or magneto-optical.

For more information, see the following sections:

• "Managing Volumes" on page 118
• "Configuring Volume Storage" on page 128
• "Using DiskXtender" on page 130
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Managing Volumes
EmailXtender collects messages received by the Message Center into volumes 
(or container files), which it then organizes by the month of creation. (This is the 
original creation date for the message, and not the date when EmailXtender 
processes them and places them into a message volume.) 

If you are archiving messages in multiple languages, EmailXtender creates a 
separate volume for each language it archives. (For more information on 
language support in EmailXtender, refer to the Planning the Installation chapter 
of the EmailXtender Installation Guide.)

This organization allows for quick indexing and speeds search times when 
locating archived messages through the Search Plug-in or Web Search Client.

Volumes contain email data and classification information (classification rules, 
properties used to create the file, and vault, cabinet, folder, and month names). 

Volumes close after they reach the allotted capacity or are idle for five days. 
EmailXtender then copies them to the storage drive as .emx files. Once they are 
copied to the storage drive, they can be written out to other media, such those 
supported through DiskXtender.

Because volumes are stored as .emx files, you can add volumes to any 
EmailXtender Message Center with no loss of data or need to convert files, and 
they can be used to restore an entire Message Center. 

In addition, if volumes were created with earlier versions of EmailXtender, 
you can upgrade the volumes to take full advantage of new features available 
in the latest release.

The EmailXtender Administrator allows you to manage individual volumes or 
to manage all volumes for a given month. For more information, see the 
following sections:

• "Managing Individual Volumes" on page 118
• "Managing Volumes by Month" on page 124

Managing Individual Volumes

The EmailXtender Administrator allows you to view all volumes for the node 
currently selected in the Tree view when you set the Message Center List view 
to Volume mode. You can then manually close, delete, or monitor the status of 
individual volumes, as well as restore "Lost and Found" volumes to the 
system. In the event that you have upgraded from an earlier release of 
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EmailXtender, you can also upgrade the volumes created while you were 
using the earlier release so that you can take advantage of the features 
available in the latest release. For more information, see the following sections:

• "Checking the Status of a Volume" on page 119
• "Closing a Volume" on page 120
• "Restoring a Volume" on page 120
• "Upgrading a Volume" on page 122
• "Deleting a Volume" on page 123

Checking the Status of a Volume

You can determine the status of a volume using the Message Center List view 
of the EmailXtender Administrator. 

To check the status of a volume:

1. In the Tree view of the Administrator, select the folder or cabinet 
containing the volume for which you want to check status.

2. Set the Message Center List view of the Administrator to Volume mode. 
(Open the View menu and then select Message Center>View by Volume, 
or click the arrow on the Message Center View toolbar icon and select 
View by Volume.)

A list of volumes appears in the Message Center List view (top right pane) 
of the Administrator.
• A yellow folder icon in the left-most column of the Message Center 

List view indicates a volume is online or available.

Figure 42. Online Volume Icon

• A folder icon with a red X in the left-most column of the Message 
Center List view indicates a volume is offline or unavailable.

Figure 43. Offline/Unavailable Volume Icon
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• The Status column of the Message Center List view indicates 
additional status information. If the volume is still receiving 
messages and hasn’t reached capacity, the status is listed as Open. If a 
re-index request has been submitted for the volume, the status is 
listed as Re-index Pending.

Closing a Volume

Volumes close automatically after they reach the allotted capacity or are idle 
for five days. If necessary, however, you can manually close an open volume. 

When you close a volume, EmailXtender copies the volume to the storage 
drive as an .emx file. Once it is copied to the storage drive, it can be written out 
to other media, such as the media supported through DiskXtender 2000.

Manually closing a volume before it reaches capacity forces EmailXtender to 
start a new volume when it receives new messages. 

You cannot reopen volumes that you manually close.

To close an open volume:

1. In the Tree view of the Administrator, select the folder or cabinet 
containing the volume you want to close.

2. Set the Message Center List view of the Administrator to Volume mode. 
(Open the View menu and then select Message Center>View by Volume, 
or click the arrow on the Message Center View toolbar icon and select 
View by Volume.)

3. Right-click the volume you want to close and then select Close Volume 
from the shortcut menu that appears. 

Restoring a Volume

When you dispose of monthly data for a set of volumes, you can no longer 
access the messages in the volumes, but they are not physically deleted; they 
are placed in Lost and Found storage and can be restored if necessary. For more 
information on disposing of monthly data, see "Disposing of Monthly Data" on 
page 127.

Volumes that are created on one EmailXtender server and then copied to 
another EmailXtender server are also considered Lost and Found volumes. 

If you update EmailXtender from an earlier release to the current release, you 
must also restore all volumes created with the earlier release.
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To restore a volume:

1. Set the Message Center List view of the Administrator to Volume mode. 
(Open the View menu and then select Message Center>View by Volume, 
or click the arrow on the Message Center View toolbar icon and select 
View by Volume.)

2. In the Tree view, select the Server node. All Lost and Found volumes 
appear in the Message Center List view. 

Figure 44. Message Center List View with Lost and Found Volumes

3. Right-click the volumes you want to restore and choose Add Volume from 
the shortcut menu. 

4. Activate the changes (Options>Activate Changes). The selected volumes 
are moved to the appropriate folder and cabinet. If the folder or cabinet 
does not already exist, EmailXtender automatically creates them to match 
the previous configuration under which the volumes were archived. The 
Status column displays Re-Index Pending for all volumes that 
EmailXtender has yet to add. As volumes are restored, the indexes and 
database are updated to include their information.

Note: If you restored volumes because you updated EmailXtender to a newer 
release, you may also need to upgrade the volumes. For more information, see 
"Upgrading a Volume" on page 122.
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Upgrading a Volume

When you update EmailXtender from a release earlier than 4.3, the volumes 
created with the earlier release are displayed in the Administrator with a 
Year/Month date of Legacy. This makes it clear that these volumes were 
created with a previous release of EmailXtender.

Figure 45. EmailXtender Administrator with Legacy Volumes

In order to take full advantage of increased search speed and database 
improvements included in Release 4.3, you must upgrade the legacy volumes. 
Although this process can be lengthy, depending on how many legacy 
volumes exist, the simple improvements in performance and space savings 
make the upgrade worthwhile.

Note: When you upgrade volumes stored on write-once media, the old media 
becomes obsolete and new media must be used to store the re-processed 
volumes.

If you are using rewritable media, such as a hard disk or NAS device, you can 
choose whether to delete the legacy volumes after you upgrade them. Deleting 
the volumes allows you to save storage space on the media you’re currently 
using with the EmailXtender system. If you are planning to delete the legacy 
volumes, however, you should back them up before you delete them.

To upgrade legacy volumes:

1. If you are using rewritable media and you plan to delete the legacy 
volumes, back up the legacy volumes.
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2. Set the Message Center List view of the Administrator to Volume mode. 
(Open the View menu and then select Message Center>View by Volume, 
or click the arrow on the Message Center View toolbar icon and select 
View by Volume.) 

3. Right-click the legacy volume you want to upgrade, and choose Upgrade 
from the shortcut menu. The Upgrade dialog box appears.

Figure 46. Upgrade Dialog Box

4. Choose whether to delete the legacy volume after you upgrade it. 

• To delete the volume after upgrade, select the check box.
• To leave the legacy volume in addition to the upgraded volume, leave 

the check box clear.

Note: EmailXtender only deletes volumes that are on rewritable media.

5. Click OK. A confirmation message appears.

6. Click OK. The Status column displays Upgrade Pending until 
EmailXtender begins upgrading the volume. As the upgrade progresses, a 
new message volume is opened to hold the reprocessed messages. The 
Year/Month date for the new volume reflects the date the reprocessed 
messages were originally sent. The volume name, however, is based on the 
exact time when the messages were reprocessed. 

Deleting a Volume

After you dispose of a volume’s monthly data, you can delete the volume. (For 
more information on disposing of monthly data, see "Disposing of Monthly 
Data" on page 127.) 

Note: You can only delete message volumes that are stored on rewritable 
media. 
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As a precaution, the EmailXtender Administrator does not provide a volume 
deletion feature. You must open Windows Explorer and navigate to the 
directory on the EmailXtender server in which the volumes (.emx files) are 
stored, and then delete the files and/or the directory in which the files are 
stored.

Example: Deleting Volumes from February 2002

In the following example, you delete the volumes in the default cabinet and 
folder with messages from February 2002. 

1. Dispose of the monthly data for the volumes from February 2002. (Set the 
Message Center List view of the Administrator to Month mode by opening 
the View menu and then selecting Message Center>View by Volume. Then 
right-click the volume for February 2002, which is listed as 200202 in the 
Year/Month column, and select Dispose Monthly Data from the shortcut 
menu. Click Yes on the confirmation message that appears.)

2. Open Windows Explorer and navigate to the E drive, which you have 
designated as the EmailXtender storage drive.

3. Delete the folder containing the volumes for February 2002 
(E:\EmailVault_Index_Archive_200202).

Managing Volumes by Month

When you set the Message Center List view of the EmailXtender 
Administrator to Month mode, EmailXtender groups all of the volumes for a 
given month so that you can perform functions on them at the same time, such 
as re-indexing message data, removing monthly indexes, and disposing of all 
monthly data to save disk space. For more information, see the following 
sections:

• "Re-indexing Data" on page 125
• "Removing Monthly Indexes" on page 126
• "Disposing of Monthly Data" on page 127
• "Ejecting Volumes" on page 128
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Re-indexing Data

You may need to re-index data in order to restore an index that you deleted to 
save space (for more information, see "Removing Monthly Indexes" on 
page 126), replace a corrupted index, or repair an index that is missing 
messages.

When EmailXtender detects a corrupted index, a message is written to the 
Event Log and the EmailXtender Administrator identifies the corrupt index 
using a red exclamation mark ( ), as shown in Figure 47 on page 125.

When an index is missing messages, the EmailXtender Administrator 
identifies the index using an envelope with a red exclamation point 
( ), as shown in Figure 47 on page 125.

Figure 47. Corrupt and Missing Message Identifiers

You may also discover that an index is corrupt when you attempt to search the 
index and EmailXtender notifies you that it is corrupt. 

Note: Unlike corrupted indexes, indexes missing messages can be searched.

When an index is corrupt or missing messages, you should re-index the 
volume to which the index belongs. You can re-index only the corrupt index, 
the index missing messages, or all the data for a particular month.
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Note: Re-indexing data can be time-consuming and should only be done when 
necessary.

To re-index data:

1. Set the Message Center List view of the Administrator to Month mode. 
(Open the View menu and then select Message Center>View by Month, or 
click the arrow on the Message Center View toolbar icon and select View 
by Month.) 

2. You have the following choices:

• To re-index a volume with a corrupt index, right-click the volume 
identified by the red exclamation mark ( ) and then select Re-index 
Corrupt Indexes Only from the shortcut menu.

• To re-index a volume with indexes missing messages, right click the 
volume identified by the envelope with a red exclamation mark( ) 
and then select Re-index All Monthly Data from the shortcut menu.

• To re-index all data for a month, right-click the month and then select 
Re-index All Monthly Data from the shortcut menu.

3. Click Yes on the confirmation message that appears. The Volumes 
Reindexing column in the Message Center List view displays the status of 
the process. 

Note: If you re-index the data and it does not result in a valid index, there is 
probably a problem with one of the messages in the index. Check the event log 
for an EmailXtender error message about the corrupt index. For more 
information, see "Viewing EmailXtender Events" on page 157. If you cannot 
correct the problem, remove the problematic messages from the archive and 
then index the archive again to create a valid index.

Removing Monthly Indexes

Depending on the amount of message data that EmailXtender processes, 
indexes for individual months can become quite large and use a large amount 
of disk space. 

You may want to back up indexes for past months and remove them from the 
local hard drive. Then, if a search needs access to these removed indexes, you 
can copy them back to the local drive. 

You can also remove the indexes without backing them up, and then re-index 
the month later if necessary. For more information on reindexing, see 
"Re-indexing Data" on page 125.
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Note: Re-indexing data can be time-consuming and should only be done when 
necessary.

To remove indexes:

1. Set the Message Center List view of the Administrator to Month mode. 
(Open the View menu and then select Message Center>View by Month, or 
click the arrow on the Message Center View toolbar icon and select View 
by Month.) 

2. Right-click the month object for which you want to remove the index and 
then select Remove Monthly Index from the shortcut menu. A 
confirmation message appears.

3. Click Yes. The index information is removed from the 
\EmailVault_Cabinet\IndexDir\EmailVault_Cabinet_Folder directory in the 
EmailXtender install directory where Cabinet is the name of the cabinet and 
Folder is the name of the folder for which the index was generated.

Disposing of Monthly Data

In order to save room in the database and index directories, you can dispose of 
the data in those directories for a specific month. 

Disposing of monthly data does not remove the actual message volumes, 
however. They are placed in Lost and Found storage, and can be restored if 
necessary. For more information on restoring Lost and Found volumes, see 
"Restoring a Volume" on page 120. For more information on permanently 
removing a volume, see "Deleting a Volume" on page 123.

To dispose of monthly data:

1. If any of the volumes associated with the month for which you are 
disposing data are open, close them. The disposal of monthly data fails if 
there are any open volumes present in the month object. For instructions, 
see "Closing a Volume" on page 120.

2. Set the Message Center List view of the Administrator to Month mode. 
(Open the View menu and then select Message Center>View by Month, or 
click the arrow on the Message Center View toolbar icon and select View 
by Month.) 

3. Right-click the month containing the data you want to remove and then 
select Dispose Monthly Data from the shortcut menu. A confirmation 
message appears.

Note: If you chose to remove monthly data for multiple volumes, then a 
confirmation message appears for each volume. 
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4. Click Yes. The month data is removed from the database and index 
directories, and the volumes are moved to Lost and Found storage.

Ejecting Volumes

If you are using DiskXtender 2000 removable media as the storage location for 
EmailXtender volumes, you must use the MediaStor Administrator interface 
to eject media. For instructions, refer to the DiskXtender 2000 MediaStor 
Administrator’s Guide.

Configuring Volume Storage
You can change the directory in which volumes (also called container files) are 
stored, and adjust the maximum capacity for message volumes. You may want 
to change the volume path, for example, if the storage drive that you are using 
reaches capacity. 

You can also change the type of media you are using to store the volumes. If 
you are only writing the volumes to the EmailXtender storage drive, you 
should select the Hard Disk media type. If you want to write volumes to 
another media type through the use of DiskXtender, you should install and 
configure DiskXtender and then specify the media type in the EmailXtender 
Administrator. 

To configure volume storage:

1. In the Tree view of the Administrator, right-click the EmailXtender server 
node and select Properties from the shortcut menu. The Computer 
Properties dialog box appears.
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Figure 48. Computer Properties Dialog Box

2. To change the directory to which volumes are stored, enter a new path in 
the Extended Container Path text box.

Note: If you are using DiskXtender to extend the EmailXtender storage 
drive, you should specify the DiskXtender extended drive in the Extended 
Container Path.

3. To change the maximum size a volume may reach before a new volume is 
created, enter the maximum file size in MB in the Container File Size (MB) 
text box. The value should be between 10 MB and 650 MB.

When selecting the maximum file size, you should enter an amount that 
best uses the full capacity of the media. You can write more than one 
volume to a piece of media, so the maximum file size should be a number 
that, when multiplied, closely fills the capacity of the media.
If you are planning to use DiskXtender to write EmailXtender files to an 
EMC Centera device, you should set the volume size to 90 MB. There are 
known performance issues when retrieving volumes of 100 MB and 
greater from an EMC Centera device. Setting the volume size to 90 MB 
allows for slight overflow of the volumes before they are closed, while 
keeping the total volume file size to under 100 MB.
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4. To configure the type of media on which EmailXtender stores volumes, 
select the new media type from the Media Type drop-down list.

• Hard Disk - Select Hard Disk if you are planning to store volumes on 
a hard disk, or if you are planning to write volumes to storage media 
through DiskXtender using the Network Attached Storage (NAS) or 
Tivoli Storage Manager (TSM) media services.

• WORM Media - Select WORM Media if you are planning to write 
volumes to WORM media using DiskXtender.

• MO Media - Select MO Media if you are planning to write volumes 
to magneto-optical media using DiskXtender.

• Tape Media - Select Tape Media if you are planning to write volumes 
to tape media using DiskXtender through either the MediaStor or 
StorageTek ACSLS media services.

• DVD RAM - Select DVD RAM if you are planning to write volumes 
to DVD-RAM media using DiskXtender.

• Centera - Select Centera if you are planning to write volumes to an 
EMC Centera device using DiskXtender.

5. Click OK.

6. Activate the changes (Options>Activate Changes).

Using DiskXtender
When EmailXtender volumes close, EmailXtender copies them to the storage 
drive on the EmailXtender server as .emx files. You can use LEGATO 
DiskXtender to "extend" the capacity of the EmailXtender storage drive by 
automatically writing .emx files to other storage media.

DiskXtender manages the movement of data from NTFS volumes, such as the 
EmailXtender storage drive, to a pool of storage media. Once a media service 
has provided access to media (for example, by mounting a piece of media in 
the drive of a storage device), DiskXtender communicates directly with the 
media to read and write data and perform media tasks.

DiskXtender supports a number of storage media types, including EMC 
Centera devices, tape, DVD-R, DVD-RAM, magneto-optical, Ultra-Density 
Optical (UDO), WORM, WORM-tape, and Network Attached Storage (NAS). 
(DiskXtender considers NAS media to be any media available through a 
connection to a share on a network. This could be a network share, like a RAID 
or a NAS device, or simply a shared folder on a server on the network. It could 
even be a shared media folder on another DiskXtender extended drive.)
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Because DiskXtender "extends" the capacity of NTFS volumes by providing 
automatic file migration services, the NTFS volumes are called DiskXtender 
extended drives. DiskXtender extends the drives by moving files to media and 
fetching files from media. Frequently used files can be kept on the volume, 
while less active files can be moved to storage media and purged from the 
drive. To a client or application retrieving files from a drive extended by 
DiskXtender, all files, whether on the extended NTFS volume or on the storage 
media, appear to be present on the NTFS volume.

DiskXtender automates the migration of files to media using a rule-based 
system. Rather than just migrating all files to media without distinction 
between files, you can select which files should be moved to what types and 
pieces of media and when. DiskXtender tracks each file and each piece of 
media so that when a client or application requests file data that has been 
moved to media, DiskXtender can find the file and retrieve it.

For more information setting up DiskXtender and EmailXtender, see the 
following sections:

• "Configuring DiskXtender" on page 131
• "Configuring EmailXtender for Use With DiskXtender" on page 133
• "Automatic File Migration Activities" on page 134

Configuring DiskXtender

To configure DiskXtender for use with EmailXtender, perform the following 
steps in the DiskXtender Data Manager interface:

1. Create a media service. A media service simply provides access to the 
media so that Data Manager can work with it. For some media services, 
like LEGATO MediaStor, this means placing requested media into a drive. 
For other media services, like EMC Centera or Network Attached Storage 
(NAS), this means simply providing access to a place where the data is 
written.

2. Create an extended drive. When you are using DiskXtender with 
EmailXtender, you should select the EmailXtender storage drive as the 
extended drive.

3. Prepare the media. The way you prepare the media depends on the media 
service you are using.
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• EMC Centera - If you are using the EMC Centera media service, there 
are no additional steps you must take to prepare the media. (You do 
not need to create the virtual media or allocate it to the extended 
drive; EmailXtender does this automatically for you when it begins 
closing volumes.)

• MediaStor or StorageTek ACSLS - If you are using the MediaStor or 
StorageTek ACSLS media services, allocate blank media from the 
media service to the extended drive. When you allocate media, 
DiskXtender claims the media for file migration from the specified 
extended drive.

• NAS or Tivoli Storage Manager (TSM) - If you are using the NAS or 
TSM media services, create the virtual media and allocate it to the 
extended drive.

4. Schedule drive scans and the movement of files to media. 

• During a drive scan, DiskXtender inventories the files on the 
extended drive and identifies the files that qualify for movement to 
media, purge, or deletion. Files that qualify for movement to media 
are written to the move list, and the appropriate retention period is 
applied to each file (if retention periods are configured). 

• The move list is processed (and the files are moved to media) when 
the Move files to media schedule is active. The Move files to media 
schedule allows you to tell DiskXtender exactly when to move file 
data out to storage media (allowing you to schedule the use of 
network resources for that activity). 

5. For the remaining DiskXtender settings, you should leave the defaults 
unless instructed to change them by a LEGATO technical representative, 
with the exception of the Use special application filtering option on the 
Options tab of the Service Properties dialog box. This option allows you to 
specify whether an application can recall or directly read a purged file that 
resides on storage media. If you are using virus scanning software on the 
EmailXtender storage drive (the extended drive), you should add the 
executable file for the virus scanning software to the Special Application 
Filtering List and set the file to No recall.
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Important: If you are using the EMC Centera, MediaStor, or StorageTek 
ACSLS media services, do not create media folders, move groups, move rules, 
or purge rules. These items are created automatically by EmailXtender. In 
addition, you should not label StorageTek ACSLS or MediaStor media. 
EmailXtender also does this automatically. For more information, see 
"Automatic File Migration Activities" on page 134.

6. If you are using the NAS or TSM media services, create the media folders, 
move groups, move rules, and purge rules to enable file migration and 
purging. Automatic file migration is not available when you use these 
media services.

You may want to create media folders for each storage drive directory for 
EmailXtender folders or cabinets.

Configuring EmailXtender for Use With DiskXtender

Once you finish configuring DiskXtender, perform the following steps so that 
EmailXtender can interface properly with DiskXtender:

1. Configure EmailXtender to use the media type you set up in DiskXtender. 
You can select a media type either when you install EmailXtender or by 
opening the Computer Properties dialog box. For more information on 
selecting the media type on the Computer Properties dialog box, see 
"Configuring Volume Storage" on page 128.

2. If you are planning to use DiskXtender to write EmailXtender files to an 
EMC Centera device, change the default volume size to 90 MB, instead of 
the default size of 100 MB. There are known performance issues when 
retrieving volumes of 100 MB and greater from an EMC Centera device. 
Setting the volume file size to 90 MB allows for slight overflow of the 
volumes before they are closed, while keeping the total volume file size to 
under 100 MB. For more information on changing volume file size, see 
"Configuring Volume Storage" on page 128.

3. If you are planning to set retention periods, you should set them before 
you begin journaling mail and closing volumes. For more information on 
setting retention periods, see "Configuring a Folder" on page 85.
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Automatic File Migration Activities

Once you configure DiskXtender and EmailXtender, the system can begin 
automatically migrating volumes to media.

Important: If you are using the NAS or TSM media services, automatic file 
migration is not available. You must use the EMC Centera, MediaStor, or 
StorageTek ACSLS media services if you want to benefit from automatic file 
migration.

As EmailXtender closes volumes and copies them to the storage drive as .emx 
files, EmailXtender automatically creates the necessary media folders, move 
groups, and move rules in DiskXtender based on the Message Center folders, 
collection rules, and retention periods. (EmailXtender does not create purge 
rules, which define which files should be purged from the extended drive, 
since the Purge files after move option is selected for each move rule. This 
means that purge rules are unnecessary because all volumes are immediately 
purged from the extended drive once DiskXtender moves them to media.)

Media folders are folders on the extended drive, move groups are specific 
groupings of media assigned to a media folder, move rules define which files 
in a media folder are moved to each move group.

EmailXtender automatically configures DiskXtender as follows:

• One media folder - The first time a volume closes in EmailXtender, the 
system automatically creates a single media folder, called EmailXtender. 
It also labels blank StorageTek ACSLS and MediaStor media and adds the 
media to the media folder.

• One move group per folder per month - EmailXtender then creates one 
move group each month for each EmailXtender folder and adds media to 
the move group. If you configured a retention period for an EmailXtender 
folder, the retention period is configured for the move group.

• One move rule per folder per month - EmailXtender also creates one 
move rule each month for each EmailXtender folder, and sets the move 
rule to move only .emx files, to mark all files for direct read, and to purge 
files immediately after they are moved to media. (Direct read means that 
files are read directly from media rather than being copied back to the 
extended drive when requested.) If you configured a retention period for 
an EmailXtender folder, the retention period is configured for the move 
rule (in addition to being configured at the move group level).



Chapter 5: Configuring Message Archival

EmailXtender, Release 4.7
Administrator’s Guide 135

5

Note: If you are using DVD-R media, files are not marked for direct read 
or purged until you finalize the media.

Note: If you are using DiskXtender to write volumes to removable media, 
such as DVD-R, tape, or magneto-optical, you may want to disable direct 
read to avoid too many competing read and write requests to the library 
containing the media. Consult with a LEGATO technical representative to 
determine if this strategy is appropriate for you.

You should leave the remaining defaults configured for the media folder, move 
groups, and move rules unless instructed to change them by a LEGATO 
technical representative, with the exception of the Maximum media 
simultaneously receiving files option on the Options tab of the Move Group 
Properties dialog box. If you are using the EMC Centera media service, you 
should set this option to 4. 

Important: If volumes exist on the EmailXtender storage drive before you 
extend the storage drive using DiskXtender, EmailXtender does not 
automatically configure DiskXtender to move those volumes; only volumes 
that close after you extend the storage drive cause automatic configuration to 
occur. You must create the media folder, move group, and move rule, as well 
as perform the associated assignments, manually using the DiskXtender Data 
Manager Administrator interface. For instructions, refer to the DiskXtender 
documentation.

Once a drive scan occurs, volumes are added to the move list. They are then 
moved out to media when the Move files to media activity schedule is active. 
They are also automatically purged and marked for direct read.
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Chapter 6: Maintenance

To ensure that all messages are being processed as you intend, you should 
regularly verify the health of the EmailXtender system. You can do this by 
performing daily maintenance tasks on the EmailXtender server and by 
periodically clearing the EmailXtender server of files. You should also perform 
regular backups of the EmailXtender server.

If necessary, you can change account information, such as the user mailbox 
where EmailXtender error messages are sent and the EmailXtender service 
account. The Utilities directory on the EmailXtender installation CD-ROM 
provides a number of utilities that can assist you in maintaining the 
EmailXtender system.

Before you begin regular maintenance tasks, however, it’s important to 
understand the path that messages take through the EmailXtender system. 

For more information, see the following sections:

• "How EmailXtender Processes Messages" on page 139
• "Daily Maintenance Tasks" on page 140
• "Periodically Clearing the EmailXtender Server of Files" on page 153
• "Backing Up an EmailXtender Server" on page 157
• "Viewing EmailXtender Events" on page 157
• "Editing Account Information" on page 159
• "Maintenance Utilities" on page 161

Note: This information assumes that you have installed EmailXtender in a 
supported configuration as described in the EmailXtender documentation and 
in the Messaging Compatibility Guide available on the LEGATO website. For 
maintenance information for previous releases, or if you have a non-standard 
configuration, contact LEGATO Technical Support.
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Figure 49. Overview of Message Processing Flow
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How EmailXtender Processes Messages
EmailXtender processes messages from a variety of sources. As EmailXtender 
archives and indexes these messages, they are moved through a series of 
directories. The previous diagram and following steps describe this 
processing.

1. EmailXtender acquires the message.

• If the message is from a Lotus Domino or Microsoft Exchange mail 
server, that message is placed in a .mailbox subdirectory of the 
\EmailXtender\EmailVault\DropDir directory. There is one .mailbox 
directory for each mailbox connector you define for EmailXtender.

• If the message is from UNIX sendmail, the EmailXtender Bloomberg 
Mail Parser, or a supported instant messaging (IM) product, the 
message is placed in the Internet Information Server (IIS) drop 
directory, \Inetpub\mailroot\Drop.

2. The message is then moved to the \EmailXtender\MsgCenter directory, 
where the message is processed further. If the message cannot be moved 
to this directory for some reason, the message is placed in the 
\EmailXtender\EmailVault\BadDir directory. 

Note: If the message is acquired using EmailXtract, the message is placed 
directly in the \EmailXtender\MsgCenter directory.

3. The message is then prepared for indexing. The message is unpacked into 
the message components (message body, attachments, and so on) in a 
subdirectory of the Message Center directory. 

If there is a problem unpacking the message, the message is placed in the 
\EmailXtender\MsgCenter\BadDir directory, and the original message 
(which had problems) remains in the \MsgCenter directory.

4. A pointer to the message is then archived in an open volume and in a 
subdirectory of the \EmailXtender\EmailVault_Cabinet_Folder\StorageDir 
directory (where Cabinet and Folder are the names of the cabinet and folder, 
respectively). 

5. When the volume is closed, the message is written to a volume (.emx file, 
also called a container file) in the location you specified on the General tab 
of the Computer Properties dialog box using the EmailXtender 
Administrator interface.

If there is a problem in archiving the message, the message is placed in the 
\EmailXtender\EmailVault_Cabinet_Folder\BadDir directory. 
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6. When the message is indexed, the resulting index files are placed in a 
subdirectory of the \EmailXtender\EmailVault_Cabinet\IndexDir directory. 

If there is a problem in indexing the message, the message is placed in the 
\EmailXtender\EmailVault_Cabinet\BadDir directory.

Daily Maintenance Tasks
There are a number of daily tasks that you should perform on the 
EmailXtender server to make sure that the system is operating well and that all 
messages are being processed appropriately. 

Table 6. Daily EmailXtender Server Maintenance Tasks

! Task For details, see:

Check the event logs for unexplained or 
problematic events

page 141

Check for large numbers of messages in the 
EmailXtender message queues 

page 141

Check the number of messages on the mail server page 144

Check that the EmailXtender indexer is indexing 
data

page 146

Check for large numbers of open volumes page 147

Check that the policy engine (ExAddrRule.exe) 
initialized

page 147

Check that EmailXtender processes are getting 
adequate processing time

page 148

Check for excess files in the Message Center 
directory

page 150

Check for unprocessed messages in BadDir 
directories

page 151

Check dates on the .dlc and .xrc files page 152
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You can collect most of the EmailXtender system status information you need 
using the ExMailStatus tool, which is discussed in "ExMailStatus" on page 169. 
Once you use this tool to generate a report, you can analyze the report and look 
for any potential problems.

Check the Event Logs

Events that can effect the EmailXtender system are reported in the OTG, 
Application, and System event logs. You should periodically review those logs 
to see if any unexplained or problematic events have occurred in 
EmailXtender, or any of the software EmailXtender uses, such as Microsoft 
Exchange, Lotus Domino, or the operating system.

To view these event logs using the Event Viewer, select Programs> 
Administrative Tools>Event Viewer from the Start menu. The Event Viewer 
opens to display the following event logs: Application Log, Security Log, 
System Log, and OTG. Double-click any of these event logs to see the events 
in that log. The OTG log is installed by EmailXtender. The other logs are 
installed as part of the operating system.

Alternatively, to view only the EmailXtender events in the OTG event log, 
select Programs>LEGATO EmailXtender>EmailXtender Administrator from 
the Start menu. The EmailXtender Administrator appears. To view 
EmailXtender events, select Events from the View menu. The Event 
Information dialog box appears. For more information on using the Event 
Information Dialog box, see "Viewing EmailXtender Events" on page 157.

Check the Message Queues

You should check each of the message queues that EmailXtender uses to make 
sure that there is not a large number of messages in any of those queues. The 
number of messages that constitute a "large number" varies depending on the 
messaging environment, but for a large environment, a queue containing 5,000 
or more messages typically indicates a problem.

Check for and repair corrupt indexes page 152

Check search, retrieval, and export capabilities page 153

Table 6. Daily EmailXtender Server Maintenance Tasks

! Task For details, see:
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You can view the current state of the message queues using the Computer 
Management MMC application in Microsoft Windows.

To view the current state of message queues:

1. Open the Computer Management application. From the Windows Start 
menu on the EmailXtender server, select Programs>Administrative 
Tools>Computer Management. 

2. On the Tree tab in the left pane, expand the nodes as follows:

Services and Applications>Message Queuing>Private Queues
The EmailXtender queues appear under the Private Queues node and are 
all named with the prefix ex. 
The following figure from the Computer Management application in 
Windows 2000 displays these queues:

Figure 50. EmailXtender Message Queues

You should check the following queues for an excessive amount of messages. 
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Note: When you check a queue, you need to check the Queue messages queue 
for the actual messages. EmailXtender does not use the Journal messages 
queue, which appears at the same level as the Queue messages queue and is 
created by Microsoft Message Queuing (MSMQ).

• ex10_incoming_queue

The ex10_incoming_queue lists the messages stored in the 
EmailXtender\EmailVault\DropDir\*.mailbox folders. Messages in this 
queue are distributed to the ex10_incoming_queue_n queues in round robin 
order. This queue interacts with the ExEmail.exe service.

• ex_10_incoming_queue_0, ex_10_incoming_queue_1, 
ex_10_incoming_queue_2, and ex_10_incoming_queue_3

The ex_10_incoming_queue_n queues contain messages that are to be 
processed by the unpacker. These messages are moved from the .Mailbox 
directories to the EmailXtender\MsgCenter directory, where they are 
unpacked.
If any of the queues have a large number of messages in proportion to the 
other ex_10_incoming_queue_n queues, then you may have a queue that is 
blocked by a message that cannot be processed. 
To correct this problem, use the ReadMSMQ.exe tool to locate, obtain a 
copy of, and remove the lead message in the queue. Once this message has 
been removed, the queue should begin processing and the saved message 
can be sent to LEGATO Technical Support for analysis. For more 
information on using the ReadMSMQ utility, see "ReadMSMQ" on 
page 180.
This queue interacts with the ExEmail.exe service.

• ex30_rule_queue

The ex30_rule_queue is where keyword and specific address collection and 
exclusion rules are processed, and where the decision is made as to which 
volumes the message belongs to, as well as whether the message can be 
discarded.
If you are using EmailXaminer, messages may accumulate in this queue if 
there are problems that prevent messages from being sent to 
EmailXaminer.
This queue interacts with the ExEmail.exe service.

• ex40_emailvault

The ex40_emailvault queue contains the data that the Archive service uses 
to create message-id.xvlt files. After rule processing completes, the 
ExArchive.exe service creates a message-id.xvlt file and places it in an 
existing volume folder, or it creates a new volume folder and places it in 
the new folder in the following directory:
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\EmailXtender\EmailVault_Index_Archive\StorageDir\YYYYMM\ 
The associated message files already exist. Volumes are then built from the 
.xvlt files and folders.
This queue interacts with the ExArchive.exe service.

• ex50_index_queue

The ex50_index_queue contains messages to be added to the list of 
messages to be indexed. If this queue contains no messages, it does not 
mean that the indexer has indexed all messages. 
Messages in this queue have references added to a .xvlts file in the 
EmailXtender\EmailVault_Index\Dropdir directory. The ExIndex.exe service 
processes messages that have left the ex50_index_queue at 10 minute 
intervals.

Check the Number of Messages on the Mail Server

You should check the number of messages on the mail server in addition to 
checking the number of messages in the message queues. If there are a large 
number of message in either the mail server or the message queues, you 
should investigate to determine if there is a problem. For more information, 
see the following sections:

• "Many Messages on the Mail Server and in the Message Queues" on 
page 144

• "Many Messages on the Mail Server and Few or None in the Message 
Queues" on page 145

Many Messages on the Mail Server and in the Message Queues

When there are a large number of messages on the mail server and a large 
number of messages in the message queues, it is possible the system has a 
problem that is preventing messages from being processed. Typically, this is 
caused by one or more of the following conditions:

• There are numerous large messages in the queues which are taking a 
significant amount of time to be unpacked. 
Action: No action is needed. The large number of messages should be 
reduced automatically once the larger messages have been processed.
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• The message queues are not functioning properly. 
Action: Verify that there are no message queueing errors in the event log. 
For more information on viewing the event log, see "Viewing 
EmailXtender Events" on page 157. If there are, see the Microsoft Message 
Queueing (MSMQ) documentation for information on correcting the 
problem. 

• EmailXtender cannot process one or more messages. Typically, this 
indicates that the EmailXtender unpacker component cannot process the 
message for an unknown reason, such as the message being badly 
formed.
Action: Remove the problematic messages from the system to free the 
queues. Retain and submit the problematic messages to LEGATO 
Technical Support for analysis.
Use the ReadMSMQ.exe tool to remove the problematic messages from the 
queue. For more information on using the ReadMSMQ utility, see 
"ReadMSMQ" on page 180.

Many Messages on the Mail Server and Few or None in the Message 
Queues

When there is a high volume of messages on the mail server and all of the 
message queues are empty, there may be a problem at the mail server or at the 
EmailXtender server that is preventing EmailXtender from establishing a 
connection to the mail server. This can be caused by one or more of the 
following conditions:

• Domino and Notes or Exchange and Outlook have stopped functioning 
properly. To verify that this is the case, open the appropriate mail client 
and connect to the associated journal mailboxes. If you cannot connect to 
the journal mailbox, the mail system has stopped functioning properly.
Action: See your mail system documentation for information on how to 
diagnose and correct the problem.

• The distribution list cache file (EmailXtender.dlc) is missing.
Action: Check for a recent EmailXtender.dlc file in the \Program 
Files\OTG\EmailXtender folder. If this file does not exist, it needs to be 
created by the Address Rule service, ExAddrRule.exe. Verify that this 
service is running. For more information on this file, see "Check that the 
Policy Engine (ExAddrRule.exe) Initialized" on page 147.
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• The distribution list cache file (EmailXtender.dlc) is not being updated. The 
EmailXtender.dlc file should have been modified within the last day. 
Action: If the EmailXtender.dlc file is older than a day, it is not being 
updated regularly by the Address Rule service, ExAddrRule.exe. Verify that 
this service is running. For more information on this file, see "Check that 
the Policy Engine (ExAddrRule.exe) Initialized" on page 147.

Check that the Indexer Is Indexing Data

The EmailXtender indexer (the ExIndex.exe service) creates a full-text index of 
messages found in the \Program 
Files\OTG\EmailXtender\EmailVault_Index\DropDir directory. 

To verify that the indexer is functioning properly: 

1. Verify that the ExIndex.exe service is running.

2. While reindexing is occurring, verify that the trans.tbl file exists in the 
EmailXtender\EmailVault_Index\DropDir directory and that it has a recent 
modification time and date. 

This file should change frequently, so it should have a very recent 
modification date. If this file has not been modified in the last hour, it is 
likely that there is a problem with the indexer. 
The trans.tbl file only exists when the indexer is actively reindexing 
messages. If the file does not exist, that does not necessarily indicate a 
problem; it could indicate that no indexing is occurring.

3. Check the size of the \DropDir directory to make sure that messages are 
being indexed regularly. 

In a system where all of the messages have been indexed, this directory is 
empty. Typically, .xvlts, and .txvlts files exist in the directory. 
The total number of messages waiting to be indexed can be roughly 
determined by dividing the total size of the directory in bytes by 862 bytes. 
If this directory contains a large number of files, there may be a problem 
with the indexer.

4. Check the \BadDir directories for any .xvlts or .txvlts files.

The existence of the temporary .xvlts or .txvlts files indicates that an index 
may be corrupt.
When an index is corrupt, a corrupt.idx file is generated as the index file, 
and the current .xvlts or .txvlts file is copied into the appropriate \BadDir 
directory. A \BadDir directory exists for each EmailXtender cabinet and 
folder.
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To repair a corrupt index, use the HealthCheck utility. Once the index is 
repaired, you can delete the associated .xvlts or .txvlts file from the \BadDir 
directory. For more information on using the HealthCheck utility, see 
"HealthCheck" on page 161.

Action: If any of these tasks indicate a problem with the indexer, check the 
event log for any error messages from the indexer. For more information on 
viewing the event log, see "Viewing EmailXtender Events" on page 157.

Check for Large Numbers of Open Volumes

Use the EmailXtender Administrator interface to see if there are a large 
number of open volumes. A large number of open volumes may indicate that 
the Archive service (ExArchive.exe) is having problems closing volumes. This 
may indicate that something is wrong with the storage drive (which is the 
extended drive, if you are using DiskXtender), or that the drive may be full.

Check that the Policy Engine (ExAddrRule.exe) Initialized

Check the event log to verify that the EmailXtender Address Rule service 
(ExAddrRule.exe) is running and initialized. For more information on viewing 
the event log, see "Viewing EmailXtender Events" on page 157.

When the Address Rule service (also referred to as the policy engine) is 
initialized, the following message appears in the event log with a source of 
EmailXtender and a category of AddrRule:

Background policy engine initialized and swapped in for use

EmailXtender cannot pull messages from the mail server until the policy 
engine has initialized.

Action: If the policy engine has not initialized, verify that the EmailXtender.dlc 
file exists. This file must exist for the policy engine to initialize. If this file does 
not exist, the Address Rule service creates it. However, depending on how 
many distribution lists you have in the mail system, it may take a long time -- 
possibly several hours for a large number of distribution lists.

EmailXtender cannot create the EmailXtender.dlc file unless there is at least one 
mailbox connector for each mail server for which you installed EmailXtender 
support. This means that you would need at least one mailbox connector for 
an Exchange only installation, at least one mailbox connector for a Domino 
only installation, or one mailbox connector for Exchange and one mailbox 
connector for Domino if you installed EmailXtender support for both types of 
mail servers. For more information on adding mailbox connectors, see "The 
Email Connection Mailboxes Tab" on page 69.
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Check that EmailXtender Processes Receive Adequate Processing Time

You should verify that EmailXtender processes are running and are receiving 
adequate processing time. To open the EmailXtender Services Information 
dialog box, choose Service Info from the View menu in the Administrator, or 
click the Service Info toolbar icon.

Figure 51. EmailXtender Services Information Dialog Box

EmailXtender uses the following processes:

• Email Data Source

In a Microsoft Exchange environment, the Email Data Source service 
(ExEmail.exe) pulls messages from the mailboxes to which the mail server 
journals. 
In a Lotus Domino environment, the Email Data Source service pulls 
messages from the mailbox connector to which the mail server sends them 
(ExJournal.nsf). 
If EmailXtender has a problem processing any messages, this service 
deposits the messages in question in either the 
EmailXtender\EmailVault\BadDir or the EmailXtender\MsgCenter\BadDir 
folder, from which the administrator can review them. 
The Email Data Source service also performs mail classification when mail 
is saved in the EmailXtender Message Center.

• Archive

The Archive service (ExArchive.exe) monitors message volumes. It creates 
volumes (.emx files, also called container files) of messages that have been 
classified for archival. When the volumes reach their allotted capacity or 
are idle for five days, they are written to hard disk or other specified media 
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supported with the use of DiskXtender. In addition, this service also 
communicates with the DiskXtender Software Developer’s Kit (SDK), if it 
is being used with EmailXtender. 

• Index

The Index service (ExIndex.exe) performs full-text indexing of email 
messages and attachments.

• Administration API

The Administration service (ExAdmin.exe) supports the EmailXtender 
Administrator program, a graphical user interface that allows you to 
easily view and manage the EmailXtender Message Center.

• Query

The Query service (ExQuery.exe) performs user authentication and search 
tasks. The EmailXtender Search Plug-in and Web Search client use this 
service. It also communicates with EmailXtract to verify that email has 
been archived before it is removed from the message store. 

• Exchange Manager

The Exchange Manager service (ExExchangeMgr.exe) manages the 
EmailXtender interaction with Microsoft Exchange to allow shortcut 
resolution for messages extracted by EmailXtract. This service also 
interacts with Microsoft Outlook Web Access (OWA) shortcut support.

• Notes Manager

The Notes Manager service (ExNotesMgr.exe) manages the EmailXtender 
interaction with Lotus Domino to allow shortcut resolution for messages 
extracted by EmailXtract.

• Address Rule

The Address Rule service (ExAddrRule.exe) is a policy engine that manages 
interactions between EmailXtender and an LDAP or ADS server when 
they are configured within EmailXtender and used to apply message 
filters. It controls the caching of policy information on the EmailXtender 
server based on information and changes within the LDAP or ADS server.

Action: If the previously listed processes are not running, start them and 
review the event log to verify that no errors appeared when they started. To 
start an EmailXtender service, right-click the service in the EmailXtender 
Services Information dialog box and select Start from the shortcut menu.

Note: You cannot manage the ExAdmin service from the EmailXtender 
Services Information dialog box. You must stop and start the ExAdmin service 
using the Windows services management feature.

Action: If these processes are running but are not receiving sufficient 
resources, consider adding more resources to the EmailXtender installation.
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Check for Excess Files in the Message Center Directory

Verify that there are not a large number of files generated by either the 
unpacker or by open volumes in the Message Center directory, Program 
Files\OTG\EmailXtender\MsgCenter. 

If there are a large number of files, examine the file specifications to determine 
why these files are in the directory. For more information, see the following 
sections:

• "Many .access, .ref, or Attachment Files" on page 150
• "Many Files With No Extension" on page 150

Many .access, .ref, or Attachment Files
If there are a large number of .access, .ref, or attachment files in the 
\MsgCenter directory, this indicates that the indexer has a backlog of 
accumulated messages and has not yet processed these intermediate files. 
This backlog may indicate that there is a problem with the indexer.
To determine if the indexer is working properly, see "Check that the 
Indexer Is Indexing Data" on page 146. 
Once you correct the problem with the indexer, these files are removed 
from the \MsgCenter directory as the indexer processes them.

Many Files With No Extension

If there are a large number of files with no file extensions (buffered files) in the 
\MsgCenter directory, this indicates that either or both of the following 
conditions may be occurring:

• There are a large number of open EmailXtender volumes. Buffered files in 
this case indicate that data is not getting stored on permanent media 
because the volumes are not closing. 
Action: For more information on the corrective action you need to take to 
close these volumes, see "Check for Large Numbers of Open Volumes" on 
page 147. Once the volumes are closed, the buffered files are removed 
from the \MsgCenter directory.

• If you are using EmailXaminer, large numbers of buffered files may 
indicate that EmailXaminer reviewers have a significant backlog of 
messages to review. Buffered files are left in the \MsgCenter directory 
until after sample sets have been reviewed to provide quick access to that 
data. 
Action: For more information on verifying that EmailXaminer is 
functioning properly, refer to the EmailXaminer documentation.
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Check for Unprocessed Messages in BadDir Directories

Check for any unprocessed messages in the various \BadDir directories.

EmailXtender places messages it cannot process in one of several \BadDir 
directories. The \BadDir directory in which a message is placed indicates the 
problem with the message.

• \EmailVault\BadDir

EmailXtender places messages in the \EmailVault\BadDir directory when 
it is able to pull the message from the mail source (such as the Exchange 
mail server, the Domino mail server, or the \Inetpub\mailroot directory) 
but cannot process the message.
The message may not be processed because of a problem with the message 
or a problem with the network connection. For example, messages may 
not be processed if the network connection is lost between the 
EmailXtender server and the mail server during processing, or if the 
EmailXtender server fails in some way during processing because the 
operating system crashes or reboots.

• \MsgCenter\BadDir

EmailXtender places messages into the \MsgCenter\Baddir directory 
when a message cannot be processed by the unpacker.

• \EmailVault_Cabinet\BadDir or \EmailVault_Cabinet_Folder\BadDir

If a message is processed by the unpacker but then encounters other 
problems during archiving or indexing, it is placed in the \BadDir 
directory under the associated cabinet or folder. This may be the default 
cabinet (\EmailVault_Index), the default folder 
(\EmailVault_Index_Archive) or a user-defined cabinet or folder, such as 
\EmailVault_MyCabinet_MyFolder.

Action: If you find unprocessed messages, move the messages to the 
\MsgCenter\BadDir directory and then use the ExBadDirProcessor.exe utility to 
reprocess the messages. For more information, see "ExBadDirProcessor" on 
page 171.

If the messages are not processed after using this utility, record any errors you 
find in the event log and contact LEGATO Technical Support for assistance.
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Check Dates on the .dlc and .xrc Files

To ensure that EmailXtender is processing messages using the most up-to-date 
distribution lists and rules, verify that the following files on the EmailXtender 
install drive are up-to-date:

• Program Files\OTG\EmailXtender\EmailXtender.dlc

• Program Files\OTG\EmailXtender\RuleCacheFiles\*.xrc 

If these files are no more than a day old, they are probably up-to-date.

If these files are out-of-date, it is possible that modifications to distribution lists 
and rules are not being accurately reflected by the EmailXtender server.

The EmailXtender.dlc file is the Distribution List Cache file. If this file is not 
up-to-date, then EmailXtender may not accurately associate users with the 
distribution lists to which they belong.

The .xrc files are the EmailXtender Rules Cache files. If these files are not 
up-to-date, then collection and exclusion rules are applied but do not reflect 
any changes made to distribution group membership for users indicated in 
specific address rules. Additionally, any changes made to keyword rules after 
the last modified date on .xrc files are not applied until the rule files are rebuilt.

To make tracking of .xrc files easier, you can enable rule cache logging. At the 
root of the EmailXtender registry branch, 
HKey_Local_Machine\Software\OTG\EmailXtender, set the RuleCacheLog 
value to 1. Then stop and restart the EmailXtender Address Rule service. This 
creates a collection of readable .log files associated with the .xrc files in the 
\EmailXtender\RuleCacheFiles directory the next time the policy engine 
initializes.

Check for and Repair Corrupt Indexes

Use the HealthCheck utility to verify that all indexes are available and that no 
corrupt indexes exist.

Action: If a corrupt index exists, use the HealthCheck utility to re-index the 
data. If this does not result in a valid index, there is probably a problem with 
one of the messages in the index. Check the event log for an EmailXtender 
error message about the corrupt index. For more information on viewing the 
event log, see "Viewing EmailXtender Events" on page 157.

If you cannot correct the problem, remove the problematic messages from the 
archive and then index the archive again to create a valid index. For more 
information on using the HealthCheck utility, see "HealthCheck" on page 161.
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Check Search, Retrieval, and Export Capabilities

Verify that the search, retrieval, and result list export capabilities are working 
properly. This is a test of the ExQuery.exe and ExArchive.exe services. 

To verify that search, retrieval, and result list export capabilities are working 
properly:

1. Search for messages using various time and date ranges with the Before 
search option.

2. Open several of the messages you retrieve.

3. Use the Copy to Folder option to export some of these messages.

Action: If you have any problems performing the previous tasks, verify that 
the ExQuery.exe and the ExArchive.exe services are running. If the ExQuery.exe 
and the ExArchive.exe services are running, review the event log for any 
EmailXtender errors associated with those services. For more information on 
viewing the event log, see "Viewing EmailXtender Events" on page 157.

Periodically Clearing the EmailXtender Server of Files
You should periodically clear the EmailXtender server of files that are no 
longer being processed. The files may be unnecessary files that can safely be 
deleted, or they may be messages that were incompletely processed.

You should also clear the EmailXtender server of unnecessary files before you 
update the release of EmailXtender you are running, since you must bring the 
server down for the update.

For more information, see the following sections:

• "Preparing the EmailXtender Server for Cleanup" on page 154
• "Clearing the EmailVault Drop Directory" on page 155
• "Clearing the Message Center BadDir Directory" on page 155
• "Clearing the Message Center Directory" on page 156
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Preparing the EmailXtender Server for Cleanup

To prepare to clear the EmailXtender server of files:

1. Stop new messages from entering the system.

• Remove all mailbox connectors from the EmailXtender server. This 
prevents any new Domino or Exchange messages from coming into 
the system.

• Verify that the SMTP drop directory, \Inetpub\mailroot\Drop, is 
empty, and stop any processes that place mail into that directory. 
These processes depend on the environment and may include a 
sendmail process on a remote UNIX system or processes associated 
with instant messaging products that send messages to 
EmailXtender. This prevents messages from these sources from 
coming into the system.

2. Add a single mailbox connector to an empty mailbox for the Domino or 
Exchange mail system. Creating this mailbox connector allows 
EmailXtender to have address book access without allowing it to pull any 
new mail. If the EmailXtender server is configured to receive mail from 
both Domino and Exchange, you need one mailbox connector for each.

3. Verify that all EmailXtender message queues are empty of messages. For 
more information on checking the message queues, see "Check the 
Message Queues" on page 141.

Note: All EmailXtender services need to be running to empty these 
queues.

4. Check the index drop directories to make sure all indexing has completed. 
An index drop directory is defined for each cabinet. 

The default index drop directory is \Program 
Files\OTG\EmailXtender\EmailVault_Index\DropDir. 
This directory includes the following files:
• .xvlts files (index runs ready for processing)
• .txvlts files (index runs not quite ready for processing)
• A trans.tbl file (a file that exists while indexing takes place)
If re-indexing is occurring, a buffered file, a directory created for each 
message during the volume re-index process, and some number of .reindex 
or .redoindex files also appear in the index drop directory.
The full-text indexing process is complete when no .xvlts, .txvlts, .reindex, 
.redoindex, or trans.tbl files are left in any of the index drop directories.
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5. Once you complete these steps, the EmailXtender server is stopped and all 
messages have been completely processed. You should also close all open 
volumes using the EmailXtender Administrator interface. For more 
information on closing volumes, see "Closing a Volume" on page 120. 

Clearing the EmailVault Drop Directory

After a message has been pulled from a mail server into the vault drop 
directory, a message is placed on the EmailXtender incoming MSMQ queue, 
ex10_incoming_queue, for processing.

Messages can be left, unprocessed in the EmailXtender EmailVault drop 
directory, \Program Files\OTG\EmailXtender\EmailVault\DropDir, when 
message queues become corrupt or when the queues are manually purged. 

To recover these messages:

1. Locate the messages to be moved.

2. Move the messages to the Message Center \BadDir directory.

3. Reprocess the messages in the Message Center \BadDir directory using the 
ExBadDirProcessor.exe utility. For more information, see 
"ExBadDirProcessor" on page 171.

Important: These messages have already been entered into the Microsoft SQL 
Server database. Processing them again without using the 
ExBadDirProcessor.exe utility may result in the deletion of the message when it 
is considered a duplicate message.

These messages are in the .mailbox folders. Exchange messages have a .msg file 
extension, and Domino messages have a .onm file extension.

Clearing the Message Center BadDir Directory

When a message cannot be unpacked successfully, it is placed in the Message 
Center BadDir directory:

\Program Files\OTG\EmailXtender\MsgCenter\BadDir

To clear these messages from the Message Center BadDir directory, reprocess 
the files using the ExBadDirProcessor.exe utility. For more information, see 
"ExBadDirProcessor" on page 171.
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The reprocessing often succeeds because message unpacking has improved 
with newer releases of EmailXtender. Often, these improvements allow 
messages that could not be unpacked by a previous release of the software to 
be successfully unpacked with a more up-to-date version of the software. 

Clearing the Message Center Directory

When no messages are being received and all open volumes are closed, the 
Message Center directory, \Program Files\OTG\EmailXtender\MsgCenter, 
should be empty. The Message Center should only be a temporary storage area 
for various types of processing.

To clear the Message Center directory:

1. Remove the directories created by the unpacking process.

When there is a problem creating an index, the directory into which a 
message was unpacked may remain in the Message Center directory. 
These directories have the same name as the message from which they are 
generated. For example, a 424733F15F05C3F5022504C6.dir directory is 
created when 424733F15F05C3F5022504C6 is the name of the message.
If index drop directories for each of the cabinets are empty and there is 
nothing in the message queues, then there should be no .dir directories in 
the Message Center. If .dir directories exist, the cabinet drop directories are 
empty, and the message queues are empty, then you should remove these 
.dir directories.

2. If you had to remove any .dir directories from the Message Center 
directory, check to see if any indexes are corrupt. (The existence of 
orphaned .dir directories in the Message Center directory implies that 
corrupt indexes may have been created.) For more information on finding 
and fixing corrupt indexes, see "Check for and Repair Corrupt Indexes" on 
page 152.

3. Handle any remaining messages in the Message Center. 

Any message left in the Message Center after all open volumes have been 
closed and all message acquisition has stopped is potentially a lost 
message that should be either recovered or deleted.
To delete or reprocess these remaining messages, use the HealthCheck 
utility on the messages to determine what volume is associated with each 
message. For more information, see "HealthCheck" on page 161. 
You may want to spot check the messages in the Message Center by 
searching for the message identifier and attempting to retrieve the 
message. If the message has an existing, permanently archived volume 
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associated with it, then you can delete the message. If the message refers 
to a volume that has been lost, you can reprocess that message using the 
ExBadDirProcessor.exe utility with the –nv option. This option should only 
be used if a volume has been lost. For more information, see 
"ExBadDirProcessor" on page 171.

Backing Up an EmailXtender Server
When the EmailXtender server is processing email, the server keeps a number 
of files open. These files include SQL tables, message queues, and full-text 
indexes. These files need to be closed to perform a backup of the EmailXtender 
server. 

The ExSuspend.exe utility suspends and then resumes the EmailXtender 
services in the proper order. This causes all needed files to be closed without 
requiring that the EmailXtender server be shut down, and allows operations 
that only require the ability to read data, such as searches, to proceed while a 
backup is in process.

For more information on using ExSuspend.exe, see "ExSuspend" on page 173.

Viewing EmailXtender Events
You can view EmailXtender events using the Event Information dialog box. 
You can also send selected events to a specified email account.

To view and send EmailXtender event information:

1. From the View menu in the Administrator, choose Events, or click the 
Events toolbar icon.

Figure 52. Events Toolbar Icon

The EmailXtender Event Information dialog box appears.
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Figure 53. EmailXtender Event Information Dialog Box

2. From the Displayed Severity Level drop-down list, choose the type of 
event you want to view. You can view Information events, Warning events, 
or Error events.

3. Once you select the type of events you want to view, you have several 
view options:

• To refresh the event list to reflect events that have occurred since you 
first opened the EmailXtender Event Information dialog box, click 
Reload Events.

• To erase events from the event log so that you can begin viewing only 
the most recent events, click Clear All Events.

• To sort the event list by category, severity, date, or message data, click 
the appropriate column heading.

• To view an event in a format that you can copy and paste into another 
application, double-click the event. The Event Details dialog box 
appears.

4. To send event notices to a specific email address or distribution list, enter 
the email address or distribution list in the Email Address text box. 

To select the address from the Microsoft Exchange or Lotus Domino 
Address Book, click Email Address.

5. In the EmailXtender Event Information dialog box, select the events you 
want to send, and then click Send Events.

6. Click OK to close the EmailXtender Event Information dialog box.
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Editing Account Information
The Account Information dialog box allows you to edit the EmailXtender 
Administrator account, edit the EmailXtender service account, and define 
supervisor groups.

To view and edit EmailXtender account information:

1. From the View menu in the Administrator, choose Account Info or click 
the Account Info toolbar icon. 

Figure 54. Account Info Toolbar Icon

The EmailXtender Account Information dialog box appears.

Figure 55. EmailXtender Account Information Dialog Box

2. To change the user mailbox where EmailXtender error messages are sent, 
enter the friendly name or SMTP format of the new administrator email 
address in the Admin Email Address text box. To use an address book to 
select the account, click Admin Email Address.

3. To test name resolution for the administrator email address, click Send Test 
Message and then log into the administrator mailbox to verify that the test 
message was received.
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4. If you want to allow a select group of users to search for and view 
messages sent from and to another select group of users, configure 
supervisor groups. For more information, see "Supervisor Groups" on 
page 194.

5. To change the EmailXtender service account, click User. The Edit Service 
Account dialog box appears. 

Figure 56. Edit Service Account

6. In the Domain text box, enter the name of the Windows domain to which 
the service account belongs. 

Note: The service account, which you configured when you installed 
EmailXtender, is an integral part of the authentication between 
EmailXtender and the email server. Erroneous changes to the service 
account can cause some EmailXtender services to terminate due to 
authentication problems. The service account should have at least local 
administrative rights.

7. In the User text box, enter the user name of the new service account.

8. In the Password text box, enter the password for the new service account.

9. Re-enter the password in the Confirm Password text box.

10. Click OK save the changes and return to the EmailXtender Account 
Information dialog box. 

11. Click OK to save the changes and close the EmailXtender Account 
Information dialog box.

12. Activate the changes (Options>Activate Changes).
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Maintenance Utilities
There are several utilities that can assist you in maintaining the EmailXtender 
system. These utilities can be installed from the EmailXtender kit or copied 
from the Utilities directory on the installation CD. For more information, see 
the following sections:

• "HealthCheck" on page 161
• "ExMailStatus" on page 169
• "ExBadDirProcessor" on page 171
• "ExSuspend" on page 173
• "Managexvlt" on page 176
• "UnpackContainer" on page 178
• "ReadMSMQ" on page 180

HealthCheck

The HealthCheck utility, which you install when you install EmailXtender 
server components, allows you to maintain the data on a local or remote 
EmailXtender server. Using the HealthCheck utility, you can perform the 
following maintenance tasks:

• Verify that all messages were archived for each month, index, and 
volume.

• Verify that messages are not missing from a volume.
• Rebuild a corrupt month or index.

For example, you may determine from the EmailXtender Administrator 
interface that a volume is missing a message because the status icon for the 
volume changes. To determine which message is missing, you should check 
the event log. (For more information on using the event log, see "Viewing 
EmailXtender Events" on page 157.) You can then use the HealthCheck utility 
to verify whether the message appears in the EmailXtender database, and then 
either re-index the volume or delete the identifier for the message from the 
database.

For more information, see the following sections:

• "Starting the HealthCheck Utility" on page 162
• "Exploring the HealthCheck Utility Interface" on page 163
• "Verifying Indexes" on page 165
• "Verifying Message Identifiers" on page 166
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• "Generating a Report of All Documents" on page 166
• "Rebuilding Indexes" on page 168
• "Deleting Message Identifiers from the Database" on page 168

Starting the HealthCheck Utility

When you start the HealthCheck utility, you can either automatically load the 
data for a particular month or you can simply launch the utility and a prompt 
appears to assist you in selecting the month.

• To start the utility before selecting a month:
1. You have the following choices:

– From the Windows Start menu, select Programs>LEGATO 
EmailXtender>EmailXtender HealthCheck.

– From the EmailXtender Administrator interface, open the View 
menu and then select Health Check Utility, or click the 
HealthCheck utility toolbar icon. 

Figure 57. HealthCheck Utility Toolbar Icon

– Enter the following at the command line: 
E:\Programs\OTG\EmailXtender\bin\HealthCheck.exe

where E: is the drive on which you installed the utility.
2. In the Select Server and Month to Load dialog box, choose the 

EmailXtender server, month, and year, and then click OK.

Figure 58. Select Server and Month to Load Dialog Box

• To start the utility and automatically load the data for a particular month:
You have the following choices:
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– In the EmailXtender Administrator interface, select the month. Then 
open the View menu and select Health Check Utility. Alternatively, 
you can select the month and then click the HealthCheck utility 
toolbar icon. (If you select multiple months, one instance of the utility 
is launched for each month.)

– Use the /m and /s options followed by a colon and a value at the 
command line, as shown in the following example:
E:\Programs\OTG\EmailXtender\bin\HealthCheck.exe 
/m:yyyymm /s:exserver

where E: is the drive on which you installed the utility, yyyymm is the 
month (four-digit year and then two-digit month), and exserver is the 
name of the EmailXtender server you want to maintain.

Exploring the HealthCheck Utility Interface

The HealthCheck utility provides an easy-to-use graphical user interface so 
that you can view EmailXtender volume and index status information, and 
perform related maintenance tasks from a single location.

Figure 59. HealthCheck Utility
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The HealthCheck utility interface consists of four panes:

• The Month pane on the left displays the data associated with the month 
you select when you start the HealthCheck utility. You can expand the 
month to view the cabinets and indexes that are part of the month. 

• The List pane on the top right displays either the list of volumes or the list 
of indexes, depending on whether you select a cabinet or index in the 
Month pane. (If you select an index, the list of volumes appears. If you 
select a cabinet or month, the list of indexes appears.)
– The volume list displays the status of the volume (an icon that 

indicates whether a volume is valid, missing a message, or corrupt), 
the name of the volume, the number of messages indexed and 
archived for the volume, the size of the volume, and the processing 
status of the volume (Open, Closed, Corrupt, Re-index Pending, or 
Re-indexing). 

– The index list displays the status of the index (an icon that indicates 
whether an index is valid, missing a message, or corrupt), the name 
of the index, the number of volumes indexed and archived for each 
index, the number of messages indexed and archived for each index, 
the size of the index, and the date the index was created and 
modified. 

• The Totals pane displays totals for the information itemized in the List 
pane.

• The Log pane at the bottom of the window displays processing 
information from the HealthCheck utility. To save this information to a 
file, open the Options menu and then select Log File>Save As. To clear the 
contents of the Log pane, open the Options menu and then select Log 
File>Clear Log File.

Refreshing the HealthCheck Utility

To update the data listed in the HealthCheck utility interface or in the 
EmailXtender server list, open the Options menu and then select Refresh.

Connecting to Another EmailXtender Server

You can run the HealthCheck utility for a local EmailXtender server and for 
remote computers.
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To connect to another EmailXtender server:

1. From the Server menu in the utility, select Open. The Select Server and 
Month to Load dialog box appears.

Figure 60. Select Server and Month to Load Dialog Box

2. Select the server from the drop-down list. If the server you want to use is 
not listed, you can attempt to discover the server on the network by 
clicking Discover Servers.

3. Select the month and year from the corresponding drop-down lists.

4. Click OK.

Selecting Data for Another Month

When you are finished using the HealthCheck utility to manage the data for 
one month, you can choose another month to manage without closing the 
utility.

To select data for another month from the utility:

1. From the Server menu, select Open. The Select Server and Month to Load 
dialog box appears.

2. Select the server, month, and year from the corresponding drop-down 
lists.

3. Click OK.

Verifying Indexes

You can verify a single index or all indexes in a month. 

• To verify a single index, select the index in the Month pane of the utility 
and then open the Tools menu and choose Verify Index. 

• To verify all the indexes for a month, open the Tools menu and then 
chooseVerify All.
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If any messages are found to be missing in the index, the message identifiers 
of those messages will be listed.

Verifying Message Identifiers

You can use the HealthCheck utility to verify that a message is listed in the 
EmailXtender database. This function is useful, for example, in cases where a 
volume is missing a message and the message identifier is listed in the event 
log. 

To verify that the identifier of a selected message occurs in the EmailXtender 
database:

1. Determine the message identifier for the message you want to check. (The 
message identifier may appear in the event log or in the Log pane of the 
HealthCheck utility.)

2. Copy the message identifier to the Windows clipboard using a Copy 
command. To copy the value from the Log pane, select the value, 
right-click, and then select Copy from the shortcut menu.

3. Open the Tools menu and then select Message ID Check. The Enter 
Message ID dialog box appears.

Figure 61. Enter Message ID Dialog Box

4. Enter the message identifier and then click OK.

Generating a Report of All Documents

You can use the HealthCheck utility to generate a list of all the documents 
(such as attachments and messages) associated with an index or month. 

To generate a report of all documents for an index or month:

1. Select the index or month in the Month pane of the utility interface.

2. From the Tools menu, select Document Report. The report appears in the 
Log pane. 

3. You can save the output of the Log Pane by opening the Options menu and 
selecting Log File>Save As.
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Example: HealthCheck Utility Document Report

The following example shows a sample document report.

==================================================================

Thursday, January 27, 2005 13:49:50

------------------------------------------------------------------

ChkIndx run on Thursday, January 27, 2005 at 01:49:49 PM

Indexes Look OK.

ChkVol run on Thursday, January 27, 2005 at 01:49:49 PM

Index        : \EmailVault_Index_Archive\200411\000

Number of email messages In Index : 65

Number Non Email Msgs In Index    : 48

Number Documents  In Index        : 113

Number of Messages in Volume      : 65

Number of Deleted Msgs in Volume  : 0

IdxDocList Check Volume run on Thursday, January 27, 2005 at 01:49:49 PM

Index                      : \EmailVault_Index_Archive\200411\000

Number Matching Lines      : 113

Number Email Messages      : 65

Number Volume Messages     : 65

Number Non Email Msgs      : 48

Number Documents           : 113

==========================================================================

Thursday, January 27, 2005 14:56:28

--------------------------------------------------------------------------

Status Volume Message Id Filename

OK 20050127133152 42cc481f7d49662e07a48c45 42cc481f7d49662e07a48c45.access

OK 20050127133152 42d6d6782fde02e65272e9d2 42d6d6782fde02e65272e9d2.access

OK 20050127133152 42d914764a7db96d9cd0ca74 42d914764a7db96d9cd0ca74.access
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OK 20050127133152 42d914764a7db96d9cd0ca74 dailyblast123.pdf

Index                      : \EmailVault_Index_Archive\200411\000

Number Matching Lines      : 113

Number Email Messages      : 65

Number Non Email Msgs      : 48

Number Documents           : 113

Rebuilding Indexes

If an index is corrupt or missing one or more messages, you can use the 
HealthCheck utility to rebuild the index. You can rebuild a single index or all 
indexes for a month. Note that the first step performed during rebuilding is 
verifying the index.

If the index is corrupt, the utility fully rebuilds the index. If the index is not 
corrupt and is only missing one or more messages, the utility does not need to 
completely rebuild the index; it repairs the index. Repairing the index takes 
less time than completely rebuilding it.

• To rebuild a single index, select the index you want to rebuild from the 
Month pane in the utility, and then open the Tools menu and choose 
Rebuild Index. 

• To rebuild all indexes in a month, open the Tools menu and then choose 
Rebuild All.

Deleting Message Identifiers from the Database

You can use the HealthCheck utility to delete a message identifier from the 
database. This can be useful if a volume indicates that it is missing messages 
and you determine that the messages do not belong to the volume. 

To delete message identifiers from the EmailXtender database:

1. Determine the message identifier you want to delete. (The message 
identifier may appear in the event log or in the Totals pane of the 
HealthCheck utility.)

2. Copy the message identifier to the Windows clipboard using a Copy 
command. To copy the value from the Log pane, select the value, 
right-click and then select Copy from the shortcut menu.
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3. Open the Tools menu and then select Remove ID Check. The Enter 
Message ID dialog box appears.

Figure 62. Enter Message ID Dialog Box

4. Enter the message identifier and then click OK. 

ExMailStatus

The ExMailStatus.exe utility generates a log file that summarizes the current 
state of the EmailXtender server. ExMailStatus.exe logs all or some of the 
following data:

• EmailXtender server information
• Status of the EmailXtender disk, services, volumes, and indexes
• List of running processes on the server
• Contents of the message queues
• List of non-processed messages
• SQL Server database information
• Status of the EmailXtender state file
• Top 20 error events from the event, application, and system logs

ExMailStatus.exe is controlled using command line options. You can use the 
Windows Task Scheduler to generate a log file using this utility at regular 
intervals, such as every 3 hours.

ExMailStatus Options

You control the ExMailStatus.exe utility using command line options, as shown 
in the following example:

D:\ExMailStatus.exe -a user@example.com -top 20 -age 30
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The following table summarizes the command line options for the 
ExMailStatus.exe utility.

Table 7. Command Line Options for ExMailStatus.exe

Option Specifies

-a address[;address] . . . The one or more email addresses to which the status 
log should be sent. Multiple addresses should be 
separated with semi-colons.

-f filename

-f [path]unique[.ext]

The status log should be written to a file. 
• If a file is specified, the log will be created in a file 

with that name in the same directory as the 
ExMailStatus.exe file.

• If the unique keyword is used, the log file will be 
created with the name ExMailStatusnnnnn, where 
nnnnn is a random number. If the path portion of the 
name is specified, the file is placed in that directory. 
If the ext portion of the name is specified, the file 
will have that file extension. For example, specifying 
-f c:\temp\unique.dat would cause the file 
ExMailStatus98976.dat to be created in the c:\temp 
directory.

-i number The number of times the status should be written, 
typically to a file. The amount of time between these 
iterations is specified using the –w option.

-w number The amount of seconds to wait between iterations of 
generating the status log.

-s That the status log be written to the screen.

-v List the EmailXtender file versions in the status log.

-top number The number of top error events to list in the status log.

-age number The number of days to keep status log files that are 
named ExMailStatus*.*, where * is one or more 
alphanumeric characters. If you choose to name the 
log file differently, this option will have no effect.

-reg List registry settings in the status log.
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ExMailStatus Examples

The following are a series of sample ExMailStatus.exe command lines.

• To email the EmailXtender server status to sfrank@company.com and 
alice@ibm.com, enter the following:
ExMailStatus -a sfrank@company.com;alice@ibm.com

• To email the EmailXtender server status to a file 10 times at 60 second 
intervals, enter the following:
ExMailStatus -i 10 -w 60 -f unique.txt

• To create a file named EXmslog.txt that contains 10 iterations of the status 
log, 60 seconds apart, enter the following:
ExMailStatus -i 10 -w 60 -f EXmslog.txt -top 10

• To create a file named EXmslog.txt that contains the status log and deletes 
previous status files that are older than 30 days, enter the following:
ExMailStatus -f EXmslog.txt -age 30

ExBadDirProcessor

The ExBadDirProcessor.exe utility moves messages that do not have an assigned 
volume from the EmailXtender BadDir directory to the Drop directory for 
reprocessing. This utility can be run interactively or non-interactively. For 
more information, see the following sections:

• "Non-Interactive" on page 172
• "Interactive" on page 172
• "Processing Messages Associated with Volumes" on page 172
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Non-Interactive

If you run ExBadDirProcessor.exe with the –ni option, it does not prompt you 
for any input. This form is best used when calling the utility from a script. The 
following is an example of the utility running with the –ni option.

> ExBadDirProcessor -ni

EmailXtender Bad Dir processor, Version 4.60

Copyright LEGATO Software

MsgId File Time In DB? Volume         

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

0000000080142E578C77F83E 04/25/2003 15:13:13:453 Yes 20030112160137

00000000805A2439E7A8CFA9 04/25/2003 15:14:29:375 No

3B894A01803A8AC0D7B10510 04/25/2003 15:13:53:937 No

3D0D97B7800B9FED14BE6239 04/25/2003 22:02:29:953 No                       

Interactive

If you run ExBadDirProcessor.exe without the –ni option, it runs in interactive 
mode, and you are asked to confirm that each bad message should be moved. 
The following is an example of the utility running interactively.

> ExBadDirProcessor

EmailXtender Bad Dir processor, Version 4.50

Copyright LEGATO Software

Bad messages directory: F:\Program Files\OTG\EmailXtender\MsgCenter\BadDir

Drop directory : C:\Inetpub\mailroot\Drop

Continue? (Y/N)

Processing Messages Associated with Volumes

Running ExBadDirProcessor.exe using the –nv option causes messages to be 
reprocessed even if they have volumes associated with them. This option 
should only be used when a volume is lost; it should never be used at any other 
time.

To use this option, move all the orphaned messages from the Message Center 
directory to the Message Center \BadDir directory, and then run this utility 
with the –nv option.



Chapter 6: Maintenance

EmailXtender, Release 4.7
Administrator’s Guide 173

6

ExSuspend

The ExSuspend.exe utility suspends and then resumes the EmailXtender 
services in the proper order. This causes all needed files to be closed without 
requiring that the EmailXtender server be shut down, and allows operations 
that only require the ability to read data, such as searches, to proceed while a 
backup is in process.

Typically, you call ExSuspend.exe from a script as part of the regular backup of 
an EmailXtender system, although you can also run the utility interactively 
from the command line. The way you use the utility determines what 
command line options are available. 

ExSuspend.exe is available in the Utilities directory of the EmailXtender 
installation CD. You should copy the utility to a directory on the EmailXtender 
server before you run it either interactively or from a script.

When you use ExSuspend.exe to suspend an EmailXtender server, the 
following occurs:

1. The exEmail.exe service stops requesting that mailbox connectors pull 
messages.

2. The ExExchangeMB(ExExch~1) processes (for Exchange) exit from the task 
list.

3. The ExEmail.exe service stops processing the unpacker queues, such as 
ex10_incoming_queue_0 and ex10_incoming_queue_1.

4. The ExEmail.exe service stops processing messages in the ex30_rule_queue 
queue. 

5. The ExArchive.exe service stops processing the ex40_emailvault queue.

6. The ExArchive.exe service finishes recording the current volume and 
suspends performing any further recording.

7. The ExIndex.exe service stops processing the ex50_index_queue queue.

8. The ExIndex.exe service finishes the current document it is indexing, stops 
the current index run, and suspends any further index runs.

9. If a volume is being re-indexed, the ExIndex.exe service finishes 
re-indexing the current volume and suspends any further volume 
re-indexing.

The ExQuery.exe service continues to operate and allow search requests to take 
place. Unless suspended, auditing also continues to monitor query requests 
and update the MSMQ queues and the database.
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For more information, see the following sections:

• "ExSuspend Options" on page 174
• "Interactive" on page 175
• "Non-interactive" on page 176

ExSuspend Options

You control the ExSuspend.exe utility using command line options, as shown in 
the following example:

Exsuspend -suspend -timeout 1200

The following table summarizes the command line options for the 
ExSuspend.exe utility.

Note: You can also check the status of ExSuspend.exe by running the executable 
at the command line with no options.

Table 8. ExSuspend Options

Option Description

-suspend Suspends processing of EmailXtender services, except 
for the Query service and the Audit service.

-resume Resumes processing of EmailXtender services, except for 
the Query service and the Audit service.

-block Waits for the suspend or resume operation to complete.

-timeout seconds The number of seconds to wait for a resume or suspend 
operation to complete. 

When you specify the -timeout option, you can also use 
the -block option. If you do not specify the -block option 
after using the -timeout option, the -block option is set 
by default.

-auditsvc Suspends or resumes the Audit service only.

-noshowtime Prevents the elapsed time from appearing. Typically, this 
is used when ExSuspend.exe is used within a script. If you 
use this option, you must also enter the -timeout option.
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Interactive

You can run ExSuspend.exe interactively from the command line.

1. Run the ExSuspend.exe executable and use the -suspend and -timeout 
options, as shown in the following example, which suspends the services 
and terminates the utility after 1,200 seconds (20 minutes) if it is not 
successful.

Exsuspend -suspend -timeout 1200

While the services are suspended, the timeout seconds are counted as they 
elapse (unless you use the -noshowtime option), and the Current Server 
State is listed as "Suspended", as shown in the following example:
C:\exsuspend>exsuspend -suspend -timeout 1200

EmailXtender Suspend Operation, Version 1.2

Copyright Legato Systems Inc.

Warning:  timeout used without block -- block assumed

Elapsed time: 56 sec

Current Server State: Suspended

C:\exsuspend>

2. If you are using the EmailXtender Audit Utility, run the ExSuspend.exe 
executable and use the -suspend, -auditsvc, and -timeout options, as 
shown in the following example, to suspend the Audit Utility service after 
you have suspended the other services. You suspend the Audit service last 
so that you have a complete audit record of all EmailXtender activity.

Exsuspend -suspend -auditsvc -timeout 1200

While the Audit Utility service is suspended, the timeout seconds are 
counted as they elapse (unless you use the -noshowtime option), and the 
Current Audit State is listed as "Suspended", as shown in the following 
example:
C:\exsuspend>exsuspend -suspend  -auditsvc -timeout 1200

EmailXtender Suspend Operation, Version 1.2

Copyright Legato Systems Inc.

Warning:  timeout used without block -- block assumed

Elapsed time: 56 sec

Current Audit State: Suspended

C:\exsuspend>

3. After the server backup is complete, use ExSuspend.exe to resume the 
Audit Utility service, as shown in the following example:
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Exsuspend -auditsvc -resume -timeout 1200

4. Use ExSuspend.exe to resume the remaining EmailXtender services, as 
shown in the following example:

Exsuspend -resume -timeout 1200

Once the services are resumed, the Current Server State and Current Audit 
State are listed as "Running".

5. When ExSuspend.exe exits, one of the following values is returned:

Non-interactive

You can call ExSuspend.exe from a script as part of the regular backup process 
for an EmailXtender system. When using ExSuspend from a script, you should 
use the same sequence of commands that you use when you run the utility 
from the command line (suspend the EmailXtender services and then the 
Audit Utility service; after the backup is complete, resume the Audit Utility 
service and then the remaining EmailXtender services). For more information, 
see "Interactive" on page 175. In addition, however, you should set the 
-noshowtime option so that the elapsed time does not appear in the output. 

Managexvlt

You can use the Managexvlt utility to troubleshoot recording problems and to 
reconcile .xvlt pointer files with messages stored in the EmailXtender 
MsgCenter directory.

Table 9. ExSuspend.exe Return Values

Return Value Meaning

0 The operation was successful.

1 The operation failed.

2 The timeout value was exceeded before the requested 
operation could be completed.
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Managexvlt Options

You control the Managexvlt utility using command line options, as shown in 
the following example:

ManageXvlts -l -d 
"D:\Programs\OTG\EmailXtender\EmailVault_Index_Archive\Stora
geDir\200310\20031014214401\3E750C2A2F2516E97A19CD18.xvlt"D:
\ExMailStatus.exe -a user@example.com -top 20 -age 30

The following table summarizes the command line options for the Managexvlt 
utility.

Managexvlt Examples

The following are a series of sample Managexvlt command lines.

• To display the contents of 3E750C2A2F2516E97A19CD18.xvlt, enter the 
following:
ManageXvlts -l -d "D:\Program 
Files\OTG\EmailXtender\EmailVault_Index_Archive\StorageD
ir\200310\20031014214401\3E750C2A2F2516E97A19CD18.xvlt"

Table 10. Command Line Options for Managexvlt

Option Description

-d path The .xvlt file or the directory that contains the .xvlt files you 
want to process. An example of the directory is D:\Program 
Files\OTG\EmailXtender\EmailVault_Index_Archive\Storage
Dir\yyyymm.

If the file or directory name contains spaces, enclose the 
name in quotation marks (").

-l List all .xvlt contents(rather than listing only problems)

-v Verify the existence of the associated file in the MsgCenter 
directory.

-s Verify the message file size for each .xvlt file.

-adjsize Update the .xvlt file with the actual message file size.

-b Abbreviate filenames by not displaying the full path to the 
MsgCenter directory.
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• To verify the existence of the MsgCenter file associated with each .xvlt file 
in volume 20031014214401, enter the following:
ManageXvlts -v -d "D:\Program 
Files\OTG\EmailXtender\EmailVault_Index_Archive\StorageD
ir\200310\20031014214401"

• To verify the existence of the MsgCenter file associated with each .xvlt file 
and the file size for each entry in volume 20031014214401, enter the 
following:
ManageXvlts -v -s -d "D:\Program 
Files\OTG\EmailXtender\EmailVault_Index_Archive\StorageD
ir\200310\20031014214401"

UnpackContainer

The UnpackContainer utility extracts all messages from a container. Each 
message is extracted into a unique folder along with the associated access file 
and any attachments.

UnpackContainer Options

You control the UnpackContainer utility using command line options, as 
shown in the following example:

UnPackContainer -s D:\Containers\20030422101517.emx -d 
F:\UnpackDir

The following table summarizes the command line options for the 
UnpackContainer utility.

Table 11. Command Line Options for UnpackContainer

Option Description

-s container_path The complete path to the container file. 

-d destination_path The path to the folder where you want the messages 
unpacked. Within the folder you specify, one subfolder 
is created for each message that is unpacked. Each of the 
subfolders contains the message and any related files.

-c The utility should continue if an error is encountered. If 
you don’t use this option, the utility stops if it 
encounters an error.
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UnpackContainer Examples

The following are a series of sample UnpackContainer command lines.

• To extract files from the 20030422101517.emx container file and place 
them in the F:\UnpackDir directory, enter the following:
UnPackContainer -s D:\Containers\20030422101517.emx -d 
F:\UnpackDir

• To extract files that match the MD5 value 3E9AC23F907D26629C015F54 
from the 20030422101517.emx container file and place them in the 
F:\UnpackDir directory, enter the following:
UnPackContainer -s D:\Containers\20030422101517.emx -d   
F:\UnpackDir -md5 3E9AC23F907D26629C015F54

• To mark the message with the MD5 identifier 
3E9AC23F907D26629C015F54 as deleted without removing the message 
from the container file, enter the following:
UnPackContainer -s  D:\Containers\20030422101517.emx -dm 
3E9AC23F907D26629C015F54

• To mark the message with the MD5 identifier 
3E9AC23F907D26629C015F54 as not deleted without removing the 
message from the container file, enter the following (which reverses the 
effect of using the -dm option):

-u The utility should unpack individual messages.

-e The encryption key, which is required to access 
encrypted volumes.

-md5 The MD5 value for a message.

-dm Marks a message as deleted. The MD5 value for the 
message must be specified.

-rm Marks a message as restored. The MD5 value for the 
message must be specified. This option reverses the 
effect of the -dm option.

-blob Only BLOB messages should be extracted.

Table 11. Command Line Options for UnpackContainer

Option Description
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UnPackContainer -s  D:\Containers\20030422101517.emx -rm 
3E9AC23F907D26629C015F54

ReadMSMQ

The ReadMSMQ utility allows you to delete a message from a message queue, 
move a message from one queue to another, or copy the message from the 
queue to a file.

ReadMSMQ Options

You control the ReadMSMQ utility using command line options, as shown in 
the following example:

ReadMSMQ -s: queue1 -d: queue2 -rm

The following table summarizes the command line options for the 
ReadMSMQ utility.

Table 12. Command Line Options for ReadMSMQ

Option Description

-s: source_queue Queue from which messages are read.

-o: output_file File into which messages are written.

-i: source_file File from which messages are read before placing them in 
the output_queue queue. 

-d: output_queue Queue to which messages are sent.

-rm Removes all messages from the source queue.

-p: Number The number of messages processed. You can enter a value 
from 1 to 99999. If you do not enter a value, the utility 
uses the default value of 50. 

For every set number of messages processed, a period 
appears. For example, if 100 messages are processed and 
you enter 50 for this option, two periods appear.

-f: Number Removes the specified number of messages from the top 
of queue. If you do not enter a value, the utility uses the 
default value of 1.
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ReadMSMQ Example

To move all messages from the source queue, queue1, to a destination queue, 
queue2, enter the following:

ReadMSMQ -s: queue1 -d: queue2 -rm
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Chapter 7: Troubleshooting

This chapter contains information on resolving common problems you may 
encounter with the EmailXtender system. 

To minimize system difficulties, you should regularly perform the steps 
discussed in "Chapter 6: Maintenance" on page 137.

For more information on troubleshooting, see the following sections:

• "Troubleshooting Message Collection" on page 183
• "Troubleshooting Volumes" on page 185
• "Troubleshooting Shortcuts" on page 187
• "Troubleshooting Searches" on page 189
• "Troubleshooting the EmailXtender Server" on page 190
• "Miscellaneous Troubleshooting and Errors" on page 191
• "Getting Help" on page 191

Troubleshooting Message Collection
You may encounter the following problems with collecting messages in 
EmailXtender.

• Unprocessed messages (in \BadDir directories or the drop directory)

When EmailXtender encounters a problem with a message, it moves the 
message into one of the \BadDir directories. 
– If there is a problem processing a message, the message is placed in 

the \Program Files\OTG\EmailXtender\EmailVault\BadDir directory.
– If there is a problem archiving the message, the message is placed in 

the \Program Files\OTG\EmailXtender\EmailVault_Cabinet_Folder 
\BadDir directory.
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– If there is a problem unpacking the message for indexing or if there is 
a problem archiving the message through an EmailXtract task, the 
message is placed in the \Program Files\OTG\EmailXtender 
\MsgCenter\BadDir directory.

– If there is a problem indexing the message, the message is placed in 
the \Program Files\OTG\EmailXtender\EmailVault_Cabinet\BadDir 
directory.

Messages can also be left unprocessed in the EmailXtender EmailVault 
drop directory, \Program Files\OTG\EmailXtender\EmailVault\DropDir, 
when message queues become corrupt or when the queues are manually 
purged.
If you find unprocessed messages in one of the \BadDir directories or the 
drop directory, move the messages to the \MsgCenter\BadDir directory 
and then use the ExBadDirProcessor.exe utility to reprocess the messages. 
For more information, see "ExBadDirProcessor" on page 171.

Important: These messages may have already been entered into the Microsoft 
SQL Server database. Processing them again without using the 
ExBadDirProcessor.exe utility may result in the deletion of the message when it 
is considered a duplicate message.

• Blocked message queues/large numbers of messages in the message 
queues

When there are a large number of messages on the mail server and a large 
number of messages in the message queues, it is possible the system has a 
problem that is preventing messages from being processed. For more 
information on resolving these problems, see "Many Messages on the Mail 
Server and in the Message Queues" on page 144.
If any of the queues have a large number of messages in proportion to the 
other ex_10_incoming_queue_n queues, then you may have a queue that is 
blocked by a message that cannot be processed. 
To correct this problem, use the readmsmq.exe tool to locate, obtain a copy 
of, and remove the lead message in the queue. Once this message has been 
removed, the queue should begin processing and the saved message can 
be sent to LEGATO Technical Support for analysis. 
If you are using EmailXaminer, messages may accumulate in the 
ex30_rule_queue if there are problems that prevent messages from being 
sent to EmailXaminer.
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• EmailXtender is not archiving mail

There are a number of steps you can take to troubleshoot EmailXtender in 
the event that no mail is being archived.
1. Verify that there is at least one cabinet and one folder.
2. Verify that you did not disable mail collection on the General tab of 

the Folder Properties dialog box for each folder. For more 
information, see "Configuring a Folder" on page 85.

3. If you have configured rules, verify that none of the rules exclude all 
mail from collection.

4. Verify that there is a mailbox connector and that the mailbox 
connector is configured in the EmailXtender Administrator. For more 
information, see "The Email Connection Mailboxes Tab" on page 69.

5. Check whether there are a large number of messages on the mail 
server. When there is a high volume of messages on the mail server 
and all of the message queues are empty, there may be a problem at 
the mail server or at the EmailXtender server that is preventing 
EmailXtender from establishing a connection to the mail server. For 
more information, see "Many Messages on the Mail Server and Few 
or None in the Message Queues" on page 145.

6. Verify that the policy engine (ExAddrRule.exe) has initialized. 
EmailXtender cannot pull messages from the mail server until the 
policy engine has initialized. For more information, see "Check that 
the Policy Engine (ExAddrRule.exe) Initialized" on page 147.
If the policy engine has not initialized, verify that the EmailXtender.dlc 
file exists. This file must exist for the policy engine to initialize. If this 
file does not exist, the Address Rule service creates it. However, 
depending on how many distribution lists you have in the mail 
system, it may take a long time -- possibly several hours for a large 
number of distribution lists.

Note: EmailXtender cannot create the EmailXtender.dlc file unless 
there is at least one mailbox connector for each mail server for which 
you installed EmailXtender support.

Troubleshooting Volumes
You may encounter the following problems with volumes when maintaining 
EmailXtender.
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• Corrupt volume indexes

When EmailXtender detects a corrupted index, a message is written to the 
Event Log and the EmailXtender Administrator identifies the corrupt 
index using a red exclamation point (!), as shown in Figure 63 on page 186.

Figure 63. Corrupt Index Identifier

You may also discover that an index is corrupt when you attempt to search 
the index and EmailXtender notifies you that it is corrupt. 
When an index is corrupt, you should re-index the volume to which the 
index belongs. You can re-index only the corrupt index, or all the data for 
a particular month. For more information, see "Re-indexing Data" on 
page 125.

Note: Re-indexing data can be time-consuming and should only be done 
when necessary.

If you re-index the data and it does not result in a valid index, there is 
probably a problem with one of the messages in the index. Check the event 
log for an EmailXtender error message about the corrupt index. (To open 
the EmailXtender Event Information dialog box, choose Events from the 
View menu in the Administrator, or click the Events toolbar icon.) 
If you cannot correct the problem, remove the problematic messages from 
the archive and then index the archive again to create a valid index.

• Lost and Found volumes

To view all Lost and Found volumes, set the Message Center List view of 
the Administrator to Volume mode. (Open the View menu and then select 
Message Center>View by Volume, or click the arrow on the Message 
Center View toolbar icon and select View by Volume.) Then, in the Tree 
view, select the Server node.
Lost and Found volumes are generated when you dispose of monthly data 
for a set of volumes (you can no longer access the messages in the volumes, 
but they are not physically deleted), when you create volumes on one 
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EmailXtender server and then copy them to another EmailXtender server, 
and sometimes when you update EmailXtender from an earlier release to 
the current release.
To add Lost and Found volumes back into the EmailXtender system so 
you can search for and view messages in the volumes, you must restore 
the volumes. For instructions, see "Restoring a Volume" on page 120.

• Too many open volumes

A large number of open volumes may indicate that the Archive service 
(ExArchive.exe) is having problems closing volumes. This may indicate 
that something is wrong with the storage drive (which is the extended 
drive, if you are using DiskXtender), or that the drive may be full. For 
more information, see "Check for Large Numbers of Open Volumes" on 
page 147. 

Troubleshooting Shortcuts
If you are using EmailXtract to create shortcuts of messages on the mail server, 
you may encounter the following problems:

• Shortcuts are not created when you run the Shortcut task

You should re-run the Shortcut task through EmailXtract and set the 
logging level on the Logging tab to Message Detail. The log file should 
give an indication of whether the messages are being shortcut and what 
actions EmailXtract is taking.

• Client computers are having trouble downloading the Public 
Organizational Forms necessary to resolve shortcuts

You should verify that that the Public Organizational Forms Library 
exists, that you configured the correct permissions for it, that replication 
of the Public Organizational Forms Library to additional Microsoft 
Exchange servers occurred properly, and that there are no communication 
issues between the EmailXtender server, the Microsoft Exchange server, 
and the client computer. You should also verify that the form is visible 
from client computers. For more information on configuring permissions 
and replication, refer to the Installing EmailXtender chapter of the 
EmailXtender Installation Guide. 

• The body of a message still appears in the Preview Pane, even though 
the message has been shortcut

You should verify that the Public Organizational Forms Library and the 
EmailXtender shortcut forms are visible from the client computer. In 
addition, you should verify that the client computer has correct 
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permissions for the Public Organizational Forms Library and that the 
EmailXtender shortcut forms have been correctly downloaded from the 
Microsoft Exchange server.

• You can see the shortcut icon through Microsoft Outlook, but you 
cannot open the shortcut message

Check the EmailXtender server for errors. In some cases, this problem may 
be caused by permissions issues between the EmailXtender server, the 
Microsoft Exchange server, and the client computer. You should open 
Microsoft Internet Information Services (IIS) on the EmailXtender server 
and check the EXShortcut folder to verify that the Exchange server and the 
client computer can access the folder. You should also open the 
EmailXtender custom contact in the Exchange Address Book to verify that 
the EmailXtender server appears under the contact’s custom properties.
If you have shortcut messages on multiple Exchange servers in different 
domains, open the Address Book in Outlook and verify that you can view 
the EmailXtender custom contact. If you have mailboxes in different 
domains and you can view the custom contact but you are still having 
trouble opening a shortcut message, verify that you can open the 
mailboxes from the EmailXtender server.

• You are having difficulty seeing the shortcut icon for shortcuts you are 
viewing through Microsoft Outlook Web Access (OWA)

You must install EmailXtender OWA shortcut support and then upgrade 
each shortcut by re-running the Shortcut task with the OWA Enabled 
option selected. For instructions on installing OWA shortcut support, refer 
to the Installing EmailXtender chapter of the EmailXtender Installation Guide. 
For instructions on the OWA Enabled option on the Shortcut tab of the 
Shortcut task, see "Shortcut" on page 341.
If you have already installed OWA shortcut support and you still cannot 
see the shortcut icon through OWA, you may be having issues with 
shortcut creation. You should re-run the Shortcut task through 
EmailXtract and set the logging level on the Logging tab to Message 
Detail. The log file should give an indication of whether the messages are 
being shortcut and what actions EmailXtract is taking.

• Miscellaneous OWA difficulties

Review the previous shortcut troubleshooting recommendations, since 
most of the same principles and techniques (insufficient permissions, 
event logs, etc.) apply. You should also check the installation log that was 
generated when you installed OWA shortcut support; most OWA shortcut 
issues result from errors during the install.
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Troubleshooting Searches
You may encounter the following problems when performing searches in 
EmailXtender.

• Difficulty searching for messages, opening messages, or using the 
Copy to Folder option (to export messages)

If you are having difficulty finding, opening, or exporting messages using 
either the EmailXtender Search Plug-in or the Web Search Client, verify 
that the ExQuery.exe and the ExArchive.exe services are running. To open 
the EmailXtender Services Information dialog box, choose Service Info 
from the View menu in the Administrator, or click the Service Info toolbar 
icon.
If the ExQuery.exe and the ExArchive.exe services are running, review the 
event log for any EmailXtender errors associated with those services. To 
open the EmailXtender Event Information dialog box, choose Events from 
the View menu in the Administrator, or click the Events toolbar icon.

• Supervisors are not finding expected messages sent to the users in their 
supervisor group

If supervisors (designated in a supervisor group) are searching for 
messages belonging to the users in their group but are unable to find them, 
EmailXtender may have received the message after the group was created. 
To allow supervisors access to messages received before you created the 
supervisor group, you need to re-index volumes containing the messages. 
For more information, see "Re-indexing Data" on page 125.

Note: Re-indexing data can be time-consuming and should only be done 
when necessary.

Note: If you are using EmailXtender Archive Edition, supervisor searches 
are not available. You must upgrade to a full EmailXtender license to 
access this feature.

• Searches for distribution groups are not returning hits for the 
individual members of the group, or vice versa

If the EmailXtender.dlc file is not up-to-date, then EmailXtender may not 
accurately associate users with the distribution lists to which they belong. 
The .xrc files are the EmailXtender Rules Cache files. If these files are not 
up-to-date, then collection and exclusion rules are applied but do not 
reflect any changes made to distribution group membership for users 
indicated in specific address rules. For more information, see "Check Dates 
on the .dlc and .xrc Files" on page 152.
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Troubleshooting the EmailXtender Server
If you find that you are starting to run out of disk space on the EmailXtender 
server, there are a number of steps you can take to resolve the problem. 

1. Verify that EmailXtender is successfully archiving messages and that the 
messages are not being blocked in the message queues. For more 
information, see "Check the Message Queues" on page 141.

2. Check for any unprocessed messages in the various \BadDir directories. 
For more information, see "Check for Unprocessed Messages in BadDir 
Directories" on page 151. If you find unprocessed messages, move the 
messages to the \MsgCenter\BadDir directory and then use the 
ExBadDirProcessor.exe utility to reprocess the messages. For more 
information, see "ExBadDirProcessor" on page 171.

3. Verify that there are not a large number of files generated by either the 
unpacker or by open volumes in the Message Center directory, Program 
Files\OTG\EmailXtender\MsgCenter\. For more information, see "Check 
for Excess Files in the Message Center Directory" on page 150.

4. Consider backing up indexes for past months and removing them from 
the local hard drive. (Then, if a search needs access to these removed 
indexes, you can copy them back to the local drive.) Or, you can remove 
the indexes without backing them up and then re-index later, if necessary. 
For more information on removing indexes and then reindexing data, see 
"Removing Monthly Indexes" on page 126 and "Re-indexing Data" on 
page 125.

5. Consider saving room in the database and index directories by disposing 
of the data in those directories for a specific month. For more information, 
see "Disposing of Monthly Data" on page 127.

Note: Disposing of monthly data does not remove the actual message 
volumes, however. They are placed in Lost and Found storage, and can be 
restored if necessary. For more information on restoring Lost and Found 
volumes, see "Restoring a Volume" on page 120.

6. If you are writing .emx files to the local drive, consider changing the 
location to a drive with more space, or expand archive space by writing the 
.emx files out to other media, such as media supported through 
DiskXtender. DiskXtender supports a variety of media types, including 
EMC Centera devices, DVD-R, tape, and magneto-optical. For more 
information on using EmailXtender with DiskXtender, see "Using 
DiskXtender" on page 130.
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Miscellaneous Troubleshooting and Errors
You may encounter the following miscellaneous problems and error messages 
while working with EmailXtender:

• Error Message: Connecting to the EX Admin Service

If an error message about connecting to the EX Admin service appears 
while you are starting the EmailXtender Administrator interface, another 
person on another computer may be configuring the EmailXtender server 
to which you are trying to connect.

• Temporary Profile Error

If the EmailXtender Exchange Manager service issues a Temporary Profile 
Error Message, it means that the EmailXtender server cannot access the 
mail server to collect mail. 
Be sure that you have created at least one mailbox connector. For more 
information, see "The Email Connection Mailboxes Tab" on page 69.

• Configuration changes are not appearing in the Administrator

If you are using the Administrator interface to make changes to the 
Message Center architecture, rules, or other features in , and the changes 
do not appear, be sure that you have activated the changes (from the 
Options menu, choose Activate Changes).

Getting Help
The LEGATO web site provides contact information, software patches, 
technical documentation, and information about available technical support 
programs.

• Customers with an active support agreement have access to the LEGATO 
integrated product knowledge base. Help with software issues is also 
available through Technical Support.

• Customers without an active support agreement can contact Support Sales 
and Renewal to purchase annual software update subscriptions, or 
technical support services for per-update/per-incident assistance.

Note: LEGATO Software technical support and update subscription services 
apply only to (i) LEGATO price-listed software that LEGATO supplies to its 
customers; and (ii) customers that have entered into an authorized LEGATO 
technical support agreement.
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Chapter 8: Controlling Searches

When you install EmailXtender on the EmailXtender server, the software 
publishes a website (located at http://localhost/EmailXtender, where localhost is 
the IP address or server name of the EmailXtender server). Administrators, 
supervisors, and users can access this website to search the EmailXtender 
archive at any time. 

In addition, you can install the EmailXtender Search Plug-in on any computer 
with a Microsoft Outlook or Lotus Notes client installed. The Search Plug-in 
offers EmailXtender search functionality from within these programs.

EmailXtender automatically allows all users to search their own email for 
messages from a particular sender or to a particular recipient, as well as for 
messages that contain certain keywords in the Subject field, message body, or 
attachments. You do not need to perform additional configuration to allow 
user searches.

If you want to authorize certain users to search and view messages of other 
selected users, you can define supervisor groups. Typically, this is used to 
allow managers to review the messages of their subordinates. 

You may also want to allow certain users to search for and view all messages 
in the EmailXtender mail archive. This type of search is called an administrator 
search. Administrators can also delete messages they retrieve through a 
search. 

If you have configured the EmailXtender Message Center so that certain types 
of messages are filtered into specific cabinets or folders, you may want to allow 
a few select users to search for and view all messages in a particular cabinet or 
folder. This type of search is called a directed search, and used in combination 
with supervisor and administrator searches, it allows you to be very exact 
about who has permission to view certain messages.
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Note: If you are using EmailXtender Archive Edition, you can only install the 
Search Plug-in on the EmailXtender server or use the Web Search Client for an 
administrator search. User searches, supervisor searches, and directed 
searches are prohibited. In addition, EmailXaminer and EmailXtender Audit 
functionality is not available. You must upgrade to a full EmailXtender license 
to have access to these features.

For more information on controlling searches, see the following sections:

• "Supervisor Groups" on page 194
• "Administrator Searches" on page 201
• "Directed Searches" on page 202

For more information on performing searches, refer to the EmailXtender Search 
User’s Guide.

Supervisor Groups
You can define supervisor groups to authorize certain users to search and view 
messages of other selected users. Typically, this is used to allow managers to 
review the messages of their subordinates. 

When users want to perform a supervisor search, they simply select the name 
of their supervisor group from the Search Type drop-down list in the Search 
window of either the Web Search Client or the Search Plug-in. For more 
information on performing searches, refer to the EmailXtender Search User’s 
Guide.

You can then audit all supervisor searches and views using EmailXtender 
Audit. For more information on EmailXtender Audit, see "EmailXtender 
Audit" on page 205.

Note: Audit cannot produce reports that include searches performed before 
you install EmailXtender Audit. If you intend to audit supervisor searches, 
you should install EmailXtender Audit as soon as you configure supervisor 
groups.

Note: If you are using EmailXtender Archive Edition, supervisor searches are 
not allowed. You must upgrade to a full EmailXtender license to access this 
feature.

For more information about working with supervisor groups, see the 
following sections:

• "Creating a Supervisor Group" on page 195
• "Editing a Supervisor Group" on page 198
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• "Deleting a Supervisor Group" on page 201

Creating a Supervisor Group

When you create a supervisor group, you specify one or more supervisors and 
the users whose mail the supervisors can search for and view. 

The supervisors can then monitor messages that EmailXtender receives from 
and for the users after you create the supervisor group; messages that 
EmailXtender received before you created the group are not available for 
supervisor review unless you re-index the volumes containing the messages. 
For more information on re-indexing volumes, which can be time-consuming 
if the volumes are large, see "Re-indexing Data" on page 125. For this reason, 
you should ideally evaluate whether you want to configure supervisor groups 
before you begin journaling messages.

Note: If you are using both Microsoft Exchange and Lotus Domino, you must 
create separate supervisor groups for each environment, even if the email 
addresses you are adding to the group appear in both environments.

To create a supervisor group:

1. From the View menu in the Administrator, select Account Info, or click the 
Account Info toolbar icon. 

Figure 64. Account Info Toolbar Icon

The EmailXtender Account Information dialog box appears. 
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Figure 65. EmailXtender Account Information Dialog Box

2. In the Supervisor Groups region, click Add. The Edit Group dialog box 
appears.

Figure 66. Edit Group Dialog Box

3. In the Group Name text box, enter a unique name for the supervisor 
group.

4. Choose the supervisors (users authorized to search and view the 
mailboxes of the users listed in the Users list box) for the group.

a. Click the Add button next to the Supervisors list box.
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If you are using EmailXtender with in an Exchange environment, the 
Exchange Address Book appears. 
If you are using EmailXtender in a Lotus Domino environment, the 
Notes Address Book appears.

b. Select the address book containing the user you want to add as a 
supervisor. 

c. Double-click the name of the user you want to add as a supervisor. 
You can select a distribution list or a specific user.
The selected user name appears in the right list box. 

d. Click OK to save the changes and return to the Edit Group dialog 
box.

5. Choose the user mailboxes over which the selected supervisors have 
authority. 

a. Click the Add button next to the Users list box.
If you are using EmailXtender in an Exchange environment, the 
Exchange Address Book appears. 
If you are using EmailXtender in a Lotus Domino environment, the 
Notes Address Book appears.

b. Select the address book containing the user you want to add. 
c. Double-click the name of the user you want to add. You can select a 

distribution list or a specific user.

Note: If you select a distribution list, all messages sent to the 
distribution list are available for search, as well as messages sent to the 
individual members of the distribution list. The reverse is also true. If 
a user is a member of a distribution list, searching for messages to a 
user also returns messages sent to that user as part of the distribution 
list.

The selected user name appears in the right list box. 
d. Click OK to save the changes and return to the Edit Group dialog 

box.

6. Click OK to save the changes and return to the Account Information 
dialog box.

7. Click OK again to close the EmailXtender Account Information dialog box.

8. Activate the changes (Options > Activate Changes).
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Using either the Web Search or the Search Plug-in, the users you assigned as 
supervisors can begin monitoring the messages sent to and from the users you 
assigned to the group. For more information on searching for messages, refer 
to the EmailXtender Search User’s Guide.

Important: If you want the supervisors to be able to search messages sent to or 
from the users before you created the supervisor group, you must re-index the 
volumes on which the messages are stored. For more information, see 
"Re-indexing Data" on page 125.

Editing a Supervisor Group

If necessary, you can change the membership of a group to reflect corporation 
management and personnel changes. You can add and remove supervisors 
and users, as well as view the address book properties for a supervisor or user.

If you change the membership of the supervisors group, the new supervisors 
can monitor messages that EmailXtender receives from and for the users after 
you made the change; messages that EmailXtender received before you 
changed the group are not available for supervisor review unless you re-index 
the volumes containing the messages. Similarly, if you change the 
membership of the users group, the supervisors can monitor messages that 
EmailXtender receives from and for the new users after you change the user 
group. For more information on re-indexing volumes, which can be 
time-consuming if the volumes are large, see "Re-indexing Data" on page 125. 

To edit a supervisor group:

1. From the View menu in the Administrator, select Account Info, or click the 
Account Info toolbar icon. 

Figure 67. Account Info Toolbar Icon

The EmailXtender Account Information dialog box appears. 
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Figure 68. EmailXtender Account Information Dialog Box

2. From the Supervisor Groups list, select the group that you want to change 
and click Edit. The Edit Group dialog box appears.

Figure 69. Edit Group Dialog Box

3. Adjust the membership of the supervisors group as necessary. You have 
the following choices:

• To add a supervisor, click the Add button to the right of the 
Supervisors list box. The Address Book appears. Select the user or 
distribution list you want to add as a supervisor and then click Add. 
Click OK to return to the Edit Group dialog box.
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• To remove a supervisor, select the supervisor you want to remove 
from the Supervisors list and then click the Remove button to the 
right of the Supervisors list.

• To view the properties of a supervisor account, select the supervisor 
from the Supervisors list and then click the Properties button to the 
right of the Supervisors list. When you finish, click OK to return to 
the Edit Group dialog box. 

4. Adjust the membership of the users as necessary. You have the following 
choices:

• To add a user, click the Add button to the right of the Users list box. 
The Address Book appears. Select the user or distribution list you 
want to add and then click Add. Click OK to return to the Edit Group 
dialog box.

Note: If you select a distribution list, all messages sent to the 
distribution list are available for search, as well as messages sent to the 
individual members of the distribution list. The reverse is also true. If 
a user is a member of a distribution list, searching for messages to a 
user also returns messages sent to that user as part of the distribution 
list.

• To remove a user, select the user you want to remove from the Users 
list and then click the Remove button to the right of the Users list.

• To view the properties of a user account, select the user from the 
Users list and then click the Properties button to the right of the Isers 
list. When you finish, click OK to return to the Edit Group dialog box. 

5. Click OK to return to the EmailXtender Account Information dialog box.

6. Click OK again to close the EmailXtender Account Information dialog box.

7. Activate the changes (Options > Activate Changes).

Using either the Web Search or the Search Plug-in, the users you assigned as 
supervisors can begin monitoring the messages sent to and from the users you 
assigned to the group. For more information on searching for messages, refer 
to the EmailXtender Search User’s Guide.

Important: If you want the supervisors to be able to search messages sent to or 
from the users before you changed the group, you must re-index the volumes 
on which the messages are stored. For more information, see "Re-indexing 
Data" on page 125.
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Deleting a Supervisor Group

If you no longer need a supervisor group, you can remove it.

To delete a supervisor group:

1. From the View menu in the Administrator, select Account Info, or click the 
Account Info toolbar icon. 

Figure 70. Account Info Toolbar Icon

The EmailXtender Account Information dialog box appears. 

Figure 71. EmailXtender Account Information Dialog Box

2. From the Supervisor Groups list, select the group you want to delete and 
then click Remove. 

3. Click OK.

4. Activate the changes (Options > Activate Changes).

Administrator Searches
If you want to allow certain users to search for and view all messages in the 
EmailXtender mail archive, you can add them to the EmailXtender 
administrators group so that they can perform administrator searches. 
Administrators can also delete messages they retrieve through a search. 
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When users want to perform an administrator search, they simply select 
Admin from the Search Type drop-down list in the Search window of either 
the Web Search Client or the Search Plug-in. For more information on 
performing searches, refer to the EmailXtender Search User’s Guide.

Administrator searches can be useful in reducing the cost of discovering email 
during litigation, audit, investigation, or any other discovery activity.

Permissions for administrator searches are based on Windows authentication. 
To allow users to perform administrator searches, you must add them to the 
exAdmin group on the EmailXtender server.

To give a user permission to perform an administrator search:

1. From the Start menu on the EmailXtender server, select 
Programs>Administrative Tools>Computer Management. The groups for 
the local computer are listed in the Groups list. 

2. Double-click the exAdmin group, or select the exAdmin group in the list 
and choose Properties from the User menu. The Local Group Properties 
dialog box appears. 

3. Click Add. The Add Users and Groups dialog box appears. 

4. Select the appropriate domain from the drop-down list of domains.

5. From the Names list, select the user name of the user to whom you want 
to give permission to perform an administrator search. 

6. Click Add. The user is added to the list at the bottom of the window. 

7. When all users you want to add to the group are listed, click OK.

Directed Searches
If you have configured the EmailXtender Message Center so that certain types 
of messages are filtered into specific cabinets or folders, you may want to allow 
a few select administrators to use the Web Search or Search Plug-in to search 
for messages in a particular cabinet or folder. This type of search is called a 
directed search, and used in combination with supervisor and administrator 
searches, it allows you to be very exact about who has permission to view 
certain messages.

When users want to perform a directed search, they simply select the name of 
the cabinet or folder from the Search Type drop-down list in the Search 
window of either the Web Search Client or the Search Plug-in. For more 
information on performing searches, refer to the EmailXtender Search User’s 
Guide.
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You can audit all directed searches using EmailXtender Audit. For more 
information on EmailXtender Audit, see "EmailXtender Audit" on page 205.

Note: Audit cannot produce reports that include searches performed before 
you install EmailXtender Audit. If you intend to audit directed searches, you 
should install EmailXtender Audit as soon as you configure directed searches.

Note: If you are using EmailXtender Archive Edition, directed searches are not 
allowed. You must upgrade to a full EmailXtender license to access this 
feature.

To set up directed searches:

1. In the Tree view of the Administrator, right-click the cabinet or folder for 
which you want to set directed search permissions and then select 
Properties from the shortcut menu. The Properties dialog box for the 
selected cabinet or folder appears.

2. Select the Directed Search Access Rights tab.

Figure 72. Cabinet Properties Dialog Box - Directed Search Access 
Rights Tab
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3. Add the users whom you want to be able to search the selected cabinet or 
folder.

a. Right-click in the Folder Administrators list box and select Add from 
the shortcut menu. The Address Book appears.

b. Double-click the name of the user to whom you want to give directed 
search permissions. The user name appears in the right list box. 

c. Click OK. The new user is listed in the Folder Administrators box of 
the Directed Search Access Rights tab. 

4. Remove the users whom you want to prevent from searching the selected 
cabinet or folder. In the Folder Administrators list box, right-click the user 
you want to remove and then select Remove from the shortcut menu.

5. Click OK.

6. Activate the changes (Options > Activate Changes).
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EmailXtender Audit allows you to discourage unauthorized viewing and 
deletion of messages by tracking when administrators view and access 
messages sent to other users, and by tracking when messages and volumes 
have been deleted from the EmailXtender message store.

When you install EmailXtender Audit, information about each supervisor 
search, administrator search, or directed search is logged to the private 
message queue. (For more information on installing EmailXtender Audit, refer 
to the EmailXtender Installation Guide.) After a delay of approximately one 
minute, message information is transferred into the Microsoft SQL Server 
database created by EmailXtender Audit.

You can then generate a report to view the information in the database. There 
are five report templates included with EmailXtender Audit, but you can also 
create custom report templates through Crystal Reports to produce reports 
with additional information. The standard reports allow you to view 
information on deleted messages, deleted volumes, all users who viewed a 
certain message, all messages a certain user viewed, and all users who viewed 
the messages of a certain user.
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Figure 73. Auditing Process

Note: EmailXtender Audit can only produce reports for searches and deletions 
that were performed after its installation. As a result, Audit cannot work 
retroactively to produce a complete report if searches and deletions took place 
before you installed Audit.
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Once you generate a report, you can print the report or export it to a hard disk, 
an application, a Microsoft Exchange folder, or a Lotus Domino database. You 
can also send the report in an email to a specific address as an attachment.

If you want to generate and view audit reports from a remote computer, you 
can install the EmailXtender Audit Utility on the remote computer. For more 
information on installing the Audit Utility, refer to the EmailXtender Installation 
Guide.

Note: If you are using EmailXtender Archive Edition, the EmailXtender Audit 
Utility is not available. You must upgrade to a full EmailXtender license to 
access this feature.

For more information, see the following sections:

• "Standard Reports" on page 207
• "Custom Reports" on page 219
• "Viewing, Printing, and Exporting Reports" on page 220

Standard Reports
There are five report templates included with EmailXtender Audit:

• The Deleted Messages report allows you to view a list of messages that 
have been deleted from the EmailXtender archive by an administrator. 
For more information on running this report, see "Deleted Messages 
Report" on page 208.

• The Deleted Volumes report allows you to view a list of volumes that 
have been deleted from the EmailXtender by an administrator. For more 
information on running this report, see "Deleted Volumes Report" on 
page 210.

• The Users Accessing a Message report allows you to view a list of 
supervisors or administrators who have searched for or viewed a 
particular message. For more information on running this report, see 
"Users Accessing a Message Report" on page 212.

• The Messages Accessed by a User report allows you to view a list of 
messages that were either viewed or returned as search hits for a specific 
supervisor or administrator. For more information on running this report, 
see "Messages Accessed by a User Report" on page 214.

• The User Accessed by Other Users report allows you to view a list of 
supervisors or administrators who have searched for or viewed messages 
to or from a specific user. For more information on running this report, 
see "User Accessed by Other Users Report" on page 216.
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Deleted Messages Report

You can run a Deleted Messages audit report to view a list of messages that 
have been deleted from the EmailXtender archive by a supervisor or 
administrator. 

The report includes the following information:

• The date the message was deleted
• The administrator or supervisor who deleted the message
• Limited message header information (From, Received, and Subject)
• The name of the volume to which the message belonged

To create a Deleted Messages report:

1. Launch EmailXtender Audit. From the Windows Start menu, select 
Programs>LEGATO EmailXtender>Audit Reports. The Audit 
Administrator appears.

Figure 74. Audit Administrator Window

2. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.
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Figure 75. Select Report Dialog Box

3. Select Deleted Messages Report and click OK. The Report Options dialog 
box appears.

Figure 76. Report Options Dialog Box for a Deleted Messages Report

4. Enter search criteria for the report. You have the following choices:

• To search for deleted messages that were sent by a specific user, click 
Mail Sent By. The Outlook or Notes Address Book appears. Choose a 
name from the list and click OK.

• To search for messages deleted by a specific administrator, click 
Administrator. The Outlook or Notes Address Book appears. Choose 
a name from the list and click OK.

• To search for messages deleted within a specific timespan, select 
None, After, Before, or Between from the Audited Date drop-down 
list, and then select dates from the corresponding date drop-down 
lists as needed.

• To search for all messages deleted by all administrators during any 
time period, leave all boxes empty.

5. Click Create Report. The report appears in the Report View window.
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You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

Deleted Volumes Report

You can run a Deleted Volumes audit report to view a list of volumes that have 
been deleted from EmailXtender by an administrator. 

The report includes the following information:

• The date each volume was deleted
• The administrator who deleted the volume
• The volume start and end dates
• The recordset number
• The number of messages included in the volume
• The volume’s folder path

To create a Deleted Volumes report:

1. Launch EmailXtender Audit. From the Windows Start menu, select 
Programs>LEGATO EmailXtender>Audit Reports. The Audit 
Administrator appears.

Figure 77. Audit Administrator Window

2. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.
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Figure 78. Select Report Dialog Box

3. Select Deleted Volumes Report and click OK. The Report Options dialog 
box appears.

Figure 79. Report Options Dialog Box for a Deleted Volumes Report

4. Enter search criteria for the report. You have the following choices:

• To search for volumes deleted by a specific administrator, click 
Administrator. The Outlook or Notes Address Book appears. Choose 
a name from the list and click OK.

• To search for volumes deleted within a specific timespan, select 
None, After, Before, or Between from the Audited Date drop-down 
list, and then select dates from the corresponding date drop-down 
lists as needed.

• To search for a specific volume, enter the name of the volume in the 
Volume Name text box.

• To search for all volumes deleted by all administrators during any 
time period, leave all boxes empty.

5. Click Create Report. The report appears in the Report View window.
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You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

Users Accessing a Message Report

You can run a Users Accessing a Message audit report to view a list of 
supervisors or administrators who have searched for or viewed a specific 
message. To run the report, you must use the EmailXtender Search Plug-in to 
determine the ID number for the message.

The report includes the following information:

• The name of the person who originally sent the message
• The date the message was received at the mail server
• The subject line of the message
• The supervisors or administrators who have searched for or viewed the 

message
• The query used to search for the message

If the supervisor or administrator opened the message to view it (as opposed 
to simply receiving the message in a list of search results), a view icon appears 
next to the listing in the report.

Figure 80. View Icon

To create a Users Accessing a Message report:

1. Using the EmailXtender Search Plug-in, determine the message ID for the 
message on which you want to report. 

a. Perform a search for the message.
b. In the EmailXtender Search window, which contains the results, open 

the View menu and select Show Message IDs. 
c. Copy down the message ID for the message on which you want to 

report. 
For more information on using the Search Plug-in, refer to the 
EmailXtender Search User’s Guide.

2. Launch EmailXtender Audit. From the Windows Start menu, select 
Programs>LEGATO EmailXtender>Audit Reports. The Audit 
Administrator appears.
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Figure 81. Audit Administrator Window

3. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.

Figure 82. Select Report Dialog Box

4. Select Users Accessing a Message and click OK. The Report Options dialog 
box appears.

Figure 83. Report Options Dialog Box for a Users Accessing a Message 
Report

5. Enter the message ID, or, to generate a report of users accessing all 
messages, leave the text box blank.

6. Click Create Report. The report appears in the Report View window.
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Figure 84. Sample Users Accessing a Message Report

You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

Messages Accessed by a User Report

You can run a Messages Accessed by a User report to view a list of messages 
that were either viewed by or returned as search hits for a specific supervisor 
or administrator. This type of report can be especially helpful in monitoring 
the actions of specific administrators, to ensure that all searching and viewing 
is job-related.

The report includes the following information:

• The name of the person who originally sent the message
• The ID number for the message
• The date the message was received at the mail server
• The administrators who have searched for or viewed the message
• The date on which they searched for or viewed the message 
• The query used to search for the message

If the supervisor or administrator opened the message to view it (as opposed 
to simply receiving the message in a list of search results), a view icon appears 
next to the listing in the report.
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Figure 85. View Icon

To create a Messages Accessed by a User report:

1. Launch EmailXtender Audit. From the Windows Start menu, select 
Programs>LEGATO EmailXtender>Audit Reports. The Audit 
Administrator appears.

Figure 86. Audit Administrator Window

2. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.

Figure 87. Select Report Dialog Box

3. Select Messages Accessed By a User and click OK. The Report Options 
dialog box appears.
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Figure 88. Report Options Dialog Box for a Messages Accessed by a User 
Report

4. Click Address to specify the administrator or supervisor whose searches 
you want to audit. The Outlook or Notes Address Book appears. 

5. Choose a name from the list and click OK.

6. To monitor the administrator or supervisors searches within a specific 
timespan, select None, After, Before, or Between from the Audited Date 
drop-down list, and then select dates from the corresponding date 
drop-down lists as needed.

7. From the Event Type drop-down list, choose whether to view a list of only 
messages that have been returned as search results for the specified 
person, or both messages that have been returned as search results and 
messages that the person opened and viewed.

8. Click Create Report. The report appears in the Report View window.

You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

User Accessed by Other Users Report

You can run a User Accessed by Other Users report to view a list of 
administrators or supervisors who performed searches to retrieve messages 
for a certain user.

The report includes a separate section for each message the supervisor or 
administrator accessed. For each message, the following information appears:

• The ID number for the message
• The date the message was received at the mail server
• The subject line for the message
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• The names of the supervisors or administrators who have searched for or 
viewed the message

• The date on which they searched for or viewed the message
• The query used to search for the message

If the supervisor or administrator opened the message to view it (as opposed 
to simply receiving the message in a list of search results), a view icon appears 
next to the listing in the report.

Figure 89. View Icon

To create a User Accessed by Other Users report:

1. Launch EmailXtender Audit. From the Windows Start menu, select 
Programs>LEGATO EmailXtender>Audit Reports. The Audit 
Administrator appears.

Figure 90. Audit Administrator Window

2. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.
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Figure 91. Select Report Dialog Box

3. Select User Accessed by Other Users and click OK. The Report Options 
dialog box appears.

Figure 92. Report Options Dialog Box for a User Accessed by Other 
Users Report

4. Click User to specify the user whose messages the supervisors or 
administrators are accessing. The Outlook or Notes Address Book 
appears. 

5. Choose a name from the list and click OK.

6. Click Administrator to specify the supervisors or administrators whose 
searches you want to audit. The Outlook or Notes Address Book appears. 

7. Choose a name from the list and click OK.

8. To monitor the administrator or supervisors searches within a specific 
timespan, select None, After, Before, or Between from the Audited Date 
drop-down list, and then select dates from the corresponding date 
drop-down lists as needed.
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9. From the Event Type drop-down list, choose whether to view a list of only 
messages that have been returned as search results for the specified 
person, or both messages that have been returned as search results and 
messages that the person opened and viewed.

10. Click Create Report. The report appears in the Report View window.

You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

Custom Reports
You can use Crystal Reports to design additional EmailXtender audit reports 
using the data in the EmailXtender Audit SQL Server database. You can then 
run the reports from within EmailXtender Audit and display the information 
in the Report View window.

To run custom reports from EmailXtender Audit:

1. Install Crystal Reports and use it to create a report template to retrieve the 
information you need from the EmailXtender Audit database. For 
instructions on installing and using Crystal Reports, refer to the Crystal 
Reports documentation. 

2. If it is not open already, launch EmailXtender Audit. From the Windows 
Start menu, select Programs>LEGATO EmailXtender>Audit Reports.

3. From the File menu, select Open, or click the Open toolbar icon. The Select 
Report dialog box appears.

Figure 93. Select Report Dialog Box
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4. Click Browse, and then browse to the location to which you saved the 
Crystal Reports template.

5. Click OK in the Select Report dialog box to run the report. The report 
appears in the Report View window.

You can modify the way the report appears in the window, print the 
report, or export it to a number of formats and destinations. For more 
information, see "Viewing, Printing, and Exporting Reports" on page 220.

Viewing, Printing, and Exporting Reports
After you have generated a report, the report appears in the Report View 
window. In addition to merely previewing the report, you have access to the 
following functionality using the Report View toolbar.

Table 13. Audit Report View Options

Task Icon Instructions

Close the Report 
View window

Click the Close Current View toolbar 
icon.

Print the report 1. From the File menu, select Print, or 
click the Print toolbar icon. The 
Print dialog box appears, with the 
default printer chosen.

2. In the Print dialog box, select which 
pages to print and how many 
copies to produce.

3. Select OK.

Export the report Click the Export Report toolbar icon. 
For detailed instructions, see 
"Exporting an Audit Report" on 
page 221.

Refresh the 
report data

Click the Refresh toolbar icon to refresh 
the report with any new data that has 
changed since you initially generated 
the report.
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Exporting an Audit Report

You can export audit reports in a variety of file formats and to a variety of 
locations. For example, you can export a report to Microsoft Word format and 
view it in Word immediately, or you can export the report as a Portable 
Document Format (PDF) file and send it as an email attachment. 

Zoom in or out on 
the report

From the Zoom drop-down list, select a 
zoom ratio with which to view the 
report. 

Go to the first 
page of the report

Click the Go To First Page toolbar icon.

Go to the 
previous page of 
the report

Click the Go To Previous Page toolbar 
icon.

Go to the next 
page of the report

Click the Go To Next Page toolbar icon.

Go to the last 
page of the report

Click the Go To Last Page toolbar icon.

Go to a specific 
page of the report

In the text box, enter the page number 
you want to go to and then press 
[Enter].

Stop report data 
from loading

Click the Stop Loading toolbar icon.

Search for 
specific text 
strings within the 
report

1. Click the Search Text toolbar icon. 
The Search dialog box appears.

2. Enter the text you are looking for 
and click Find Next. The text you 
search for is highlighted with a red 
box.

Table 13. Audit Report View Options

Task Icon Instructions
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The following table contains a list of the file formats in which you can export 
a report.

Table 14. Export Format Types

Format Description

Acrobat Format 
(PDF)

The report is exported as a PDF file. You can choose the 
range of pages you wish to export. Adobe Acrobat 
must be installed on the computer in order to export in 
PDF format.

Character-separated 
values

The report is exported as a text file with a .chr 
extension. Values are separated and delimited by the 
characters you choose. If you are using Crystal 
Reports, you can specify whether you want to use the 
same date and number formats that are used in the 
report.

Comma-separated 
values (CSV)

The report is exported as a text file with a .csv 
extension. Values are separated by commas and 
delimited by quotes. If you are using Crystal Reports, 
you can specify whether you want to use the same date 
and number formats that are used in the report.

Crystal Reports 
(RPT)

The report is exported as a Crystal Reports file. Crystal 
Reports must be installed on the computer where you 
are creating and exporting the report.

Data Interchange 
Format (DIF)

The report is exported as a Data Interchange Format 
file, with a .dif extension.

Excel 2.1 (XLS)
Excel 3.0 (XLS)
Excel 4.0 (XLS)
Excel 5.0 (XLS)
Excel 5.0 (XLS) 
(Extended)
Excel 7.0 (XLS)
Excel 7.0 (XLS) 
(Extended)
Excel 8.0 (XLS)
Excel 8.0 (XLS) 
(Extended)

The report is exported as a Microsoft Excel file of the 
version you specify. If you export as version 5.0 
Extended or later, you can specify additional Excel 
output options, which include column heading usage, 
worksheet functions for populating subtitle fields, 
constant or object-based column width, and tabular or 
non-tabular format.
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HTML 3.0 (Draft 
Standard)
HTML 3.2 
(Standard)
HTML 3.2 
(Extended)

The report is exported as an HTML file that conforms 
to the HTML standard specified in the format name. 
Before saving, you are prompted for the directory to 
which EmailXtender should save the file. If you are 
exporting the file to an application (see "Exporting to 
an Application" on page 224), the directory you specify 
is ignored, as the HTML is not saved to disk.

Lotus 1-2-3 (WK1)
Lotus 1-2-3 (WK3)
Lotus 1-2-3 (WKS)

The report is exported as a Lotus 1-2-3 file, with the 
extension (.wk1, .wk3, or .wks) specified in the format 
name.

ODBC - * These report formats are not currently supported in 
EmailXtender.

Paginated Text The report is exported as a text file, where each page is 
separated based on the number of lines per page you 
specify. When specifying an amount in the Lines Per 
Page dialog box that appears, remember that the lines 
you specify include all lines in the report page. For 
example, if a report contains 30 lines of data on page 1 
and you specify 50 lines for page length, 20 empty lines 
then separate page 1 and page 2. You must specify at 
least one line greater than the maximum number of 
lines of data in a report page or the report will not be 
exported. If you do not want any pagination, use 0 in 
the Lines Per Page box.

Record style 
(columns of values)

The report is exported as a text file, with values listed 
in columns.

Report Definition The report is exported as a Crystal Reports report 
definition file (with a .txt extension).

Rich Text (Exact) 
Format

The report is exported as a Rich Text Format (.rtf) file.

Tab-separated text The report is exported as a text file (with a .ttx 
extension), with text separated by tabs and values 
delimited with quotes.

Table 14. Export Format Types

Format Description
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For more information on exporting the files to each type of location, see the 
following sections:

• "Exporting to an Application" on page 224
• "Exporting to Disk" on page 225
• "Exporting to an Exchange Folder" on page 226
• "Exporting to a Lotus Domino Database" on page 228
• "Emailing a Report as an Attachment" on page 229

Exporting to an Application

You can export a report directly to an application from the Report View 
window. 

If a file association is established on the EmailXtender Audit computer (for 
example, if files with .doc extensions are configured to open in Microsoft 
Word), the report opens in the associated application. If not, you are prompted 
to choose an application to use to open the report.

To export a report to an application:

1. From the Report View window, click the Export Report toolbar icon. The 
Export dialog box appears.

Tab-separated 
values

The report is exported as a text file (with a .tsv 
extension), with values separated by tabs and 
delimited with quotes.

Text The report is exported as a text file (with a .txt 
extension).

Word for Windows The report is exported as a Word for Windows 2.0 file.

XML The report is exported as an XML file, using a Crystal 
Reports schema.

Table 14. Export Format Types

Format Description
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Figure 94. Export Dialog Box

2. From the Format list, select the file format in which you want the report 
exported. For more information about the formats you can use, see Table 
14 on page 222.

3. From the Destination drop-down list, select Application. 

4. Click OK. 

You may be prompted to specify additional format options, depending on 
the file format you selected. 
Otherwise, the report opens in its native application. (If the file format is 
not associated with an application, the Open with dialog box appears. 
Select an application in which to view the report and click OK.)

Exporting to Disk

You can export a report of any format to a file on the hard disk or on the 
network.

To export a report to disk:

1. From the Report View window, click the Export Report toolbar icon. The 
Export dialog box appears.

Figure 95. Export Dialog Box

2. From the Format list, select the file format in which you want the report 
exported. For more information about the formats you can use, see Table 
14 on page 222.

3. From the Destination drop-down list, select Disk. 
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4. Click OK.

You may be prompted to specify additional format options, depending on 
the file format you selected. 
Otherwise, the Choose Export File box appears.

Figure 96. Choose Export FIle Dialog Box

5. Navigate to the location where you want to save the file.

6. In the File name text box, enter a name for the file.

7. Click Save.

Exporting to an Exchange Folder

You can export a report to a Microsoft Exchange folder. For example, you 
could use this function to export a report to your Inbox, a specific personal 
folder, or a Public Folder.

Note: The MAPI profile that you use must have access rights to the folder to 
which you want to export the report.

To export a report to an Exchange folder:

1. From the Report View window, click the Export Report toolbar icon. The 
Export dialog box appears.
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Figure 97. Export Dialog Box

2. From the Format list, select the file format in which you want the report 
exported. For more information about the formats you can use, see Table 
14 on page 222.

3. From the Destination list, select Exchange Folder. 

4. Click OK.

You may be prompted to specify additional format options, depending on 
the file format you selected. 
Otherwise, the Choose Profile dialog box appears.

Figure 98. Choose Profile Dialog Box

5. Select your MAPI profile (or the profile that corresponds to the Exchange 
mailbox to which you want to export the report) and click OK. The Select 
a Folder dialog box appears.
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Figure 99. Select a Folder Dialog Box

6. Select the folder where you want to save the report and then click OK. The 
report is exported to the specified Exchange folder. 

Note: When you open the message in Outlook, it does not appear in the 
Preview pane, as it is not a conventional email message. You must 
double-click the report within Outlook to launch the application in which 
to view the report.

Exporting to a Lotus Domino Database

You can export a report to a Lotus Domino database. The account that you 
used to start Notes and launch EmailXtender must have access to a database 
in order to export a report to it.

To export a report to a Lotus Notes database:

1. From the Report View window, click the Export Report toolbar icon. The 
Export dialog box appears.

Figure 100. Export Dialog Box
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2. From the Format list, select the file format in which you want the report 
exported. For more information about the formats you can use, see Table 
14 on page 222.

3. From the Destination list, select Lotus Domino. 

4. Click OK. The Select Database dialog box appears.

5. From the Servers drop-down list, select a server.

6. Click OK. A message appears to prompt you for a password.

7. Enter the password and then click OK. The available Notes databases 
populate the Databases list box. 

8. Select a database and click OK. 

You may be prompted to specify additional format options, depending on 
the file format you selected. 
Otherwise, the Comments dialog box appears. 

9. If you have any comments, enter them and then click OK. A message 
appears to prompt you for a password.

10. Enter the password and then click OK. The report is exported to the Notes 
specified Notes database.

Emailing a Report as an Attachment

You can use MAPI to email a report as an attachment to a specific address.

To export a report using Microsoft Mail (MAPI):

1. From the Report View window, click the Export Report toolbar icon. The 
Export dialog box appears.

Figure 101. Export Dialog Box

2. From the Format list, select the file format in which you want the report 
exported. For more information about the formats you can use, see Table 
14 on page 222.

3. From the Destination list, select Microsoft Mail (MAPI). 
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4. Click OK.

You may be prompted to specify additional format options, depending on 
the file format you selected. 
Otherwise, the Send Mail dialog box appears.

Figure 102. Send Mail Dialog Box

5. In the To text box, enter the email address or MAPI friendly name to which 
you want to send the report, or click Address to select an email address 
from the address book. 

6. If you want to copy the message to another email address, enter the email 
address or MAPI friendly name in the Cc text box, or click Address to 
select an email address from the address book.

7. In the Subject text box, enter a subject line for the email message.

8. In the Message text box, enter any accompanying information for the 
report.

9. Click Check Names to verify that the recipient email addresses are valid.

10. Click Send. The report is sent as an attachment to an email message.
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Chapter 10: Archiving Bloomberg Mail

Bloomberg L.P. provides the Bloomberg Professional® Service, which is a 
subscription-based service used by brokerages and financial institutions to 
share information in a secure and confidential manner. Email traffic is routed 
through servers located at the Bloomberg centers and, as part of the 
subscription to this service, Bloomberg provides all email routed through its 
servers to clients in an aggregated text file. This text file contains all email that 
originated from or was directed to the client company and then routed 
through the Bloomberg mail servers.

The EmailXtender Bloomberg Mail Parser processes Bloomberg aggregated 
text files containing the mail and separates them into individual emails that 
conform to the RFC 822 email standard. The parser then writes the mail files 
to a directory you specify. 

After you run the parser, you must manually copy files into the 
c:\inetpub\mailroot\drop directory so that EmailXtender can full-text index 
and store the email, allowing you to use EmailXaminer to sample and review 
the messages based on company compliance policies.

Note: If you are using EmailXtender Archive Edition, the Bloomberg Mail 
Parser is not available. You must upgrade to a full EmailXtender license to 
access this feature.

To configure and run the Bloomberg Mail Parser:

1. Review Bloomberg Mail concepts. For more information, see "Bloomberg 
Mail Concepts" on page 232. 

2. Install the parser. For more information, see "Installing the Parser" on 
page 244.

3. Review a sample Bloomberg Mail message input file to determine if you 
need to modify the way the parser processes the message input file. 
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You can also test the parser by running it in test mode. For more 
information on running the parser in test mode, see "Running the Parser" 
on page 251.
To troubleshoot the parser once you run it in test mode, review the log file. 
For more information, see "Interpreting Log File Messages" on page 253.

4. If necessary, create a configuration file to modify the way the parser 
processes the message input file. For more information, see "Editing the 
Parser Configuration File" on page 244.

5. Test the configuration file with the parser by running the parser in test 
mode. For more information on running the parser in test mode, see 
"Running the Parser" on page 251.

To troubleshoot the parser once you run it in test mode, review the log file. 
For more information, see "Interpreting Log File Messages" on page 253.

6. If necessary, assign each email address that will result from parsing of 
Bloomberg files as a legacy email address in the properties of the 
corresponding user on the mail server. For more information, see "Adding 
Legacy Email Addresses" on page 250. 

This is required because EmailXtender and EmailXaminer use the Lotus 
Domino or Microsoft Exchange address book to resolve Bloomberg email 
addresses. 
To determine what email address formats result from parsing the 
Bloomberg files, you need to parse the files with the Bloomberg Mail 
Parser in test mode and look at the resulting log file. For more information, 
see "Running the Parser" on page 251 and "Interpreting Log File Messages" 
on page 253.

7. Once you resolve all parser issues, you can run the parser and output the 
resulting message files to an output directory, from which you can archive 
them to EmailXtender. You can either run the parser manually as a 
command line application, or you can schedule it using the Windows Task 
Scheduler. For more information on running the parser, see "Running the 
Parser" on page 251.

Bloomberg Mail Concepts
Before you begin parsing Bloomberg Mail and archiving it through 
EmailXtender, you should be comfortable with terminology and concepts 
related to Bloomberg Mail and EmailXtender. For more information, see the 
following sections:
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• "Bloomberg Input Files" on page 233
• "Configuration File" on page 240
• "Command Line Parameters" on page 240
• "Parser Output" on page 240

Bloomberg Input Files

Bloomberg sends two files daily: 

• Message input file - An aggregated text file containing all email that 
originated from or was directed to the client company and then routed 
through the Bloomberg mail servers. For more information, see "Message 
Input File" on page 233.

• Attachment input file - A compressed file containing any attachments for 
the emails. For more information, see "Attachment Input File" on 
page 239.

Message Input File

Bloomberg provides the message input file in a variety of formats. Not all 
Bloomberg customers receive the same format; therefore, the parser must be 
able to recognize the log format and parse accordingly.

The Bloomberg Mail Parser identifies the two most commonly occurring 
Bloomberg email formats as the Bull format and the Bear format. 

Both the Bull format and the Bear format identify each message, breaking out 
the header information and message body, but they differ in how they identify 
the message header attributes. The demarcation line between the end of one 
message and the start of the next is the primary difference between the two 
formats. The location and terminal information is not included in the Bull 
format, and the message number is not located in the same place. 

Note: Although the address format appears to differ, the address format is not 
consistent among classic logs anyway and is not considered a significant 
difference. 

You can request that Bloomberg deliver message input files in one of the two 
preconfigured formats, or you can customize one of the preconfigured formats 
to match the format delivered by Bloomberg.

For more information on the two preconfigured formats, see the following 
sections:

• "Bear Log Format" on page 234
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• "Bull Log Format" on page 236

In addition, Bloomberg encodes a variety of user address formats. For more 
information on the user address formats that the Bloomberg Mail Parser 
supports, see "Observed User Address Formats" on page 238.

Bear Log Format

The following is an example of Bear format message.

========================== Count:      1 
==========================

      Message sent:  4/04/2003  at  15:30

>From: ALMA AARDVARK - ANGUS INVESTMENTS / JERSE

>Location:11TH FLOOR  

 >To: BILL TELL - ARROW FINANCIAL                                                      

 >Location: SUITE 910   

 >To: WILL QUILL - ARROW FINANCIAL                                                      

 >Location: 2550        

 >Sent from terminal:   881574 -  3

I put abs confirms on the web thx, alma                         

The Bear format can be summarized as:

Table 15. Bear Format

Message Start ======================= Message Count:   # 
=======================
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The message header consists of the following attributes:

Message Header Message Sent: mm/dd/yyyy HH:MM:SS

From: <sender>

To: <recipient>

This message has the attachment: <Attachment>

Note: THERE WERE MORE RECIPIENTS NOT BELONGING TO YOUR 
FIRM

Blank line

Message Body Body of the Message

Table 16. Bear Format Message Header Attributes

Seq. Field Frequency Description

1 ======================= 
Message Count:   # 
=======================

Once Indicates beginning of the message 
and identifies the message within the 
log file.

2 Message Sent: Once Time is in 24-hour format in New 
York time (EST).

3 From: Once

4 To: 1 or more

5 This message has the 
attachment:

0 or more (Optional) Identifies one file sent 
with the message.

6 Note: THERE WERE MORE 
RECIPIENTS NOT 
BELONGING TO YOUR FIRM

0 or 1 (Optional) Indicates that the message 
was ‘Sent:’ to one or more people 
external to the firm or customer 
account.

7 Blank Line Once Carriage return line feed. Denotes 
end of header; message body to 
follow.

Table 15. Bear Format
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Bull Log Format

The following is an example of a Bull format message:

=====Begin Message=====

Message#: 8

Message Sent: 02/24/2003 15:30:08

From: AAARDVARK@bloomberg.net| ALMA  AARDVARK | ANGUS 
INVESTMENTS| | 

To: BTELL@bloomberg.net |BILL TELL ARROW FINANCIAL 
|1234|98765

Subject: STOCK GAINS

15:22 *MAJOR INDEXES END ON UPNOTE, CNN SAYS

15:21 *STOCKS RISE AHEAD OF JOB DATA, CBS SAYS

=====End Message=====
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The Bull format can be summarized as:

The message contains the following attributes:

Table 17. Bull Format

Message Start =====Begin Message=====

Message Header Message#: number

Message Sent: mm/dd/yyyy HH:MM:SS

From: <sender>

To: <recipient>

Note: More Recipients

Attachment: <attachment name>

Subject:

Blank line

Message Body Body of the Message

Message End =====End Message=====

Table 18. Bull Format Message Attributes

Seq Field Frequency Description

1 =====Begin Message===== Once Indicates the beginning of the message.

2 Message#: Once A number identifying the message in the 
file. The number is not padded with 
spaces.

3 Message Sent: Once Time is in 24-hour format in New York 
time (EST).

4 From: Once

5 To: 1 or more
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Observed User Address Formats

Bloomberg encodes a variety of user address formats. The sender and recipient 
information forms listed in the following table were identified in email files 
supplied by Bloomberg to its customers. All are very similar; however, the 
way the user, company, and SMTP address are separated differs. The parser 
supports all of these address formats:

6 Note: More Recipients 0 or 1 (Optional) Indicates that the message 
was sent to one or more people external 
to the firm or customer account.

7 Attachment: 0 or more (Optional) Identifies an attachment file 
that is included with the message. One 
line per attachment.

8 Subject: Once

9 Blank Line Once Carriage return line feed. Denotes end of 
header; message body to follow.

10 =====End Message===== Once Indicates the end of the message.

Table 19. Supported User Address Formats

Format # Format

1 <Name> [Name] [Name] - <Account Name>

2 <User Name>bb<Account Name> ( <SMTP Address> )

3 <User Name> ( <SMTP Address> )

4 <User Name>bb<Account Name> ( <User Name>bb<Account 
Name> )

5 <User Name>,bb<Account Name> ( <User Name>bb<Account 
Name> )

6 <User Name>, <Account Name> ( <User Name>, <Account 
Name> )

Table 18. Bull Format Message Attributes

Seq Field Frequency Description
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A log file with type 1 messages will only contain messages of this type. 
Similarly a log with type 11 only contains type 11 messages. However, 
message types 2 through 10 can be intermixed within a log file.

Before using the Bloomberg Mail Parser, you must assign each email address 
that will result from parsing of Bloomberg files as a legacy email address in the 
properties of the corresponding user on the mail server. This is required 
because EmailXtender and EmailXaminer use the Lotus Domino or Microsoft 
Exchange address book to resolve Bloomberg email addresses. For more 
information, see "Adding Legacy Email Addresses" on page 250.

Attachment Input File

Bloomberg provides the attachments for its email in a compressed file. The 
compressed attachments file typically shares the same root name as the 
message input file. For example, if the message input file is named 
acct2525.04232003, then the compressed attachments file is named 
acct2525.04232003.tar.gz. 

Before you use the parser, you should decompress the attachments file and 
reference its location through the -A command-line flag. The parser only needs 
to know the name of the directory from which the attachments file was 
decompressed. The parser searches the directory for the attachment and then 
adds it to the message. 

7 <SMTP Address> ( <SMTP Address> )

8 <Name> ( SMTP Address )

9 <Name>

10 <SMTP Address>

11 <SMTP Address> | <User Name> | <Account Name> | [Firm 
Number] | [Account Number]

Legend:
<…> Required
[…] Optional
bb Two adjacent spaces

Table 19. Supported User Address Formats

Format # Format
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You should not decompress multiple message input files to the same location. 
Although it appears likely that all messages are uniquely identified across 
time, there is no need to risk the chance that the message numbers may be 
reused, possibly resulting in the wrong attachment being found.

Configuration File

The Bloomberg Mail Parser uses a Microsoft Windows .ini configuration file. 
This file contains definitions of the various message fields so that the parser 
can parse Bloomberg files.

You can use the default settings in the configuration file; however, if the parser 
cannot successfully parse the Bloomberg file, you must modify the 
configuration file to tailor the parser to work with the specific Bloomberg 
format you are receiving.

For more information on editing the configuration file, see "Editing the Parser 
Configuration File" on page 244.

Command Line Parameters

The Bloomberg Parser is a command line application named BBPARSER. The 
application uses several command flags to identify the Bloomberg source file 
and the destination directory. Additional flags control error reporting and 
customized parsing. For more information, see "Running the Parser" on 
page 251.

Note: You can run the Bloomberg Mail Parser either manually from the 
command line or on a scheduled basis using the Windows Task Scheduler. 

Parser Output

Once you run the parser, it outputs the messages and their attachments and a 
log file. Using command line options, you can also direct the parser to output 
an inventory file. For more information, see the following sections:

• "Messages and Attachments" on page 241
• "Log File" on page 242
• "Inventory Report" on page 243
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Messages and Attachments

If you install the Bloomberg Mail Parser on the EmailXtender server, the parser 
filters messages using the address rules you configured through the 
EmailXtender Administrator interface. For more information on configuring 
rules, see "Collection and Exclusion Rules" on page 93.

Note: If you install the parser on a separate server, the parser archives all valid 
messages to EmailXtender, regardless of EmailXtender address rules.

The parser extracts From and To information from the message and queries 
EmailXtender to determine whether the message should be saved or 
discarded. The FilterAddresses parameter in the Bloomberg section of the 
parser configuration file controls whether message filtering should occur.

Messages that EmailXtender directs to be saved are written to the output 
directory specified on the command line. Message that EmailXtender directs 
to be discarded are either discarded or saved to the discarded messages output 
directory, depending on the command line flags you enter. The output 
directories are created automatically if they do not already exist. 

Inside the message output directory, one or more subdirectories are created as 
necessary to hold all of the messages. The subdirectories are used to 
circumvent file system restrictions that limit the number of files that a 
directory can contain. 

Each message, or .eml file, is a MIME-formatted RFC 822 message and, as such, 
has a unique message ID. Bloomberg does not include a message identifier 
with each message. Instead, the .eml file is uniquely named to reflect the 
customer and the date the message file was created. The parser uses the source 
file name and the Bloomberg message number to generate a unique message 
ID. A typical filename might be S100.16876020.eml, where 100 is the message 
number and 16876020 is the message ID.

By using the source file and the message number, EmailXtender recognizes 
duplicate messages when they are added to the \InetPub\mailroot\Drop 
directory so that EmailXtender can process and archive them.
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There is one message per parsed message body. The From, To, and Subject 
fields contain the following information:

Log File

The parser reports to the BBPARSER.ERRORS.TXT file the number of emails 
processed, in three categories:

Table 20. Bloomberg Mail Parser Output

Field Description

From Friendly name of the sender in the format available from 
the message; for example,  first name and last name.

Date The time stamp in the message body of when the mail 
message was sent. The Bloomberg file does not identify 
the time zone from which a message was sent. The parser 
was written with the assumption that the message time is 
Eastern Standard Time (EST). The parser takes the 
message time and converts it to a UTC (universal) time. 
When the message is viewed from an EmailXtender or 
EmailXaminer client, the message time should appear as a 
local time.

To Friendly name of the recipients.

Subject Either the actual message subject or the text string 
supplied in the configuration file.  The subject is listed as 
Bloomberg if the message does not contain a subject.

Message Body The message body contains the entire message starting 
from one delimiter to the next.

Table 21. Bloomberg Parser Log File Categories

Category Description

Had errors Number of messages that were not processed
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The total of these three tallies should equal the number of emails originally 
received from Bloomberg.

The log file also reports any errors that may have occurred during processing.

For more information on interpreting the messages in the parser log file, see 
"Interpreting Log File Messages" on page 253.

Inventory Report

The parser can also generate an inventory file in .csv format that identifies all 
messages that were extracted from the Bloomberg source file. The parser 
writes one line of information for each .eml file created. The following fields 
appear in the inventory file and are separated, or delimited, by the caret 
character (^):

Archived Number of .eml files created in the output directory specified 
on the command line

Discarded Number of messages that were discarded by message 
filtering or the number of .eml files created in the discarded 
messages output directory specified on the command line

Table 22. Inventory Report FIelds

Field Contents

MsgNumber 1, 2, ... 500, ...

Date When sent

To Recipients

From Sender

Subject Subject line

Archived • 1 if to be archived to the -D directory
• 0 if not (and written to the -U directory if provided)

EML Msg filename

Table 21. Bloomberg Parser Log File Categories

Category Description
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You can save the inventory file as a .txt file and then load the file into a 
spreadsheet program like Microsoft Excel for easier viewing.

Installing the Parser
You can install the Bloomberg Mail Parser on the EmailXtender server at the 
same time that you install EmailXtender server components. If you want to 
install the parser on a computer other than the EmailXtender server, you can 
use the same setup wizard you used to install EmailXtender server 
components. For more information, refer to the Installing EmailXtender chapter 
of the EmailXtender Installation Guide.

Once you install the parser, you may need to create or modify a parser 
configuration file so that the parser works with the specific Bloomberg Mail 
format you are receiving. For more information, see "Editing the Parser 
Configuration File" on page 244.

In addition, you must assign each email address that will result from parsing 
of Bloomberg files as a legacy email address in the properties of the 
corresponding user on the mail server. This is required because EmailXtender 
and EmailXaminer use the Lotus Domino or Microsoft Exchange address book 
to resolve Bloomberg email addresses. For more information, see "Adding 
Legacy Email Addresses" on page 250.

Editing the Parser Configuration File
Once you install the Bloomberg Mail Parser, you may need to create or modify 
a parser configuration file so that the parser works with the specific Bloomberg 
Mail format you are receiving.

The configuration file is a Microsoft Windows .ini file containing definitions 
that help the parser to parse Bloomberg Mail files by identifying the various 
message fields.

If you do not specify a configuration file on the command line when you run 
the parser, a set of default values are used to parse the files. If the parser cannot 
successfully parse the Bloomberg file using the default values; however, you 
must create a configuration file to tailor the parser to work with the specific 
Bloomberg Mail format you are receiving.
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You do not need to include all of the parameters in the configuration file. If you 
do not specify a parameter in the configuration file, the parser uses the 
corresponding default value. For this reason, when you are creating a 
configuration file, you only need to add the parameters you want to change 
from the defaults.

To create a configuration file:

1. Open a Bloomberg message input file with a text editor (such as WordPad) 
and make sure that the standard delimiter definitions match what you see 
in the Bloomberg file. Follow this step carefully because any mistakes in 
the delimiter definitions adversely affect the email file parsing process.

2. Using the text editor, create a new text file and name it filename.ini, where 
filename is an easily identifiable name that you will specify on the parser 
command line.

3. Start the new text file with a text string, such as [Bloomberg]. The text 
string should be the first text in the Bloomberg file’s section header.

4. Enter each parameter you want to change on its own line, and separate the 
parameter from the value you are defining by using an equal (=) sign. You 
can use spaces or tabs on either side of the equal sign, but do not enclose 
string values using quotation marks.

To comment out an individual line, enter a semi-colon (;) as the first 
character on the line.
For more information on the parameters you can enter, see the following 
sections:
• "Editing the Bloomberg Section" on page 246
• "Editing the Bear Section" on page 247
• "Editing the Bull Section" on page 248
To see an example of a configuration file that uses all of the default values, 
see "Bloomberg Mail Parser Configuration File with Default Values" on 
page 249

5. Save and close the configuration file.

6. You can verify any edits by running the parser in test mode and specifying 
the configuration file on the command line. This parses the file and flags 
any errors, but does not create the actual mail message files. For more 
information on running the parser, see "Running the Parser" on page 251.



EmailXtender, Release 4.7
Administrator’s Guide

Chapter 10: Archiving Bloomberg Mail

246

10

Editing the Bloomberg Section

The following table lists the log file format and settings in the parser 
configuration file that are independent of the log file format.

Table 23. Configuration File Settings for Bloomberg Section

Setting Description

LogFormat Bear or Bull

MaxLineLength Reasonable estimate as to the maximum line length 
in the log file. Defaults to 4,096 characters.

CompanyName Whether the parser should attempt to extract the 
company name from the email address.
• 0 - No
• 1 - Yes (Default)

Domain The email domain string to be used for all 
computed email addresses, if not included in the 
received message.

CleanUp Whether the source log file(s) are to be deleted once 
the parsing is complete.
• 0 – No (Default)
• 1 – Yes

RecipientLog Whether recipients log should be created every 
time the parser is run. Does not affect –Test 
operation.
• 0 – No (Default)
• 1 – Yes

FilterAddresses Whether the the parser queries EmailXtender 
address rules to filter emails
• 0 – No (Default)
• 1 -- Yes



Chapter 10: Archiving Bloomberg Mail

EmailXtender, Release 4.7
Administrator’s Guide 247

10Editing the Bear Section

The Bear section of the parser configuration file allows the parser to be 
adapted to the specific text used in a message input file that generally uses the 
Bear format.

UseCommaSeperator Whether the leftmost comma denotes the boundary 
between the user name and the company name.  
This only applies to address format 6.
• 0 – No (Default)
• 1 -- Yes

Note: Part of the parameter keyword must be 
misspelled.

NameSeparator The character used to separate the various parts of 
the friendly name in the email address. Valid 
characters are:
• . (period, the default)
• - (dash)
• _ (underscore)
• (nothing)

Table 24. Configuration File Settings for Bear Section

Setting Description

Date Message Sent:

From >From:

Header ============

Location >Location:

Subject Bloomberg Message (any string, applied to all messages)

Attachment >This message has the attachment: 

Table 23. Configuration File Settings for Bloomberg Section

Setting Description
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Editing the Bull Section

The Bull section of the parser configuration file allows the parser to be adapted 
to the specific text used in a message input file that generally uses the Bull 
format.

Terminal >Sent from terminal

To >To:

Table 25. Configuration File Settings for Bull Section

Setting Description

MsgStart =====Begin Message=====

MsgNumber Message#:

Date Message Sent:

From From:

To To:

Note Note:

Attachment Attachment:

Subject Subject:

MsgEnd =====End Message=====

Table 24. Configuration File Settings for Bear Section
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Example: Bloomberg Mail Parser Configuration File with Default Values

The following example illustrates a parser configuration file. All of the values 
listed are the default values the parser uses.

[Bloomberg]

LogFormat = Bear

MaxLineLength = 4096

CompanyName = 1

Domain = BB

CleanUp = 0

RecipientLog = 0

FilterAddresses = 0

UseCommaSeperator = 0

NameSeparator = .

[Bear]

Date = Message Sent:

From = >From:

Header = ======================= Message Count:

Location = >Location:

Subject = Bloomberg Message

Terminal = >Sent from terminal

To = >To:

Attachment = This message has the attachment:
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[Bull]

MsgStart = =====Begin Message=====

MsgNumber = Message#:

Date = Message Sent:

From = From:

To = To:

Note = Note:

Attachment = Attachment:

Subject = Subject:

MsgEnd = =====End Message=====

Note: The UseCommaSeperator parameter is misspelled and should be 
spelled as it is listed in this example.

Adding Legacy Email Addresses
Before using the Bloomberg Mail Parser, you must assign each email address 
that will result from parsing of Bloomberg files as a legacy email address in the 
properties of the corresponding user on the mail server. This is required 
because EmailXtender and EmailXaminer use the Lotus Domino or Microsoft 
Exchange address book to resolve Bloomberg email addresses. 

To determine what email address formats result from parsing the Bloomberg 
files, you need to parse the files with the Bloomberg Mail Parser in test mode 
and look at the resulting log file. For instructions on running the parser in test 
mode, see "Running the Parser" on page 251.

For example, one email address format that might result from a parsed 
Bloomberg file is FIRSTNAME.LASTNAME@BB. For example, the recipient in the 
following line from a Bloomberg email text file:

>To: JOHN        SMITH          - LEGATO SYSTEMS

creates a recipient of JOHN.SMITH@BB by default.

The default domain of @BB can be changed to match another domain and the 
separator character between FIRSTNAME and LASTNAME can be changed, but 
the order of FIRSTNAME followed by LASTNAME name cannot be changed. 
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In other words, if recipients’ email addresses are in the format 
johnsmith@legato.com, you can skip this step; however, if email addresses 
are in the format jsmith@legato.com, you must add jsmith@legato.com 
as a legacy email address.

Running the Parser
You can run the Bloomberg Mail Parser either manually from the command 
line or on a scheduled basis using the Windows Task Scheduler. 

You can also automate operation with customized scripts written to satisfy 
your requirements and operation norms. LEGATO Professional Services staff 
is available to assist in these efforts. 

When you execute the parser (BBPARSER) from the command line, you must 
specify the source file containing Bloomberg Mail messages and the output 
directory in which the .eml files are placed. You can also then enter any number 
of additional command line flags to further control error reporting and 
customize parsing, such as identifying a parser configuration file or running 
the parser in test mode so that no .eml files are extracted.

The output directory you enter at the command line should be a temporary 
directory, not the \inetpub\mailroot\drop directory on the EmailXtender 
server. Using a temporary directory enables you to review the parser output 
for completeness and errors. Should any problems occur, you can delete the 
temporary directory, resolve the problem, and rerun the parser. 

Once you are satisfied that the parser successfully processed the message 
input file, you should copy the resulting .eml files to the 
\InetPub\mailroot\Drop directory on the EmailXtender server. 

To run the Bloomberg Mail Parser:

1. Decompress the attachments file.

2. Enter the following at the command line:

BBPARSER -S SourceFileName -D DestinationDirectory Flags
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where SourceFileName is the name of the message input file, DestinationDirectory 
is the directory in which you want the resulting .eml files placed, and Flags are 
the remaining parser flags you enter. The following table describes the 
available parser flags:

Table 26. Parser Command Line Flags

To do this: Enter this flag:

Specify the location of the directory in which you want to 
place resulting message attachments

-A

Specify the configuration file with custom parsing 
information, should the default parameters require 
adjustment

-C

Specify the pathname to the message inventory file, which 
contains one line per message created

-I

Specify the mail domain, which is the recipient’s member 
domain

Note: You can also specify the domain in the configuration 
file. Should the domain be specified in both locations, the 
command line instance is used.

-M

Only process the first x number of messages

This flag saves time and disk space when message input 
files are large.

-MsgLimit

To specify the name of the recipient’s log file -R

Run the parser in test mode. 

The source is parsed; however, no messages are created. 
Any parsing problems are logged to the 
BBParser.Errors.Txt file. This flag is used to validate the 
message input file.

-Test

Specify the directory where discarded messages are stored 
when message filtering (through EmailXtender address 
rules) is used

-U

Display command line help -? or -H
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For more information on the output the parser produces, see "Parser Output" 
on page 240.

Interpreting Log File Messages
The parser reports to the BBPARSER.ERRORS.TXT file the configuration 
parameters used to process the message input file, as well as the number of 
emails processed, in three categories:

The information is reported using the following format:

Processed %d messages: 

%8d : Had Issues

%8d : Archived

%8d : Discarded

The total of these three tallies should equal the number of emails originally 
received from Bloomberg.

Any errors incurred during the parsing process are also logged to the 
BBPARSER.ERRORS.TXT file. 

If you encounter errors in the log file, you should extract errant messages from 
the message input file and add them to a new file. You should then reprocess 
the original message input file, resolve the errors, and finally, process the new 
file with the problematic messages. The new filename should be based upon 
the original message log filename. 

Table 27. Bloomberg Parser Log File Categories

Category Description

Had errors Number of messages that were not processed

Archived Number of .eml files created in the output directory specified 
on the command line

Discarded Number of messages that were discarded by message 
filtering or the number of .eml files created in the discarded 
messages output directory specified on the command line
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You may encounter the following errors in the parser log file:

• %d - Missing attachment: %s

The selected message should have an associated attachment, but the 
attachment cannot be found.

• %d - Unacceptable recipient SMTP address: %s

The SMTP address for the recipient for the selected message is invalid.
• %d - Unacceptable sender SMTP address: %s

The SMT address for the sender for the selected message is invalid.
• %d - Unrecognized message format

The format of the selected message is different than the parser expected.
• ERROR: Either the archive directory does not exist or it is a file. The 

parser cannot continue.

The value you entered for the output directory cannot be found or it was 
found, but it is a file. The parser does not create the path if it does not exist.

• ERROR: The address filter was requested, however it is not available, 
the parser cannot continue.

The email address rules filter (for EmailXtender collection and exclusion 
rules) is not available.

• ERROR: The message inventory pathname is a directory, the parser 
cannot continue.

The value you entered for the inventory file (using the -I flag) is a 
directory and not a filename.

• ERROR: The unarchived directory is a file or cannot be created, the 
conversion cannot continue.

The value you entered for the output directory for discarded emails 
cannot be found or it was found, but it is a file. The parser does not create 
the path if it does not exist 

• Insufficient number of parameters, app terminating.

One or more of the required parameters are missing.
• Parser terminated processing message #%d, the disk is full.

The parser cannot continue parsing messages because the disk to which it 
is writing the .eml files is full.

• Unable to create the temporary attachment directory:\n\t%s

The scratch directory used to stage the attachment files cannot be created, 
thereby preventing the attachments from being added to the message.
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• Warning: Config file not found, using defaults.

The configuration file specified cannot be found; the program default 
settings will be used instead.

• WARNING: Unable to determine absolute path for config file:

%s

Processing will continue with the defaults.

The configuration file specified cannot be found; the program default 
settings will be used instead.

In addition, you may encounter the following return code messages:

Table 28. Bloomberg Mail Parser Return Codes

Message Error Condition

0=Successful PARSER_ARCHIVE_DIR_DOES_NOT_EXIST

1 PARSER_BAD_FROM_SMTP

2 PARSER_BAD_TO_SMTP

3 PARSER_ATTACHMENT_NOT_FOUND

4 ERROR_BAD_ARGUMENTS

5 PARSER_ARCHIVE_DIR_DOES_NOT_EXIST

6 PARSER_BAD_FROM_SMTP

7 PARSER_BAD_TO_SMTP

8 PARSER_ATTACHMENT_NOT_FOUND

9 ERROR_BAD_ARGUMENTS

160=Missing required 
parameters

PARSER_ARCHIVE_DIR_DOES_NOT_EXIST
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Chapter 11: EmailXtract

EmailXtract, which is an installable component of EmailXtender, allows you to 
manage messages in the message store on a Microsoft Exchange or Lotus 
Domino mail server. When you install EmailXtract on the mail server, you can 
search for, analyze, and delete messages in the message store. 

When you install EmailXtract on the EmailXtender server, you can accomplish 
the following tasks in addition to searching for and analyzing messages in the 
mail server message store:

• Archive legacy messages in the mail server’s message store to an 
EmailXtender server

• Archive other item types, such as contacts, notes, tasks, and meetings
• Archive items from public folders and .pst files in a Microsoft Exchange 

environment, and from .nsf files in a Lotus Domino environment
• Remove messages from the mail server and replace them with pointers 

(shortcuts) to copies of the archived messages
• Restore shortcuts after you create them
• Delete messages from the mail server message store (after archiving 

them, if you want to archive the messages)

You can manage the mail server message store through EmailXtract by setting 
up tasks. There are five EmailXtract tasks: Archive, Shortcut, Delete, Search, 
and Analysis. 

All tasks in EmailXtract are based on a set of default settings. There are some 
settings that are global for all tasks, some that are unique to a Microsoft 
Exchange environment, some that are unique to a Lotus Domino environment, 
and some that are unique to each type of task. You can change the default 
settings if necessary when you create a specific task. 

EmailXtract allows you to run tasks immediately, schedule them to run later, 
or schedule them to run on a recurring basis.
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Once EmailXtract completes a task, you can view task results as a chart, export 
them, or print them.

For more information, see the following sections:

• "Using the EmailXtract Administrator" on page 258
• "Configuring EmailXtract Options" on page 262
• "Understanding Tasks" on page 268
• "Configuring Tasks" on page 300
• "Managing Scheduled Tasks" on page 347
• "Managing Task Results" on page 349

For more information on installing EmailXtract, refer to the EmailXtender 
Installation Guide.

Using the EmailXtract Administrator
Because EmailXtract is a Microsoft Windows-based package, the same 
navigational standards apply to all of its components. The EmailXtract 
Administrator provides a user-friendly interface that allows you to easily 
configure tasks and manage task results. For more information, see the 
following sections:

• "Starting the Administrator" on page 258
• "Exploring the Administrator Interface" on page 260
• "Automatically Sizing Columns" on page 262

Starting the Administrator

The first time you launch EmailXtract, you must access the program through 
the Windows Start menu. 

Depending on your mail environment, select one of the following options 
when starting EmailXtract for the first time:

• Start>Programs>LEGATO EmailXtract>EmailXtract for Exchange
• Start>Programs>LEGATO EmailXtract>EmailXtract for Notes

Note: If you are using Microsoft Exchange, you also need to select a default 
mail (MAPI) profile.

In a mixed-mail environment (both Exchange and Domino), you can run one 
session each of EmailXtract for Exchange or EmailXtract for Notes at the same 
time.
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After you have configured EmailXtract for use, and opened and closed 
EmailXtract during a session, you can access the program using either the 
Windows Start menu or an icon in the Windows task bar.

Figure 103. EmailXtract Taskbar Icon

To start the EmailXtract Administrator:

1. You have the following choices:

• From the Start Menu, select Program >LEGATO EmailXtract> 
EmailXtract for Exchange or EmailXtract for Notes.

• Right-click the EmailXtract icon in the status area of the task bar, and 
then select Open EmailXtract from the shortcut menu that appears.

The EmailXtract Administrator appears.

2. Click OK. One of the following occurs:

• If you have installed EmailXtract on a server with a Microsoft 
Outlook client, the Choose Profile dialog box appears.

Figure 104. Choose Profile Dialog Box

Select the MAPI profile for the default administrator that will run the 
majority of the EmailXtract tasks, and then click OK. 

Note: Administrative access rights to an Exchange server are based 
upon the privileges associated with the Windows user account in use 
and not with the MAPI profile in use. In general, the MAPI profile is 
used to provide access to address books and a listing of available 
Exchange servers.

Note: You can change the MAPI profile used for individual tasks 
using the Profile tab when you configure a task. For more information, 
see "Profile" on page 320.
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• If you have installed EmailXtract on server with a Lotus Notes client, 
you are prompted to enter the password for the installed Notes user. 
Enter the password and click Enter. 

3. Configure EmailXtract options. For more information, see "Configuring 
EmailXtract Options" on page 262.

Exploring the Administrator Interface

The EmailXtract Administrator allows you to configure EmailXtract options, 
as well as to create and manage tasks.

Figure 105. EmailXtract Administrator

The Administrator window contains several components that allow you to 
navigate through and configure EmailXtract:

• The menu bar contains the menu commands and can be found at the top 
of the window. For more information, see "Menu Bar" on page 261.

• The toolbar, containing toolbar icons that allow you to perform frequently 
used functions, can be found just below the menu bar. For more 
information, see "Toolbar" on page 261.
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• The status bar, which displays information about the selected command 
or toolbar icon, can be found at the bottom of the window. For more 
information, see "Status Bar" on page 262.

Note: The EmailXtract Administrator interface cannot display multi-byte 
characters (such as Japanese or Simplified Chinese characters). These 
characters appear in the interface as question marks (?).

Menu Bar

The menu bar contains a list of options with commands for carrying out 
functions in the Administrator. You can configure EmailXtract options, create 
tasks, manage tasks, and access online help.

Toolbar

The toolbar contains icons that provide quick access to many of the 
Administrator commands and features.

Note: The icons for the Archive, Shortcut, and Delete tasks are dimmed (not 
available) when you install EmailXtract on a mail server.

Table 29. EmailXtract Administrator Toolbar

Icon Function

Launches the Archival Task dialog box, where you can configure 
an Archive task. For more information, see "Archive Task" on 
page 270.

Launches the Shortcut Task dialog box, where you can configure 
a Shortcut task. For more information, see "Shortcut Task" on 
page 277.

Launches the Deletion Task dialog box, where you can configure 
a Delete task. For more information, see "Delete Task" on 
page 284.

Launches the Search Task dialog box, where you can configure a 
Search task. For more information, see "Search Task" on page 290.

Launches the Analysis Task dialog box, where you can configure 
an Analysis task. For more information, see "Analysis Task" on 
page 294.
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Status Bar 

The status bar is located at the bottom of the Administrator window and 
displays information about the selected command or toolbar icon. 

To show or hide the status bar:

• From the View menu, select Status Bar. A check mark beside the 
command indicates that the status bar is displayed.

Automatically Sizing Columns

The AutoSize Columns option allows you to automatically size the columns in 
any of the visible panes of the Administrator so that they are only as wide as 
their longest entry.

To automatically adjust the size of columns in the Administrator:

• From the View menu, select AutoSize Columns.

Configuring EmailXtract Options
You should configure EmailXtract options, which are used as the default 
information for the system, before you begin setting up tasks. 

Launches the Scheduled Tasks dialog box, where you can 
manage tasks that have been scheduled (as opposed to being run 
immediately). For more information, see "Managing Scheduled 
Tasks" on page 347.

Launches the Configuration Options dialog box, where you can 
set default task settings, establish task priority, and set 
application directories. For more information, see "Configuring 
EmailXtract Options" on page 262.

Launches the EmailXtract Online Help. 

Table 29. EmailXtract Administrator Toolbar

Icon Function
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To configure EmailXtract options:

1. In the EmailXtract Administrator, select Options>Configuration 
Properties. The Configuration Options dialog box appears.

Figure 106. Configuration Options Dialog Box

2. Select and configure each of the tabs.

• Default Task Settings - Allows you to configure task settings for use 
as the basis for all new tasks. For more information, see "Default Task 
Settings" on page 263.

• Runtime Priorities - Allows you to maximize EmailXtract 
performance by establishing task priority in relationship to other 
actions within EmailXtract. For more information, see "Runtime 
Priorities" on page 264.

• Profile- Allows you to change the default MAPI profile. For more 
information, see "Profile" on page 266.

• Directories - Allows you to change the default paths for the log and 
chart files directories. For more information, see "Directories" on 
page 267.

3. When you finish configuring EmailXtract options, click OK. 

Default Task Settings

The Default Task Settings tab of the Configuration Options dialog box allows 
you to configure task settings that can be used as the basis for all new tasks. 
EmailXtract saves the settings you configure as default settings, and 
automatically populates new tasks with the default values. 
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This can save time if you use the same task settings repeatedly. For example, if 
you want to run Archive tasks at the same time each day, you could set the 
default Archive task setting on the Scheduling tab to the desired time. 

When you configure a task, you can change these settings for the individual 
task without affecting the default settings. 

To configure default task settings:

• On the Default Task Settings tab, click the button that corresponds to the 
task for which you want to configure default task settings.

Note: The Archive Task, Shortcut Task, and Delete Task buttons appear 
only if you installed EmailXtract on the EmailXtender server. 

Figure 107. Default Task Settings Tab

The dialog box that appears is identical to the dialog box that appears 
when you configure a specific task. For more information, see the 
following sections:
– "Archive Task" on page 270
– "Shortcut Task" on page 277
– "Delete Task" on page 284
– "Search Task" on page 290
– "Analysis Task" on page 294

Runtime Priorities

The Runtime Priorities tab of the Configuration Options dialog box allows you 
to maximize EmailXtract performance by establishing task priority in 
relationship to other actions within EmailXtract. This helps you to balance the 
processing load on the server.
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You can choose whether foreground or background tasks take priority within 
EmailXtract. For example, if you select the Highest priority for EmailXtract 
task processing, screen and mouse movement within the EmailXtract 
Administrator may be slow or hesitant. 

If you are using Microsoft Exchange, you can also specify the level of 
importance that EmailXtract has in comparison to other applications that use 
the Exchange server. 

Figure 108. Configuration Options Dialog Box - Runtime Priorities Tab

To configure runtime priorities:

1. From the Application Priority drop-down list, select the importance that 
EmailXtract has in comparison to other applications that use the Exchange 
server. Choose a higher priority level to place a greater priority on 
EmailXtract processing (rather than on other applications) on the 
Exchange server.

Note: The Application Priority drop-down list appears on the Runtime 
Priorities tab only when EmailXtract is used in a Microsoft Exchange 
environment

2. From the Task Priority drop-down list, choose whether foreground or 
background tasks take priority within EmailXtract. Choose a higher 
priority level to place a greater priority on background tasks (rather than 
on foreground tasks such as screen and mouse movements).
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Profile

The Profile tab of the Configuration Options dialog box, which appears only if 
you are using EmailXtract with Microsoft Exchange, allows you to change the 
default MAPI profile that is used to communicate with the EmailXtender 
server. EmailXtract uses the default profile to process all EmailXtract tasks.

You specified the default MAPI profile the first time you opened the 
EmailXtract Administrator.

Note: Administrative access rights to an Exchange server are based upon the 
privileges associated with the Windows user account in use, and not with the 
MAPI profile in use. In general, the MAPI profile is used to provide access to 
address books and a listing of available Exchange servers.

Note: You can change the MAPI profile used for individual tasks using the 
Profile tab when you configure a task. For more information, see "Profile" on 
page 320.

Note: If you are applying EmailXtract tasks to messages that use multi-byte 
character sets (such as Japanese and Simplified Chinese) and you want to 
change the MAPI profile that EmailXtract uses, you must first delete the 
language journaling profiles that EmailXtract creates automatically. To delete 
the profile, right-click the Microsoft Outlook icon on the desktop of the 
EmailXtender server, and then select Properties from the shortcut menu. On 
the Service tab, click Show Profiles. On the General tab of the Mail dialog box, 
select all of the exExtract-language-codepage profiles (where language is the name 
of the language and codepage is the codepage number), and then click Remove. 
You can then change the profile.
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To choose a different default MAPI profile:

1. On the Profile tab, click New Profile. 

Figure 109. Configuration Options Dialog Box - Profile Tab

A list of MAPI profiles that have been set up locally appears. 

2. Select the profile you want to use as the MAPI default and click OK. 

Directories

The Directories tab of the Configuration Options dialog box allows you to 
change the default paths for both the log files and chart files directories. The 
default location for both is a subdirectory of the EmailXtract install directory 
(\Program Files\OTG\EmailXtract). 

The log files contain information about actions taken in EmailXtract. 
EmailXtract names the log files TaskName.log, where TaskName is the name 
defined in the Task Name text box on the task’s Scheduling tab. You can view 
log files using any text editor, such as Notepad.

You can view all task results (except for Search task results) as charts, and save 
these charts as image files. These chart files are written to the location you 
specify on the Directories tab.
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To change the default directories:

1. In the Log Files text box on the Directories tab, enter the path to which you 
want log files written, or click Browse to browse to a location.

Figure 110. Configuration Options Dialog Box - Directories Tab

2. In the Chart Files text box, enter the path to which you want chart files 
written, or click Browse to browse to a location.

Understanding Tasks
EmailXtract tasks allow you to manage messages in the message store on a 
Microsoft Exchange or Lotus Domino mail server. There are five EmailXtract 
tasks: Archive, Shortcut, Delete, Search, and Analysis. 

When you install EmailXtract on the EmailXtender server, you can run all of 
the tasks. When you install EmailXtract on the mail server, however, you can 
run only the Search and Analysis tasks.
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The following table lists the types of activities you can accomplish using 
EmailXtract and the task you should use to accomplish them.

For more information on each of the tasks, see the following sections:

Table 30. EmailXtract Task Capabilities

Requirement
EmailXtract 
Task

Archive legacy messages (messages from before you installed 
EmailXtender) in the mail server’s message store to an 
EmailXtender server

Archive

Archive messages from the mail server to an EmailXtender 
server on a scheduled basis rather than in real-time

Archive

Archive other item types, such as contacts, notes, tasks, and 
meetings

Archive

Archive items from public folders and .pst files in a Microsoft 
Exchange environment, and from .nsf files in a Lotus Domino 
environment, to an EmailXtender server

Archive

Archive messages when you are using EmailXtender Archive 
Edition

Archive

Remove messages from the mail server and replace them 
with pointers (shortcuts) to copies of the archived messages

Shortcut

Replace shortcuts with copies of archived messages (in other 
words, restore the messages to the mail server)

Shortcut

Delete messages from the mail server message store Delete

Archive messages from the mail server message store to an 
EmailXtender server and then delete them from the mail 
server

Delete

Search for a specific message so that you can delete it from 
the mail server message store

Search

Determine the average message size, total message count, 
attachment type and size information, and aging of messages 
in the mail server message store

Analyze
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• "Archive Task" on page 270
• "Shortcut Task" on page 277
• "Delete Task" on page 284
• "Search Task" on page 290
• "Analysis Task" on page 294

Archive Task

The Archive task, available when you install EmailXtract on an EmailXtender 
server, allows you to archive messages and other items in the mail server 
message store to an EmailXtender Message Center. 

When you run an Archive task, EmailXtract examines the specified types of 
items in the specified locations. Those that match the criteria you set are 
examined to make sure they have not already been archived by EmailXtender. 
All messages and items that do not already exist in the EmailXtender Message 
Center are archived and then bundled into volumes on the EmailXtender 
server. 

The Archive task is useful in the following types of situations: 

• To archive messages that were sent or received before you installed 
EmailXtender. This allows you to not only attain the benefits of the 
EmailXtender system from the moment you install it, but also to take 
advantage of EmailXtender features with old messages residing on the 
email system. 

• To archive messages as a scheduled batch process rather than on a 
real-time basis. For example, you can set up the Archive task to archive 
all email messages during non-working hours. 

Note: If you archive message as a scheduled batch process, keep in mind 
that messages that are received and deleted by users between the 
scheduled batch processes cannot be archived to the EmailXtender 
Message Center.

• To archive other item types like appointments, meetings, notes, and 
contacts. If you want to archive these types of items, you must use an 
EmailXtract Archive task because EmailXtender can only archive email 
messages.

• To archive messages in public folders or .pst files if you are using 
Microsoft Exchange, or to archive messages in .nsf files if you are using 
Lotus Domino. If you want to archive these types of items, you must use 
an EmailXtract Archive task because EmailXtender cannot archive from 
public folders, .pst files, and .nsf files.
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• To archive messages when you are using EmailXtender Archive 
Edition. You must use the Archive task to archive mail when you are 
using EmailXtender Archive Edition because real-time message capture is 
not available.

You configure Archive task settings using the tabs on the Archival Task dialog 
box, which is shown in the following example:

Figure 111. Archival Task Dialog Box
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There are some tabs that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, and some that are unique to a Lotus 
Domino environment. The following table lists the tabs that appear, 
depending on whether you are using Microsoft Exchange or Lotus Domino.

Using the tabs in the Archival Task dialog box, you can customize the task so 
that you archive only the messages or items you want. For example, you could 
archive only items that are:

• Older than a certain date
• Located in certain folders or mailboxes
• Larger than a certain size
• From a certain sender
• To a certain recipient
• Of a certain type, such as an email message, calendar item, or contact
• Containing certain content (keywords)

The Archival Task dialog box also allows you to schedule the task to run at a 
certain time or even on a recurring basis. In addition, you can configure how 
EmailXtract writes task run information to a log file. 

Table 31. Archive Task Dialog Box Tabs

If you are using Exchange, 
the following tabs appear:

If you are using Domino, 
the following tabs appear:

• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Profile
• Mailbox
• Public Folders
• PST Selection
• Logging

• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Mailbox Selection
• NSF Selection
• Logging
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The following table contains information about each of the tabs in the Archive 
Task dialog box.

Table 32. Archive Task Settings

Tab Name Description/Guidelines For more information, see:

Date Settings Allows you to specify which messages to 
archive based upon the date the 
messages were either received at the mail 
server or last modified. You can specify a 
date or date range.

"Date Settings" on page 310

Folder Settings Allows you to specify the folders from 
which EmailXtract should archive items. 
This could include the Inbox, Outbox, 
Deleted Items, Calendar, Contacts, and 
Sent Items in Exchange, or the Inbox, 
Sent, and Trash in Domino, among 
others.

Note: You may not want to archive items 
in the Deleted Items/Trash folders.

"Folder Settings" on page 319 
(Exchange) or "Folder 
Settings" on page 336 
(Domino)

Item Types Allows you to specify the types of items 
to archive. This could include email 
messages, meetings, appointments, and 
reports, among others.

"Item Types" on page 316 
(Exchange) or "Item Types" on 
page 333 (Domino)

Logging Allows you to specify whether the run 
information for the task is written to a 
log file, and if so, whether the 
information overwrites or appends to the 
existing log file. You can also designate 
how much detail the log file should 
contain.

"Logging" on page 314

Mailbox 
(Exchange)/ 
Mailbox Selection 
(Domino)

Allows you to specify the mail servers 
and mailboxes containing the messages 
you want to archive.

"Mailbox" on page 322 or 
"Mailbox Selection" on 
page 338
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Message Content Allows you to specify which messages to 
archive based upon the content of those 
messages, such as the subject of the 
message, filenames of any message 
attachments, sender or recipient of the 
message, or size of the message.

"Message Content" on 
page 303

NSF Selection Allows you to archive messages from .nsf 
mail databases not locked by a Lotus 
Domino server. These mail databases 
might include mail files from people who 
have left the organization or mail 
databases that users set up on their local 
computers.

"NSF Selection" on page 339

Profile Allows you to use a different MAPI 
profile to access the messages or other 
items that you want to archive.

"Profile" on page 320

PST Selection Allows you to archive messages from .pst 
files.

"PST Selection" on page 325

Table 32. Archive Task Settings

Tab Name Description/Guidelines For more information, see:
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You can configure default settings for each of these tabs using the Default Task 
Settings tab of the Configuration Options dialog box. EmailXtract saves the 
settings you configure as default settings, and automatically populates new 
tasks with the default values. This can save time if you use the same task 
settings repeatedly. However, you can change the default settings if necessary 
when you create a specific task. For more information on default task settings, 
see "Default Task Settings" on page 263.

When you finish configuring a task, you can view and manage tasks that are 
currently running or scheduled to run in the future. You can edit the task, 
delete the task if it is not currently in progress, suspend the task if it is 
scheduled to run in the future, force a scheduled task to run immediately, and 
stop a task that is currently in progress. For more information, see "Managing 
Scheduled Tasks" on page 347.

Once an Archive task is complete, you can use the EmailXtender Search 
Plug-in or the Web Search Client to search for the messages and items you 
archived. For more information on running a search, refer to the EmailXtender 
Search User’s Guide.

Public Folders Allows you to archive items in public 
folders. Items in both the root public 
folder and all subfolders of the public 
folder are included.

Note: All items you archive from public 
folders still belong to their creators and 
can only be retrieved during a search by 
the creator or administrator.

"Public Folders" on page 324

Scheduling Allows you to name the Archive task and 
choose whether to run the task 
immediately or to schedule it to run at a 
later time. You can also configure the 
task to run on a regularly scheduled 
basis, to run until it completes, or to stop 
at a certain time. Finally, you can 
configure the task to run as a service, 
which does not require you to be logged 
in when the task is processed.

"Scheduling" on page 312

Table 32. Archive Task Settings

Tab Name Description/Guidelines For more information, see:
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Note: After you run an Archive task against a .pst or .nsf file, there may be 
messages that you cannot retrieve through a search unless you are an 
administrator. EmailXtender determines what users have access to these 
messages based on the To and From fields. Because a .pst or .nsf file may 
contain outdated address information, some of the email addresses and 
distribution lists referenced in the messages may not be current in the 
Exchange or Domino environment. If this information is not available for 
EmailXtender to determine who should be able to access the messages in 
question, the messages are accessible only to EmailXtender administrators.

The results of the Archive task appear in a task results window in the 
EmailXtract Administrator. The task results window displays summary server 
information about the task; task results, such as mailbox information (for 
example, messages archived, total message size, total mailboxes, number of 
duplicate messages encountered, etc.); and the task log file.

You can view task results as a bar graph, stacked bar graph, or pie chart, all of 
which you can print or save as an image file for future reference. You can also 
organize chart data by message size in MB, the total number of messages, or 
the average size of messages. You can also export task results to a .csv file. For 
more information on managing task results, see "Managing Task Results" on 
page 349.

EmailXtract Support for Archival of Modified Lotus Notes Data

Releases of EmailXtract prior to 4.7 did not support the archival of modified 
data, such as modified meetings. Beginning with EmailXtract 4.7, archiving of 
modified data by EmailXtract is supported for Lotus Notes. 

Releases of EmailXtract prior to 4.7 did not support the archiving of modified 
documents because EmailXtract did not take into account the modification 
history of documents. In an environment where only real-time journaling and 
archival is taking place, this is not a problem because the message documents 
captured and archived are always the unmodified version of the document. 
However, in an environment where EmailXtract is used to archive 
non-messaging data, such as calendar entries, modified documents can be 
erroneously archived as the original documents. 

EmailXtract support for archival of modified Lotus Notes data has the 
following effects:

• Support for archival of modified documents only extends to Notes 
documents that have not been archived. Documents archived by prior 
releases of EmailXtract are not archived again when they are modified, 
and behave in the same manner as they did in previous releases.
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• EmailXtract no longer modifies documents when they are archived or 
shortcut and does not change unread marks during processing.

• Recipients of unmodified documents continue to be the owners of those 
documents. The owner of a modified document is the individual that 
made the modification.

Shortcut Task

The Shortcut task, available when you install EmailXtract on the EmailXtender 
server, removes messages from the mail server and replaces them with 
pointers to copies of the messages that are archived in EmailXtender. This 
allows you to save space on the mail server. For example, you may want to 
create shortcuts of messages that are older than 30 days or that have 
attachments.

Note: You can only shortcut email messages; you cannot configure shortcuts 
for other item types, such as contacts or calendar items.

If you are using Microsoft Exchange, you can shortcut messages on the mail 
server, in public folders, or in .pst files. You may not want to shortcut messages 
in .pst files if the .pst files are not accessible to the mail server, however. The .pst 
files must be accessible to the mail server so that you can restore the shortcuts, 
if necessary. Creating shortcuts of messages in a .pst file does not reduce the 
size of the file unless you compact the file after you create the shortcuts.

If you are using Lotus Domino, you can shortcut messages on the mail server 
or in .nsf files. If the .nsf files reside on the mail server, creating shortcuts allows 
you to save additional space on the server. 

Note: EmailXtract does not create shortcuts of messages that have been either 
sent by East Asian language versions of Microsoft Outlook or encoded by East 
Asian encoding systems such as JIS-Shift, JIS, JIS Allow-1 byte Kana, GB2312, 
EUC, or HZ. EmailXtract skips these messages and logs the event.

If you use Microsoft Exchange and you allow users to access their email 
through Outlook Web Access (OWA), you can configure shortcuts so that they 
are accessible through OWA. There are a number of preliminary setup steps 
you must complete before creating shortcuts that are accessible through OWA. 
For more information, refer to the EmailXtender Installation Guide.

If you previously created shortcuts and did not enable them for OWA, you can 
use the Upgrade Shortcuts option to upgrade them so that users can access the 
shortcuts through OWA.
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When you create shortcuts, you can control how they appear in the mail client. 
You can configure them to appear with the term "(Archived)" at the beginning 
of each message subject title. You can also set them up so that only the message 
header appears; the message body will not appear in the preview pane.

For Microsoft Exchange only, you can also use the Shortcut to Mailbox option 
(available on the PST Selection tab) to create a new folder in the owner’s mail 
client (identified by the .pst file name) which preserves the .pst file’s folder 
structure and shortcuts to each item.

If you are using Microsoft Exchange and a user opens a shortcut message, the 
message is copied from the EmailXtender archive to the mail server and then 
read from the mail server. If you are using Lotus Domino, the message is read 
directly from the EmailXtender archive.

Once you shortcut a message, a copy of the message remains in the 
EmailXtender archive. If necessary, you can use the Shortcut task to restore the 
message, which copies the message from the EmailXtender archive back to the 
mail server. Before you restore messages to the mail server, you should verify 
that you have sufficient space to accommodate the return of the messages and 
their attachments.

If you are using Microsoft Exchange, the message is restored to its original 
folder. If you are using Lotus Domino, you can restore the message either to its 
original folder or to another folder by selecting the new folder on the Folder 
Settings tab. For more information on the Folder Settings tab, see "Folder 
Settings" on page 336.

If you are using Microsoft Exchange and you made shortcuts with previous 
releases of EmailXtract (4.2x and earlier), you can enable users to view those 
shortcuts by upgrading them. Before you upgrade shortcuts, you must 
upgrade the message volumes in EmailXtender. For more information, see 
"Upgrading a Volume" on page 122.

Shortcuts with no associated message in the EmailXtender archive are known 
as unresolved shortcuts. You can verify whether shortcuts have an associated 
message stored in the archive. You can also choose to remove any unresolved 
shortcuts as part of the verification. Shortcuts can become unresolved due to 
any of the following reasons:

• Shortcuts were upgraded from version 4.2 of EmailXtender to a later 
version, and the resulting MD5 identifier was miscalculated.

• There are rules for a cabinet or a folder that exclude messages from being 
archived. This can also occur you configure an EmailXtract task that 
creates shortcuts to messages that were excluded from being archived.
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• Archived messages were deleted from the archive and shortcuts in user 
mailboxes were associated with the deleted messages.

Before you run a Shortcut task to actually create, restore, or upgrade shortcuts, 
you can run the task in simulation mode to determine how much space you 
can save by creating the shortcuts or how much space you will use by restoring 
shortcuts.

You configure Shortcut task settings using the tabs on the Shortcut Task dialog 
box, which is shown in the following example:

Figure 112. Shortcut Task Dialog Box
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There are some tabs that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, some that are unique to a Lotus Domino 
environment, and one tab - the Shortcut tab - that only appears for the Shortcut 
task. The following table lists the tabs that appear, depending on whether you 
are using Microsoft Exchange or Lotus Domino.

Using the tabs in the Shortcut Task dialog box, you can customize the task so 
that you shortcut only certain messages. For example, you could shortcut only 
messages that:

• Are older than a certain date
• Are larger than a certain size
• Contain attachments
• Reside in certain folders or mailboxes
• Are sent from a certain address
• Are received by a certain address
• Contain certain content (keywords)

The Shortcut Task dialog box also allows you to schedule the task to run at a 
certain time or even on a recurring basis. In addition, you can configure how 
EmailXtract writes task run information to a log file. 

Table 33. Shortcut Task Dialog Box Tabs

If you are using Exchange, 
the following tabs appear:

If you are using Domino, 
the following tabs appear:

• Shortcut
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Profile
• Mailbox
• Public Folders
• PST Selection
• Logging

• Shortcut
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Mailbox Selection
• NSF Selection
• Logging



Chapter 11: EmailXtract

EmailXtender, Release 4.7
Administrator’s Guide 281

11

The following table contains information about each of the tabs in the Shortcut 
Task dialog box.

Table 34. Shortcut Task Settings

Tab Name Description/Guidelines For more information, see:

Date Settings Allows you to specify which messages to 
shortcut based upon the date the 
messages were either received at the mail 
server or last modified. You can specify a 
date or date range.

"Date Settings" on page 310

Folder Settings Allows you to specify the folders from 
which EmailXtract should shortcut 
messages. This could include the Inbox, 
Deleted Items in Exchange, Trash in 
Domino, or user-defined/custom 
folders, among others.

"Folder Settings" on page 319 
(Exchange) or "Folder 
Settings" on page 336 
(Domino)

Item Types Not available for the Shortcut task, since 
you can only Shortcut email messages.

Logging Allows you to specify whether the run 
information for the task is written to a 
log file, and if so, whether the 
information overwrites or appends to the 
existing log file. You can also designate 
how much detail the log file should 
contain.

"Logging" on page 314

Mailbox 
(Exchange)/ 
Mailbox Selection 
(Domino)

Allows you to specify the mail servers 
and mailboxes containing the messages 
you want to shortcut.

"Mailbox" on page 322 or 
"Mailbox Selection" on 
page 338

Message Content Allows you to specify which messages to 
shortcut based upon the content of those 
messages, such as the subject of the 
message, filenames of any message 
attachments, sender or recipient of the 
message, or size of the message.

"Message Content" on 
page 303
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NSF Selection Allows you to choose whether to 
shortcut messages in .nsf files. If the .nsf 
files reside on the mail server, creating 
shortcuts does allow you to save space on 
the mail server.

"NSF Selection" on page 339

Profile Allows you to use a different MAPI 
profile to access the messages that you 
want to shortcut.

"Profile" on page 320

PST Selection Allows you to choose whether to 
shortcut messages in .pst files. You may 
not want to shortcut messages in .pst files 
if the .pst files are not accessible to the 
mail server. The .pst files must be 
accessible to the mail server so that you 
can restore the shortcuts, if necessary.

Note: Creating shortcuts of messages in a 
.pst file does not reduce the size of the file 
unless you compact the file after you 
create the shortcuts.

"PST Selection" on page 325

Public Folders Allows you to shortcut messages in 
public folders. Messages in both the root 
public folder and all subfolders of the 
public folder are included.

Note: All items you shortcut from public 
folders still belong to their creators and 
can only be retrieved during a search by 
the creator or administrator.

"Public Folders" on page 324

Table 34. Shortcut Task Settings

Tab Name Description/Guidelines For more information, see:
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You can configure default settings for each of these tabs using the Default Task 
Settings tab of the Configuration Options dialog box. EmailXtract saves the 
settings you configure as default settings, and automatically populates new 
tasks with the default values. This can save time if you use the same task 
settings repeatedly. However, you can change the default settings if necessary 
when you create a specific task. For more information on default task settings, 
see "Default Task Settings" on page 263.

When you finish configuring a task, you can view and manage tasks that are 
currently running or scheduled to run in the future. You can edit the task, 
delete the task if it is not currently in progress, suspend the task if it is 

Scheduling Allows you to name the Shortcut task 
and choose whether to run the task 
immediately or to schedule it to run at a 
later time. You can also configure the 
task to run on a regularly scheduled 
basis, to run until it completes, or to stop 
at a certain time. Finally, you can 
configure the task to run as a service, 
which does not require you to be logged 
in when the task is processed.

"Scheduling" on page 312

Shortcut Allows you to choose whether you are 
creating, verifying, restoring, or 
upgrading shortcuts, as well as whether 
the task will run in simulation mode. If 
you are creating shortcuts, you can also 
choose whether the shortcuts should 
appear with the term "(Archived)" at the 
beginning of each message subject title, 
and whether to take the body of each 
message out of the preview pane and 
display only the message header. You 
can also create shortcuts only for 
messages that have attachments, and 
choose whether to allow users to access 
shortcuts through OWA.

"Shortcut" on page 341

Table 34. Shortcut Task Settings

Tab Name Description/Guidelines For more information, see:
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scheduled to run in the future, force a scheduled task to run immediately, and 
stop a task that is currently in progress. For more information, see "Managing 
Scheduled Tasks" on page 347.

Once a Shortcut task is complete, you can use the EmailXtender Search Plug-in 
or the Web Search Client to search for the messages and items you shortcut. For 
more information on running a search, refer to the EmailXtender Search User’s 
Guide.

Depending on the settings you selected on the Shortcut tab, shortcut messages 
may appear with the term "(Archived)" at the beginning of each message 
subject title. In addition, only the message header may appear for shortcut 
messages; the message body may not appear in the preview pane.

The results of the Shortcut task appear in a task results window in the 
EmailXtract Administrator. The task results window displays summary server 
information about the task, task results, and the task log file.

Note: If you run the Shortcut task in simulation mode, the potential results 
appear in the task results window but no messages are actually shortcut.

You can view task results as a bar graph, stacked bar graph, or pie chart, all of 
which you can print or save as an image file for future reference. You can also 
organize chart data by message size in MB, the total number of messages, or 
the average size of messages. You can also export task results to a .csv file. For 
more information on managing task results, see "Managing Task Results" on 
page 349.

If you encounter problems once you begin creating shortcuts, see 
"Troubleshooting Shortcuts" on page 187 for more information.

Delete Task

The Delete task, available when you install EmailXtract on an EmailXtender 
server, removes messages from the mail server message store and can archive 
them to EmailXtender if they do not already exist in the EmailXtender archive. 
The Delete task is designed to assist you in managing the size of the mail server 
information store.

If you are using Microsoft Exchange, you can archive and delete messages and 
items such as appointments, tasks, and notes from mailboxes, public folders, 
and .pst files. If you are using Lotus Domino, you can archive and delete 
messages and other items from mailboxes and private .nsf mail databases. 

Before you run a Delete task to actually delete items, you can run the task in 
simulation mode to determine how many files will be deleted as a result of the 
task or how much space you can save by deleting the files.
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You configure Delete task settings using the tabs on the Deletion Task dialog 
box, which is shown in the following example:

Figure 113. Deletion Task Dialog Box
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There are some tabs that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, some that are unique to a Lotus Domino 
environment, and one tab - the Deletion tab - that only appears for the Delete 
task. The following table lists the tabs that appear, depending on whether you 
are using Microsoft Exchange or Lotus Domino.

Using the tabs in the Deletion Task dialog box, you can customize the task so 
that you delete only the messages or items you want. For example, you could 
delete only items that are:

• Older than a certain date
• Located in certain folders or mailboxes
• Larger than a certain size
• From a certain sender
• To a certain recipient
• Of a certain type, such as an email message, calendar item, or contact
• Containing certain content (keywords)

The Deletion Task dialog box also allows you to schedule the task to run at a 
certain time or even on a recurring basis. In addition, you can configure how 
EmailXtract writes task run information to a log file. 

Table 35. Deletion Task Dialog Box Tabs

If you are using Exchange, 
the following tabs appear:

If you are using Domino, 
the following tabs appear:

• Deletion
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Profile
• Mailbox
• Public Folders
• PST Selection
• Logging

• Deletion
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Mailbox Selection
• NSF Selection
• Logging
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The following table contains information about each of the tabs in the Deletion 
Task dialog box.

Table 36. Delete Task Settings

Tab Name Description/Guidelines For more information, see:

Date Settings Allows you to specify which messages to 
delete based upon the date the messages 
were either received at the mail server or 
last modified. You can specify a date or 
date range.

"Date Settings" on page 310

Deletion Allows you to choose whether to verify 
that a message has been archived to the 
EmailXtender Message Center before 
you delete the message, as well as 
whether the task will run in simulation 
mode. If you choose to verify archival 
and the Delete task encounters a message 
that has not been archived, the task 
archives the message before deleting it.

"Deletion" on page 344

Folder Settings Allows you to specify the folders from 
which EmailXtract should delete items. 
This could include the Inbox, Outbox, 
Deleted Items, Calendar, Contacts, and 
Sent Items in Exchange, or the Inbox, 
Sent, and Trash in Domino, among 
others.

"Folder Settings" on page 319 
(Exchange) or "Folder 
Settings" on page 336 
(Domino)

Item Types Allows you to specify the types of items 
to delete. This could include email 
messages, meetings, appointments, and 
reports, among others.

"Item Types" on page 316 
(Exchange) or "Item Types" on 
page 333 (Domino)

Logging Allows you to specify whether the run 
information for the task is written to a 
log file, and if so, whether the 
information overwrites or appends to the 
existing log file. You can also designate 
how much detail the log file should 
contain.

"Logging" on page 314
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Mailbox 
(Exchange)/ 
Mailbox Selection 
(Domino)

Allows you to specify the mail servers 
and mailboxes containing the messages 
you want to delete.

"Mailbox" on page 322 or 
"Mailbox Selection" on 
page 338

Message Content Allows you to specify which messages to 
delete based upon the content of those 
messages, such as the subject of the 
message, filenames of any message 
attachments, sender or recipient of the 
message, or size of the message.

"Message Content" on 
page 303

NSF Selection Allows you to delete messages from .nsf 
mail databases not locked by a Lotus 
Domino server. These mail databases 
might include mail files from people who 
have left the organization or mail 
databases that users set up on their local 
computers.

"NSF Selection" on page 339

Profile Allows you to use a different MAPI 
profile to access the messages or other 
items that you want to delete.

"Profile" on page 320

PST Selection Allows you to delete messages from .pst 
files.

"PST Selection" on page 325

Table 36. Delete Task Settings

Tab Name Description/Guidelines For more information, see:
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You can configure default settings for each of these tabs using the Default Task 
Settings tab of the Configuration Options dialog box. EmailXtract saves the 
settings you configure as default settings, and automatically populates new 
tasks with the default values. This can save time if you use the same task 
settings repeatedly. However, you can change the default settings if necessary 
when you create a specific task. For more information on default task settings, 
see "Default Task Settings" on page 263.

When you finish configuring a task, you can view and manage tasks that are 
currently running or scheduled to run in the future. You can edit the task, 
delete the task if it is not currently in progress, suspend the task if it is 
scheduled to run in the future, force a scheduled task to run immediately, and 
stop a task that is currently in progress. For more information, see "Managing 
Scheduled Tasks" on page 347.

Once a Delete task is complete, the results of the task appear in a task results 
window in the EmailXtract Administrator. The task results window displays 
summary server information about the task; task results, such as mailbox 
information (for example, messages archived, total message size, total 
mailboxes, number of duplicate messages encountered, etc.); and the task log 
file.

Note: If you run the Delete task in simulation mode, the potential results 
appear in the task results window but no messages are actually deleted.

Public Folders Allows you to delete items in public 
folders. Items in both the root public 
folder and all subfolders of the public 
folder are included.

"Public Folders" on page 324

Scheduling Allows you to name the Delete task and 
choose whether to run the task 
immediately or to schedule it to run at a 
later time. You can also configure the 
task to run on a regularly scheduled 
basis, to run until it completes, or to stop 
at a certain time. Finally, you can 
configure the task to run as a service, 
which does not require you to be logged 
in when the task is processed.

"Scheduling" on page 312

Table 36. Delete Task Settings

Tab Name Description/Guidelines For more information, see:
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You can view task results as a bar graph, stacked bar graph, or pie chart, all of 
which you can print or save as an image file for future reference. You can also 
organize chart data by message size in MB, the total number of messages, or 
the average size of messages. You can also export task results to a .csv file. For 
more information on managing task results, see "Managing Task Results" on 
page 349.

Search Task

The Search task, which is available when you install EmailXtract either on the 
mail server or on the EmailXtender server, allows you to search for messages 
or other item types, such as calendar items or contacts, on mail servers. You 
can then view the messages or delete (purge) them from the mail server’s 
message store.

If you are using Microsoft Exchange, you can search for messages and items 
such as appointments, tasks, and notes from mailboxes, public folders, and .pst 
files. If you are using Lotus Domino, you can search for messages and items 
from mailboxes and private .nsf mail databases. 

You configure Search task settings using the tabs on the Search Task dialog 
box, which is shown in the following example:

Figure 114. Search Task Dialog Box
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There are some tabs that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, and some that are unique to a Lotus 
Domino environment. The following table lists the tabs that appear, 
depending on whether you are using Microsoft Exchange or Lotus Domino.

Using the tabs in the Search Task dialog box, you can customize the task so that 
you can maximize search results. For example, you could search for items that 
are:

• Older than a certain date
• Located in certain folders or mailboxes
• Larger than a certain size
• From a certain sender
• To a certain recipient
• Of a certain type, such as an email message, calendar item, or contact
• Containing certain content (keywords)

The Search Task dialog box also allows you to schedule the task to run at a 
certain time or even on a recurring basis. In addition, you can configure how 
EmailXtract writes task run information to a log file. 

Table 37. Search Task Dialog Box Tabs

If you are using Exchange, 
the following tabs appear:

If you are using Domino, 
the following tabs appear:

• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Profile
• Mailbox
• Public Folders
• PST Selection
• Logging

• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Mailbox Selection
• NSF Selection
• Logging
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The following table contains information about each of the tabs in the Search 
Task dialog box.

Table 38. Search Task Settings

Tab Name Description/Guidelines For more information, see:

Date Settings Allows you to search for messages based 
upon the date the messages were either 
received at the mail server or last 
modified. You can specify a date or date 
range.

"Date Settings" on page 310

Folder Settings Allows you to specify the folders in 
which EmailXtract should search for 
items. This could include the Inbox, 
Outbox, Deleted Items, Calendar, 
Contacts, and Sent Items in Exchange, or 
the Inbox, Sent, and Trash in Domino, 
among others.

"Folder Settings" on page 319 
(Exchange) or "Folder 
Settings" on page 336 
(Domino)

Item Types Allows you to specify the types of items 
to search for. This could include email 
messages, meetings, appointments, and 
reports, among others.

"Item Types" on page 316 
(Exchange) or "Item Types" on 
page 333 (Domino)

Logging Allows you to specify whether the run 
information for the task is written to a 
log file, and if so, whether the 
information overwrites or appends to the 
existing log file. You can also designate 
how much detail the log file should 
contain.

"Logging" on page 314

Mailbox 
(Exchange)/ 
Mailbox Selection 
(Domino)

Allows you to specify the mail servers 
and mailboxes containing the messages 
you want to search for.

"Mailbox" on page 322 or 
"Mailbox Selection" on 
page 338
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Message Content Allows you to specify which messages to 
search for based upon the content of 
those messages, such as the subject of the 
message, filenames of any message 
attachments, sender or recipient of the 
message, or size of the message. You can 
also set the maximum number of search 
results EmailXtract should return.

"Message Content" on 
page 303

NSF Selection Allows you to search for messages in .nsf 
mail databases not locked by a Lotus 
Domino server. These mail databases 
might include mail files from people who 
have left the organization or mail 
databases that users set up on their local 
computers.

"NSF Selection" on page 339

Profile Allows you to use a different MAPI 
profile to access the messages or other 
items that you want to search for.

"Profile" on page 320

PST Selection Allows you to search for messages in .pst 
files.

"PST Selection" on page 325

Public Folders Allows you to search for items in public 
folders. Items in both the root public 
folder and all subfolders of the public 
folder are included.

"Public Folders" on page 324

Scheduling Allows you to name the Search task and 
choose whether to run the task 
immediately or to schedule it to run at a 
later time. You can also configure the 
task to run on a regularly scheduled 
basis, to run until it completes, or to stop 
at a certain time. Finally, you can 
configure the task to run as a service, 
which does not require you to be logged 
in when the task is processed.

"Scheduling" on page 312

Table 38. Search Task Settings

Tab Name Description/Guidelines For more information, see:
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You can configure default settings for each of these tabs using the Default Task 
Settings tab of the Configuration Options dialog box. EmailXtract saves the 
settings you configure as default settings, and automatically populates new 
tasks with the default values. This can save time if you use the same task 
settings repeatedly. However, you can change the default settings if necessary 
when you create a specific task. For more information on default task settings, 
see "Default Task Settings" on page 263.

When you finish configuring a task, you can view and manage tasks that are 
currently running or scheduled to run in the future. You can edit the task, 
delete the task if it is not currently in progress, suspend the task if it is 
scheduled to run in the future, force a scheduled task to run immediately, and 
stop a task that is currently in progress. For more information, see "Managing 
Scheduled Tasks" on page 347.

Once a Search task is complete, the results of the task appear in a task results 
window in the EmailXtract Administrator. You can purge items that appear in 
the results list from the mail server message store. You can also view those 
items or remove them from the search results for easier viewing. In addition, 
you can export task results to a .csv file. For more information on managing 
task results, see "Managing Task Results" on page 349.

Analysis Task

The Analysis task, which is available when you install EmailXtract either on 
the mail server or on the EmailXtender server, allows you to evaluate the 
contents of mail servers to determine average message size, total message 
count, attachment information, and aging of messages. The data you collect 
using an Analysis task can help you decide how to manage the mail server 
message store. For example, you may determine that you have a large number 
of messages with attachments, so you might want to create shortcuts for those 
messages.

If you are using Microsoft Exchange, you can analyze data for messages and 
items such as appointments, tasks, and notes from mailboxes, public folders, 
and .pst files. If you are using Lotus Domino, you can analyze data for 
messages and items from mailboxes and private .nsf mail databases. 

You can view either a summary or detailed analysis of information. 

• The summary analysis contains approximate information about the 
current size of the mailbox and the number of messages it contains. 
EmailXtract does not open and enumerate individual folders and 
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messages, and no filtering of the messages is performed as part of the 
analysis, regardless of what is specified on the other tabs of the Analysis 
task dialog box.

• A detailed analysis charts mailbox and server size information, and 
provides a thorough and accurate analysis of email age or attachment size 
and type. This analysis is based on the criteria configured on the other 
tabs of the Analysis task dialog box.

You can also choose whether to collect information about attachments, such as 
the number of attachments and their size, or the file types of the attachments.

You configure Analysis task settings using the tabs on the Analysis Task 
dialog box, which is shown in the following example:

Figure 115. Analysis Task Dialog Box
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There are some tabs that are global for all tasks, some that are unique to a 
Microsoft Exchange environment, some that are unique to a Lotus Domino 
environment, and one tab - the Analysis Settings tab - that only appears for the 
Analysis task. The following table lists the tabs that appear, depending on 
whether you are using Microsoft Exchange or Lotus Domino.

Using the tabs in the Analysis Task dialog box, you can customize the task so 
that you analyze only the messages or items you want. For example, you could 
collect data for items that are:

• Older than a certain date
• Located in certain folders or mailboxes
• Larger than a certain size
• From a certain sender
• To a certain recipient
• Of a certain type, such as an email message, calendar item, or contact
• Containing certain content (keywords)

The Analysis Task dialog box also allows you to schedule the task to run at a 
certain time or even on a recurring basis. In addition, you can configure how 
EmailXtract writes task run information to a log file.

Table 39. Analysis Task Dialog Box Tabs

If you are using Exchange, 
the following tabs appear:

If you are using Domino, 
the following tabs appear:

• Analysis Settings
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Profile
• Mailbox
• Public Folders
• PST Selection
• Logging

• Analysis Settings
• Message Content
• Date Settings
• Item Types
• Folder Settings
• Scheduling
• Mailbox Selection
• NSF Selection
• Logging
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The following table contains information about each of the tabs in the Analysis 
Task dialog box.

Table 40. Analysis Task Settings

Tab Name Description/Guidelines For more information, see:

Analysis Settings Allows you to choose whether you want 
to view a summary or detailed report, as 
well as whether you want to view 
information by each quarter of the year. 
You can also choose whether to view 
information about attachments, such as 
the number of attachments and their 
size, or the file types of the attachments.

"Analysis Settings" on 
page 346

Date Settings Allows you to specify which messages to 
analyze based upon the date the 
messages were either received at the mail 
server or last modified. You can specify a 
date or date range.

"Date Settings" on page 310

Folder Settings Allows you to specify the folders from 
which EmailXtract should analyze items. 
This could include the Inbox, Outbox, 
Deleted Items, Calendar, Contacts, and 
Sent Items in Exchange, or the Inbox, 
Sent, and Trash in Domino, among 
others.

"Folder Settings" on page 319 
(Exchange) or "Folder 
Settings" on page 336 
(Domino)

Item Types Allows you to specify the types of items 
to analyze. This could include email 
messages, meetings, appointments, and 
reports, among others.

"Item Types" on page 316 
(Exchange) or "Item Types" on 
page 333 (Domino)

Logging Allows you to specify whether the run 
information for the task is written to a 
log file, and if so, whether the 
information overwrites or appends to the 
existing log file. You can also designate 
how much detail the log file should 
contain.

"Logging" on page 314
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Mailbox 
(Exchange)/ 
Mailbox Selection 
(Domino)

Allows you to specify the mail servers 
and mailboxes containing the messages 
you want to analyze.

"Mailbox" on page 322 or 
"Mailbox Selection" on 
page 338

Message Content Allows you to specify which messages to 
analyze based upon the content of those 
messages, such as the subject of the 
message, filenames of any message 
attachments, sender or recipient of the 
message, or size of the message.

"Message Content" on 
page 303

NSF Selection Allows you to analyze messages from 
.nsf mail databases not locked by a Lotus 
Domino server. These mail databases 
might include mail files from people who 
have left the organization or mail 
databases that users set up on their local 
computers.

"NSF Selection" on page 339

Profile Allows you to use a different MAPI 
profile to access the messages or other 
items that you want to analyze.

"Profile" on page 320

PST Selection Allows you to analyze messages from 
.pst files.

"PST Selection" on page 325

Table 40. Analysis Task Settings

Tab Name Description/Guidelines For more information, see:
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You can configure default settings for each of these tabs using the Default Task 
Settings tab of the Configuration Options dialog box. EmailXtract saves the 
settings you configure as default settings, and automatically populates new 
tasks with the default values. This can save time if you use the same task 
settings repeatedly. However, you can change the default settings if necessary 
when you create a specific task. For more information on default task settings, 
see "Default Task Settings" on page 263.

When you finish configuring a task, you can view and manage tasks that are 
currently running or scheduled to run in the future. You can edit the task, 
delete the task if it is not currently in progress, suspend the task if it is 
scheduled to run in the future, force a scheduled task to run immediately, and 
stop a task that is currently in progress. For more information, see "Managing 
Scheduled Tasks" on page 347.

Once an Analysis task is complete, the results of the task appear in a task 
results window in the EmailXtract Administrator. The task results window 
displays summary server information about the task; task results, such as 

Public Folders Allows you to analyze items in public 
folders. Items in both the root public 
folder and all subfolders of the public 
folder are included.

Note: All items you analyze from public 
folders still belong to their creators and 
can only be retrieved during a search by 
the creator or administrator.

"Public Folders" on page 324

Scheduling Allows you to name the Analysis task 
and choose whether to run the task 
immediately or to schedule it to run at a 
later time. You can also configure the 
task to run on a regularly scheduled 
basis, to run until it completes, or to stop 
at a certain time. Finally, you can 
configure the task to run as a service, 
which does not require you to be logged 
in when the task is processed.

"Scheduling" on page 312

Table 40. Analysis Task Settings

Tab Name Description/Guidelines For more information, see:
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mailbox information (for example, messages analyzed, total message size, 
total mailboxes, number of duplicate messages encountered, etc.); and the task 
log file.

You can view task results as a bar graph, stacked bar graph, or pie chart, all of 
which you can print or save as an image file for future reference. You can also 
organize chart data by message size in MB, the total number of messages, or 
the average size of messages. If you choose the Complete Mailbox Analysis 
option as well as either the Attachment info totals or the Attachment type 
information option, you can display task results for the attachments in a 
separate chart. You can also export task results to a .csv file. For more 
information on managing task results, see "Managing Task Results" on 
page 349.

Configuring Tasks
The way you manage the mail server message store in EmailXtract is by setting 
up tasks. There are five types of tasks: Archive, Shortcut, Delete, Search, and 
Analysis. 

When you install EmailXtract on the EmailXtender server, you can run any of 
these tasks. When you install EmailXtract on the mail server, however, you can 
only run the Search and Analysis tasks.

All tasks are based on a set of default settings that you configure using the 
Default Task Settings tab of the Configuration Options dialog box. EmailXtract 
saves the settings you configure as default settings, and automatically 
populates new tasks with the default values. This can save time if you use the 
same task settings repeatedly. However, you can change the default settings if 
necessary when you create a specific task. For more information on default 
task settings, see "Default Task Settings" on page 263.

You configure task settings using the tabs on each task’s dialog box, as shown 
in the following example:
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Figure 116. Sample Task Dialog Box

To open the task dialog box for each task:

Table 41. Task Configuration Options

To configure 
this task:

Select this 
toolbar icon:

Or use this menu 
combination:

Archive Tasks>Archive Email

Shortcut Tasks>Shortcut Email

Delete Tasks>Delete Email
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There are some settings/tabs that are global for all tasks, some that are unique 
to a Microsoft Exchange environment, some that are unique to a Lotus Domino 
environment, and some that are unique to the type of task. 

The following table lists the tabs that appear for each task (global tabs appear 
for all tasks, regardless of the mail environment, Exchange-only tabs appear 
for all tasks in a Microsoft Exchange environment, Domino-only tabs appear 
for all tasks in a Lotus Domino environment, and task-specific tabs appear 
only for the related task).

*The Folder Settings and Item Types tabs contain different options depending 
on the mail environment you are using.

For detailed information on the task settings you can configure on each of the 
tabs, see the following sections:

• "Global Task Settings" on page 303
• "Task Settings for Microsoft Exchange" on page 316
• "Task Settings for Lotus Domino" on page 333
• "Task-Specific Settings" on page 340

Search Tasks>Search Email

Analysis Tasks>Analyze Message 
Store

Table 42. Task Setting Tabs

Global Tabs Exchange-Only Tabs Domino-Only Tabs Task-Specific Tabs

• Message Content
• Date Settings
• Scheduling
• Logging

• Item Types*
• Folder Settings*
• Profile
• Mailbox
• Public Folders
• PST Selection

• Item Types*
• Folder Settings*
• Mailbox Selection
• NSF Selection

• Shortcut
• Deletion
• Analysis Settings

Table 41. Task Configuration Options

To configure 
this task:

Select this 
toolbar icon:

Or use this menu 
combination:
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Global Task Settings

You must configure the same options on the Message Content, Date Settings, 
Item Types, Scheduling, and Logging tabs regardless of the task you want to 
run. For more information, see the following sections:

• "Message Content" on page 303
• "Date Settings" on page 310
• "Scheduling" on page 312
• "Logging" on page 314

Message Content

The Message Content tab allows you to specify which messages to process in 
an EmailXtract task based upon the content of those messages. You can select 
messages using the following content types:

• Subject of the message
• Filenames of any message attachments
• Sender or recipient of the message
• Size of the message
• Whether the message has been read
• Sensitivity (Exchange) or Mood (Domino) of the message

If you are using Microsoft Exchange, you can also apply the task to messages 
that are identified as Deleted Retention Items. Such messages exist only when 
the Exchange server is set to retain deleted items.

Important: When you specify these criteria, it is important to note that the task 
processes only those messages that match all specified criteria and not just 
some of those criteria. 

The Message Content tab appears slightly different in a Microsoft Exchange 
environment than it does in a Lotus Domino environment. In a Microsoft 
Exchange environment, you can choose the Sensitivity of a message, as well as 
whether to apply the task to Deleted Retention Items. 
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Figure 117. Message Content Tab for Microsoft Exchange

In Lotus Domino, you choose the Mood of a message instead.

Figure 118. Message Content Tab for Lotus Domino
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To configure message content criteria for a task: 

1. In the Subject text box, enter the subject line for the message. You can 
construct detailed Subject queries using wildcards and Boolean operators. 
For more information, see "Special Characters" on page 308 and "Boolean 
Queries" on page 309. 

Before you create a Subject query, however, it is helpful to understand how 
EmailXtract processes the query. For more information, see "Subject Field 
Processing" on page 307.
If you are applying the task to messages that use multi-byte languages 
(such as Japanese or Simplified Chinese), do not use multi-byte characters 
in the Subject text box. If you use multi-byte characters, EmailXtract will 
complete the task without errors, but the matching word requirements 
will be ignored.

2. In the Attachments text box, enter the name of the attachment. 

• Wildcards - You can use the asterisk (*) or question mark (?) 
characters as wildcards in the attachment filename. For more 
information on using wildcards, see "Special Characters" on page 308.

• Boolean queries - You cannot use logical operators such as AND, OR, 
NOT, and parentheses in a query in the From text box.

• Multiple entries - To enter multiple attachments, separate the 
filenames with semicolons. The task processes messages containing 
any of the listed attachments. 

If you are applying the task to messages that use multi-byte languages 
(such as Japanese or Simplified Chinese), do not use multi-byte characters 
in the Attachments text box. If you use multi-byte characters, EmailXtract 
will complete the task without errors, but the matching word 
requirements will be ignored.

3. In the From text box, enter the email address of the person or the name of 
the group or distribution list that sent the message. To select a name or 
address from an address book, click From.

• Groups/distribution lists - If you enter the name of a group or 
distribution list, the task processes all messages that were sent from 
the group or distribution list as well as all messages that were sent 
from the individuals that belong to the group or distribution list.

• Wildcards - You can use the asterisk (*) or question mark (?) 
characters as wildcards in the email address or group/distribution 
list name. For more information on using wildcards, see "Special 
Characters" on page 308.
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• Boolean queries - You cannot use logical operators such as AND, OR, 
NOT, and parentheses in a query in the From text box.

• Multiple entries - To enter multiple senders, separate the email 
addresses, group names, or distribution list names with semicolons. 
You can also select multiple senders from the address book when you 
click From.

4. In the Sent to text box, enter the email address of the person or the name 
of the group or distribution list that received the message. To select a name 
or address from an address book, click Sent to.

• Groups/distribution lists - If you enter the name of a group or 
distribution list, the task processes all messages that were received by 
the group or distribution list as well as all messages that were 
received by the individuals that belong to the group or distribution 
list.

• Wildcards - You can use the asterisk (*) or question mark (?) 
characters as wildcards in the email address or group/distribution 
list name. For more information on using wildcards, see "Special 
Characters" on page 308.

• Boolean queries - You cannot use logical operators such as AND, OR, 
NOT, and parentheses in a query in the Sent to text box.

• Multiple entries - To enter multiple recipients, separate the email 
addresses, group names, or distribution list names with semicolons. 
You can also select multiple recipients from the address book when 
you click Sent to.

5. In the Greater than text box, enter the message size in KB that a message 
must be greater than or equal to in order to be processed by the task. If you 
enter zero, the task processes messages of all sizes.

6. If you are configuring a Search task, in the Max Search Hits text box, enter 
the maximum number of search results the task should return. To return 
all messages that match the search criteria, enter zero.

7. Choose whether to include Read and Unread items in the task.

• To include only items that have been read, select the Read check box 
and clear the Unread check box.

• To include only items that have not yet been read, clear the Read 
check box and select the Unread check box.

• To include both Read and Unread items (all messages), select both the 
Read and Unread check boxes.
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Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any items.

8. Choose the Sensitivity or Mood selection that the message must match.

• If you are using Microsoft Exchange, choose the Sensitivity setting, 
such as Normal, Personal, Private, or Confidential.

• If you are using Lotus Domino, choose the Mood setting, such as 
Normal, Joke, Reminder, Question, or Thank You.

• To process messages regardless of their Sensitivity or Mood, select all 
check boxes.

Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any items.

9. If you are using Microsoft Exchange, choose whether to include deleted 
items that have been retained. Such messages exist only when the 
Exchange server is set to retain deleted items. 

Note: This check box is not available for the Shortcut task.

Subject Field Processing

To understand how to construct a Subject field query, you need to understand 
how the query is processed.

1. The query is separated into terms. A term is one or more characters that is 
bounded by two delimiters. 

2. The delimiters of the terms are discarded. Term delimiters include the 
following characters:

• Space, tab, line feed, or return
• Backslash (\)
• Comma (,)
• Colon ( : )
• Semicolon ( ; )
• Quotation mark ( " )
• Apostrophe ( ' )
• Period ( . )
• Exclamation point ( ! ) 
• Question mark ( ? )
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Note: Each of these delimiters may themselves be searched for as terms, if 
they are themselves delimited. For example, the exclamation point and 
semicolon characters would be the terms in the following query because 
the exclamation point is delimited by two commas and the semicolon is 
delimited by a comma and a space: ,!,; 

For example, in the following query string:
Re: EmailXtender \temp directory

The colon (:), backslash (\), and spaces would be discarded, and the 
following terms would be processed: 
• Re

• EmailXtender

• temp

• directory

3. The terms are used to match text in the appropriate field. All terms in the 
search query must be present in the results returned; however, they can be 
in any order and do not need to be adjacent.

Special Characters

There are several special characters that allow you to override the default 
processing of terms in a search query.
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You can use question marks and asterisks as wildcards in the Subject, 
Attachments, From, and Sent to text boxes on the Message Content tab. You 
can also use a bounded string to search for a certain text string. 

Boolean Queries

You can use the AND, OR, and NOT logical operators as well as parentheses 
to construct a Boolean query in the Subject text box on the Message Content 
tab. 

Note: You cannot search for logical operators themselves. 

Table 43. Special Characters in an Advanced Search

Special 
Character Description

Question mark 
(?)

Matches any single character. 

Note: You cannot search for the question mark character 
itself because it is a wildcard character. 

Example: Enter the following in the Attachments text box 
to return messages with an attachment that has a filename 
of trades.doc, trades.zip, trades.xls, etc.: trades.???

Asterisk (*) Matches zero or more characters. When used alone in a 
query, it matches everything. When used in combination 
with other characters, it matches the terms that contain it. 

Example: Enter the following in the From text box to 
return messages that were sent by John Smith, John 
Smyth, John Smooth, etc.: john.sm*th@domain.com

Bounded String A collection of characters within either single or double 
quotes. Any text within the string is treated literally. The 
same type of quote must be used on both sides of the 
string.

Example: Enter the following in the Subject text box to 
return messages with the phrase "cats and dogs" in the 
Subject line: ’cats and dogs‘ 

Note: In this example, the word "and" would be treated as 
a term to be searched for and not as a logical operator for a 
Boolean query.
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The following table describes how to use these logical operators:

Date Settings

The Date Settings tab allows you to specify which messages to process based 
upon the date the messages were either received at the mail server or last 
modified. You can specify a date or date range.

Table 44. Using Logical Operators in the Subject Field

Operator Specifies that

AND Finds messages that include all terms separated by the 
operator. 

Example: Enter the following to return messages with a 
subject line that includes the word "Buy" and the word 
"Sell" but not messages that include only "Buy" or only 
"Sell": Buy AND Sell

OR Finds messages that include either or both of the terms 
separated by the operator. 

Example: Enter the following to return messages with a 
subject line that includes the word "Buy", the word "Sell", 
or both "Buy" and "Sell": Buy OR Sell.

NOT Finds messages that do not include the term that follows 
the operator. 

Example: Enter the following to return messages with a 
subject line that includes the word "Buy" but not the word 
"Sell": Buy NOT Sell.

( ) Allows you to group portions of a search expression. 

Example: Enter the following to return messages with a 
subject line that includes the word "Buy" but not the word 
"Sell": Buy AND (NOT Sell)
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Figure 119. Date Settings Tab

To configure date settings criteria for a task:

1. In the Based Upon region at the bottom of the tab, choose whether the date 
settings should consider the date the message was received at the mail 
server or the date the message was last modified. (A modified message is 
a new instance of a message.)

Note: To process both original and modified messages, you must run two 
tasks - one based on the received date and the other based on the modified 
date.

2. In the Date Matching Parameters region, choose the age or date range for 
the message. 

• Messages older than - To process messages that are older than a 
certain number of days, select Messages older than and then enter the 
number of days as a whole number in the text box.
Example: If today is December 20 and you enter 2 as the number of 
days, EmailXtract processes messages that were either received or 
modified before December 18.

• Messages newer than - To process messages that are newer than a 
certain number of days, select Messages newer than and then enter 
the number of days as a whole number in the text box.
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Example: If today is December 20 and you enter 2 as the number of 
days, EmailXtract processes messages that were either received or 
modified after December 18.

• Use exact date range - To process messages that fall within a certain 
date range, select Use exact date range, select an operator, and then 
enter the date(s).
– Since - To process all messages that have been received or 

modified since a certain date, select Since and then enter a single 
date.

– Before - To process all messages that were received or modified 
prior to a certain date, select Before and then enter a single date.

– Between - To process all messages that were received or modified 
during a certain date range (including on the specified dates), 
select Between and then enter a start and end date.

• Use all dates - To process all messages regardless of the date they 
were received or modified, select Use all dates.

Scheduling

The Scheduling tab allows you to choose whether to run the task immediately 
or to schedule it to run at a later date. You can also configure the task to run on 
a regularly scheduled basis, to run until it completes, or to stop at a certain 
time. Finally, you can configure the task to run as a service, which does not 
require you to be logged in when the task is processed.

It can be useful to stop a task at a certain time if you do not want the task to 
impact other processes. For example, you may want to set up a regularly 
occurring Archive task to run overnight when system usage is at its lowest. If 
the task does not finish processing before most users arrive and begin using 
the system, however, you can configure the task to stop so that it does not 
provide a visible performance impact. 
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Figure 120. Scheduling Tab

To schedule a task:

1. In the Task Name text box, enter a unique name for the task. When you 
add a new task, EmailXtract automatically generates a task name such as 
as Task9999, where 9999 is a generated incremental number. You can either 
use the automatically generated name or enter a descriptive name for the 
task.

Note: When you configure default task settings, the Task Name text box is 
dimmed.

2. In the Task Frequency region, choose the frequency with which you want 
the task to repeat.

• Manual Task - Select Manual Task to run the task manually. To run a 
task manually, open the Scheduled Tasks dialog box (from the Option 
menu, select Scheduled Tasks), select the task, and then click Force 
Run.

• One-Time Task - Select One-Time Task to run the task once, starting 
at the time you designate in the Task Run Time region.

• Recurring Daily Task - Select Recurring Daily Task to run the task 
every day starting at the time you designate in the Task Run Time 
region.
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• Recurring Weekly Task - Select Recurring Weekly Task to run the 
task every week. Then, from the drop-down list, choose the day of the 
week on which you want the task to run. 

• Recurring Monthly Task - Select Recurring Monthly Task to run the 
task every month. Then, in the text box, enter the day of the month on 
which you want the task to run.

3. In the Task Frequency region, choose whether to run the task as a service. 
Running a task as a service allows you to exit EmailXtract Administrator 
and log out of the system. The task will process unattended according to 
the configured settings.

4. In the Task Run Time region, choose whether to start the task immediately 
or to start the task later.

• To run the task immediately, select Run Task Now.
• To run the task later, select Start Task At, and then enter the time in 

text box. 

5. Choose whether to allow the task to run until it is complete or to stop the 
task at a certain time.

• To allow the task to run until it is complete, select Run Until 
Complete.

• To stop the task at a certain time, select Stop Task At, and then enter 
the time in the text box. 

Logging

The Logging tab allows you to specify whether the run information for the task 
is written to a log file, and if so, whether the information overwrites or 
appends to the existing log file. You can also designate how much detail the 
log file should contain for the task.

If you are using Lotus Domino, you can choose whether to write all error 
messages to a log file instead of displaying the error messages and stopping 
the application.

Note: EmailXtract log files cannot display multi-byte characters (such as 
Japanese or Simplified Chinese characters). These characters appear in the log 
file as question marks (?).
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Figure 121. Logging Tab

To configure logging for a task:

1. In the Log Enabling region, choose whether to write events to a log file.

• To write events to a log file, select the Log Events to File check box.
• To disable logging for the task, clear the Log Events to File check box. 

If you disable logging, all of the other options on the Logging tab are 
dimmed.

2. If you chose to write events to a log file, choose whether to overwrite the 
existing log file or to append the new events to the existing log file. This 
option is useful when configuring recurring tasks; one-time tasks always 
produce a new log file as long as the task name is unique.

• To replace the previous log file with the current log file for recurring 
tasks, select Overwrite existing log file.

• To add the current log events to the existing file when running a 
recurring task, select Append to existing log file. 

3. In the Log Message Level region, choose the amount of information to 
include in the log file. 

• To write only serious server errors to the log file, select Severe Errors 
Only. 
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• To write server summary information to the log file, select Server 
Summary. 

• To write mailbox summary information to the log file, select Mailbox 
Summary. 

Note: Choosing a summary option decreases the size of log files and 
reduces the amount of time needed to process the task. 

• To write a detailed log of the number of messages processed by the 
task, as well as a summary of totals for each mail server, select 
Message Detail. This option also logs severe server errors.

4. If you are using Lotus Domino, choose whether to write all error messages 
to a log file instead of displaying them and stopping the application, if 
applicable. 

• To write error messages to a log file, select the Suppress Notes Errors 
to Log File check box.

• To display error messages and stop the application, clear the 
Suppress Notes Errors to Log File check box.

Task Settings for Microsoft Exchange

If you are using Microsoft Exchange, you must configure the same options on 
the Folder Settings, Profile, Mailbox, Public Folders, and PST Selection tabs 
regardless of the task you want to run. For more information, see the following 
sections:

• "Item Types" on page 316
• "Folder Settings" on page 319
• "Profile" on page 320
• "Mailbox" on page 322
• "Public Folders" on page 324
• "PST Selection" on page 325

Item Types

The Item Types tab allows you to specify the types of items - such as email 
messages, meetings, appointments, and reports - to process in an EmailXtract 
task. 

The Item Types tab is available for all tasks except the Shortcut task, since only 
email messages may contain shortcuts.
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Note: If you are configuring a Delete task and you select the Create Shortcuts 
option on the Deletion tab, the Item Types tab is dimmed. For more 
information on the Deletion tab, see "Deletion" on page 344.

You must coordinate the item types you select on the Item Types tab with the 
folders you select on the Folder Settings tab. For example, if you want to 
process appointments that reside in the Calendar folder, you must select the 
Appointments check box on the Item Types tab and the Calendar check box on 
the Folder Settings tab. For more information on selecting folder settings 
criteria, see "Folder Settings" on page 336.

In addition, if you want to apply the task to item types in public folders or .pst 
files, you should specify folders or files using the Public Folders and PST 
Selection tabs, respectively. For more information, see "Public Folders" on 
page 324 and "PST Selection" on page 325.

Figure 122. Item Types Tab for Microsoft Exchange
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The item types listed in the following table appear on the Item Types tab when 
you are using Microsoft Exchange. This table also lists the message class for 
each item type to allow you to better identify each item type.

To configure item types criteria for a task:

• On the Item Types tab, choose the item types you want to include in the 
task.
– To include an item type, select the check box for the item type.

Table 45. Microsoft Exchange Item Types

Item Type Description Message Class

Meetings All meeting request messages ipm.schedule

Appointments All Calendar folder entries or 
meeting request messages

ipm.appointment

Journal Entries All Journal folder entries ipm.activity

Sticky Notes All Notes folder entries ipm.stickynote

Posted Messages All messages posted to a public 
folder

ipm.post

Other Any entry that is not one of the other 
standard types, or derived from one 
of the standard types; for example, a 
distribution list entry or a custom 
document type

Not applicable

Email Messages All email messages ipm.note

Tasks All task entries ipm.task

Contacts All contact items ipm.contact

Reports All reports, such as read receipt and 
delivery reports

report.ipm.note

Files All documents in a folder

Note: Documents do not include 
attachments to a message; they are 
simply standalone documents

ipm.document
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– To exclude an item type, clear the check box for the item type.
– To include all item types, click Select All.
– To clear all of the selected item types at once, click Clear All.

Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any items.

Folder Settings

The Folder Settings tab allows you to specify which folders - such as the Inbox, 
Outbox, Deleted Items, and Sent Items - EmailXtract should include in the 
task. You can also include the Calendar, Contacts, Journal, and Notes folders 
in the task.

Figure 123. Folder Settings Tab for Microsoft Exchange

Each of the folders that are listed, except for User Defined Folders, correspond 
to a folder in the Microsoft Outlook mail client.

You should consider the following guidelines when selecting folders:

• Deleted Items - If you are configuring an Archive task, you may want to 
clear the Deleted Items check box so that you do not archive deleted 
items.
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• User Defined Folders - This option allows you to apply the task to 
user-created folders. If the user-created folders reside within other 
folders, such as the Inbox, you must select both the Inbox and User 
Defined Folders check boxes. If the user-created folders are located at the 
top level of the mailbox, similar to the Inbox or Sent Items folders, you 
only need to select the User Defined Folders check box.

• Coordinating with item type selections - You must coordinate the 
folders you select on the Folder Settings tab with the item types you select 
on the Item Types tab. For example, if you want to process appointments 
that reside in the Calendar folder, you must select the Appointments 
check box on the Item Types tab and the Calendar check box on the 
Folder Settings tab. For more information on selecting item types, see 
"Item Types" on page 316.

• Public folders and .pst files - If you want to apply the task to public 
folders or .pst files, you should specify folders or files using the Public 
Folders and PST Selection tabs, respectively. For more information, see 
"Public Folders" on page 324 and "PST Selection" on page 325.

To configure folder settings criteria for a task:

• On the Folder Settings tab, choose the folders you want to include in the 
task.
– To include a folder, select the check box for the folder.
– To exclude a folder, clear the check box for the folder.
– To include all folders, click Select All.
– To clear all of the selected folders at once, click Clear All.

Note: If you are configuring a Shortcut task, the Calendar, Contacts, 
Journal, and Notes check boxes are dimmed. You cannot apply a Shortcut 
task to these folders.

Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any folders.

Profile

The Profile tab allows you to set a different MAPI profile for access to 
messages or other items that you want to process using the task and to enable 
the use of HTTPS or Forms Authentication to connect to Outlook Web Access 
(OWA). 
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Figure 124. Profile Tab

The Profile tab displays the default MAPI profile that you specified either 
when you opened the EmailXtract Administrator the first time or when you 
configured EmailXtract options on the Configuration Options dialog box. For 
more information, see "Starting the Administrator" on page 258 and "Profile" 
on page 266. 

Note: Administrative access rights to an Exchange server are based upon the 
privileges associated with the Windows user account being used, and not with 
the MAPI profile being used. In general, the MAPI profile is used to provide 
access to address books and a listing of available Exchange servers.

Note: If you are applying EmailXtract tasks to messages that use multi-byte 
character sets (such as Japanese and Simplified Chinese) and you want to 
change the MAPI profile that EmailXtract uses, you must first delete the 
language journaling profiles that EmailXtract creates automatically. To delete 
the profile, right-click the Microsoft Outlook icon on the desktop of the 
EmailXtender server, and then select Properties from the shortcut menu. On 
the Service tab, click Show Profiles. On the General tab of the Mail dialog box, 
select all of the exExtract-language-codepage profiles (where language is the name 
of the language and codepage is the codepage number), and then click Remove. 
You can then change the profile.
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To configure the Profile tab:

1. Make sure that the selected profile has the proper privileges. If the profile 
is going to be used to archive, shortcut, or delete items from public folders, 
make sure it has sufficient permissions to access all selected folders.

a. To change the profile, click New Profile. A list of MAPI profiles that 
have been set up locally appears.

b. Select the profile you want to use as the MAPI default and click OK. 

2. Choose whether to enable the use of the HTTPS (HTTP over SSL) protocol 
or forms-based authentication between EmailXtender, Exchange, and 
Outlook Web Access (OWA). 

• To use HTTPS, select the Use HTTPS to connect to Exchange OWA 
check box. Once this option is selected, you can only access Exchange 
servers that are using the SSL (Secure Socket Layer) to connect to 
OWA. If the option is not selected, only non-SSL servers can be used.

• To enable the use of forms-based authentication, select the Use Forms 
Authentication option and then enter the user name (including 
domain) and password of the EmailXtender service account.
(When you select the Use Forms Authentication option, the Use 
HTTPS to connect to Exchange OWA option is automatically selected 
as well.)

3. Click OK. 

Mailbox

The Mailbox tab allows you to specify the mail servers and mailboxes from 
which the task processes messages. 
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Figure 125. Mailbox Tab

To select mail servers and mailboxes for the task:

1. In the Exchange Servers list box, choose the Exchange servers from which 
the task will process messages. You must select at least one server.

• To process messages from a server, select the check box column for 
the server.

• To exclude a server from the task, clear the check box column for the 
server.

2. To confirm that the MAPI profile you selected on the Profile tab has the 
proper privileges on the selected servers, click Test Admin. For more 
information on selecting a profile, see "Profile" on page 320.

3. Choose the mailboxes on the selected servers that you want to include in 
the task.

• To process all mailboxes on the selected mail servers, select All 
Mailboxes from the drop-down list.

• To select email addresses or distribution lists from the address book, 
select User or Group Name from the drop-down list and then click 
Address Book to select the names.

• To manually enter an email address or distribution list name, select 
Enter User or Group from the drop-down list and then enter the 
name in the text box.
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Note: When specifying a distribution list for a task, the distribution list 
name cannot include the equals sign (=). Specifying a distribution list 
name containing that character, such as =Benefits= , will result in the 
task not being performed.

4. If you selected the User or Group Name option from the drop-down list 
and you want to exclude a particular email address or distribution list 
from the task, select the Exclude Names in List check box and then enter 
the name in the text box. 

Public Folders

The Public Folders tab allows you to include items in public folders in the task. 
Items in both the root public folder and all subfolders of the public folder are 
included.

Figure 126. Public Folders Tab

Note: The items in the public folder that are processed by the task depend on 
the item types selected on the Item Types tab. For more information, see "Item 
Types" on page 316.

Note: If you are running an Archive or Shortcut task, keep in mind that all 
items in the public folders that are processed by the task still belong to their 
creators and can only be retrieved during a search by the creator or 
administrator.
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Note: In order for public folders to work correctly with EmailXtract and 
EmailXtender, the EmailXtender service account must be set as an owner for 
those public folders that are accessed by the programs.

To include public folders in the task:

1. Add all public folders you want the task to process.

a. Click Add Folders. The existing public folders appear in the Choose 
Public Folder dialog box. 

b. Select a folder and then click OK. The public folder is listed in the 
Folder Selection list box with a check mark in the leftmost column.

Note: If you are applying the task to messages that use multi-byte 
languages (such as Japanese or Simplified Chinese), do not select a public 
folder with a name that uses multi-byte characters. You can, however, 
select a public folder with a name that does not use multi-byte characters, 
and EmailXtract will apply the task to multi-byte language messages 
within that public folder.

2. Remove all public folders you do not want the task to process. 

3. Click Test Admin to verify that the profile you specified on the Profile tab 
has access to the selected folders. If access is allowed, the Admin column 
displays a value of Yes for each folder. For more information on selecting 
a profile, see "Profile" on page 320.

PST Selection

PST files that exist on end user machines or in other locations can represent 
challenges for companies that want to be able to ensure that items associated 
with Outlook users are archived in EmailXtender. You can use EmailXtract to 
find and select .pst files across the network and archive them in EmailXtender. 
This renders existing messages that are migrated to the EmailXtender archive 
accessible to search, restore, and delete features included in EmailXtender.
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Figure 127. PST Selection Tab

Using the PST Selection tab, you can perform the following actions:

• Find and select .pst files – You can auto-find or manually browse the 
network for .pst files. Once .pst files are discovered, you can select the 
ones you want to process.

• Determine .pst ownership (automatically or manually) – When you 
select one or more .pst files, EmailXtract attempts to automatically 
determine the owner of the .pst file using addressing information in the 
file. In cases where ownership cannot be automatically determined, you 
can manually associate an owner with the .pst file. 

• Create shortcuts to archived items in the end user’s Outlook client 
interface – Once the migration is completed, you can use the Shortcut to 
Mailbox option to create a new folder in the owner’s mailbox on the 
Microsoft Exchange server (identified by the .pst file name) which 
preserves the .pst folder structure and shortcuts to each message. This 
allows the end user access to the messages while eliminating the need for 
a .pst file to exist on the end user’s local machine. 

Alternatively, you can create shortcuts to the messages in the .pst file on 
the end user’s local machine.

Note: Replacing messages in .pst files with shortcuts on the end user’s 
local machine does not reduce their size unless you compact the .pst files 
after you create the shortcuts. To compact a file, you must instruct the end 
user to open the Properties dialog box for the file in Microsoft Outlook, 
select the Advanced tab, and then choose Compact Now.
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• Delete, move, hide or make .pst files read-only after they have been 
archived – You can then perform post-processing actions on the .pst files 
which include deleting, hiding, moving or marking them as read-only. 
This enables you to eliminate the need for .pst files to exist on an end 
user’s local machine. 

PST Migration Best Practices

The following sections describe best practice recommendations for migrating 
.pst files:

• "Migration Considerations" on page 327
• "Migration Planning Recommendations" on page 328
• "Testing PST Migration" on page 328

Migration Considerations

Understand the following considerations:

• Before beginning the migration process, verify that the .pst files you want 
to include in the task are not open or being used by a user. See "Migration 
Planning Recommendations" on page 328 for more information.

• The EmailXtender administrator or service that is running this task must 
have administrator rights on all machines selected for the migration.

• EmailXtract cannot archive password-protected.pst files. Work with the 
file owner to remove password protection before archiving the .pst file.

• The .pst migration process utilizes additional resources on the 
EmailXtender server. You should schedule tasks during times when 
normal EmailXtender processing is low.

• Outlook client versions on the EmailXtender server must match or exceed 
the Outlook client version on the computers on which .pst files are being 
migrated. For example:
– If you have Outlook 2000 on the EmailXtender server, you can only 

migrate Outlook 2000 or XP .pst files, but not Outlook 2003 .pst files. 
– If client machines in your environment include a mixture of Outlook 

2000 and Outlook 2003, then the EmailXtender server must have 
Outlook 2003 installed.

• You should enable logging to file and set the Log Message Level to 
Message Detail. See "Logging" on page 314 for more information.
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• Post-processing tasks are predicated on the successful processing of each 
.pst file. If migration fails for one or more .pst files, any post-processing 
options configured in the task will not take place for the files which could 
not be migrated. Post-processing options for .pst files which were 
successfully migrated will be applied.

Migration Planning Recommendations

Consider the following planning recommendations:

• Determine how many .pst files you can realistically process in a given 
time period. See "Testing PST Migration" on page 328 for details. 

• Determine the best time to perform migrations. In most cases, overnight 
or weekend processing is recommended to minimize impact to both users 
and EmailXtender resources.

• Decide how you want to group your users. In an environment with many 
small domains, you may want to process .pst files on all computers in 
each domain. In an environment with large domains, you may want to 
group computers alphabetically or sequentially. Or, you may want to 
group computers according to functional area or department

• Develop email communication to notify users of upcoming processing
– Describe the goals of the processing and benefits to the organization 

and the user.
– Describe when users can expect the processing to take place.
– Describe the users’s responsibilities to support processing (e.g., close 

Outlook, logout, ensure folders in which .pst files are located are not 
read-only).

– Describe what users can expect to see in their Outlook mail client 
after processing is complete. If you select the Shortcut to Mailbox 
post-processing option, .pst files (including the intact folder structure) 
will be represented in the user’s Outlook mail client. If you do not 
select the Shortcut to Mailbox option, users can search for items that 
were in the archived .pst files using the Search Plug-in or Web Search.

– Describe any actions users may need to take to complete processing 
(e.g., delete any folders where a .pst file was previously stored to 
remove Outlook file not found error messages).

– Provide contact information for questions or issues.

Testing PST Migration

Before conducting PST migration, you should conduct tests to determine the 
following: 
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• How long does it take to process a given number of .pst files? For 
example, if you plan on processing .pst files overnight and it takes 24 
hours to process 100 .pst files, you may want to process a much smaller 
number of .pst files in each overnight task.

• Identify and resolve any common issues. 

Selecting PST Files

You can select .pst files to be processed by the task using the Auto-Find button 
or by manually browsing. For more information, see the following sections:

• "Auto-Finding PSTs" on page 329
• "Browsing for PSTs" on page 331

Auto-Finding PSTs

Important: Before beginning this procedure, verify that the .pst files you want 
to include in the task are not open or being used by a user. 

To search for .pst files to include in the task:

1. Click Auto-Find. The PST Search wizard displays a list of available 
domains.

Figure 128. PST Search Wizard

Do one of the following:
– Select an entire domain.
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– Expand one or more domains to view the list of computers in that 
domain. 

– Expand one or more servers to view the list of volumes.

Note: You must have appropriate administrative privileges to select .pst 
files. For example, to select all .pst files within a domain, you must have 
domain administrator privileges for that domain or local administrator 
privileges for each computer in the domain.

2. Click Next.

The PST Search wizard displays the search progress, including the path 
that is currently being searched.
After the search is completed, the PST Search wizard displays the results.

Figure 129. PST Search Wizard Results

3. Select the check box next to each .pst file you want to add to the PST 
Selection tab or click the Select All check box and click Finish. 

EmailXtract attempts to determine the owner for each .pst file selected. 

Note: If an owner cannot be determined automatically, you can associate 
one manually. See "Refining the List of PST Files to Process" on page 331 
for more information. 

Note: If you are applying the task to messages that use multi-byte 
languages (such as Japanese or Simplified Chinese), do not select a .pst file 
with a name that uses multi-byte characters. You can, however, select a .pst 
file with a name that does not use multi-byte characters, and EmailXtract 
will apply the task to multi-byte language messages within that file.

Once processing is complete, the .pst files display in the PST Files to 
process list on the PST Selection tab.
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Browsing for PSTs

Note: Before beginning this procedure, verify that the .pst files you want to 
include in the task are not open or being used by a user. 

To manually browse for .pst files to include in the task:

1. Click Browse and then browse to the .pst file you want to include in the 
task.

Note: If you are applying the task to messages that use multi-byte 
languages (such as Japanese or Simplified Chinese), do not select a .pst file 
with a name that uses multi-byte characters. You can, however, select a .pst 
file with a name that does not use multi-byte characters, and EmailXtract 
will apply the task to multi-byte language messages within that file.

2. Click OK. 

EmailXtract attempts to determine the owner for each .pst file selected. 

Note: If an owner cannot be determined automatically, you can associate 
one manually. See "Refining the List of PST Files to Process" on page 331 
for more information. 

Once processing is complete, the .pst files display in the PST Files to 
process list on the PST Selection tab.

Refining the List of PST Files to Process

To refine the list of .pst files you want to process when the task is performed:

1. Review the PST Files to process list. The list displays:

– Selection status - a check mark indicates whether the .pst file will be 
included in the task

– PST file name - name of the .pst file
– PST path name - network path of the .pst file
– PST status - status of the .pst file.
– Owner - owner of the .pst file.  

2. Remove .pst files you do not want the task to process by highlighting one 
or more .pst files and clicking Remove.

3. If the Owner field is blank for one or more .pst files, you can assign the 
owner from the Exchange address book or manually enter an Exchange or 
SMTP display name and address. 

Note: In most cases, it is preferable to use the Modify Owner With Address 
Book option.
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Select one or more .pst files, right click and select one of the following:
– Modify Owner With Address Book - You can select the owner from 

the Exchange Address Book
– Modify Owner Manually - You can manually enter the owner's full 

legacy distinguished name for Exchange (for example, 
/o=Organization/ou=OrganizationalUnit/cn=recipients
/cn=UserName) or the SMTP display name and address

4. Select one or more .pst files and click Test/Open to verify that the profile 
you specified on the Profile tab has access to the selected files. For more 
information on selecting a profile, see "Profile" on page 320.

5. Configure any PST post-processing options. See "Configuring PST 
Post-Processing Options" on page 332.

Configuring PST Post-Processing Options

Depending on the type of task you are configuring (Archive or Shortcut), you 
can selectively perform the following post-processing options on .pst files after 
the task is run. 

Note: You must have appropriate administrative privileges to execute these 
options.

• Make PST(s) Read-Only - Archive and Shortcut tasks only. Select this 
option to make the .pst file read-only. This prevents the end user from 
adding any more messages to the .pst file.

• Hide PST(s) - Archive and Shortcut tasks only. Select this option to hide 
the .pst file. 

• Move PST(s) to - Archive and Shortcut tasks only. Select this option to 
move the .pst file to a specified location. Use the Browse button to define 
the folder location to which the .pst file is moved.

• Delete PST(s) - Archive task only. Select this option to delete the .pst file. 
Selecting this check box disables all other post-processing options.

• Shortcut to Mailbox - Shortcut task only. Select this option to create a 
new folder in the owner’s mailbox on the Microsoft Exchange server 
(identified by the .pst file name) which preserves the .pst file’s folder 
structure and shortcuts to each message.
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Important: PST post-processing options you select are applied to all .pst files 
selected (indicated by a check mark in the leftmost column) in the PST files to 
process list. 

Verifying PST Migration

Check the log file to verify the successful processing of each .pst file, as well as 
any post-processing options that were selected in the task. 

To resolve failures:

• Identify the .pst files that failed
• Identify and resolve the reasons for the failure
• Edit the archive task you ran and unselect the .pst files that were 

processed successfully and leave ones that need to be tried again.
• Rerun the task.

Task Settings for Lotus Domino

If you are using Lotus Domino, you must configure the same options on the 
Folder Settings, Mailbox Selection, and NSF Selection tabs regardless of the 
task you want to run. For more information, see the following sections:

• "Item Types" on page 333
• "Folder Settings" on page 336
• "Mailbox Selection" on page 338
• "NSF Selection" on page 339

Item Types

The Item Types tab allows you to specify the types of items - such as email 
messages, meetings, appointments, and reports - to process in an EmailXtract 
task. 

The Item Types tab is available for all tasks except the Shortcut task, since only 
email messages may contain shortcuts.

Note: If you are configuring a Shortcut task, the Item Types tab is dimmed. For 
more information on the Deletion tab, see "Deletion" on page 344.
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You must coordinate the item types you select on the Item Types tab with the 
folders you select on the Folder Settings tab. For example, if you want to 
process appointments that reside in the Calendar view, you must select the 
Appointments check box on the Item Types tab and the Calendar check box on 
the Folder Settings tab. For more information on selecting folder settings 
criteria, see "Folder Settings" on page 336.

In addition, if you want to apply the task to item types in .nsf files, you should 
specify folders or files using the NSF Selection tab. For more information, see 
"NSF Selection" on page 339.

Figure 130. Item Types Tab for Lotus Domino

The following item types appear on the Item Types tab when you are using 
Lotus Domino: 

Table 46. Lotus Domino Item Types

Item Type Description

Anniversary All Appointment forms that have a document property of 
AppointmentType with a value of Anniversary.

Appointments All Appointment forms that have a document property of 
AppointmentType with a value of Appointment.
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To configure item types criteria for a task:

• On the Item Types tab, choose the item types you want to include in the 
task.
– To include an item type, select the check box for the item type.
– To exclude an item type, clear the check box for the item type.
– To include all item types, click Select All.
– To clear all of the selected item types at once, click Clear All.

Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any items.

Contacts All Contact forms, which contain contact information for a 
person or business. 

Note: This item type is only valid when you are using IBM 
Lotus Domino Web Access (iNotes).

Email Messages All Memo, Reply, or Reply with History forms.

Event All Appointment forms that have a document property of 
AppointmentType with a value of Event.

Meetings All Appointment forms that have a document property of 
AppointmentType with a value of Meetings.

Meeting Notices All Notice forms.

Other All other forms that are not listed in this table. Specifically, 
any form that is not an Anniversary, Appointment, 
Contact, Memo, Reply, Reply with History, Event, 
Meeting, Notice, Reminder, Delivery Report, Non 
Delivery Report, Return Receipt, Read Receipt, or To Do 
form.

Reminder All Appointment forms that have a document property of 
AppointmentType with a value of Reminder.

Reports All Delivery Report, Non Delivery Report, Return Receipt, 
or Read Receipt forms.

To Do’s All Task forms, which contain items on a To Do list.

Table 46. Lotus Domino Item Types

Item Type Description
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Folder Settings

The Folder Settings tab allows you to specify which folders - such as the Inbox, 
Sent, and Trash - EmailXtract should include in the task. You can select folders, 
views, or a combination of both folders and views. 

Figure 131. Folder Settings Tab for Lotus Domino

When EmailXtender processes a task, it processes folders first. It then 
processes the views.

You should consider the following guidelines when selecting folders and 
views:

• Trash - If you are configuring an Archive task, you may want to clear the 
Trash check box so that you do not archive deleted items.

• All User Defined and Custom Email Folder/View- The All User Defined 
option allows you to apply the task to user-created folders and views. If 
you want to apply the task to only a single user-created folder or view, 
enter the name of the folder or view in the Custom Email Folder/View 
text box. If you want to apply the task to more than one user-created 
folder or view (but not all), you must create multiple tasks and enter each 
folder or view in the Custom Email Folder/View text box.

• All Documents - When you select the All Documents view with other 
views or folders, it can cause duplicate processing for some tasks, such as 
the Search and Analysis tasks.
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• Soft Deletions - The Soft Deletions view acts as another Trash folder in 
Notes R6, so users can process Soft Deletions as they would any other 
view/folder. The Soft Deletions view is not available when using the 
Archive, Shortcut, or Delete tasks.

• Coordinating with item type selections - You must coordinate the 
folders you select on the Folder Settings tab with the item types you select 
on the Item Types tab. For example, if you want to process appointments 
that reside in the Calendar folder, you must select the Appointments 
check box on the Item Types tab and the Calendar check box on the 
Folder Settings tab. For more information on selecting item types, see 
"Item Types" on page 333.

• .nsf files - If you want to apply the task to .nsf files, you should specify 
folders or files using the NSF Selection tab. For more information, see 
"NSF Selection" on page 339.

Important: When you delete a document from a view in Notes, that document 
is also deleted from any folders in which it occurs. When you delete a 
document from a folder in Notes or Outlook, that document remains in any 
other folders in which it occurs.

To configure folder settings criteria for a task:

1. On the Folder Settings tab, choose the folders and views you want to 
include in the task.

– To include a folder or view, select the check box for the folder or view.
– To exclude a folder or view, clear the check box for the folder or view.
– To include all folders and views, click Select All.
– To clear all of the selected folders and views at once, click Clear All.

Note: You should select at least one of the check boxes; otherwise, the task 
will not apply to any folders.

Note: If you are running a Shortcut task, you cannot select the Calendar, 
Meetings, To Do’s and Contacts views because shortcuts are not supported 
for those views. 

2. To include a custom folder or view created through the mail program, 
enter the name of the folder or view as it appears in the Notes Designer 
(for example, Inbox/Sales), or the alias, if one was created.

3. Choose whether to include any subfolders or subviews of the selected 
custom folder or view.
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• To include subfolders or subviews, select the Include Sub-folders 
check box.

• To include only items in the root folder or view - and not any items in 
subfolders or subviews - clear the Include Sub-folders check box.

Mailbox Selection

The Mailbox Selection tab allows you to specify the mail servers and mailboxes 
from which the task processes messages. 

Figure 132. Mailbox Selection Tab

Note: If you specify mail filenames in the Person documents for users on the 
Domino system, the mail filename entries in the Person documents should not 
include .nsf as part of the value. If the Lotus Notes configuration does not use 
the proper mail file naming convention or have administrative rights, 
EmailXtract may not find all mailboxes on the Domino server that you select 
on the Mailbox Selection tab.

To select mail servers and mailboxes for the task:

1. In the Servers list box, choose the Domino servers from which the task will 
process messages. You must select at least one server.

• To process messages from a server, select the check box column for 
the server.
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• To exclude a server from the task, clear the check box column for the 
server.

2. To view the Notes ID addressing information, click Show Detail.

3. To verify that the selected Notes ID has the proper privileges on the 
selected mail servers and mailboxes, click Test Admin. The ID that appears 
is the one used by the Lotus Notes client installed on the local server and 
can only be modified through the Notes client interface. The ID must be an 
administrative ID with Manager level access to all mailboxes on the mail 
server, and it must have the ability to delete. 

4. Choose the mailboxes on the selected servers that you want to include in 
the task.

• To process all mailboxes on the selected mail servers, select All 
Mailboxes from the drop-down list.

• To select email addresses or distribution lists from the address book, 
select User or Group Name from the drop-down list and then click 
Address Book to select the names.

• To manually enter an email address or distribution list name, select 
Enter User or Group from the drop-down list and then enter the 
name in the text box.

Note: When specifying a distribution list for a task, the distribution list 
name cannot include the equals sign (=). Specifying a distribution list 
name containing that character, such as =Benefits= , will result in the 
task not being performed.

5. If you selected the User or Group Name option from the drop-down list 
and you want to exclude a particular email address or distribution list 
from the task, select the Exclude Names in List check box and then enter 
the name in the text box. 

NSF Selection

The NSF Selection tab allows you to include messages from .nsf mail databases 
not locked by a Lotus Domino server in the task. These mail databases might 
include mail files from people who have left the organization or mail databases 
that users set up on their local computers.
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Figure 133. NSF Selection Tab

To include .nsf files in the task:

1. Add all .nsf files you want the task to process.

a. Verify that the .nsf files you want to include in the task are not open or 
being used by a user.

b. Click Browse and then browse to the .nsf file you want to include in 
the task.

c. Click OK. The .nsf file appears in the list box on the NSF Selection tab 
with a check mark in the leftmost column.

2. Remove all .nsf files you do not want the task to process by selecting the 
file and then clicking Remove. 

3. Click Test/Open to verify that the configured Notes user has access to the 
selected files. 

Task-Specific Settings

The Shortcut, Deletion, and Analysis Settings tabs appear only for their 
respective tasks. For more information, see the following sections:

• "Shortcut" on page 341
• "Deletion" on page 344
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• "Analysis Settings" on page 346

Shortcut

The Shortcut tab allows you to configure shortcuts so that email messages are 
removed and replaced with pointers to copies of the messages in the 
EmailXtender archive. This allows you to save space on the mail server.

Figure 134. Shortcut Tab

Note: EmailXtract does not create shortcuts of messages that have been either 
sent by East Asian language versions of Microsoft Outlook or encoded by East 
Asian encoding systems such as JIS-Shift, JIS, JIS Allow-1 byte Kana, GB2312, 
EUC, or HZ. EmailXtract skips these messages and logs the event.

When you create shortcuts, you can control how they appear in the mail client. 
You can configure them so that only the message header appears; the message 
body will not appear in the preview pane. If you use Microsoft Exchange, you 
can also set them up to appear with the term "(Archived)" at the beginning of 
each message subject title. 

If you do want users to be able to view the message body of a shortcut message 
using the Preview Pane in Microsoft Outlook, an additional COM Add-in 
must be installed on each client computer. This COM Add-in is installed 
automatically when you install the Search Plug-in or when you install shortcut 
form support on the Exchange server and the forms are replicated to client 
computers. For more information, refer to the EmailXtender Installation Guide.
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If you use Microsoft Exchange and you allow users to access their email 
through Outlook Web Access (OWA), you can configure shortcuts so they are 
accessible through OWA. There are a number of preliminary setup steps you 
must complete before creating shortcuts that are accessible through OWA. For 
more information, refer to the Installing EmailXtender chapter of the 
EmailXtender Installation Guide.

Note: You cannot view shortcut messages through OWA if you have enabled 
forms-based authentication in the Microsoft Exchange environment.

If you previously created shortcuts and did not enable them for OWA, you can 
use the Upgrade Shortcuts option to upgrade them so that users can access the 
shortcuts through OWA.

Once you shortcut a message, a copy of the message remains in the 
EmailXtender archive. If necessary, you can use the Shortcut task to restore the 
message from the EmailXtender archive back to the mail server. If you are 
using Microsoft Exchange, the message is restored to its original folder. If you 
are using Lotus Domino, you can restore the message either to its original 
folder or to another folder by selecting the new folder on the Folder Settings 
tab. For more information on the Folder Settings tab, see "Folder Settings" on 
page 336.

Before you restore messages to the mail server, however, you should verify 
that you have sufficient space to accommodate the return of the messages and 
their attachment.

If you are using Microsoft Exchange and you created shortcuts with previous 
releases of EmailXtract (4.2x and earlier), you can enable users to view those 
shortcuts by upgrading them. Before you upgrade shortcuts, you must 
upgrade the message volumes in EmailXtender. For more information, see 
"Upgrading a Volume" on page 122.

Shortcuts with no associated message in the EmailXtender archive are known 
as unresolved shortcuts. You can verify whether shortcuts have an associated 
message stored in the archive. You can also choose to remove any unresolved 
shortcuts as part of the verification. For information about how shortcuts can 
become unresolved, see "Shortcut Task" on page 277.

Before you run a Shortcut task to actually create, verify, restore, or upgrade 
shortcuts, you can run the task in simulation mode to determine how much 
space you can save by creating the shortcuts or how much space you will use 
by restoring shortcuts. 
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To configure Shortcut task settings:

1. Choose whether to run the Shortcut task in simulation mode. 

• To run the task in simulation mode, select the Simulation mode check 
box.

• To run the task and actually create, restore, or upgrade shortcuts, 
clear the Simulation mode check box.

2. Choose whether to create, verify, restore, or upgrade shortcuts.

• To remove messages and replace them with pointers to messages in 
the EmailXtender archive, select Create Shortcuts.

• To verify shortcuts have an associated message in EmailXtender, 
select Verify Shortcuts. To delete unresolved shortcuts, select the 
Delete Missing Shortcuts check box.

• To restore shortcut messages to the mail server, select Restore 
Shortcuts to Mail Server.

Note: Before you restore messages to the mail server, verify that you 
have sufficient space to accommodate the return of the messages and 
their attachments.

• If you are using Microsoft Exchange and you want to upgrade 
shortcuts, select Upgrade Shortcuts.

3. If you are creating shortcuts, choose whether to take the body of each 
message out of the preview pane and display only the message header.

• To display only the message header, select the Remove message body 
check box.

• To display the message body in the preview pane, clear the Remove 
message body check box.

4. If you are creating shortcuts, choose whether to only shortcut messages 
that have attachments.

• To only shortcut messages with attachments, select the Only Items 
with Attachments check box.

• To shortcut all messages, regardless of whether they have 
attachments, clear the Only Items with Attachments check box.

5. If you are creating shortcuts and you are using Microsoft Exchange, choose 
whether the shortcuts should appear with the term "(Archived)" at the 
beginning of each message subject title.

• To add the designation to each shortcut, select the PrePend 
"(Archived)" to message subject check box.
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• To leave the message subject title as is, clear the PrePend "(Archived)" 
to message subject check box

6. If you are creating shortcuts and you are using Microsoft Exchange, choose 
whether to allow users to access shortcuts through OWA.

• To allow access to shortcuts through OWA, select the OWA Enabled 
check box.

• To prevent access to shortcuts through OWA, clear the OWA Enabled 
check box. 

Note: There are a number of preliminary setup steps you must complete 
before creating shortcuts that are accessible through OWA. For more 
information, refer to the EmailXtender Installation Guide. 

Note: You should select the OWA Enabled check box if you are creating 
shortcuts that you want to be accessible through OWA or if you have 
shortcuts that you created previously without enabling OWA access. If 
you are upgrading existing shortcuts, you should select the Upgrade 
Shortcuts option and then select the OWA Enabled check box.

Deletion

The Deletion tab allows you to choose whether to verify that a message has 
been archived to the EmailXtender Message Center before you delete the 
message. (If you are using Microsoft Exchange, you can also delete other types 
of items such as appointments, tasks, and notes. For more information on 
selecting item types, see "Item Types" on page 316.)
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Figure 135. Deletion Tab

If you choose to verify archival and the Delete task encounters a message that 
has not been archived to EmailXtender, the task archives the message before 
deleting it.

If it does not matter whether the message has been saved to the EmailXtender 
archive, you can delete the message without verifying archival.

Before you run a Delete task to actually delete messages, you can run the task 
in simulation mode. 

To configure Delete task settings:

1. Choose whether to run the Delete task in simulation mode. 

• To run the task in simulation mode, select the Simulation mode check 
box.

• To run the task and actually delete messages, clear the Simulation 
mode check box.

2. Choose whether to verify that all messages you are deleting have been 
archived to the EmailXtender Message Center.

• To verify archival, select Verify archival before deleting messages. If 
EmailXtract encounters messages or items that do not already exist in 
the EmailXtender archive, it archives them.
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• To delete messages without verifying whether they have been 
archived, select Delete messages without verifying archival.

Analysis Settings

The Analysis Settings tab allows you to evaluate the contents of mail servers 
to determine average message size, total message count, attachment 
information, and aging of messages. 

Figure 136. Analysis Settings Tab

You can view either a summary or detailed analysis of information. 

• The summary analysis contains approximate information about the 
current size of the mailbox and the number of messages it contains. 
EmailXtract does not open and enumerate individual folders and 
messages, and no filtering of the messages is performed as part of the 
analysis, regardless of what is specified on the other tabs of the Analysis 
task dialog box.

• A detailed analysis charts mailbox and server size information, and 
provides a thorough and accurate analysis of email age or attachment size 
and type. This analysis is based on the criteria configured on the other 
tabs of the Analysis task dialog box.
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You can display the results of the Analysis task in a chart for easier viewing 
and analysis. This chart can be divided up into the four quarters of the year, 
matching common business practices, so that you can regularly monitor the 
growth of the message store. For more information on viewing and managing 
task results, see "Managing Task Results" on page 349.

To configure Analysis task settings:

1. Choose whether to perform a quick, approximate analysis of the message 
store, or a detailed but more lengthy analysis of the message store. 

• To perform an approximate analysis of a message store, select 
Mailbox Size Summary Only (Fast).

• To perform a detailed analysis of a message store, select Complete 
Mailbox Analysis.

2. If you are performing a detailed analysis, choose whether to display 
information by quarter. 

• To collect information and display it by quarter, select the Collect 
information by Quarters check box.

• To display all information as a single group, clear the Collect 
information by Quarters check box.

3. If you are performing a detailed analysis, choose whether to collect basic 
information about the number of attachments and their sizes.

• To collect basic information about attachments, select the Attachment 
info totals check box.

• To exclude basic attachment information from the analysis, clear the 
Attachment info totals check box.

4. If you are performing a detailed analysis, choose whether to collect 
information about the types of attachments in the message store.

• To collect information about the types of attachments in the message 
store, select the Attachment type information check box.

• To exclude information about the types of attachments in the message 
store, clear the Attachment type information check box.

Managing Scheduled Tasks
When you configure a task to run, the task is added to a queue in the 
Scheduled Tasks dialog box. From the Scheduled Tasks dialog box, you can 
view and manage tasks that are currently running or scheduled to run in the 
future. You can manage the tasks as follows:
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• Edit a task
• Delete tasks that are not currently in progress
• Suspend a task that is scheduled to run in the future
• Resume a task that you suspended
• Force a task that is scheduled to run in the future to run immediately
• Stop a task that is currently in progress

To manage scheduled tasks:

1. From the Options menu, select Scheduled Tasks. The Scheduled Tasks 
dialog box appears.

Figure 137. Scheduled Tasks Dialog Box

2. You have the following choices:

• To edit a task, right-click on the task and then select Edit from the 
shortcut menu, or select the task and then click Edit. 

• To delete a task that is scheduled to run in the future (rather than a 
manual task), right-click on the task and then select Delete from the 
shortcut menu, or select the task and then click Delete.

• To suspend a task that is scheduled to run in the future (rather than a 
manual task), right-click on the task and then select Suspend from the 
shortcut menu, or select the task and then click Suspend.

• To resume a task that you suspended, right-click on the task and then 
select Resume, or select the task and then click Resume.
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• To force a task that is scheduled to run in the future (rather than a 
manual task) to run immediately, right-click on the task and then 
select Force Run from the shortcut menu, or select the task and then 
click Force Run.

• To stop a task that is currently in progress, right-click on the task and 
then select Cancel Run, or select the task and then click Cancel Run.

Managing Task Results
After a task completes, the results appear in a task results window in the 
EmailXtract Administrator.

Figure 138. Sample Task Results Window

The task results window contains three regions:

• The top region displays summary server information about the task.
• The middle region displays task results; for instance, mailbox information 

in an Archive, Delete, or Analysis task (including messages processed, 
total message size, total mailboxes, number of duplicate messages 
encountered, and so on) or a list of matching mail messages in a Search 
task. 
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• The lower region displays the task log file. The amount of detail shown in 
the log file is determined by the criteria you selected on the Logging tab 
when you configured the task. 

Note: EmailXtract log files cannot display multi-byte characters (such as 
Japanese or Simplified Chinese characters). These characters appear in the 
log file as question marks (?).

There are a number of ways you can further manipulate task results, 
depending on the type of task you have run. 

When you run a Search task, you can delete, or purge, items that appear in the 
results list from the mail server message store. You can also view those items 
or remove them from the search results for easier viewing.

When you run any of the other tasks (Archive, Shortcut, Delete, and Analysis), 
you can view task results as a bar graph, stacked bar graph, or pie chart, all of 
which you can print or save as an image file for future reference. You can also 
organize chart data by message size in MB, the total number of messages, or 
the average size of messages.

If you run an Analysis task and you choose the Complete Mailbox Analysis 
option as well as either the Attachment info totals or the Attachment type 
information option, you can display task results for the attachments in a 
separate chart.

Regardless of the task you run, you can also export task results to a .csv file.

For more information, see the following sections:

Table 47. Task Result Options by Task

Task Task Result Options

All tasks "Exporting Task Results to a .csv File" on page 351

Search • "Purging Search Task Results from the Mail 
Server" on page 351

• "Viewing Search Task Results" on page 352
• "Removing Items from Search Task Results" on 

page 352
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After you run a task and the results appear in the task window, you can export 
the results to a .csv (Comma Separated Value) file so that you can view the 
results as a spreadsheet through programs such as Microsoft Excel. This 
feature is available for all EmailXtract tasks.

To export task results to a .csv file:

1. Select any line in the top two regions of the task results window.

2. Right-click on the line and then select Export to CSV file from the shortcut 
menu. The Save As dialog box appears.

3. Enter a path and filename for the file, and then click Save.

Purging Search Task Results from the Mail Server

When you run a Search task and the results appear in the task window, you can 
delete, or purge, messages in the results list from the mail server message store. 

Important: Unlike with the Delete task, EmailXtract does not verify whether 
the items you are deleting using the Purge command have been archived to the 
EmailXtender Message Center. For more information on using a Delete task to 
delete messages from the mail server message store, see "Delete Task" on 
page 284. 

Archive, Shortcut, 
Delete, Analysis

• "Viewing Task Results as a Chart" on page 352
• "Printing a Chart" on page 357
• "Saving a Chart as an Image File" on page 358

Analysis (with a 
Complete Mailbox 
Analysis and either the 
Attachment info totals 
or the Attachment type 
information option)

"Viewing an Attachment Chart" on page 360

Table 47. Task Result Options by Task

Task Task Result Options
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To purge items from the mail server:

1. Select the items in the results list that you want to delete. 

2. Right-click on the items and then select Purge Message(s) from the 
shortcut menu that appears. A confirmation message appears.

3. Click Yes.

Viewing Search Task Results

When you run a Search task and the results appear in the task window, you can 
view the messages that appear in the results list using the default mail client. 
From the mail client, you can then forward or reply to the messages, if 
necessary.

To view items in the results list: 

1. Select the items in the results list that you want to view. 

2. Right-click the items and then select View Message(s) from the shortcut 
menu that appears. The items open through the default mail client.

Removing Items from Search Task Results

When you run a Search task and the results appear in the task window, you can 
reduce the number of items that appear in the results list without deleting the 
messages from the mail server. This allows you to more easily review the 
search results. 

To remove items from the results list:

1. Select the items in the results list that you want to remove from the list. 

2. Right-click the items and select Remove from Hits List from the shortcut 
menu that appears.

Viewing Task Results as a Chart

After you run an Archive, Shortcut, Delete, or Analysis task and the results 
appear in the task window, you can view the task results as a chart. (You 
cannot view Search task results as a chart.) 

The chart can reflect data for all mailboxes or for an individual mailbox. You 
can change the appearance of the chart so that data is displayed as either a bar 
graph, a stacking bar graph, or a pie chart.



Chapter 11: EmailXtract

EmailXtender, Release 4.7
Administrator’s Guide 353

11

To view a task results chart:

1. Choose whether to view a chart for all mailboxes or an individual mailbox.

• To view a chart for all mailboxes, select a server in the top region of 
the task window.

• To view a chart for an individual mailbox, select the mailbox in the 
middle region of the task window.

Figure 139. Selection Determines the Type of Chart

2. Right-click the line and then select View Chart from the shortcut menu. 
The chart appears in a Chart window.

3. Choose how you want the data displayed.

• To view the chart as a bar graph, open the View menu in the Chart 
window and then select Bar Graph.
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Figure 140. Example Bar Graph

• To view the chart as a stacking bar graph, open the View menu in the 
Chart window and then select Stacking Bar Graph.

Figure 141. Example Stacking Bar Graph

• To view the chart as a pie chart, open the View menu in the Chart 
window and then select Pie Chart.
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Figure 142. Example Pie Chart

 

4. To view detailed counts, move the mouse over each segment of the chart.

If necessary, you can change the way the chart appears - including 
manipulating the way the data is graphed - so that it is easier to view or 
analyze the chart. For more information, see "Task Result Chart View Options" 
on page 355.

Task Result Chart View Options

While you are viewing a task results chart, you can change the way the chart 
appears - including manipulating the way the data is graphed. 

You can change the scale of the chart, shift the chart’s position in the window, 
zoom in on the chart, and rotate the chart. 

You can also reorganize the chart data by message size in MB or the total 
number of messages. If the task results are for an Analysis task, you can also 
reorganize chart data by the average size of messages. 

If you run an Analysis task and you choose the Complete Mailbox Analysis 
option as well as the Collect information by Quarters option, you can calculate 
an aging of the message store by quarter and displays a chart of the chosen 
aged data by message size in MB, the total number of messages, or the average 
size of messages.

• Change the chart’s scale

Press [Ctrl], hold down both mouse buttons, and then move the mouse 
down to increase chart size or up to decrease chart size.

• Shift the chart’s position within the window

Press [Shift], hold down both mouse buttons, and then move the mouse to 
shift the chart’s position within the window.
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• Zoom in on the chart

Press [Shift] or [Ctrl], hold down the left mouse button, move the mouse 
to select the area to zoom in on, and then release the mouse button.

• Rotate the chart

Hold down both mouse buttons and then move the mouse left and right 
to change the rotation angle, or up and down to change the inclination 
angle.

• Return to the default display of the chart

Press [R].
• Organize chart data by message size in MB

From the Message Sizes menu in the Chart window, select Show in Mb. 

Note: For the Analysis task, this is the default chart display.

• Organize chart data by the total number of messages in each category

From the Message Sizes menu in the Chart window, select Show by 
Messages. 

• Organize chart data by the average message size

From the Message Sizes menu in the Chart window, select Average 
Message Size. 

Note: This chart display option is only available for the Analysis task.

• Calculate an aging of the message store by quarter and display the 
chart as organized by message size in MB

From the Message Sizes menu in the Chart window, select Quarterly Sizes 
by Messages. 

Note: This chart display option is only available for the Analysis task 
when you choose the Complete Mailbox Analysis option as well as the 
Collect information by Quarters option.

• Calculate an aging of the message store by quarter and display the 
chart as organized by the total number of messages in each category

From the Message Sizes menu in the Chart window, select Quarterly Sizes 
by Mb. 

Note: This chart display option is only available for the Analysis task 
when you choose the Complete Mailbox Analysis option as well as the 
Collect information by Quarters option.

• Calculate an aging of the message store by quarter and display the 
chart as organized by average message size
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From the Message Sizes menu in the Chart window, select Quarterly 
Average Message Sizes. 

Note: This chart display option is only available for the Analysis task 
when you choose the Complete Mailbox Analysis option as well as the 
Collect information by Quarters option.

Printing a Chart

When you view Archive, Shortcut, Delete, or Analysis task results as a chart, 
you can print the chart for future reference. If necessary, you can also adjust 
print settings.

To print a chart:

• From the File menu in the Chart window, select Print.

To choose print settings:

1. From the File menu in the Chart window, select Print Settings. The Chart 
Printing dialog box appears.

Figure 143. Chart Printing Dialog Box

2. From the Output Format drop-down list, select the file type that you want 
to use when you print the chart. You have the following choices:

• Bitmap - Select this option to print the chart as a standard Windows 
.bmp file. The bitmap is generated at the same color depth as the 
video mode currently set on the computer.

• Standard Metafile - Select this option to print the chart as a standard 
Microsoft Windows Metafile (.wmf file).

• Aldus-placeable Metafile - Select this option to print the chart as a 
Windows metafile (.wmf file) called "Aldus-placeable".

• Enhanced Metafile - Select this option to print the chart as an 
enhanced metafile (.emf file).
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3. From the Output Scaling drop-down list, choose the scale that you want to 
use when you print the chart. You have the following choices:

• None - Select this option to print the chart as displayed on screen.
• Scale to Width - Select this option to scale the printed chart to the 

width of the printed page.
• Scale to Height - Select this option to scale the printed chart to the 

height of the printed page.
• Scale to Fit - Select this option to scale the printed chart to the best fit 

of the printed page.
• Scale to Max - Select this option to scale the printed chart to the 

maximum size possible. 

4. Choose whether to save the settings that are currently selected on the 
Chart Printing dialog box as the defaults.

• To save the settings as defaults, select the Save as default check box.
• To use these settings only for the current chart, clear the Save as 

default check box.

5. Click OK.

Saving a Chart as an Image File

When you view Archive, Shortcut, Delete, or Analysis task results as a chart, 
you can save the chart as an image file so that you can view the results again 
at a later date. 

By default, the chart files are saved as .jpg files in the C:\Program 
Files\OTG\EmailXtract directory where EmailXtract was installed. You can 
change the directory to which chart files are saved using the Directories tab of 
the Configuration Options dialog box. For more information, see "Directories" 
on page 267.
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To save a chart as an image file:

1. From the File menu in the Chart window, select Save as JPEG. The Save 
Chart to JPEG dialog box appears.

Figure 144. Save Chart to JPEG Dialog Box

2. In the File Name text box, enter a name for the image file. If you do not 
specify a filename, the system saves it using the task name specified on the 
Scheduling tab of the task dialog box. For example, if you generate a chart 
for a task named Task0035, the chart is saved with the name Task0035.jpg.

3. From the Output Quality drop-down list, select the quality with which 
EmailXtract should save the file. You can choose Highest, High (default 
setting), Medium, Low, or Lowest. The higher the quality, the larger the 
file size.

4. Choose whether to save the file in black and white.

• To save the file in black and white, select the Grayscale check box.
• To save the file in color, clear the Grayscale check box.

5. Choose whether to compress the file to its smallest size for the selected 
output quality.

• To compress the file, select the Optimize Compression check box.
• To leave the file uncompressed, clear the Optimize Compression 

check box.

6. Choose whether to save the settings that are currently selected on the Save 
Chart to JPEG dialog box as the defaults.

• To save the settings as defaults, select the Save as default check box.
• To use these settings only for the current chart, clear the Save as 

default check box.

7. Click OK.
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Viewing an Attachment Chart

If you run an Analysis task and you choose the Complete Mailbox Analysis 
option as well as either the Attachment info totals or the Attachment type 
information option on the Analysis Settings tab, you can display task results 
for the attachments in a separate chart. For more information on the Analysis 
Settings tab, see "Analysis Settings" on page 346.

Attachments charts make it possible for you to collect and view the statistics 
on the number, size, and types of attachments contained within the mail server 
message store.

Figure 145. Sample Attachment Analysis Chart

If you selected the Attachment info totals check box on the Analysis Settings 
tab, you can view a chart of the total number of attachments or of the total 
attachment data by size for the chosen data set.

• To view a chart of the total number of attachments, open the Attachments 
menu in the Chart window and then select Number of Attachments.

• To view a chart of the total attachment data by size, open the Attachments 
menu in the Chart window and then select Attachment Sizes in MB.

If you selected the Attachment type information check box on the Analysis 
Settings tab, you can view a chart of the number of attachments by file type or 
of the top 15 attachment types by size in MB.

• To view a chart of the number of attachments by file type, open the 
Attachments menu in the Chart window and then select Number of 
Attachment by Type.
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• To view a chart of the number of the top 15 attachment types by size in 
MB, open the Attachments menu in the Chart window and then select 
Attachment Sizes in MB by Type.
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Appendix A: Expression Operators

When you create searches or keyword rules in EmailXtender, you can use 
expression operators to further focus the results. Because EmailXtender 
full-text indexes messages and their attachments when it processes the 
messages, these operators find occurrences of the rule both in messages and 
attachments. (Only attachments selected for indexing apply, however.)

Note: You should precede words that also function as operators with an 
underscore (_) if you want EmailXtender to regard them as regular words. For 
example, if you want to find the exact phrase "trade closed and finished", you 
should enter trade closed _and finished as the search phrase.

For more information, see the following sections: 

• "AND" on page 363
• "OR" on page 364
• "NOT" on page 364
• "Wildcards" on page 364
• "Proximity-based Operators" on page 365
• "Tense Conflation" on page 366
• "Parentheses" on page 367
• "Significant Characters" on page 368
• "Insignificant Characters" on page 368
• "Punctuation Characters" on page 369

AND
You can use the expression operator AND in a search or keyword rule to find 
all items that include both of the terms. 
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Examples of acceptable syntax using AND are:

• *.pdf AND *.doc 

• trade AND closed 

• trade AND closed AND management 

Note: Simply entering trade closed in a search field or keyword rule does not 
find or filter messages where the words "trade" and "closed" both occur. It only 
returns messages that include the exact phrase "trade closed". 

Note: When using the AND operator, be aware that both terms must be in an 
attachment or in the message to match. For example, the keyword rule "trade 
AND closed" would not match a message where " trade" was in the message 
body and "closed" was in the message attachment.

OR
You can use the expression operator OR to set up an exclusive search or 
keyword rule.  

Examples of acceptable syntax using OR are:

• *.pdf OR *.doc 

• trade OR closed 

• trade OR closed OR management (This example can be changed 
through the use of parentheses to alter the order of how EmailXtender 
processes it. For more information, see "Parentheses" on page 367.)

NOT
You can use the expression operator NOT to set up a search or rule where one 
term occurs but not the other.

Examples of acceptable syntax using NOT are:

• *.pdf NOT *.doc 

• trade NOT closed 

Wildcards
You can insert the wildcard character (*) into searches or keyword rules to 
broaden the number of possibilities.
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The following table contains examples of search or filter strings and their 
results:

Proximity-based Operators
You can search or filter for terms based on how close they occur to one another. 
You can searchor filter for two terms within a certain number of paragraphs, 
within a certain number of words, or with one before another. These operators 
are described in the following sections:

• "Paragraph Proximity" on page 365
• "Word Proximity" on page 366
• "Word Order" on page 366

Paragraph Proximity

You can use the paragraph proximity operator (\number\) to search or filter for 
two terms that are within a specified number of paragraphs from each other in 
an attachment. You should first enter the first term, then a backslash, then the 
number of paragraphs allowed between the terms as a whole number, another 
backslash, and then the second term.

For example, to search or filter for attachments containing the word "trade" 
followed within eight paragraphs by the word "closed", you would enter the 
following:

trade \8\ closed 

Table 48. Wildcard Operator Examples

Using this string: Returns messages and attachments with:

*.doc A .doc attachment

manage* The word "manage" or words that begin with 
"manage", such as management, manager, 
manages, managed, etc.

trade NOT manage* The word "trade" but not any variant of 
"manage"



EmailXtender, Release 4.7
Administrator’s Guide

Appendix A: Expression Operators

366

A

Note: Paragraph proximity searching or filtering only works reliably within 
attachments and not in the body of the email message because EmailXtender 
processes the email message body. Either term can occur first in the 
attachment.

Word Proximity

You can use the word proximity operator (\number\) to search or filter for two 
terms that are within a specified number of words from each other in the 
paragraph of a message or an attachment. You should first enter the first term, 
then a slash, then the number of words allowed between the terms as a whole 
number, another slash, and then the second term.

For example, to search or filter for the word "trade" within five words of the 
word "opened", you would enter the following:

trade /5/ opened 

Either term can occur first in the paragraph.

Word Order

You can use the word order operator (...) to search or filter for two terms where 
one term is followed by another in a message or attachment. You should enter 
the term that is to occur earlier in the message or attachment, followed by the 
word order operator, and then the term that is to occur later in the message or 
attachment.

For example, to search or filter for the word "trade" followed by the word 
"closed" in a message, you would enter the following:

trade ... closed 

Note: When you use the word order operator, you must include a space before 
and after the three periods for it to be interpreted correctly.

Tense Conflation
You can use tense conflation to broaden the possibilities for results by 
querying for variants of a root verb that begin or end with the same word stem. 
Use a ~ at the end of the word for trailing conflation, or a ~ at the beginning of 
the word for leading conflation.
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The following table contains examples of search or filter strings and their 
results:

Note: When you use tense conflation to search for terms, those terms are not 
highlighted when you view the search results.

Parentheses
You can use parentheses to change the order in which the syntax is processed. 
Under normal operation, syntax is processed from left to right. For example, if 
you enter the search or filter string trade AND closed OR management, 
EmailXtender initially sets aside all messages and attachments containing both 
"trade" and "closed" as possible search results. Then it moves to the second half 
of the syntax, returning all messages and attachments that contain 
"management". Therefore, the final results set contains both messages that 
contain the words "trade" and "closed", and those that contain "management".

The following table contains examples of search or filter strings and their 
results:

Table 49. Tense Conflation Operator Examples

Using this string: Returns these results:

manage~ manage, managed, managing, etc.

~install install, uninstall, preinstall, reinstall, etc.

Table 50. Parentheses Operator Examples

Using this string: Returns these results:

trade AND (closed OR 
management)

• Messages and attachments containing both 
"trade" and "closed"

• Messages and attachments containing both 
"trade" and "management"

*.pdf NOT (*.doc OR 
*.txt)

• Messages that have .pdf attachments, as long 
as they do not also have .doc or .txt 
attachments

• No messages with .doc or .txt attachments are 
found
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Significant Characters
You can use significant characters ($ - _ % & @ , 0-9, A-Z, a-z, and the 
international character set) to further refine a search or rule.  Significant 
characters are indexed as standard alphanumeric characters.  You can search 
or filter for these characters if they are included as part of a word, or if they are 
a word by themselves. 

The following table contains examples of search or filter strings and their 
results:

Insignificant Characters
EmailXtender does not index insignificant characters (‘ / ”); it treats them the 
same as a white space. 

You cannot search or filter for these characters when they occur alone (rather 
than as part of a word); the search or rule does not differentiate between these 
characters. If you search for a single punctuation character, the search returns 
no results. 

The following table contains examples of search or filter strings and their 
results:

Table 51. Significant Character Operator Examples

Using this string: Returns messages and attachments with:

5% 5%, but not 15%

p&l p&l, but not gap&loss

$ $, but not $5

Table 52. Significant Character Operator Examples

Using this string: Returns messages and attachments with:

P/l pl, p/l, p'l, etc., but not "p l"

pl pl, p/l, p'l, etc., but not "p l"

Profit/loss profitloss, profit/loss, profit_loss, etc., but not "profit 
loss"
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Punctuation Characters
EmailXtender does not index punctuation characters (~ ! # ^ * ( ) = + [ ] { } \ | 
; : " , < > ?); it treats them the same as a white space. 

You cannot search or filter for these characters when they occur alone (rather 
than as part of a word); the search or rule does not differentiate between these 
characters. If you search for a single punctuation character, the search returns 
no results. 

The period (.) is also treated as a punctuation character, and it produces the 
same search results as other punctuation characters unless it occurs within a 
word, such as Document.doc. When a period occurs within a word, it is treated 
as an alphanumeric character.

The following table contains examples of search or filter strings and their 
results:

profitloss profitloss, profit/loss, profit_loss, etc., but not "profit 
loss"

Cents/share centsshare, cents/share, cents'share, etc., but not 
"cents share"

centsshare centsshare, cents/share, cents'share, etc., but not 
"cents share"

Table 53. Punctuation Character Operator Examples

Using this string: Returns these results:

a+b a+b, a~b, a!b, a:b, a b, etc.

a b a+b, a~b, a!b, a:b, a b, etc.

stop=halt stop=halt, stop|halt, stop halt, etc.

test. test, test., test#, test\, etc.

company.com company.com (but not "company com" or 
company~com)

Table 52. Significant Character Operator Examples

Using this string: Returns messages and attachments with:



EmailXtender, Release 4.7
Administrator’s Guide

Appendix A: Expression Operators

370

A



EmailXtender, Release 4.7
Administrator’s Guide 371

Glossary

.emx file Flat, portable files of a configurable size containing 
archived messages organized by month. Also called 
volumes or container files.

.nsf file A Lotus Domino database file. The Domino journaling 
utility automatically creates an .nsf file as a mailbox 
connector when it is installed. If users create private .nsf 
mail databases, you can use EmailXtract to archive 
messages from them.

.pst file A Microsoft Exchange Personal Folder file. You can use 
EmailXtract to archive messages from .pst files.

action rule A rule that allows you to perform an action on all 
messages collected by the vault, cabinet, or folder to which 
the rule applies. At this time, the only type of action you 
can perform on a message is to auto-forward it to the 
email address you specify.

Administrator The graphical user interface for configuring EmailXtender. 
(The graphical user interface for configuring EmailXtract 
is also called the Administrator.)

administrator search A type of search where certain users can search for and 
view all messages (even those of all other users) in the 
EmailXtender mail archive.

archive A collection of information about and including copied 
email that is accessible to EmailXtender.
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archiving The process of moving copied mail from the mail server to 
a storage location on the EmailXtender server. This process 
occurs from either the journaling mailbox (the mailbox 
connector) or through the EmailXtract Archive task.

Audit Utility An EmailXtender server component that records 
EmailXtender activity, including administrator searches, 
supervisor searches, directed searches, anddeletion of any 
messages or volumes from the EmailXtender mail archive. 
You can then generate audit reports to view statistics or 
specific information about the searches, retrieved 
messages, and deleted messages or volumes. 

BadDir directory Directories on the EmailXtender server where messages 
are placed after processing errors.

Bloomberg Mail 
Parser

An EmailXtender server component that processes 
aggregated text files containing Bloomberg mail and 
separates them into individual emails that conform to the 
RFC 822 email standard. The parser then writes the mail 
files to a specified directory, and you can direct 
EmailXtender to full-text index and archive the email.

cabinet The third-level organizational component of the 
EmailXtender Message Center. By default, EmailXtender 
creates a single cabinet named "Index"; however, you can 
create additional cabinets if necessary.

collection rule Rules that allow you to specify which messages 
EmailXtender collects.

compression With compression, EmailXtender compresses all messages 
as they are processed by the Message Center. This can 
mean a considerable savings in terms of how much disk 
space is required for message information. Compression 
does not, however, affect index or database size.

container file Flat, portable files of a configurable size containing 
archived messages organized by month. Also called 
volumes or .emx files.
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direct read A DiskXtender setting whereby files that have been 
purged from the extended drive are read directly from the 
media rather than being copied back to the extended drive 
when requested.

directed search A type of search where certain users can search for and 
view all messages (even those of all other users) in a 
specific cabinet or folder.

DiskXtender A LEGATO product that allows you to "extend" the 
capacity of the EmailXtender storage drive by 
automatically writing .emx files to other storage media.

drop directory The initial directory on the EmailXtender server from 
which EmailXtender draws messages to begin archiving 
them.

EmailXaminer An add-on component to EmailXtender that offers 
additional advanced surveillance capabilities designed 
specifically for compliance with email regulations and 
policies, including message sampling, customizable 
automated procedures, intelligent cross-mailbox 
searching, purging, and more.

EmailXtender 
Archive Edition

A version of EmailXtender that contains a subset of the 
full EmailXtender product functionality. Intended for the 
general messaging market instead of regulated industries, 
EmailXtender Archive Edition allows you to archive 
messages from Microsoft Exchange, Lotus Domino, and 
UNIX sendmail on a scheduled basis (rather than in real 
time) in order to achieve storage savings. It is not designed 
for record retention or archiving.

EmailXtract An EmailXtender server component that allows you to 
manage messages in the message store on the mail server. 
You can archive, shortcut, delete, search for, analyze 
messages and other item types.

EMC Centera A line of disk-based storage devices deployed on a 
Redundant Array of Independent Nodes (RAIN). EMC 
Centera devices use unique, permanent content addresses 
to store and retrieve data. EmailXtender can write files to 
EMC Centera through DiskXtender.
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encryption Encryption works to add security to archived items as 
they are bundled into volumes. This ensures that volumes 
are unreadable outside the EmailXtender system, thereby 
increasing the security of the archived data. You can 
encrypt email data using one of three encryption types: 
FAST, ICE-Key (64-bit), or ICE-Key (128-bit).

exclusion rule Rules that allow you to specify which messages 
EmailXtender should not collect.

extended drive In DiskXtender, an NTFS volume (such as a hard drive or 
the EmailXtender storage drive) or partitioned part of a 
hard drive for which DiskXtender provides file migration 
services by moving files to media and fetching files from 
media according to the parameters you set.

folder The fourth-level organizational component of the 
EmailXtender Message Center. By default, EmailXtender 
creates a single folder named "Archive"; however, you can 
create additional cabinets if necessary.

full-text indexing An index of all available text within the header, message, 
or attachment of an email.

journaling The process running on the Microsoft Exchange or Lotus 
Domino mail server that copies all incoming and outgoing 
mail to a mailbox (the mailbox connector) you specify.

mail router See mail server.

mail server A mail server is an application that receives incoming 
email from local users (people within the same domain) 
and remote senders and forwards outgoing email for 
delivery. A computer dedicated to such an application can 
also be called a mail server. Microsoft Exchange, IBM 
Lotus Domino, and sendmail are mail server applications.

mail transfer agent 
(MTA) 

See mail server.

mailbox connector The holding place on the mail server for messages before 
they are transferred to the EmailXtender Message Center.
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MAPI Messaging Application Program Interface. The interface 
that EmailXtender uses to access address books and to 
retrieve messages from the mailbox connector.

media A physical medium on which data is written and from 
which data can be retrieved. Depending on the type of 
media, the medium may be different and the information 
may be recorded in different ways. EmailXtender writes 
files to media (such as DVD-R or magneto-optical) 
through DiskXtender.

Message Center The server, vault, cabinets, folders, and their settings, 
which allow you to customize mail indexing and archival.

message store A dedicated mail repository on the mail server for storing, 
retrieving, and manipulating messages.

MilVault milter and 
archiver

A mail server component that works with sendmail to 
capture mail and transfer it to an EmailXtender server 
when sendmail is installed on the Sun Solaris, Red Hat 
Linux, and IBM AIX platforms.

purge When used with EmailXtract, purging means that 
messages are deleted from the mail server message store.

When used with DiskXtender, purging means that data 
for files that have been copied to media is removed from 
the extended drive and a file tag is left behind. The file tag 
allows a purged file to appear to be resident on the 
extended drive so that client computers can access it.

remote 
administration

You can administer an EmailXtender server both from the 
computer on which the EmailXtender server components 
are installed and from remote computers. To remotely 
administer an EmailXtender server, you must install the 
EmailXtender Administrator interface only (you do not 
need to install the EmailXtender server components).

retention period A folder-level setting that allows you to track how long 
volumes exist in the EmailXtender system. They are 
designed to help you to meet legal retention requirements 
by preventing you from deleting volumes before the 
specified amount of time has passed.
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rules Guidelines you configure at the vault, cabinet, or folder 
level so that you can efficiently organize email archives by 
controlling which messages EmailXtender archives.

Search Plug-in An EmailXtender client component that offers 
EmailXtender search functionality from within Microsoft 
Outlook and Lotus Notes.

server The top-level organizational component of the 
EmailXtender Message Center, the server represents the 
EmailXtender server.

shortcut Pointers that are placed on the mail server to copies of 
messages that are archived in EmailXtender.

storage media See media.

supervisor search A type of search where certain users are authorized to 
search and view messages of other selected users.

vault The second-level organizational component of the 
EmailXtender Message Center, the vault is automatically 
named "EmailVault". It collects all email data to be 
processed by EmailXtender.

volume Flat, portable files of a configurable size containing 
archived messages organized by month. Also called 
container files or .emx files

Web Search A website (located at http://localhost/EmailXtender, where 
localhost is the IP address or server name of the 
EmailXtender server) that allows administrators, 
supervisors, and users to search the EmailXtender archive.
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.access files. See ACCESS files

.dlc files. See DLC files

.emx files. See EMX files

.idx files. See IDX files

.nsf files. See NSF files

.pst files. See PST files

.ref files. See REF files

.tbl files. See TBL files

.txvlts files. See TXVLTS files

.xrc files. See XRC files

.xvlt files. See XVLT files

A

ACCESS files 150
action rules (auto-forward) 105–106
activating changes 58
address

format (Bloomberg Mail) 238
legacy (Bloomberg Mail) 250
rules, specific 95–97

administrator
account, EmailXtender 159
interface, EmailXtender 52–58
interface, EmailXtract 260–262
search 39, 46, 193, 201–202

ADS (Active Directory Services)
rules 32, 45, 91, 95, 108–116, 149
with Microsoft Exchange 110

Akonix Systems instant message capture 31
Analysis task (EmailXtract) 294–300

configuring 295–299, 346–347
managing 299
results 299, 350
scheduling 296, 299
toolbar icon 261

and, using in searches and rules 363
architecture

Message Center 25–30
Message Center, planning 60
system 22

Archive (default Message Center folder). See 
folder

Archive Edition, EmailXtender 43–45
Archive task (EmailXtract) 270–276

configuring 272–275
managing 275
results 275–276, 350
scheduling 275
toolbar icon 261

attachments 21, 23, 97–98, 139, 280, 303, 305
analysis chart 360
analyzing 269, 294–295, 297–298, 300, 

346–347, 350–351
archiving messages based on 274
Bloomberg Mail 233, 235, 237–241, 247–

252, 254–255
deleting messages based on 288
in the Message Center directory 150
indexing 31–32, 44, 59, 149, 363
input file (Bloomberg Mail) 239
restoring when they are shortcut 278, 342–

343
searching for 293, 365
searching for keywords 39, 193, 365–368
sending an audit report as 207, 221, 229
shortcutting messages based on 277, 280–

281, 283, 343
Audit Utility 24, 38, 40–42, 194, 203, 205–230

custom reports 205
database 40, 42, 205, 219
exporting a report to a Domino 

database 207, 228–229
standard reports 205
with EmailXtender Archive Edition 44

B

BadDir
cabinet directory 151, 184
checking for corrupt index files 146
checking for unprocessed messages 140, 

151, 183, 190
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folder directory 139, 151, 183
Message Center directory 139, 148, 151, 

155, 172, 184
processor utility 151, 155, 157, 171–172, 

184, 190
vault directory 139, 148, 151, 183

bang rules, keyword 97–102
Bear format (Bloomberg Mail) 233–235, 247
Bloomberg Mail Parser 25, 31, 46, 139, 231–

255
adding legacy email addresses 250
attachment input file 239
attachments (parser output) 241
automating with custom scripts 251
Bear format 233–235, 247
Bull format 233, 236–238, 248
command line parameters 240, 251–252
configuration file 240, 244–250, 252
input files 233–240
installing 244
inventory report 243, 252
log file 232, 235, 239–240, 242–243, 250, 

252–255
message input file 233–238
messages (parser output) 241
output 240–244
running 251–253
scheduling 240, 251
testing 232, 245, 250, 252
troubleshooting 253
user address formats 238
with EmailXtender Archive Edition 44

Boolean queries 305–306, 309
buffered files 150
Bull format (Bloomberg Mail) 233, 236–238, 

248
buttons, toolbar 56

C

cabinet 28, 78
BadDir directory 151, 184
configuring 79
copying 83
creating 45, 78–79, 103
creating automatically 32, 79, 91, 121
creating, reasons for 102

default (Index) 28, 78, 151
deleting 83
description 81
directed search 28, 40, 46, 82, 193, 202–204
directory 79, 151
drop directory 144, 146, 154, 156
in EmailXtender Archive Edition 44, 78–79
retention period 63
rules 28, 32, 45, 61–62, 78, 80–82, 91, 107, 

278
within the Message Center hierarchy 25–26, 

50, 59–60
cache rule logging 152
capacity

storage drive, extending 25, 37, 117, 130
storage media, usage 129
volumes 30, 117–118, 120, 128–130, 148

Centera. See EMC Centera
chart, viewing EmailXtract task results as 352–

361
Code of Federal Regulations 21
collection

rules 91–105
strategy 26

command line parameters (Bloomberg Mail 
Parser) 240, 251–252

compliance
with an email policy 22, 38, 231
with federal regulations 21

compression
shortcut task analysis chart 359
volumes 28, 31, 35, 45, 59, 65–66, 75–78

connecting to an EmailXtender server 51–52, 
164–165

container files. See volumes
corrupt

index 36, 125–126, 141, 146, 152, 156, 186
message queues 155, 184

Crystal Reports 205, 219–220, 222–224

D

database
audit 40, 42, 205, 219
deleting messages from 168
Domino mailbox connector 70, 73
Domino, analyzing 294, 298
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Domino, archiving from 31, 43, 257, 269–
270, 274, 276, 339

Domino, deleting from 284, 288
Domino, exporting an audit report to 207, 

228–229
Domino, searching for messages 290, 293
Domino, shortcutting messages in 277, 282
EmailXtender, checking the status of 169
EmailXtender, compression of 35, 65, 75
EmailXtender, entering messages into 155, 

184
EmailXtender, removing volume information 

from 127, 190
EmailXtender, updating with volume 

information 121
Delete task (EmailXtract) 284–290

configuring 285–289, 344–346
managing 289
results 289, 350
scheduling 286, 289
simulating 284, 289
toolbar icon 261

direct read (DiskXtender) 132, 134–135
directed search 28–29, 40, 46, 78, 80, 82, 85, 

88, 193, 202–204
directory

BadDir (cabinet) 151, 184
BadDir (folder) 139, 151, 183
BadDir (Message Center) 139, 148, 151, 155, 

172, 184
BadDir (vault) 139, 148, 151, 183
cabinet 79, 151
chart file, EmailXtract 267–268
drop (cabinet) 144, 146, 154, 156
drop (IIS) 139
drop (SMTP) 154, 171, 231, 241, 251
drop (vault) 139, 143, 155, 184
folder 84, 127
index (folder) 140
log file (EmailXtract) 267–268
mailbox connector 139
Message Center 139–140, 172, 190
Message Center, clearing 156–157
Message Center, excess files 150
storage (folder) 139, 144

disabling message collection 90

DiskXtender 23, 25, 30, 36–37, 45–46, 85, 
117–118, 120, 128–135, 147, 149, 187, 190

retention considerations 64
distribution list 21, 93, 104–105, 108, 112, 147, 

152, 158, 185, 189, 197, 199–200, 276, 
305–306, 318, 323–324, 339

cache file 145, 152
DLC files 145, 147, 152, 185, 189
domain rules 61, 93–95
Domino. See Lotus Domino
drive scan (DiskXtender) 132, 135
drop directory

cabinet 144, 146, 154, 156
IIS (Internet Information Server) 139
SMTP 154, 171, 231, 241, 251
vault 139, 143, 155, 184

DVD-R 23, 25, 36–37, 117, 130, 135, 190
DVD-RAM 37, 130

E

EmailVault. See vault
EmailXaminer 22, 38, 143, 150, 184, 231–232, 

239, 242, 244, 250
with EmailXtender Archive Edition 44

EmailXtender.dlc 145, 152, 189
EmailXtract 21, 25, 30, 43, 92–93, 104–105, 

139, 149, 184
Analysis task 294–300, 346–347
Archive task 46, 270–276
configuring options 262–268
configuring tasks 300–347
date settings 310–312
default task settings 263
Delete task 284–290, 344–346
directories for log and chart files 267–268
exporting task results 350–351
folder settings 319–320, 336–338
item types 316–319, 333–335
logging 187–188, 267, 272–273, 276, 280–

281, 284, 286–287, 289, 291–292, 296–
297, 300, 314–316, 350

logging directories 263, 267
Lotus Domino settings 333–340
mailbox settings 322–324, 338–339
managing scheduled tasks 347–349
managing task results 349–361
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MAPI profile 266–267, 320–322
Message Content settings 303–310
Microsoft Exchange task settings 316–333
NSF selection 339–340
PST selection 325–333
public folder settings 324–325
runtime priorities 264
scheduling tasks 262, 312–314
Search task 290–294
Search task, purging results 351
Search task, removing items from results 352
Search task, viewing results 352
Shortcut task 47, 277–284, 341–344
Shortcut task, troubleshooting 187–188
task capabilities 269
viewing task results as a chart 350, 352–361
with EmailXtender Archive Edition 44

EMC Centera 23, 25, 36–37, 64, 117, 129–131, 
133–135, 190

EMX files 23, 25, 30, 35–37, 46, 117–118, 120, 
139, 148, 190

deleting 124
transferring to another EmailXtender 

server 118
writing to storage media 117, 130–135

encryption 28, 31, 35, 45, 59, 65–66, 75
key 65, 75, 77
volumes 75–78

errors
Bloomberg Mail Parser 242, 253–255
troubleshooting 191

event log
application 141
EmailXtender 125–126, 141, 145, 147, 149, 

151–153, 157–158, 186, 189
security 141
system 141

exAdmin
group 40, 51, 202
service 149

Exchange. See Microsoft Exchange
exclusion rules 61
exporting EmailXtract task results 350–351
expression operators 99, 363–369

and 363
insignificant characters 368
not 364

or 364
parentheses 367
proximity-based 365–366
punctuation 369
significant characters 368
syntax 367
tense conflation 366
wildcards 364

extended drive 25, 37, 117, 129–131, 147, 187
creating 131
scanning for viruses 132

external message rules (SMTP) 107–108

F

FaceTime Communications instant message 
capture 31

FAST encryption 65, 75
folder 29, 84

BadDir directory 139, 151, 183
configuring 85–88
copying 89
creating 45, 84–85, 103
creating automatically 32, 69, 82, 84, 91, 

107, 121
creating, reasons for 102
default 29
deleting 89
description 85–87
directed search 40, 46, 88, 193, 202–204
directory 84, 127
disabling mail collection 29, 85–87
in EmailXtender Archive Edition 44, 78–79, 

84, 89
index directory 140
media. See media folder
public. See public folders
retention period 29, 31, 35, 46, 59, 62–64, 

84–85
retention period, setting 86, 88
rules 28–29, 32, 45, 84–85, 88, 91, 107, 278
settings, EmailXtract 319–320
storage directory 139, 144
within the Message Center hierarchy 25–26, 

50, 59–60
full-text index 21, 23, 25, 31–32, 59, 139–140, 

154, 231, 363
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backlog 150
checking status 165, 169
corrupt 146
corrupt, checking for 156
corrupt, repairing 141, 152, 168, 186
corrupt, replacing 36, 125–126
directory 140
drop directory 154
file size 35, 65, 75
file size, monitoring 35, 117
insignificant characters 368
performance impact 97–98
polling frequency 45, 64, 68
preparatory queue 144
punctuation characters 369
re-creating 36, 55, 120–121, 124–126, 190
removing 36–37, 55, 117, 126–127, 190
repairing 147, 168
service 144, 146, 149
significant characters 368
troubleshooting 156, 184
verifying process 140, 146–147
with EmailXtender Archive Edition 44

H

hierarchy, Message Center. See architecture

I

ICE-Key encryption 65, 75
IDX files 146
IIS (Internet Information Server)

drop directory 139
IMlogic instant message capture 31
Index (default Message Center cabinet). See 

cabinet
index. See full-text index
instant message (IM) capture 31, 46, 139

with EmailXtender Archive Edition 44

J

journaling utility 23, 71, 73, 93, 104

K

key, encryption 65, 75, 77
keyword rules 97–102

L

language support 23, 30, 34, 71, 94, 98–100, 
105, 118, 261, 266, 277, 305, 314, 321, 325, 
330–331, 341, 350

LDAP rules 32, 45, 91, 95, 108–116, 149
toolbar icon 56

legacy volumes, upgrading 122
license

EmailXtender 56
EmailXtender Archive Edition 44–45

list, distribution. See distribution list
log

application 141
Bloomberg Mail Parser 232, 235, 239–240, 

242–243, 250, 252–255
directory, EmailXtract 267–268
EmailXtender server status 169
EmailXtract 187–188, 263, 267, 272–273, 

276, 280–281, 284, 286–287, 289, 291–
292, 296–297, 300, 314–316, 350

event 125–126, 141, 145, 147, 149, 151–
153, 157–158, 186, 189

format (Bloomberg Mail Parser) 233
format, bear (Bloomberg Mail Parser) 234
format, bull (Bloomberg Mail Parser) 236
OWA shortcut support installation 188
rule cache 152
security 141
system 141

logging in
administrator mailbox 159
EmailXtender 50
EmailXtract 258
LDAP server 110

Lost and Found volumes 36, 55, 83, 89, 120, 
127, 186, 190

Lotus Domino 21
address book 91, 96, 106, 108, 158, 197, 

209, 211, 216, 218, 232, 239, 244, 250
analyzing NSF files 294, 298



Index
M - M

In
d

ex

EmailXtender, Release 4.7
Administrator’s Guide382

analyzing the message store 294
and Microsoft Exchange in one 

environment 95, 106, 195, 258
archiving from NSF files 31, 43, 257, 269–

270, 274, 276
archiving messages from 270
archiving modified data 276
checking event logs 141
deleting from NSF databases 284, 288
deleting messages from 284
EmailXtract logging 314
EmailXtract settings 43, 257, 272, 280, 286, 

291, 296, 302, 333–340
EmailXtract, using with 31
exporting an audit report to 207, 228–229
journaling process 23, 30, 59, 139, 148
journaling utility 23
LDAP rules 32, 108
logging 316
mailbox connector 23, 70, 147
mailbox connector, adding 73
message files 155
message store, managing with 

EmailXtract 257
password verification 54
restoring shortcut messages to 278, 342
searching for messages 290
searching NSF files for messages 290, 293
shortcut resolution service 149
shortcuts in NSF files 277
shortcuts in the message store 277
troubleshooting 145
viewing shortcut messages 278
with EmailXtender Archive Edition 43
with LDAP 110

Lotus Notes
password verification 260
Search Plug-in 23, 38, 193

M

magneto-optical 23, 25, 36–37, 117, 130, 190
mailbox connector 23, 30, 59, 92, 147–148, 185

adding 28, 66, 69–74, 154
deleting 74, 154
directory 139
polling frequency 28, 64, 66–68

verifying 185, 191
maintenance 42, 140–156
MAPI (Messaging Application Program 

Interface) 70, 114
profile, choosing 226–227, 258–259, 266–

267, 274, 282, 288, 293, 298, 320–322
profile, testing 323
using to email an audit report 229–230

media 23, 25, 27, 30, 36–37, 45–46, 117–118, 
120, 128, 148, 150, 190

capacity usage 129
changing types 128, 130
DiskXtender 130–135
organizing with rules 32
rewritable 122–123
write-once 122

media folder (DiskXtender) 37, 130, 133–135
media service (DiskXtender) 37, 130–131
MediaStor 131, 133–134
menu bar 53, 56, 260–261
Message Center 21, 23, 40, 59, 66, 70, 134, 

148, 193, 202, 287, 344–345, 351
adding volumes to 118
architecture 25–30
archiving messages to 270
compression 65, 75
directory 139–140, 172, 190
directory, BadDir 139, 148, 151, 155, 172, 

184
directory, clearing 156–157
directory, excess files 150
disabling mail collection 87
managing using the Administrator 49, 149, 

191
planning 60
polling frequency 64, 67
viewing 54
volumes, managing 118

message journaling. See journaling utility
message processing 139–140
message queues

blocked 184
checking 141–146
corrupt 155
log of contents 169
manually purging 155

Microsoft Exchange 21
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2000, configuring with EmailXtender 23
2003, configuring with EmailXtender 23
address book 91, 96, 106, 108, 158, 197, 

209, 211, 216, 218, 232, 239, 244, 250
analyzing PST files 294, 298
analyzing public folders 294, 299
analyzing the message store 294
and Lotus Domino in one environment 95, 

106, 195, 258
archiving calendar items, contacts, tasks, 

etc. 92
archiving from PST files 30, 43, 257, 269–

270, 274, 276, 325
archiving from public folders 43, 92, 257, 

269–270
checking event logs 141
choosing a MAPI profile 51, 258–259, 266–

267, 320–322
deleted retention items 303, 307
deleting calendar items, contacts, tasks, etc. 

from 344
deleting messages from mailboxes 284, 344
deleting messages from PST files 284, 288
deleting messages from public folders 284, 

289
deleting PST files 332
EmailXtract runtime priorities 265
EmailXtract settings 43, 257, 272, 280, 286, 

291, 296, 302, 316–333
EmailXtract, using with 30
exporting an audit report to 207, 226–228
hiding PST files 332
journaling process 23, 30, 59, 139, 148
journaling utility 23
language support 99–100
mailbox connector 23, 70–74, 147
making PST files read-only 332
message files 155
message store, managing with 

EmailXtract 257
moving PST files 332
OWA shortcut support 342, 344
preserving PST folder structure after 

shortcuts 332
Public Organizational Forms Library 187–

188
searching messages in public folders 293

searching PST files for messages 290, 293
searching public folders for messages 290
searching the message store for 

messages 290
shortcut resolution service 149
shortcut troubleshooting 187–188
shortcuts in PST files 277, 282, 326
shortcuts in public folders 277, 282
shortcuts on the mail server 277
shortcuts, restoring 278, 342
shortcuts, upgrading 278, 342
shortcuts, viewing 278
testing a MAPI profile 323
troubleshooting 145
with Active Directory Services 110
with EmailXtender Archive Edition 43
with LDAP 110

Microsoft Outlook
Search Plug-in 23, 38, 193
troubleshooting shortcuts from 188
viewing an audit report 228

Microsoft SQL Server
audit database 40, 42
entering messages into 155, 184
status 169

MilVault 23, 30, 59
move group (DiskXtender) 37, 133–135
move rule (DiskXtender) 37, 133–135
multi-byte language support 34, 71, 94, 98–

100, 105, 261, 266, 305, 314, 321, 325, 
330–331, 350

N

NAS (Network Attached Storage) 37, 122, 
130–131, 133–134

not, using in searches and rules 364
NSF files

analyzing message data 294, 298
applying EmailXtract tasks to 339–340
archiving from 31, 43, 257, 269–270, 274, 

276
deleting messages from 284, 288
ExJournal 73
searching messages 290, 293
shortcutting messages from 277, 282
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O

optical storage 23, 25, 36–37, 117, 130, 190
or, using in searches and rules 364
OWA (Outlook Web Access)

HTTPS and forms authentication 320, 322
shortcut support installation log 188
shortcut support service 149
shortcut support, enabling 277, 283, 342–

344
shortcut troubleshooting 188

P

parentheses in searches and rules 367
Parser, Bloomberg Mail. See Bloomberg Mail 

Parser
planning the Message Center architecture 60
polling frequency 28, 45, 64, 66–68, 70
priorities, runtime (EmailXtract) 264
proximity-based expression operators in searches 

and rules 365–366
PST files

analyzing message data 294, 298
applying EmailXtract tasks to 325–333
archiving from 30, 43, 257, 269–270, 274, 

276, 325
archiving from with EmailXtender Archive 

Edition 44
deleting 332
deleting messages from 284, 288
hiding 332
making read-only 332
moving 332
preserving folder structure after 

shortcuts 332
searching messages 290, 293
shortcutting messages from 277, 282, 326

public folders
access permissions 322
analyzing message data 294, 299
applying EmailXtract tasks to 324–325
archiving from 30, 43, 92, 257, 269–270, 

275
archiving from with EmailXtender Archive 

Edition 44

deleting messages from 284, 289
exporting audit reports to 226
searching messages 290, 293
shortcutting messages in 277, 282

Public Organizational Forms for shortcuts 187
punctuation in searches and rules 369
purge

message queues 155, 184
messages through EmailXtract 290, 294, 

350–352
rule, DiskXtender 37, 133–134
through DiskXtender 131–132, 134–135

Q

queues, message. See message queues

R

REF files 150
refreshing the interface 57, 164
remote administration 41, 51–52, 164–165
reports

all documents for an index or month 166
archiving 25, 30, 273, 316, 333
audit 24, 41–42, 205, 230
audit, custom 219–220
audit, emailing 229–230
audit, exporting 221, 230
audit, printing 220
audit, standard 207–219
audit, viewing 220
deleting from the message store 287, 316, 

333
error, Bloomberg Parser 242–243, 252–255
events. See event log
inventory, Bloomberg Parser 243–244
message store analysis 297
message store, analyzing 297, 316, 333
searching the message store for 292, 316, 

333
system status 141

retention period 21, 29, 31, 35, 59–60, 62–64, 
84–86, 88, 132–134

example 62
with EmailXtender Archive Edition 44
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rewritable storage media 122–123
rules

action (auto-forward) 91–92, 105–106
ADS 32, 45, 91, 95, 108–116, 149
bang 97–102
cabinet level 28, 78, 80, 82
cache files 152, 189
cache logging 152
collection 91–105
copying 83, 89
deleting 107
domain 61, 93–95
editing 106
EmailXtender 21, 23, 26, 31–32, 45, 59–60, 

91–116
exclusion 61, 91–105
expression operators 363–369
external (SMTP) 69, 79–82, 84, 91, 107–108
folder level 29, 84–85, 88
keyword 97–102
language 100
LDAP 32, 45, 91, 95, 108–116, 149
message queue 143, 184
move (DiskXtender) 37, 133–135
punctuation 369
purge (DiskXtender) 37, 133–134
service 149
specific address 95–97
strategy 61, 185
syntax 367
unmatched messages collection 102–104
vault level 28, 66, 69
with distribution lists 104–105
with the Bloomberg Mail Parser 241, 246

runtime priorities, EmailXtract 264

S

scheduling
Bloomberg Mail Parser 240, 251
EmailXtract tasks 262, 312–314

search
administrator 39, 46, 193, 201–202
auditing 24, 40, 42, 205, 207, 212–219
Boolean query 309
deleting/purging results 350–351

directed 28–29, 40, 46, 78, 80, 82, 85, 88, 
193, 202–204

domain for LDAP/ADS queries 111
duplicate results 336
expression operators 363–369
maximum number of hits 306
message store (EmailXtract) 25, 43
NSF files after archiving them 276
plug-in 23, 38, 193
PST files 329
PST files after archiving them 276
public folders 275, 282, 299
punctuation 369
removing results 352
service 149
shortcuts 284
special characters 308
supervisor 39, 46, 193–201
syntax 367
syntax for LDAP/ADS queries 112–114
task (EmailXtract) 269, 290–294
task results (EmailXtract), managing 349–

352
timeout for LDAP/ADS queries 111
toolbar icon (EmailXtract) 261
troubleshooting 189
types 21, 37–40
user 38, 193
verifying 153
viewing results 352
website 23, 37, 193
with EmailXtender Archive Edition 44

SEC (Securites and Exchange Commission) 
compliance 21

security
log 141
volumes, encryption 31, 35, 45, 59, 65, 75–

78
sendmail 23, 30, 59, 139, 154

with EmailXtender Archive Edition 44
server

Administrator interface 50, 52–57
ADS 91, 108–112, 115
configuration (volumes) 27, 30, 128–130
EmailXtender, Audit Utility on 24
EmailXtender, Bloomberg Mail Parser on 25, 

241, 244
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EmailXtender, clearing of files 153–156
EmailXtender, connecting to 50–52, 164–

165, 191
EmailXtender, DiskXtender on 25, 117, 130–

135
EmailXtender, EmailXtract on 25, 43, 257
EmailXtender, status 169
EmailXtender, status log 169
EmailXtender, troubleshooting 190
errors, writing to a log file (EmailXtract) 315
exAdmin group 40, 202
LDAP 91, 108–112, 115
mail, analysis 346–347
mail, checking for messages 144–146, 184–

185
mail, EmailXtract on 25, 43, 257
mail, mailbox connector on 59, 70–74, 185
maintenance 42, 137, 140–144, 146–156
Message Center component 25, 27, 59–60
proxy (instant message capture) 31
remote administration of 41
storage drive 23, 35–36, 117, 130
system architecture 22–25
troubleshooting 42
used as NAS media in DiskXtender 37, 130
website for searches 23, 37, 193

service 143
account, EmailXtender 137, 159–160, 325
Address Rule (ExAddrRule.exe) 145, 147, 

149, 152, 185
Administration API (ExAdmin.exe) 149
Archive (ExArchive.exe) 143–144, 147–148, 

153, 187, 189
connection error 50, 52, 191
Email Data Source (ExEmail.exe) 70, 143, 

148
Exchange Manager 

(ExExchangeMgr.exe) 71, 74, 149, 191
Index (ExIndex.exe) 144, 146, 149
Notes Manager (ExNotesMgr.exe) 149
Query (ExQuery.exe) 149, 153, 189
running EmailXtract tasks as 275, 283, 289, 

293, 299, 312
starting 149
status 169
toolbar icon 57
verifying 148–149

shortcuts
creating 25, 43, 47, 277, 284, 341–344
downloading Public Organizational Forms 

for 187
in NSF files 277, 282
in PST files 277, 326
managing the task 283
OWA support 188, 277, 342, 344
preserving PST file folder structure 332
resolution service 149
restoring 43, 278, 342–343
scheduling 280
simulation 279, 284
task results, managing 349–359
toolbar icon (EmailXtract) 261
troubleshooting 187–188
unresolved 278
upgrading 277–278, 342–343
verifying 342–343
with EmailXtender Archive Edition 44
with modified documents 277

SMTP
drop directory 154, 171, 231, 241, 251
messages, converting instant messages to 31
rules 32, 45, 69, 80–82, 91, 107–108

specific address rules 95–97
SQL Server. Microsoft SQL Server
stopping message collection 90
storage

container files 23
directory 139, 144
drive, EmailXtender 23, 25
media 23, 25, 27, 30, 36–37, 45–46, 117–

118, 120, 128, 148, 150, 190
media, capacity usage 129
media, changing types 128, 130
media, DiskXtender 130–135
media, organizing 32
media, rewritable 122–123
media, write-once 122

StorageTek ACSLS 132–134
strategy for mail collection and archival 26
supervisor search 39, 46, 189, 193–201
syntax

keyword bang rule 98–102
LDAP/ADS search 112–113
rules 367
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search 367
system architecture 22

T

tape 23, 25, 36–37, 117, 130, 190
tasks, EmailXtract. See EmailXtract
TBL files 146, 154
tense conflation in searches and rules 366
The 173
Tivoli Storage Manager (TSM) 130, 132–134
toolbar 53, 56, 260–261
troubleshooting 42

EmailXtender server 190
error messages 191
message collection 183–185
OWA shortcut access 188
searches 189
shortcuts 187–188
volumes 185–187

TXVLTS files 146, 154

U

U.S. Code of Federal Regulations 21
U.S. Securites and Exchange Commission. See SEC 

compliance
UDO (Ultra-Density Optical) 37, 130
unmatched messages collection rule 102–104
user search 38, 193
utilities

audit. See Audit Utility
ExBadDirProcessor.exe 151, 155, 157, 171–

172, 184, 190
ExMailStatus.exe 141, 169–171
ExSuspend 173
HealthCheck 147, 156, 161–169
Managexvlt 176
ReadMSMQ 143, 145, 180, 184
UnpackContainer 178

V

vault 27, 66
BadDir directory 139, 148, 151, 183
compression 28, 45, 65–66, 75–78

description 68
drop directory 139, 143, 155, 184
encryption 28, 45, 65–66, 75–78
mailbox connectors 28, 66, 69–74
polling frequency 28, 45, 64, 66–68
rules 28, 32, 66, 69, 91
within the Message Center hierarchy 25, 50, 

59–60
virus

restoring the mail system after 21
scanning for 132

volumes 23, 29, 35–37, 117–135
after a cabinet deletion 83
after a folder deletion 89
assigning messages to 143
auditing deletion of 24, 41–42, 205, 207, 

210–212
capacity 30, 129
closing 35–36, 120, 139, 155
compression 28, 31, 35, 59, 65–66, 75–78
configuring 27, 46, 128–130
corrupt, re-indexing 36, 125, 186
deleting 36, 123
disposing of data for 36, 127, 186, 190
ejecting 128
encryption 28, 31, 35, 59, 65–66, 75–78
legacy 122
Lost and Found 36, 55, 83, 89, 120, 127, 

157, 186, 190
monitoring service 148
moving between EmailXtender servers 30, 

35
NTFS 130
open, large numbers of 147, 150, 187, 190
processing messages associated with 172
re-indexing 36, 39, 125, 189, 195, 198, 200
removing indexes for 36, 126, 190
restoring 36, 120, 187
retention period 29, 31, 35, 46, 59, 63–64, 

84–88, 133
size, changing for EMC Centera 133
status 119, 169
storage drive 23, 25
storage path 129
troubleshooting 185–187
upgrading 30, 36, 122–123, 278, 342
viewing through the Administrator 55
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within the Message Center hierarchy 25, 50, 
59–60

writing to media with DiskXtender 36–37, 
46, 130–135, 190

W

Web Search Client 23, 37
website (search). See Web Search Client
wildcard characters

in EmailXtract tasks 305–306, 308–309
in keyword rules 99, 364
in searches 364

WORM 37, 130
WORM-tape 37, 130
write-once storage media 122

X

XRC files 152, 189
XVLT files 143
XVLTS files 146, 154
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